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About This Manual

This manual describes Lookout object classes, listed in alphabetical order,
in two chapters.

Conventions

The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.

> @

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash.

bold Bold text denotes items that you must select or click on in the software,
such as menu items and dialog box options. Bold text also denotes
parameter names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames and extensions, and code excerpts.

monospace bold Bold text in this font denotes the messages and responses that the computer
automatically prints to the screen. This font also emphasizes lines of code
that are different from the other examples.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value
that you must supply.
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About This Manual

Related Documentation

Lookout Object Reference Manual

The following documents contain information that you might find helpful
as you read this manual:

Getting Started With Lookout
Lookout Developer’s Manual
Lookout Operator’s Manual

Lookout Object Developer’s Toolkit Reference
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Introduction to the Lookout
Object Class Reference

This manual describes Lookout object classes, listed in alphabetical order,
in two chapters.

Chapter 2, Lookout System Objects, covers the Lookout System object
classes, native to Lookout. You use objects made from these classes as
controls and for data analysis and display.

Chapter 3, Lookout Driver and Protocol Objects, contains Lookout driver
and protocol objects that you use to connect to PLCs, RTUs, and other
hardware that is a part of your industrial automation and control system.

Input parameter syntax and data members are documented for each object
class, along with a description of the functionality of each object class.

@ Note Lookout assists you in building graphical screen displays when possible. When you
place a displayable object (like Pots or Switches) on a control panel, the appropriate
Display Parameter dialog box appears, prompting you to select a display type. If the
object is not displayable but supports an implicit signal (like Counters, LatchGates, and
OneShots), Lookout inserts an expression on the control panel.

You can elect not to display an object or its signal by clicking on the
Cancel button at any time. If you change your mind later, you can display
the object or its signal using the_ Insert»Displayable Object or
Insert»Expression commands, respectively. You can drag and drop an
object or data member from the Object Explorer to a panel at any time.

Some object classes have neither a display member nor an implicit
signal—instead they have multiple data members. If you want to display
the result of a logical or numeric data member on a control panel, you can
use the Insert»Expression command and choose the appropriate name and
data member, or drag and drop the data member from the Lookout Object
Explorer.

See the Getting Started with Lookout manual for more information on
creating objects, modifying their databases, and linking them together.
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Lookout System Objects

This chapter describes Lookout System object classes, listed in alphabetical
order. Input parameter syntax and data members are documented for each
object class, along with a description of the functionality of each object
class.
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Chapter 2 Lookout System Objects

Accumulator

Accumulator is a numeric totalizer. It samples the numeric Input any time
the Sample value transitions from off to on, adding each new sample to the
previous running total. It resets the totalized value to zero when Reset
transitions from off to on.

M ame: W
Input = ||
Sample = I
Reset = I
QK | Cancel | Help |

Figure 2-1. Accumulator Definition Parameters Dialog Box

Input is a numeric expression while Sample and Reset are logical
expressions.

The following HyperTrend demonstrates the relationship between Input,
Sample, and Reset.

r
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Accumulator Data Members

Chapter 2 Lookout System Objects

Table 2-1. Accumulator Data Members

Data Members

Type

Read

Write

Description

(implicit)

numeric

yes

no

Current totalized value, totalized since the
most recent Reset signal. Updated at the
defined Sample rate.

Comments Reset could be a regular pulse interval created by a Pulse timer, as shown

in the dialog box in Figure 2-1.

The Counter object class totalizes a number of logical events and the
Integral object class totalizes rates. Use Accumulator to totalize numeric
variables.

Related Objects Average, Minimum, Maximum, Sample
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Chapter 2 Lookout System Objects

ActiveX

Lookout Object Reference Manual

Use ActiveX controls in Lookout through the ActiveX control object. This
means you can use any of a number of widely available programming tools
to create your own custom ActiveX control that performs special tasks
unique to your needs, and then incorporate that control into your Lookout
processes.

While you can use any properly made ActiveX control installed on your
computer with the Lookout ActiveX object, Lookout has the following
useful National Instruments ActiveX controls, most of which can also be
used as indicators.

CWButton—a collection of control panel pushbuttons and switches
with special appearance, mode of operation, formatting, and animation
options.

CWKnob—a potentiometer type control that can appear as a knob or
as several different varieties of a meter, incorporating a wide variety of
functionality options.

CWDMotor—an on/off control/indicator that can appear on the front
panel as several different types of motors, that includes a variety of
appearances and function options.

CWNumEdit—numeric entry control with a variety of functionality
options and format settings.

CWPipe—an on/off control/indicator that can appear as a variety of
pipes on the front panel, that includes a wide variety of appearances
and function options.

CWPump—an on/off control/indicator that can appear on the front
panel as a variety of pump types, that includes a range of appearance
and function options.

CWSlide—a potentiometer type control that can appear as a variety of
sliders or as a tank or thermometer, with a wide variety of functionality
options.

CW Valve—an on/off control/indicator that can appear on the front
panel as several different types of valves, with a variety of appearance
and function options.
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*  CWVessel—a potentiometer type control that can appear as a variety
of tanks, bins, or hoppers, with a wide variety of functionality options

*  CWGraph—a control in Lookout 4.5 because that is an integral part of
the package containing the other controls. It is difficult to use this
control in Lookout, so we recommend that you use the HyperTrend or
the Lookout graphic objects instead of CWGraph.

The above controls are a part of National Instruments ComponentWorks
collection of ActiveX controls. You can acquire other ComponentWorks
special use controls separately through National Instruments.

Creating a Lookout ActiveX Object

Creating an ActiveX object is similar to creating any other Lookout control
object. There are a few aspects of creating an ActiveX control that are
different, as explained in the following example.

The Lookout ActiveX object is an ActiveX container for Lookout that
accepts an ActiveX control and allows it to function in a Lookout process,
allowing the object to communicate with other Lookout objects and
perform its own specific functions, as designed. The ActiveX control is a
piece of software that meets the Microsoft ActiveX control specifications.
It can be anything from a National Instruments ComponentWorks control
to a special tool you create to conform to ActiveX standards. ActiveX
controls are configured through properties, each control having its own set
of properties.

Lookout 4.5 does not support ActiveX methods and events.

@ Note Unlike other Lookout objects, you can only have one display for each ActiveX
object you create. If you attempt to place a second display on a control panel, Lookout
displays an error message instead. This also means you can not <Shift-drag> an ActiveX
display to copy it. However, you can <Ctrl-drag> an ActiveX control to make a new
instance of it.
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Complete the following steps to create an ActiveX object in Lookout.

1. Open the Select Object Class dialog box. Click the ActiveX tab. The
following dialog box appears.

Select object class: [ %]
Lookout  Active |

vV Categorize

|_1 Mational Instruments

I_] Other

B cconmended!

-~y Acrobat Contral for Activel

-y Calendar Contral 8.0

-y CwiButton Contral [National Instruments)
-~y CwiKnob Contral [Mational Instruments)
-y CwiMotar Contral [National Instruments)
-y CwNumEdit Contral [Mational Instruments)
-y CwPipe Cantrol [Mational Instruments)
-y CwPump Contral [National Instruments)
-~y CwiSlide Contral [Mational Instruments)
-y Cwhalve Contral [National Instruments)
-y Cwhessel Control (Mational Instruments)
-y Cwhessel Control (Mational Instruments)

-y Microsoft Web Browser Rescan Cantrals |

-y Windows Media Player

Cancel |

The contents of a complete list of ActiveX controls depends on what
ActiveX controls are installed on your computer by various software
packages. For example, Microsoft’s Calendar is widely distributed and will
usually appear in the list of controls with other controls, including the
National Instruments controls installed by Lookout 4.5 and any other
National Instruments products.

To help you find the most useful controls for developing a Lookout
processes, the ActiveX controls are categorized into three groups:

¢ Recommended—ActiveX controls created by National Instruments or
other sources that have been tested with Lookout.

e National Instruments Controls—ActiveX controls created by National
Instruments that are currently installed on your computer. Lookout
may not completely support all of these controls.

e Others—ActiveX controls created by someone other than National
Instruments that do not appear on the list of controls tested by National
Instruments. Lookout may or may not support untested controls.

@ Note If you have recently installed an ActiveX control and it does not appear in the
selection list, click the Rescan Controls button to look for new ActiveX registrations.
If the control you are looking for still does not appear, re-install the control.
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Select an ActiveX control. This example uses the CWButton control
from National Instruments. Click on OK. The following dialog box
appears.

Create CWButton Control [Mational Instruments) E3

MName: |

Froperty Pages... |

Yalue Property: IVaIue

I~ Remote
EL:= |

Shap back: M| ShamDelE: |2

— Property Palling
Poll R ate = I

Pall = |

Fall after write:

Control security level: IU Log events: [

[ Accept no mouse input [reat as indicator]

Ok | Cancel | Help

Notice that the default object name is a shortened version of the name
of the selected ActiveX control with a number appended. Rename it
with any name within the Lookout naming conventions.

Click the Property Pages button to access the dialog box used to
configure the ActiveX control, as it will function for this Lookout
ActiveX object. Refer to the ActiveX Control Properties section for
more information about working with ActiveX control properties.

Check the Value Property field. It contains the word vValue. If the
field is blank, you are using a custom-built ActiveX control.

Lookout control objects contain a value data member that is used
when you need to make a connection to a control that has a remote
source connection. This data member is also available in an ActiveX
object if the ActiveX control has a property we can assign that data
member to carry.

2-7 Lookout Object Reference Manual



Chapter 2 Lookout System Objects

Lookout Object Reference Manual

When you select which ActiveX control to use in your Lookout
ActiveX object, Lookout checks to see if the ActiveX control has a
property called Value. If it does, Lookout makes that property the
Value Property. If there is no property called value, Lookout leaves
the Value Property field empty.

You can create an ActiveX object without setting a Value Property.
If you do, then your completed object will not have the value, reset,
or resetValue data members, because they will not have any
ActiveX control properties to connect to.

In ActiveX terms, this is called the default property. It can be called
anything, depending on the control. For ComponentWorks this
property is called Value.

You can set virtually any property of an ActiveX control as the Value
Property, but it is best to restrict your selection to properties that are
readable, writable, and bindable, and that handle data in a form that
you will find useful in your Lookout process.

You cannot browse ActiveX Control properties through the Value
Property field, so you must know the name for the property you want
to select if it is not named Value. Refer to the documentation for the
ActiveX control you are using to determine the correct property name
for the property you want to assign as the Value Property.

Select Remote if you want to make a remote source connection for this
ActiveX object. Make the connection as you would with any other
Lookout object that permits a remote source connection.

Activate Snap back if necessary. If you activate Snap back, you can
then set Snap Delay.

Under ordinary circumstances, when a remoted Pot value is changed
from a control panel, Lookout allows a given amount of time, in
seconds to pass and if the remote value does not change to coincide
with the newly selected value, the remoted Pot snaps back to the old
value.

For most Lookout control objects, that time is set in the Lookout . INT
file using the SnapDelay key. Because of the nature of ActiveX
controls and possible added delay in response time, you can choose
whether or not to enable Snap back for an ActiveX object, and to set
the snap delay for each control (default = 2 seconds). These settings
apply only to the ActiveX object in which they were made, and do not
override the settings in the Lookout . INT file that cover the rest of the
Lookout objects.
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Refer to Appendix C, Lookout INI file, in the Lookout Developer’s
Manual for more information about . INT file setting used for other
Lookout control objects.

Set Property Polling. One of the features of ActiveX control
properties is whether or not they are bindable. A bindable property
updates automatically, and a non-bindable property control is polled.
Which properties are or are not bindable varies between ActiveX
controls.

To make sure all the non-bindable properties of the ActiveX control
refresh consistently, set a Poll Rate to refresh at regular intervals, set
a Poll trigger (such as a pushbutton or a Lookout expression that polls
under predetermined conditions), or select to Poll after Write
(refreshes the properties after they’re written to).

This is only necessary if you are reading the properties in Lookout.
Polling is not necessary if you are not reading the values of properties
in Lookout or are only reading properties that are bindable and
automatically signal Lookout when they change.

Select Accept no mouse input to disable the user input to the control.
This makes the control function as an indicator.

Click OK to accept the control.

Open the Object Explorer if it is not open already, and expand the
object. The following figure shows an ActiveX object using the
CWButton ActiveX control.

Object Explorer

= tripper 'I

E|-- Procesz1

-y $dslarm
-+ Panell
|'__'|..

[~ properties
----- [implicit]
----- w araphic
----- W poll

----- w’ polR ate
----- w reset

----- W rezelyalue
..... ﬂ" value
F-éy $Keyboard
F-éfly $5pstem
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The new object contains data members for the ActiveX object and data
members connected to the ActiveX control properties. These ActiveX
control property data members are contained in a folder named
properties. Refer to the ActiveX control documentation for more
information about the properties of specific controls.

@ Note Only top-level properties are shown as data members in Lookout 4.5. Sub properties
are not shown as data members. If necessary, you can access sub properties from the

property pages.

12. Edit the database and make any connections necessary.

13. Configure security and event logging as you would with any other
Lookout object. Remember that event logging only takes place for the
property you designate as the Value Property when you configure your
ActiveX object.

A Caution Lookout security only works when your ActiveX object is using a windowless
ActiveX control. Windowed controls bypass Lookout security. All of the National
Instruments ActiveX controls are windowless controls that can be used with Lookout
security. Refer to the documentation for any other ActiveX controls you use to see whether
they are windowed or windowless controls. For the same reason, snap back is not
guaranteed to work properly with windowed controls.

ActiveX Control Properties

Click the Property Pages button in the create object dialog box for an
ActiveX object to access the property pages for the ActiveX control you are
using with that ActiveX object. A dialog box with many tabs appears, as
shown in the following figure.

CWEButton Control [Mational Instruments] Properties EHE

Buttonl Bindingsl Imagesl Advancedl About I

Al o | @ | = @

W | =] [

Round Star LED

QK I Cancel Lol | Help |
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A Caution While the National Instruments or ComponentWorks ActiveX control property
sheets allow you to alter bindings (like Data Socket), you should consider this an advanced
activity and avoid making such changes unless you understand ActiveX controls in general
and the particular control you want to change bindings in.

ActiveX Verbs

Right-click the ActiveX display on the panel to access the ActiveX Verb
for that control, as shown in the following figure.

Object Properties. . I
Cw/Button Edit

Import Style...
Eanf..

Export Style. .
TiEextEalon.. Hel
Eackaround Ealar. i .

. Properties...

Himeric Earmat..
Juztify Text 3
Arrange 3

Most often you will be able to get to the property pages from the Verbs
menu. If the property pages are not available from the verbs menu, select
Object Properties and click the Property Pages button in the ActiveX
object dialog box.

@ Tip Detailed documentation for individual National Instruments ActiveX controls is
accessible through the Help button on the Property pages.

ActiveX Object Data Members

Data
Member Type Read Write Description

raphic numeric es no Data member used to designate
grap Yy g
which display of this control you
want to appear on an HTML
report. In the case of the ActiveX
object, only one display is
available for this purpose.

poll logical yes yes A transition to true initiates a poll
of any properties being read.
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poll rate numeric yes yes Time interval for polling. Enter a
time using standard Lookout
00:00:00.0 format.

reset logical yes yes While this value equals TRUE,

(optional) the control will be set to the value

in resetValue.

resetValue polymorphic yes yes Sets the value a control will take

(optional) when the reset data member is
TRUE.

value polymorphic yes yes The current value of the control’s

(optional) value property. If you have

remoted this control, then value is
the current value of the position
source.
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Aggregate

The Aggregate object is a way for you to create a collection of Lookout
objects, already connected and configured, and use that collection multiple
times as an element in your processes.

Create an aggregate by creating a Lookout process and saving the process
as an aggregate definition file, choosing which of the object parameters and
data members to expose when aggregate is used in another process. Then
use that aggregate definition in other processes by creating an aggregate
object that uses your aggregate definition as its source.

If you need to change the aggregate object, you can update the aggregate
definition process at any time. The next time you open the process using
that aggregate object, any changes to the definition process will be present
in the aggregate object.

Follow these useful rules and principles when you use aggregate objects.

*  An aggregate object must reference a Lookout process as a definition.
When you select the Lookout process file (. 14p) as the definition
process for your aggregate object, the usual Lookout rules about path
and Lookout path relativity apply. In order for your aggregate object to
function properly, the aggregate definition process must be present and
available in the location the aggregate object references to find it.

*  The aggregate definition processes can use both Lookout system
objects and Lookout driver and protocol objects.

*  You can create multiple aggregate objects in any given single process
using the same aggregate definition process.

*  You can create nested aggregate objects. You can make an aggregate
object using a definition file that itself contains one or more aggregate
objects.

* An aggregate object contributes to your Lookout I/O count as the
individual elements of the aggregate object definition would if they
were incorporated into your Lookout process individually.

* If you change and save the definition process for an aggregate object,
the aggregate object will reflect those changes the next time the
process containing the aggregate object is loaded and run. This
includes any changes you make to individual objects, in connections,
and in any definition configuration options you change.
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You can choose which of the data members in an aggregate definition
process will be available for use from an Aggregate object. You can
expose the data members from your definition process through an
aggregate object in several different ways:

— All data members in the definition process are available
through the aggregate object.

—  Only data members read from or written to in the definition
process are available through the aggregate object.

— Individually selected data members from the definition
process are available through the aggregate object.

— No access to any data members in the definition process
permitted. In this case the aggregate object usually functions
as a display only.

Most Lookout objects have basic parameters that you configure when
you create the object. You can change some of the parameters
programmatically and some you can not. Some of these parameters
may need to be customized for each different aggregate object you
create from a given definition process. You can make object
parameters available for configuration in an aggregate object, but
special rules apply. Refer to the Creating an Aggregate Definition
Process section for more information about how to prepare a definition
process for use in an aggregate object.

You can use any Lookout process as a definition for an Aggregate
object, but if you do so without saving that process as an aggregate
definition, you will not be able to take advantage of pre-configuring the
aggregate object to make using the object easier and more convenient.
For this reason we recommend saving the definition processes as
aggregates before using them to create an aggregate object.

Note You can create an aggregate object without specifying a definition file or by
specifying an invalid file. An object will not function without a valid definition, however.
You may find this convenient at certain times in development, debugging, or deployment
of your processes, but check to make sure the aggregate object is using a valid definition
process file if for some reason it is not working.

Lookout Object Reference Manual
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Creating an Aggregate Definition Process

You can use any Lookout process as an aggregate definition. Once you
have the process running, save the process as an aggregate definition by
selecting File»Save as Aggregate. When you save a process as an
aggregate definition, you can configure what data members and object
parameters will be available for use when you use that definition for an
aggregate object.

An aggregate object does not have any display components. However, any
panels you create in your aggregate definition process are available through
your aggregate object. If you want an aggregate display or displays, use
panels when creating the aggregate definition process. You can also create
an aggregate definition process with no panel and not have a display.

E Note You can not drag an object from inside an aggregate to make a display. You can insert
an expression or remote a control to an aggregate data member on a panel. You can not use
the display element of objects in the aggregate, itself.

@ Tip To make your application using aggregate objects easy to deploy, save all of your
aggregate definition processes in a directory inside the Lookout directory. Then when you
create an Aggregate object, using the Browse button to select the Aggregate definition
process will automatically make the path relative to the Lookout directory.

When building a definition process, remember that the collection of objects
and connections between them in the definition process can not be changed
through the Aggregate object. What you save is what you will get.

Object Parameters in an Aggregate Definition Process

Lookout objects have parameters that configure their basic properties.
Some parameters can only be set in the create object dialog box. Some
parameters accept variables as their input so that you can change the
parameters programmatically and some parameters only accept a constant.
Most are not accessible through data members. You can expose any object
parameter to configure when creating an aggregate object, but you can not
change that configuration programmatically. This is also true in the case
of parameters that ordinarily would accept a variable as an input.

In the case of constant parameters, you may find that some need a different
setting in each individual aggregate object use.
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For example, you may have a driver that requires a phone number, a serial
port setting, or an IP address, to communicate with the device it is supposed
to drive. To use this driver in an aggregate, you must be able to change such
settings for each object made. The solution is to expose the parameter when
saving the process as an aggregate definition.

When creating a definition process, enter the value for the parameter to
expose as you would in any other Lookout process, to run and test the
process before saving it as an aggregate. When saving the process as an
aggregate definition, using the steps in Saving a Process as an Aggregate
Definition, you can expose the parameter for use in an aggregate object.
The value set for the parameter when the aggregate object is created
overrides the setting made in the aggregate definition process.

In the case of parameters that accept either a constant or a variable, there is
no problem using a constant when creating the object and exposing the
parameter for aggregate use the same way as for a fixed parameter. Use a
constant for that parameter when you make an aggregate object using that
definition process.

If you need an object parameter to have a variable input in the definition
process, connect the appropriate Lookout control to that parameter when
creating the object. When you create an aggregate object using that
aggregate definition, you can manipulate the variable parameter by
connecting to the control from the host process. For example, to adjust the
period for a Waveform object, create a Pot object in the definition process,
put that control on the panel, and connect it to the Period parameter to
change the poll rate. Operate the Pot through an Aggregate object by
accessing the control panel or programmatically, using the pot’s Value
data member.

Naming and Numbering Lookout Object Parameters

Lookout object parameters appear with numbers only and not with names.
In most cases the numbered parameters correspond to the named options
configured in the Create Object dialog box, but there are also hidden
parameters used for compatibility with earlier versions of Lookout and
Lookout objects. Additionally, the number of a parameter does not always
correlate with the location of that parameter on the create object dialog box.
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Refer to Appendix A, Object Class Parameters, to work around this
difficulty. The following table is a sample of the parameter list.

Table 2-2. Modbus Slave Object Parameter List

Parameter Name Type Description

1 Address NumChnst Slave address (1 to 255)

2 Serial port TxtCnst Serial port (such as “COM2”)

3 Data rate NumCnst Baud rate; default is 9600

4 Parity TxtCnst Parity (text); default is “none”
(“Odd”’ ‘Geven”’ 4‘mark?’, ‘Gpace7’)

5 Data bits NumChnst Data bits; default is 8 (not accessible through
the create object dialog box)

6 Stop bits NumCnst Stop bits; default is 1
(1.5,2)

The parameter number corresponds to the number of the parameter as it
appears in the Connection Browser, and to the order in which parameters
appear in a Lookout source file (. 1ks).

The Name is the name of the parameter as it appears in the Create Object
dialog box for that object. The data type may be logical, numeric, or text,
and a constant or a variable. When you expose a parameter that accepts a
variable input in an aggregate object, you can only assign a fixed value to it.

Refer to Appendix A, Object Class Parameters for a complete description
of each parameter.

Saving a Process as an Aggregate Definition

After finishing the process you intend to use as an aggregate definition,
save the process as an aggregate definition. There are potentially two
phases of this saving process: exposing data members and exposing object
parameters.

Exposing Data Members in an Aggregate
Definition Process

Data members are the most commonly required elements of an aggregate
definition process. Complete the following steps to expose Lookout data
members when saving a process as an aggregate.
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Define Aggregate Data Members E

B
B
B
B

EIJ WwiF_Clrls
[l Amplitude_Pot
[l Offset_Pot

H-§y ModbusSlavel
-4y Panell

-3y Patl

H-§y Switch
B4 nWaveform1

Select File»Save As Aggregate. The Define Aggregate Data
Members dialog box appears, as shown in the figure below. This
example shows a partially expanded view of the process about to be
saved.

&' Export all data members
" Expoit only these data members:

. export_defirition

- Ex=port >

<% Period_Pat
% Phase_Pat

{;&3— SampleFate_Pat

Mew Folder

Allwdritten >

ﬁ cogine_180 - cozine180 &ll Bead 3>
randaom

Reset

Sample

SampleR ate

", saw_180 - saw180

" #ine_180 - sine180

" square_ 180 - square1B0
" tiangle_180 - triangle180

Parameters...

| BE GE

oK

Lancel |

Note You can sele

Save your process as an aggregate definition with the Export all data
members option selected, and no individual object parameters
exposed, by clicking OK. All of the data members belonging to all of
the objects in this process will then be available when you create an
aggregate object using this as a definition process.

ct any file name when you save your process as an aggregate definition.

In this way you can keep your original process without any of the aggregate options

configured and sav
process. You can al

e variations of the process to use as aggregate definitions in another
so re-save a process you have saved as an aggregate definition under the

same or a new file name, changing the data member and parameter configurations.

Lookout Object Reference Manual

Select Export only these data members to limit the data members
exposed when you create an aggregate object. When this option is
selected, only the data members visible in the right window are
exposed when you make an aggregate object from this aggregate
definition.
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4. Click the All Written or All Read buttons to expose all the data
members being written to or read from in your process. You can
remove any unwanted data members manually, if necessary.

5. Delete any unwanted data members by selecting them in the right
window and pressing the <Delete> key.

6. Select any unwritten or unread data member in the left window as
shown in the following figure, and click the Export button to expose
the data member in the aggregate.

E|-" Server_Simulator

-1 WF_Clrls
[ BMS1_1_ctil
-3 MBS1_40001_ctrl

----- $ 20001 - 39999
----- $ 0001 - 49999
----- $ BCD30001 - BCD39399
----- $" BCD40001 - BCD 49399
----- " D30001 - D39399

" 040001 - D49399
Fa0001 - F39399
----- $7 FADD0T - F49933
----- $7 H40001.H - H49933.16
----- $7 S40001 - 549993
..... g Update
-85 Panell
-8 Waveform1

Ex=port >

Mew Folder

Allwdritten >

AllBead »»

Parameters...

| BE GE

" Export all data members
& Expoit only these data members:
E11E), export_definition
= _4 ModbusSlavel
-

47 40001

-4 W aveform1

&7 SampleR ate
B4 WF_Ctils

A Ampliude_Pot
A Difset_Pat
A7 Period_Pot
------ A Phase_Pot

Ok | Lancel |

Note When you expose an individual data member manually, it appears in the folder that

is selected in the right window. Make sure the appropriate folder is selected in the right
window before exporting your data member. You can not at this time rearrange data
members after they have been exported, but you can delete and re-export them into the
location you prefer. If you want to group data members for convenience, create new folders
using the New Folder button.

7.
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If the data member representation you select represents a range, the

Select Data Member to Export dialog box appears, as shown in the

following figure.
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Select Data Member to Export E

|? oK |

8. Select the data member you want to export from the range and
click OK.

9. Repeat the process until you have added all the individual data
members you want to add.

@ Note Like any other task on a computer, you can lose considerable work if your system
crashes or you experience an interruption in power while working. If you are manually
exposing a large number of data members in an aggregate definition, save regularly by
clicking OK. Continue the process of configuring your aggregate definition by selecting
File»Save As Aggregate and resuming configuration where you left off before saving.

10. If you do not need to expose any object parameters in your aggregate
objects, finish saving your process as an aggregate definition by
clicking OK. If you do need to expose parameters, proceed to the steps
in the Exposing Parameters in an Aggregate Definition Process
section below.

@ Tip You can password-protect the Aggregate definition as you can any Lookout process
by selecting Protect file from editing with your account name/password. Remember
that your account must have a password to use this feature. Developers who have an
administrator account with no password set will have to set a password for their user
account in order to password protect their definition process.

Lookout Object Reference Manual 2-20 ni.com



Chapter 2 Lookout System Objects

Exposing Parameters in an Aggregate
Definition Process

You may need to expose certain object parameters, such as phone numbers,
IP addresses, and COM ports from within aggregate objects. Select the
parameters to expose when saving the process as an aggregate definition.

1.

Define Aggregate Parameters E

After you have exposed the data members you want available and
saved the process, if necessary, select parameters to expose by clicking
the Parameters button in the Define Aggregate Data Members
dialog box. The Define Aggregate Parameters dialog box appears, as
shown in the following figure.

E|--‘ Server_Simulator

& BMS1_1_ctl

<35 MBS51_40001_ctrl
8% ModbusSlavel
3% Panell

“ModbusSlavel

0 Slave_Address
1 Param 1

[

Exported parameters

Add/Edit »> |

_tp | Do
Mame | # I

Slave_Address “ModbusSlavel.0

“ModbusSlavel 1

<< Remove

i

Ok | Lancel |
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Select the object to expose parameters from in the left window of the
dialog box. A list of the parameters available appears in the center
window.

As discussed in the Naming and Numbering Lookout Object
Parameters section, the parameters initially appear only as numbers.
Assign names to the parameters that will appear when you create an
aggregate object later on.

Select the parameter you want to expose in your aggregate object in the
center window and click the Add/Edit button. Enter the name for that
parameter in the Exported Parameters field. Change the name by
selecting it in that field, or by selecting it in the field in the center of
the dialog box and clicking Add/Edit.

Repeat the process until you have exposed all the parameters you need
to expose.
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Click OK.

This returns you to the Define Aggregate Data Members dialog box.
If there are no other data members to export, complete saving your
process as an aggregate definition by clicking OK.

Creating and Configuring an Aggregate Object

Once you have saved a process to be used as a definition process, you can
create multiple aggregate objects from that definition. To create an
aggregate object, use the following instructions.

1.

Select Object»Create from the Lookout menu or right-click in the
Object Explorer on the process you want to put an aggregate object in,
select New Object, then select Aggregate from the list of object
classes. If you have your selection list categorized, you will find the
aggregate in the Control category. The Create Aggregate dialog box
appears, as shown in the following figure.

Create Aggregate: E
Hame: IAggregate‘I
Drefinition File to load: Browse. .. |

Iswsim_aggregate2.|4p

()8 I Cancel |

The aggregate has only one parameter of its own: the definition process
to use. Enter the name of the file for the Lookout process saved as an
aggregate in previous steps. Click the Browse button to locate the file.

@ Note You must have the .14p file for the definition process available for an aggregate
object to work. Store this file in the Lookout directory and access the file using a relative
path. If necessary you can make multiple copies of the definition process file if you have
host processes running from different directories on your computer. However, using a path
within the Lookout directory when you create an aggregate object is a better strategy.

Lookout Object Reference Manual
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Once you have set the path to the definition process, click OK. If you
did not expose any parameters when you saved the definition process
as an aggregate, this completes the task of creating an aggregate object.
If you have exposed parameters to configure, the Assign Parameter

Values dialog box appears, as shown in the following figure.

Asszign Parameter Yalues E

Enter walues faor all of the named parameters below.

ok, I
Caticel |

Mame | Walue

Slave_Address 1

Serial_Port "COMI"

Panel_Title "Simulater Server Caontrol Fanel

Pushbutton_werify_an_test

< |

The parameters configured to be available in the aggregate object when
you saved the definition process are listed at the left side of the field.
Click anywhere on a line to enter the value for the parameter that is on
that line.

The allowable values for the parameters are documented in
Appendix A, Object Class Parameters.

When you finish entering the values for the parameters, click OK to
complete the creation of the Aggregate object.

Making Connections and Editing the Database for Aggregate Objects

Make connections to the exposed data members and configure them in the
database as you would with any other Lookout object.
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Alarm

Alarm is a flexible and powerful object class you use to create various
logical- and numeric-triggered alarms that are displayed in the alarm

window.

@ Note You should first read about the Lookout alarm system in Chapter 9, Alarms and
Events, in the Lookout Developer’s Manual to aid you in designing the most efficient
alarming scheme for your application.

Create Alarm E

Mame: ILogicaIAIarm Alarm area: IF'Iant J

Meszage = I"Helief walve failed to open after 30 zeconds"

Condition = IF'LEI‘I reliefyly &MD DelayOnTimer

—* | ogical alam

Friority wave
(R file: ICi\ Browse... |

" Mumeric alam

FEriaritiss

Hittilevel= | [
Hilevel= | [
Lrlevel= I l_

Lher{ b evel = I l_
Erateiaf change = I l_

(= I [Examples 1RV ar penmiaute]

Sample = I

QK I Cancel | Help

Figure 2-2. Typical Settings for a Logical Style Alarm

There are two basic alarm types: Logical and Numeric. When Logical
alarm is selected, Lookout prompts you to enter a logical expression in
the Condition field. It then uses the logical Condition to trigger and reset
the alarm. If the alarm Condition is true, the alarm is active, and if the
condition is false, the alarm goes inactive. You can also connect an audio
Wave file to individual logical alarms. Refer to the Playwave section for
more information about using audio Wave files in Lookout.

Lookout queues alarm .wav files, with up to 100 files in the queue. Each
alarm .wav file plays completely before the next file plays. If more than
100 alarms fill the queue, new alarms cancel the currently playing files and
begin playing instead.
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When you pick the Numeric alarm selection, the name of the Condition
field changes to Signal. This prompts you to enter a numeric expression in
the field against which your various alarm setpoints are measured. Hi-Hi,
Hi, Lo, and Lo-Lo are all numeric expressions. Rate of change generates
an alarm when the signal is actively changing by the set amount for the
period of time between any two Sample pulses. The Unit time setting
determines the time units for the rate of change.

Create Alarm E
Mame: IAIarm‘I Alarm area: I J

Meszage = I

Signal = I
~" Logical alam

Eriarity e
il file I Bratse... |

—* Mumeric alam

Pricrity:

HiHilevel = [HiHiSetpoint s
Hilevel = | [ ]

Lo level = I l_

Lo-Lo level = ILoLoSetpoint IB_
Fiate of change = |2.5 |4—

Lnit time: IDD:D‘I :00.0 [Example: 1:00 for per minute]

Sample = IF'uIse [true, 0:0:1.0, 0.0]

QK I Cancel | Help |

Figure 2-3. Typical Settings for a Numeric Style Alarm

Alarm area specifies the group name associated with the alarm object. All
previously defined groups appear in the list box and may be selected with
the mouse.

Priority ranges from 1 to 10 where 10 is the most important.

Message is a text expression whose result is displayed in the alarm window
when this object generates an alarm. If alarm style is numeric, the relevant
alarm trigger prefixes your message (for example, HiHi level: Alarm
message). Refer to Chapter 9, Alarms and Events, in the Lookout
Developer’s Manual for more information about alarms.
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Alarm Data Members

Table 2-3. Alarm Data Members

Data Members Type Read Write Description

active logical yes no Result of logical alarm status. True if
alarm is active and false if alarm is
inactive.

hi logical yes no Result of numeric alarm hi data member
status.

hihi logical yes no Result of numeric alarm hihi data member
status.

lo logical yes no Result of numeric alarm lo data member
status.

lolo logical yes no Result of numeric alarm lolo data member
status.

rate logical yes no Result of numeric alarm rate data member
status.

Comments A common alarm condition is caused by a measured value going out of an
acceptable range. For example, a storage tank whose level is too low or too high can
generate several alarms: Hihi: Tank level is out of range,orLo: Tank level
is out of range. If you use a numeric style alarm to trigger the alarm and if the tank
level fluctuates or “jitters” around the alarm level settings, a new alarm record is
generated in the alarm window each time the tank level fluctuates above or below the
level settings. To alleviate this condition, you could use the Neutralzone object to filter
out minor tank fluctuations.

Note Alarms can also be defined through parameter settings on object data members.
Many times, this is the most efficient method of defining and creating alarm conditions.
Refer to the Database-Generated Alarms section of Chapter 9, Alarms and Events, in the
Lookout Developer’s Manual, and the Editing Object Databases section of Chapter 4,
Using Lookout, in the Getting Started with Lookout manual for more information about
creating alarm conditions..
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$Alarm is a global object. It makes available global alarm data such as the
number of currently active alarms.

You can use $Alarm data members just like other data members. By
inserting an expression you can display the number of active alarms in any
particular group. Or, by connecting a pushbutton to an acknowledge data
member, operators can acknowledge alarms through pushbutton selection.

Assume, for example, that you want to create a pushbutton that
acknowledges all alarms. First create a pushbutton object. Next, use the
Object»Edit Connections command to connect the pushbutton (Pb1)
to the . ack data member of $Alarm. Such a connection is shown in the
following illustration.

— Select member:
Mwritable: members: Eisting connections: St obiect...l
test =]

water
waveforms

ack
activatePanel
mminimizeP anel hd

=
Accept |
$dilarm. ack = |
MNew logical connection Clear |

— Signals:

Tags: [C|533] Path Mode: IHeIative j
In: IE paroikos. dy. natinst. com Eiailiats kel bagie]
", chilf1-24
g
% shift.f1-24
I-{;&S— $larm
----- 3% Panell

Paste \ “$Kepboard 1 Help |

Figure 2-4. Edit Connections Dialog Box for using $Alarm

The expression (Pb1) acknowledges all active alarms any time the
pushbutton is depressed. You could make similar connections to
acknowledge individual alarm areas.
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You can define new alarm areas through Alarm objects and by modifying
object database parameters. As you create each new alarm area, Lookout
adds new readable and writable data members to the $Alarm object.
$Alarm data members are described in the following table.

$Alarm Data Members

Table 2-4. $Alarm Data Members

Data Member Type Read | Write Description
ack logical no yes Upon transition from FALSE to
TRUE, acknowledges all alarms.
Ackselected logical no yes | Upon transition from FALSE to
TRUE, acknowledges all selected
alarms.
ActivatePanel logical no yes | Calls Alarm Window upon transition

from FALSE to TRUE, making it
visible on the screen.

Active numeric yes no Total number of currently active
alarms (that is, alarm conditions that
still exist).

Groupname text yes no Alarm area name associated with the
most recent alarm.

Groupname.ack logical no yes Upon transition from FALSE to
TRUE, acknowledges all alarms
within the specified group.

Groupname.active numeric yes no Number of currently active alarms
within the specified group.

Groupname.unacked numeric yes no Number of unacknowledged alarms
within the specified group.

Message text yes no Text of the message of the most recent
alarm.

MinimizePanel logical no yes | Closes Alarm Window upon transition
from FALSE to TRUE, changing it to
an icon.

Priority numeric yes no Alarm priority associated with the

most recent alarm.
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Table 2-4. $Alarm Data Members (Continued)

Data Member Type Read | Write Description
PriorityOl.active — numeric yes no Number of currently active alarms of
Priority10.active the specified priority.
PriorityOl.unacked — numeric yes no Number of unacknowledged alarms of
Priority10.unacked the specified priority.

Silence logical no yes | Turns off alarm sounds when set to
TRUE.

Name text yes no Object name associated with the most
recent alarm.

Unacked numeric yes no Total number of unacknowledged
alarms (that is, alarm conditions that
have not yet been acknowledged).

Update logical yes no Pulses high every time there is a new
alarm.

Comments Groupname in the preceding table represents the name of any specified
alarm area. The $Alarm object contains an .active, .unacked, and .ack data

member for every alarm area.

Using $Alarm with Other Objects

Every time a new alarm appears in Lookout, $Alarm.Message,
$Alarm.Name, $Alarm.Groupname, and $Alarm.Priority

are updated with the appropriate information for the new alarm. Then
$Alarm.Update pulses high to alert you that those four data members
contain fresh values.

These data members can serve many purposes, but they are specifically
designed to work with the Pager object class. In a typical application, you
could use sAlarm.Update to initiate a page, possibly including the other
four data members in the text of the page. With this system you can also
filter which alarms you want to page, and which alarms the pager ignores.
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Alternator

Lookout Object Reference Manual

Alternator is an object class Lookout uses to control a series of devices with
various commands. Typically this means rotating the usage of the devices
at specified times.

Mew Alternator [ %]
Tag: yJternato
Operating mode: ILeast Fecently Used 'l
Devices: I
I awimnurn run time: I
DD:HH:M:SS
Delay between device starts:
DD:HH:M:SS

Device failure alarm priority: |5
Device rezponse time: I

DD:HH:M:SS
Device name: I
Timer update:
DD:HH:M:SS
V' Retry Device after Alam Condition
Ok I Cancel |

You configure the Alternator using the parameters in the New Alternator
dialog box. You use the Alternator with the data members, as discussed in
the Using the Alternator section.

Operating Mode determines the way an Alternator object orders devices for
use. Select Least Recently Used to have Lookout select the device which
has been off the longest as the device to start next. Select Sequential to use
the devices in their connection order. Use sequential mode if you want to
mimic the behavior of traditional hardware alternators. Select Total Run
Time to use devices in order of their total time of use (using the
ElapsedTime data member). The Alternator will use the device with the
least total run time as the next to be started.

Devices determines the maximum number of devices that can be controlled
by the Alternator.

Maximum run time is the maximum amount of time that any one device
is allowed to run continuously. This function can be disabled by entering 0.
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Delay between device starts is the minimum amount of time between
device starts that are initiated by the Alternator object. This function can be
disabled by entering 0.

Device failure alarm priority determines the priority level of alarms
generated by the Alternator. This defaults to 5.

Device response time is the amount of time the Alternator waits for a
response from a device before activating an alarm. This function can be
disabled for individual devices by not connecting anything to the Response
data member.

Device name is a string describing the type of device that is being
controlled by the Alternator. This is used to create the alarm messages and
is also the name of the group to which the alarms belong.

Timer update specifies the resolution of the timers used by the Alternator
to decide which devices to turn on and off. This also specifies how often the
Alternator updates the ElapsedTime and RunTime data members.

When a device fails, Lookout removes that device from the sequence.
Check Retry Device after Alarm Condition to have Lookout keep trying
the device even when an alarm is active for that device. Deselecting this
option keeps the device from coming on, even after it has been replaced or
repaired. To get the device back on line, set the HOA option to Auto. (If the
HOA setting is already on Auto, you can move the HOA control off Auto
and then return it.)

Using the Alternator

You configure the Alternator with the parameters in the New Alternator
dialog box. You use the Alternator with the data members, as discussed in
the following sections.

Connecting the Alternator

Connect the DeviceRequest data members to the drivers controlling your
devices. Notice that when you connect the DeviceRequest data member to
anything, the DeviceConnect data member goes high. This connection is
the only one required for the Alternator to consider your device connected.
The RunTime, ElapsedTime, DeviceConnect, and DeviceOn data members
can be connected to or not connected, depending on whether you want that
information.
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The Command data member is the essential writable data member to
connect to. The connection to Command can be any numeric expression,
but a RadioButton or a Pot object is probably most convenient, especially
for testing and demonstration purposes. Command only accepts values in
the integer range from zero to the number of device connections specified
as a parameter.

Connect the Response data members to a response bit from each device. If
no connection is made to Response, the Alternator does not require any
response from the device.

You do not have to make connection to the Advance, Reset, and HOAmode
data members unless you want their functionality. Advance and Reset
typically are connected to Pushbuttons, and HOAmode typically connects
to a RadioButton or a Pot object. The HOAmode data member only accepts
values in the integer range from one to three. Refer to the Hand-Off-Auto
Modes section for more information about this data member.

Command and Advance

The Command data member determines the number of devices that the
Alternator is to have running at one time. When you send the Alternator its
first command, it requests a corresponding number of devices to turn on.
The DeviceRequest data member for each of these devices goes high to
signify this. When the devices respond that they are in fact on (through the
Response data member, if it is connected) the Alternator recognizes that the
device is on and the DeviceOn data member goes high.

Conversely, if the Command data member specifies that devices are to be
turned off, the DeviceRequest data members for the corresponding number
of devices goes low. The devices should then respond accordingly using the
Response data member.

When you give the Alternator a numeric command, it takes into account the
number of devices currently running, and makes its requests accordingly.
Because of this, it is important to know how the Alternator counts the
number of devices running. Devices running as a result of a Hand command
from the HOAmode data member are not counted. All other running
devices (including those with active alarms) are counted.

When the Alternator is asked to turn on a new device, it chooses the device
according to the rules of the operating mode you selected in the New
Alternator dialog box.

The Advance command turns on one device and turns off another device.
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Maximum Run Time and Delay Operation

The Maximum run time parameter specifies how long any one device can
be running. Each device has its own timer to ensure that this is enforced.
When one of these timers informs the Alternator that its device has been on
for the maximum allowed time, the Alternator executes a command
identical to the Advance command. Notice that there are two cases where
the maximum time limit is not enforced strictly. One of them is when you
have turned on a device via the HOAmode data member. The other is when
it conflicts with the operation of the Delay between device starts feature.

Delay between device starts is specified as a parameter, and limits how
often the Alternator can turn on devices. An example of the operation of the
Delay between device starts would be beginning with a new Alternator that
has none of the devices on. You issue a command using the Command data
member of 3. If the delay feature is in use, the Alternator sends three ON
requests separated by the amount of time specified by Delay between
device starts.

Hand-0ff-Auto Modes

The HOAmode data member gives you direct control over each device.

When the HOAmode data member is in Auto mode (as it is by default if you
never connect anything to this data member) the device is subject to the
commands of the Alternator. Its DeviceConnect data member will be high
to signify that the Alternator recognizes it.

In Hand mode, the device is disconnected from the Alternator and is sent
an on request. So Hand mode is essentially an on state. In Off mode the
device is disconnected and requested off. In these two modes, the
Alternator does not recognize or request anything of these devices. If you
select Auto mode again, the device is reconnected to the Alternator, and
operates as determined by the Alternator.

The integer value of this numeric data member corresponds to an operating
mode as shown in the following table

Table 2-5. HOA Modes

HOA Mode Integer
Hand 1
Off 2
Auto 3
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Elapsed Time, Run Time, and Reset

The ElapsedTime data member keeps track of how long a particular device
has been on since its last reset (or since it was created). As with most
Lookout measurements of time, the value of this data member is expressed
in days. Right-click on any display of this data and select Numeric format
to choose a convenient time scale format for display.

The RunTime data member keeps track of how long a particular device has
been on continuously. As with most Lookout measurements of time, the
value of this data member is expressed in days. Right-click on any display
of this data and select Numeric format to choose a convenient time scale
format for display.

The Reset data member is used to reset ElapsedTime.

Alternator Data Members

Table 2-6. Alternator Data Members

Data Member Type Read Write Description

Advance logical no yes Turns on the next device in the
sequence and turns off the last
device in the sequence.

Command numeric no yes Specifies how many devices the
Alternator is to have running.

DeviceConnectl - logical yes no States whether device is in the

DeviceConnect100 active sequence considered by the
Alternator.

DeviceOnl - logical yes no Confirmation of the actual device

DeviceOn100 state.

DeviceRequestl - logical yes no Output to whatever drives the

DeviceRequest100 device.
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Table 2-6. Alternator Data Members

Data Member

Type

Read

Write

Description

DeviceStatus 1-
DeviceStatus100

numeric

yes

no

(Sequential mode only.) Returns
the priority of the indicated
device in your Alternator
sequence.

While you can connect to this
data member in any Alternator
mode, this data member is only
meaningful when used in
sequential mode.

ElapsedTimel -
ElapsedTime100

numeric

yes

no

Elapsed time device has been on
since last reset.

HOAmodel -
HOAmode100

numeric

no

yes

States whether device is in Hand,
Off, or Auto mode (returns
number value for Pot object or
RadioButton).

Lagl - Lag99

numeric

yes

no

(Sequential mode only.) Numbers
the devices beginning with the
first device to be switched on
after the after the LeadSelect
device is turned on. Lagl is the
first device to be turned on in a
sequence based on the current
state of the devices.

While you can connect to this
data member in any Alternator
mode, this data member is only
meaningful when used in
sequential mode.
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Table 2-6. Alternator Data Members

Data Member

Type Read Write Description

LeadSheet

numeric yes yes (Sequential mode only.) Specifies
the start of the sequence. This is a
1 based data member. When set to
0, LeadSelect has no effect.

While you can connect to this
data member in any Alternator
mode, this data member is only
meaningful when used in
sequential mode.

Resetl - Reset100

logical no yes Used to reset the ElapsedTime
data member.

Responsel - logical no yes Response bit from device.
Response100

RunTimel - numeric yes no Elapsed time device has been on
RunTime100 continuously.

Alternator Status Messages

Lookout Object Reference Manual

Not responding to on request

A device that was sent an ON request via the DeviceRequest data member
did not respond that it had in fact turned on. How the Alternator responds
to this condition depends on the setting you choose for the Retry Device
after Alarm Condition parameter in the New Alternator dialog box. If you
enable that option, the Alternator attempts to turn the device in question on
when its turn comes, and the alarm remains active until the device responds
properly to an Alternator command.

If you disable this option, the Alternator will not attempt to turn the device
on until you change the HOA setting to Auto, or cycle the HOA setting
from Auto to another setting and then back to Auto.

Not responding to off request

A device that was sent an OFF request via the DeviceRequest data member
did not respond that it had in fact turned off. How the Alternator responds
to this condition depends on the setting you choose for the Retry Device

after Alarm Condition parameter in the New Alternator dialog box. If you
enable that option, the Alternator attempts to turn the device in question on
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when its turn comes, and the alarm remains active until the device responds
properly to an Alternator command.

If you disable this option, the Alternator will not attempt to turn the device
on until you change the HOA setting to Auto, or cycle the HOA setting
from Auto to another setting and then back to Auto.

Turned on unexpectedly

A device that was previously off and that the Alternator expected to remain
off turned on without reason. How the Alternator responds to this condition
depends on the setting you choose for the Retry Device after Alarm
Condition parameter in the New Alternator dialog box. If you enable that
option, the Alternator attempts to turn the device in question on when its
turn comes, and the alarm remains active until the device responds properly
to an Alternator command.

If you disable this option, the Alternator will not attempt to turn the device
on until you change the HOA setting to Auto, or cycle the HOA setting
from Auto to another setting and then back to Auto.

Turned off unexpectedly

A device that was previously on and that the Alternator expected to remain
on turned off without reason. How the Alternator responds to this condition
depends on the setting you choose for the Retry Device after Alarm
Condition parameter in the New Alternator dialog box. If you enable that
option, the Alternator attempts to turn the device in question on when its
turn comes, and the alarm remains active until the device responds properly
to an Alternator command.

If you disable this option, the Alternator will not attempt to turn the device
on until you change the HOA setting to Auto, or cycle the HOA setting
from Auto to another setting and then back to Auto.

Not responding to HOA command

A device did not respond properly to a command from the HOAmode data
member. How the Alternator responds to this condition depends on the
setting you choose for the Retry Device after Alarm Condition parameter
in the New Alternator dialog box. If you enable that option, the Alternator
attempts to turn the device in question on when its turn comes, and the
alarm remains active until the device responds properly to an Alternator
command.

If you disable this option, the Alternator will not attempt to turn the device
on until you change the HOA setting to Auto, or cycle the HOA setting
from Auto to another setting and then back to Auto.
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Animator

The Animator object class provides full graphical animation including
horizontal and vertical motion, dynamic resizing and visibility, dynamic
symbol sequencing and programmable color changes.

When you first create an animator object, the Select graphic dialog box
appears.

\\\\ \\\\\\\
\\ \§

Figure 2-5. Select Graphic Dialog Box

Select the graphic you want to animate. To animate colors, you must select
a Windows Metafile (.wm£). A moving animation must have the series of
images you want to animate arranged in a single bitmap so that each cell of
the animation can be defined by a grid of rows and columns.
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To create a moving animation, select the Animation name.

Create Animator Object EHE

Color  Animation |

Tag: IAnimator‘I

[:Mlook4hgraphicgiMisci\Horze. brp

100% Size [in pixels]:

Width Height

S

K= IHorizontaIF’ot

W= IVerticaIF’ot

Size = ISizeF’ot

Wisible = [visibilitySwitch

Cel/Rate = Fows Columnis

Filrnztrip:
|7 & Cel ¢ Rate[cels/zec) Brp Grid

|RatePot |5 Jn

QK I Cancel | Help |

Figure 2-6. Animator Definition Parameters Dialog Box, Animation Tab

The graphic file you select determines what images appear on the screen.
You delineate the images in a bitmap graphic by dividing it into a grid of
Rows and Columns. In the preceding illustration, the single column is

48 pixels Wide and each row is 28 pixels High. Conceivably, the grid could
consist of 32,000 cells. 100 cells would be more practical.

Each grid cell is a filmstrip image. Internally, the Animator assigns a cell

number to each image. It normally plays the filmstrip by progressing from
left to right and top to bottom, from the lowest cell number to the highest

cell number.

The Rate (cells/sec) selection you use to specify a frequency at which the
Animator progresses from one cell image to the next. The rate value can be
positive or negative and can range from 0.0000005 (one frame every
23.148 days) to 100 frames per second.
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Color Animation

Lookout Object Reference Manual

If the rate value is negative, the Animator plays the filmstrip backwards,
starting at the last cell.

You can use the Cell selection in the definition dialog box to identify a
particular cell number to display. For example, you might use this selection
to display a specific image when a PLC register is equal to a particular
value. This is similar to the multistate object, but can provide many more
states, depending on the number of cells in the bitmap.

The X and Y parameters specify the horizontal and vertical position of the
image, respectively. These numeric parameters range from 0 to 100, and
together provide the X-Y position of the image as a percent of the Animator
dimension on a control panel.

Size is a numeric parameter that ranges from 0 to 100 percent, where
100 percent is the full size of a single cell as specified by W and H.

Visible is a logical parameter that causes to the image to appear when it
goes true and disappear when it goes false.

To create color changes programmatically, select the Color tab.

With this option, you can set the color map on a . wmf graphic using a series
of five logical conditions and a default state. If no condition is true, the
default state (or color map) is imposed.

You can choose a custom color map by clicking on the color sample
associated with each logical condition. You can then select any color from
the palette available on your computer.
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Select the Show Original Colors box if you want the original color map of
the . wmf file to be imposed for that condition.

Create Animator Object EHE

Calar | Animation I

Gray Proximity

Proximity of the ariginal color to gray
necessary before it will be changed
ta the new colar.

Gray Proximity [0-100] ID

Diginal Colo Qi oo
If = | m
Elseif= | m
Elseif= | 0
Elseif= | 1 r
Elseif= | m
Else N

QK I Cancel | Help |

Figure 2-7. Animator Definition Parameters Dialog Box, Color Tab

Gray Proximity determines the color saturation point at which the selected
color replaces an original color. When this parameter is set to 0, most colors
change. When this parameter is set to 100, most colors will not change. You
can test the effects of this setting by putting your cursor over the color
button and observing the change in the graphic displayed in the dialog box
window.

Notice that the if and else if statements are evaluated in sequence. If several
conditional expressions are true at once, Multistate displays the graphic
associated with the first true expression.

For instance, if your If parameters use less-than comparisons, such as
PumpSpeed<50, the following Else if parameter must have a larger
comparison value, such as PumpSpeed<75. If you use a smaller
comparison value, such as PumpSpeed<25, the color change will not take
place. In other words, the comparison values must be used from smallest to
largest.
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Animator Data Members

In the same way, if you are using greater-than comparisons, such as
PumpSpeed>50, you must list your comparison values from largest to
smallest, so that the next Else If parameter would have to be something like
PumpSpeed>25.

Put If parameters using equality, such as PumpSpeed=50, before

parameters using inequalities.

A few minutes experimentation should help you understand the interactions

of the color choice conditions.

Table 2-7. Animator Data Members

Data Member Type Read Write Description
none — — — Animator objects do not have data
members
graphicl-graphicN | numeric yes no Denotes which display of this object

will appear on an HTML report. Only
one display is available for the ActiveX
object.

Comments Consider using an Integral object instead of a Counter/Pulse combination
when trying to achieve smooth animation.

Related Objects DialGauge, Gauge, Multistate, Pipe, Spinner
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Average actively calculates the average value of Data over time. Average
is only active when the Enable expression is true and resets to zero when
the Reset expression transitions from off to on. Average also maintains an
array of up to 35 previous averaged values. If Enable is left blank, the
object always actively calculates the average.

Mame: IW
[rata = ||
Reset = I
Enable =
QK | Cancel | Help |

Figure 2-8. Average Definition Parameters Dialog Box

Data is a numeric expression while Reset and Enable are logical
expressions.

Average Data Members

Table 2-8. Average Data Members

Data Members

Type Read | Write Description

(implicit)

numeric yes no Current average calculated since the
most recent Reset signal. Updated
approximately once per second.

1-35

numeric yes no Previous average values. Signal 1 is
the most recent prior average since the
Reset signal went high.

DataReset

logical no yes Upon transition from FALSE to
TRUE, resets to zero all data
members—including the current
average and all previous averages.
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Comments The Reset expression could be a regular pulse interval created by a
TimeOfxxxx timer, so that the pulse is synchronized to the top of the hour or day.
For example, if you want to calculate the daily average flow rate, use the output signal
from a TimeOfDay timer or a daily Spreadsheet object to reset the average calculation
at the beginning of each day. If you want to calculate the average flow rate only when
a pump is running, use the input signal from the pump motor relay in the Enable
parameter.

Related Objects Minimum, Maximum, Sample
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Counter

Counter counts the number of times that the Count expression transitions
from off to on. The digital display shows the number of pulses counted so
far, and is updated approximately once per second—however, it can
receive and count multiple pulses within a given second. The counter can
count to just under 4,503,600,000,000,000 or 142,710 years worth of pulses
at one pulse per second. When the Reset expression transitions from off to
on, the counter resets to zero.

Create counter: E

QK | Cancel | Help |

Figure 2-9. Counter Definition Parameters Dialog Box

Both Count and Reset are logical expressions.

Counter Data Members

Table 2-9. Counter Data Members

Data Member Type Read | Write Description

(implicit) numeric yes no numeric total of pulse count

Comments You should not use Counters to count external pulse signals that cycle
more often than about once per second. For higher counting speeds, use the
accumulator capabilities built into your PLC.

Related Objects Accumulator, Integral
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DataSocket

The DataSocket is a National Instruments method of transferring data
between different software applications. Use the Lookout DataSocket
object as a DataSocket client to connect to any DataSocket server running
on a computer accessible on your network.

You must create a separate DataSocket object for each DataSocket server
item you intend to access. Unlike most Lookout objects the DataSocket can
read from and write to DataSocket server arrays using a special syntax in
the data members. Refer to the Accessing DataSocket Arrays section for
more information about this feature of the object.

@ Note You must connect to an active DataSocket server for the DataSocket object to work.
Because of its ability to communicate over a network, Lookout does not ship with a
DataSocket server. You can use the DataSocket object to access data from LabVIEW,
BridgeVIEW, Measurement Studio, or other National Instruments applications running on
your network, especially if those applications are using data in arrays.

Create DataSocket [ %]

Tag: IDataS ocketl

URL: |

AcceszMode————————— [~ Update Method
 Read  Marual
 Wiite & Automatic
Dimensions: I Pl
Pall =
FallRate = |0:01

Cancel |

Access Mode specifies whether the DataSocket object is reading or writing
to the DataSocket server. If the server data is in the form of an array, you
must set the array dimensions in the Dimensions field to write to the array.

Update Method specifies how Lookout updates information being
published by the DataSocket server. If you select Manual, Lookout updates
data when you trigger the Updat e data member. With Automatic updates,
Lookout automatically watches for data to change and updates it when a
change occurs. Selecting Poll lets you choose a triggered poll or set a poll
rate of your own to update the data.
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Poll is a logical expression. When this expression changes from FALSE to
TRUE, Lookout polls the device. Use a simple expression like the signal
from a pushbutton, or a complex algorithm.

PollRate is a numeric expression that determines how often to poll the
device. Lookout polls the device at the specified time interval. Normally,
this is a simple time constant such as 0:01 (one second). Refer to the
Numeric Data Members section of Chapter 2, How Lookout Works, in the
Getting Started with Lookout manual for information about entering time
constants.

E Note The DataSocket object does not work unless you connect it to the server. Use a
Switch object connected to the Connect data member to activate the DataSocket object.

Accessing DataSocket Arrays

Lookout does not use arrays for handling data in an HMI, but many data
sources do use arrays. If you need to read from or write to a DataSocket
server item that is an array, the DataSocket permits you to use multiple data
members, one for each element in the array.

Configuring the DataSocket Object to Write to an
Array

If you are writing to an array item, configure the object by selecting the
Write option in the Access Mode section of the Create DataSocket dialog
box. This enables the Dimensions field, where you enter the dimension of
the array item.

If the array item is a one dimensional array, enter the number of elements
in the Dimensions field. If the array is multi-dimensional, use a colon (:)
to denote the elements from the rows and succeeding layers. The following
table shows examples of how to define various arrays.

Entry in the
Array Size Dimensions Field
1-Dimensional array with 17 elements 17
2-Dimensional array with 10 elements 10:20
in 20 rows
3-Dimensional array with 12 levels of 15:32:12
15 elements in 32 rows
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You do not need to define the dimensions of an array to read data from with
the DataSocket object.

Configuring DataSocket Object Data Members to
Access an Array

To access an array element, add an array index element to the generic
data.num, data.logical, or data.text data members. In this way you can
access any or all of the elements in the array you are trying to access.

Add the index numbers in object connections or in Lookout yellow
expression fields either as a panel display expression or in variables.

You can also create alias data members with index elements.

As when configuring the DataSocket object to write to an array, use
numbers and the colon (:) to serve as the index for the data you are
reading from or writing to the array. The syntax for data members is
DataSocketName.data:N:N.num wWhere DataSocketName is the
object name and N represents index numbers, as shown in the following

table.
Indexed Data Member Array element

DataSocketName.data:3.num accesses element 3 in a one-dimensional
array of numeric data.

DataSocketName.data:3.logical accesses element 3 in a one-dimensional
array of logical data

DataSocketName.data:10:5.txt accesses element 10 in row 5 of a
two-dimensional array of text data

DataSocketName.data:4:6:10.num accesses element 4 in row 6 of level 10 of a
three-dimensional array of numeric data.
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Table 2-10. DataSocket Data Members

Data Member

Type

Read

Write

Description

AccessMode

text

yes

no

Reports whether your DataSocket object
is updating manually, automatically, or by
polling, and whether it is set to read or
write.

CommPFail

logical

yes

no

Object-generated signal that is on if, for
whatever reason, Lookout cannot
communicate with the device.

Connect

logical

no

yes

When TRUE, connects the DataSocket
object to the selected server. When
FALSE, disconnects the DataSocket
object from the server.

data.logical

logical

yes

yes

Use this data member if the DataSocket
server item you are connecting to is a
logical value.

data.num

numeric

yes

yes

Use this data member if the DataSocket
server item you are connecting to is a
numeric value.

data.txt

text

yes

yes

Use this data member if the DataSocket
server item you are connecting to is a text
(string) value.

DataType

text

yes

no

Returns the data type for the DataSocket
server item you are connected to. This
information includes the dimensions of an
array, which you may find helpful in
setting up your data members to access
array data.

LastError

numeric

yes

no

Displays the last error code transmitted by
the DataSocket server.

LastMessage

text

yes

no

Displays the last message transmitted by
the DataSocket server, which may be a
status message, error message, or other
notification.
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Table 2-10. DataSocket Data Members

Data Member Type Read Write Description

OffHook logical no yes When TRUE, this flag instructs the
Scan-Data object to retain exclusive use
of its assigned communication port.

Poll logical no yes When this value transitions from FALSE
to TRUE, Lookout polls the device.

PollRate numeric no yes Lookout expression that determines the
device polling frequency.

Status text yes no Displays whether or not your DataSocket
object is connected to or disconnected
from the server. This data member will
also notify you if there is a connection
error.

Update logical yes no Object-generated signal that pulses low
each time it polls the device.

UR text yes no Displays the DSTP URL you are using to
connect to the DataSocket server.

DataSocket Status Messages

DataSocket errors are reported in the LastError data member, with
explanatory strings reported in the LastMessage data member.
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DataTable

DataTables are used in the following applications:
*  Multiplexing various data sources into a single display template.

» Importing or exporting large quantities of data to other applications
using DDE. (Unlike the DdeTable, the DataTable provides
bidirectional DDE communications. Refer to the DdeTable section
form more information about using the Dde Table.)

*  Networking multiple Lookout nodes Refer to Chapter 4, Networking,
in the Lookout Developer’s Manual for more information about using
networking with Lookout.

A DataTable contains a matrix of rows and columns, much like a
spreadsheet. Each column is represented by a letter (A — IV). Each row

is represented by a number (1 — 1,000). Letter-number combinations
represent intersections of rows and columns. Such intersections are called
cells. Any given cell contains a value. A cell value can be numeric, logical,
or textual.

E Note DataTables are advanced tools that require a mastery of Lookout object databases.
Make sure you understand editing, connecting to, and using object databases and aliases
before creating a DataTable object. Refer to Chapter 4, Using Lookout, and Chapter 5,
Developer Tour, in the Getting Started with Lookout manual for more information about
object databases.

The following dialog box appears when you create a DataTable.

Create table E

M ame: ITabIe‘I

T able location r— |mport/E xport
& Local File: Type: IXLS 'l Alarm priority: IS
" DDE
" Clear table if impart eror
SEnyiGe: I
Tl I Filename =
GHE I"tblsmp.-"xls'1

IEerm: I

Security level: ID ¥ Log events

QK I Eancell Help |

Figure 2-10. DataTable Definition Parameters Dialog Box

© National Instruments Corporation 2-51 Lookout Object Reference Manual



Chapter 2 Lookout System Objects

Specify DDE parameters if you want to use the DataTable to exchange
large quantities of data from an external source (such as Excel)
continuously, with both Lookout and the other program running. Refer to
Chapter 5, Dynamic Data Exchange, in the Lookout Developer’s Manual
for more information about DDE connections to other programs.

Specify Local if you are using the DataTable to import or export data from
Lookout into or out of a static file. Also specify Local if you are using the
DataTable to multiplex various signals into a single display or graphic
template.

To exchange data with another DataTable running in another Lookout
process, you can use ordinary Lookout connections.

The export and import data members control the transfer of data between
Lookout and a Microsoft Excel spreadsheet. The spreadsheet filename
must be entered in the Import/Export section of the Create table
dialog box.

@ Note The data table import and export data members only work with Microsoft Excel
Version 4 at this time. This feature does not work with Excel Version 5 or greater.

Lookout Object Reference Manual

Instead of entering a file name in the Import/Export dialog box, you can
enter a Lookout expression in the Filename field. You can then import and
export different files using a switch setting, a text entry box, or some other
expression input. If something goes wrong with the transfer of data,
including data corruption, Lookout reports an alarm.

Click on the Clear table if import error checkbox to clear the DataTable
before importing either from a spreadsheet or an ODBC database. This only
affects what happens if there is an error during the import. If there are no
errors during the import, the imported data always replaces the old data in
the table. However, if the checkbox is selected, the DataTable is always
cleared before starting an import, so that, if an error occurs, the DataTable
is left empty. If the checkbox is not checked and an error occurs, the old
data is left in the table.
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Create table E

M ame: |Table1
Table location — Import/E spart
@ Lacal File Type: I 'l Alarm priority: IE_
 DDE .
™ Clear table if impart erar
SEmne; |
: Connect Sting =
Tapie: I
L= I SOL command =

Security level: ID ¥ Log events

0K I Cancell Help |

Figure 2-11. DataTable Definition Parameters Dialog Box; Import from ODBC Database

The Connect String= field specifies the DataSource Name (DSN) as well
as any other parameters needed by the ODBC driver to make the connection
to your chosen data source.

The SQL command= field is where you enter the SQL string you want to
pass to the ODBC driver. Refer to the Sq/Exec section for more information
about using SQL queries in Lookout.

Multiplexing Displays and Graphics

You can use DataTables to multiplex signals into a single control panel,
used as a template. For instance, assume you have nine identical pump
stations. At each site you have a single PLC monitoring the pressure, flow
rate, and status of two pumps. You are also controlling an analog output
with an operator setpoint from Lookout. Instead of developing nine
identical control panels in Lookout, you can build just one panel and
multiplex the signals from the nine sites into a single set of graphics.
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The following figure is a graphical representation of the connections for a
possible DataTable.

A B C D E F
1 |Sitel FLC1 press FLCT flow FLCT pmp1  |PLC1 pmp2
2 |Site2 FLCZ press PLCZ flow ja) ‘g FLCZ pmp1  |PLCZ2 pmp2
3 |Sited FLC3 press FPLC3 flow % '60 FLC3 pmp1  |PLC3 pmp2
4 |Sited FLC4 press PLCA flow Y,, e FLC4 pmp1  |PLC4 pmp2
5 |Sited FLCS press PLCS flow @ FLCS pmp1  |PLCS pmp2
6 |Site FLCE press PLCE flow % FLCE pmp1  |PLCE pmp2
7 |Site7 FLCT press PLCT flow FLCY pmp1  |PLCT pmp2
8 |Sited FLCE press FPLCE flow FLCE pmp1  |PLCE pmp2
9 [Sited PLCY press PLCAO flows PLCO pmp1  |FPLCY. pmp2
Figure 2-12. Graphical Representation of a DataTable Showing Connections
@ Note At this time there is no actual view in Lookout for you to see this table. Itis a
representation, not a screen capture of a Lookout dialog box or display element.

Lookout Object Reference Manual

Each row of the table is connected to the site name, the data you want to
keep track of from the PLC at that site, and a place for the operator setpoint
data for that site.

Notice the names of the nine PLCs (PLC1, PLC2...). Each value has an alias
(press, flow, pmpl, pmp2). Each cell represents a connection made from
that PLC output to the that cell of the DataTable.

The open column D represents the connection of a single Pot object called
Setpoint to the column—not to individual cells. This way Lookout only
changes the value of a cell in column D when that particular row has been
made active. You connect the individual cells in column D (D1 through D9)
to the correct holding registers (outputs) on the respective PLCs. For
example, Tablel.D1 would be connected to the appropriate data member
of PLC1 — Tablel.D2 to the appropriate data member of PLC2, and so
on. In other words, when you intend to multiplex signals to a panel through
a data table connect inputs from a PLC or RTU to individual cells. Connect
operator setpoints (outputs) to columns.
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DataTahle Example

To practice using a DataTable, you can create a PLC simulator as shown in
the following illustration. You can use a separate control panel for each
PLC output simulator, or place all the objects you make on one panel.

@ PLC1 M= 3

Site1Pressure
(simulates B
PLC1.press)
&— —— pump1_1 (simulates PLC1.pmp1)
Site1Flow Z— pump1_2 (simulates PLC1.pmp2)

(simulates
PLC1.flow)

Setpoint indicator
(operator input)

e

Use two slider pots as your pressure and flow outputs, and two switches as
the on/off indicators for pumps one and two. You can use the dial gauge at
the bottom to check the operator input, Setpoint. Instead of connecting
the cells of your data table to PLC outputs, you connect directly to the
Lookout objects, named after the outputs for clarity.

You should create at least three sets of PLC input/output simulators.

The following example refers to the 9 PLCs mentioned in the Multiplexing
Displays and Graphics section, but you can explore using a data table
using 2 or 3 simulators.

Connect specific DataTable cells from the D column to the Setpoint
indicator for each PLC simulator.
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After you have built your simulators, open a new Control Panel to use as
your display and create a DataTable. You will create the rest of the display

in a later step.

When it first appears, the DataTable contains the number 0. This indicates
the contents of cell Al. You can increase the size of the display window,
but you cannot show the entire array of data in the table. You can view the
contents of any cell in column A by clicking on the window when you are
in run mode. Selecting the contents of that cell activates that row of the
data table.

Enter text expressions into the cells of column A to act as your table index.
For example, enter the string "Site 1" asthe connection to your
DataTable A1 . txt data member. Connect the outputs of your PLC
simulators to the cells in the B, C, E, and F columns shown in the following
figure. You will connect an operator input to the entire column D, and than
later connect individual cells in the D column to your PLC simulators.

A B C D E F
1 |Site 1 Site1Pressure | Site1Flow pump1_1 |pumpl_2
2 |Site 2 Site?Pressure | Site2Flow pumpZ_1 |pump2_2
3 |Site 3 Site3Pressure | Site3Flow pump3_1 |pump3_2
4 |Site 4 SitedPressure | SitedFlow pumpd_ 1 |pumpd_2
5 |Site 5 SiteSPressure | SiteSFlow pumps_1 |pump5_2
6 |Site B SiteBPressure | SiteBFlow pumpé_1 |pumpb_2
7 |Site 7 Site7Pressure | Site7Flow pump?_1 |pump?_2
8 |Site 8 SiteBPressure | SiteSFlow pumpé_1 |pumps_2
9 |Site 9 Site9Pressure | Site9F low pumpg_1 |pump9_2

Connecting Signals to DataTables

To connect a value to a particular cell or column within a DataTable,
use the Object»Edit Connections... command. Select the specific data
member of the DataTable to be written, and identify the data member of
the source object.
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Connecting to Cells

The value from SitelPressure is numeric. To write the value of
SitelPressure into cell B1, connect the simulated output to B1—not
Bl.logical or B1l.txt. The Edit connection dialog box is shown in the
following illustration.

Tablel connections E
— Select member: :
writable: members: Eisting connections: St Db|ECL"|
% 1.1-1000.30 - AZ kst ;I
AT4.30 Ad bt
-+
Alogical. 1V lagical 30 Adtat
3 (ogeal v ogieal A bt
A bt 14V .30 Y
% A11000 AT ket
A7 logical-¥1000. logical - ALkt
? #1.logica ogical x| ot

F
Accept |

Tablel.B1 = Site pressure

Existing numeric connection —IEIear

— Signals:
Tags: Pot Path Mode: IHeIative j
In: IE paroikos. dy.natinst.com j Contents [readable]: numeric
i pump3_1 ;I

-~ Site1Flow
- Sitel pressure

-ty Site2Flow
¢y Site2Pressure Bt
-ty SiteIFlow . |
ity SitedPressure = Paste | Sitel pressure Help |

Figure 2-13. Edit Connections Dialog Box

After you establish a connection to a cell, the value within the cell changes
any time the expression changes. Any time the value of SitelPressure
changes, the value within cell B1 changes.
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Connecting to Columns

To connect the value of the Setpoint potentiometer to column D,
select D—not D.logical or D. txt—as shown in the following
illustration. As with the previous value, you use D because you are using
a numerical value. There is no number following the D because you are
connecting to a column, not a cell.

Tablel connections E

— Select member: :
writable: members: Eisting connections: St Db|ECL"|

% AT bt 000. ket
" cursor-cursor 30
enable
executeS0L
export
import

P
Accept |
Tablel.D = Setpaint
Existing numeric connection il

— Signals:
Tags: L3Pat  Path Mode: I Relative j

Contents [readable]: numeric

% Site2Pressure
<3 SiteIFlow

Cluit

Paste | Setpaint Help |

Figure 2-14. Edit Connections Dialog Box

<% Sitelpressure
<3 Site2Flow J

Once a connection to a column is established, the value within the cell at
the currently selected row changes when the expression changes. So, if you
activate row 4 and change the value of Setpoint changes, the value within
cell D4 changes. No other cells are affected until you move the cursor to
activate another row and the operator adjusts the pot.
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Reading a Cell Value Back to a Lookout Object

When you connect the display panel potentiometer called Setpoint to
Tablel.D, you should configure your pot with the appropriate Remote
parameter to ensure that it automatically adjusts to track the value in any
cell (within the specified column) when the cursor moves to a new row.

© National Instruments Corporation

Revize potentiometer: E

M ame: IF'ot‘I

Minirriurm: ID

I awimurn: |1 0o

Resolution: |1
— Position source

 Local

& Femate
’VUHL = I\\paroikos\tablesamp\T ablel.D

= DDE

SEnyiGe: I
Tapie: I
IEerm: I

Control security level: ID ¥ Log events

Cancel |

Help |

2-59

Lookout Object Reference Manual



Chapter 2 Lookout System Objects

The Display Panel

Now that your DataTable (called Tablel) is complete, you can return to
your display panel (where you placed the DataTable object initially) and
begin to build a single control panel that allows you to multiplex the data
from your PLCs. A sample panel is shown in the following illustration.

 Control Panel

P Flow Rate Setpoint
ressure etpoin Table1.E.logical
Table1.B
Table1.Flogical
Tablel B Table1 display
._ (no connection
I

necessary)

Table1.C Potentiometer connected to Table1.D
(Column D)

Instead of using expressions that reference the actual values from your
driver objects to display values, use the column names from Tablel.

For instance, the bar graph and numeric readout for Pressure both represent
the expression Tablel.B. The actual value for Tablel.B depends on the
what row is currently active in the DataTable. In the illustration row 1 is
active, so all the expressions return the value in their respective columns at
row 4. The callouts in the picture indicate how the control panel was
developed. All are Lookout expressions except the Pot and the DataTable,
which are displayable objects.
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Operating Your Multiplexed Panel

The plate in bottom right corner of the control panel is the DataTable object
(Tablel). To view a different site with the control panel (that is, to activate
adifferent row, thereby selecting a different PLC), click on Tablel and the
following dialog box should appear.

Tablel | ]

ISite1 EreyiEus |

Mext

Site 3

Site 4 -
Sita § This list box gets the row

Site: names from Column A

Site 7 in the Data Table
Site 8

Site 9

Cancel |

By selecting a site, you connect your control panel to the PLC at that site.
This is referred to as moving the cursor to that row.

DataTable Cursors

The cursor is a DataTable pointer that you can move from row to row to
activate the values in the cells of that row. There are several methods for
controlling the location of the cursor:

*  Connect a numeric expression to the cursor data member. A typical
example would be to connect a potentiometer (minimum = 1,
maximum = the number of rows in table, resolution = 1) to the cursor.

*  Connect logical expressions to appropriate row numbers. A typical
example would be to create a pushbutton for every row and then
connect them to their respective row numbers.
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*  Use the display (list box) built into the DataTable object. A typical
example was described previously where you connected text values to
cells in column A and then displayed the table as a plate.
The following example provides a graphical representation of a DataTable
(called Tablel) showing typical values within its many cells. You can
create a multiplex effect in Lookout by referencing column names and then
selecting the row with the information you want to use. If you reference
column names (instead of individual cells), the DataTable outputs only the
values within the currently selected row. If you reference individual cells,
the DataTable outputs the current value within the cell-—no matter where
the cursor is.
A B C F

1 [Site 1 540 0 1

2 B : 0 1

3 |Site 3 57.3 480 78 0 1

4 |Site 4 57.8 410 51 1 1

5 |Site 5 51.8 560 92 1 0

6 |Site 6 88.3 490 40 0 1

7 |Site 7 79.4 530 53 1 0

8 |Site 8 921 520 71 1 0

9 |Site 9 59.9 550 62 0 1

Outputs = Site2 77.9 460 78 0

Figure 2-15. DataTable with Cursor at Row 2 and Corresponding Outputs
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The value of cell B2 is currently 77.9. Therefore, the Tablel .B data
member is also 77.9. If you move the cursor to row 9, the value of
Tablel.B changes to 59.9, as shown.

A B C D E F
1 |Site 1 67.8 540 0 1
2 |Site 2 779 460 0 1
3 |Site 3 57.3 480 0 1
4 |Site 4 57.8 410 1 1
5 |Site 5 51.8 560 1 0
6 |Site 6 88.3 490 0 1
7 [Site 7 794 530 1 0
8 |Site 8 92.1 520 1 0
9 0 1
Outputs = Site9 59.9 550 62 0 1
Figure 2-16. DataTable with Gursor at Row 9 and Corresponding Outputs
Using Multiple Cursors
The previous description assumes you are using just one cursor. But a
DataTable can have up to 64 cursors. Multiple cursors allow you to select
multiple rows at the same time. When using multiple cursors, you also
use multiple names for each column. For a given column, each name is
associated with a given cursor. If you are using two cursors in the previous
example (cursor and cursor . 2), you can reference the column name of
a given column as follows.
Table 2-11. Column Names
A B C D E F
cursor Atxt B C D E.logical Flogical
cursor.2 A.txt.2 B.2 C2 D.2 E.logical.2 Flogical.2
Earlier, when you were using just one cursor, you connected the value of a
potentiometer called Setpoint to column D. Subsequently the value of
Setpoint was written to the cell at the row selected by the cursor. But
when there are multiple cursors, you have to select which cursor you are
writing to. Thus, depending on how you want your table to work, you might
connect the potentiometer to both Tablel.D and Tablel.D. 2.
© National Instruments Corporation 2-63 Lookout Object Reference Manual



Chapter 2 Lookout System Objects

DataTable Data Members

Table 2-12. DataTable Data Members

Data Members Type Read | Write Description

executeSQL logical no yes Imports data from an ODBC database
into the DataTable when value goes
high, using the connect string and
SQL command you enter in the
Create/modify DataTable dialog box.

(implicit) DdeTable no no Not displayable in Lookout, but it can
be referenced by a DDE link from
another application.

1.1-1000.64 logical no yes Specifies row (1, 2, 3, ...1000) or
specifies row.cursor (for example,
24.2 is the selector for row 24,
cursor 2). Upon transition from false
to true, the specified cursor moves to
specified row.

A.1-1V.64 numeric yes yes Specifies column names (for
example, A, B, C...IV) or specifies
column names and associated cursor
numbers (such as, A.1,B.1, A.2, B.2,
and so on.)

Read—returns a numeric value from
the cell specified by the column and
currently selected row of the indicated
cursor.

Write—writes a numeric value into
the cell specified by the column and
currently selected row of the indicated
Ccursor.
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Table 2-12. DataTable Data Members (Continued)

Data Members Type

Read | Write

Description

Alogical.1 —
IVlogical .64

logical

yes yes

Specifies column names

(for example, A.logical, B.logical,
C.logical, ...IV.logical) or specifies
column names and associated cursor
numbers (such as, A.logical.l,
B.logical.1, A.logical.2, B.logical.2,
and so on.)

Read—returns a logical value from
the cell specified by the column and
currently selected row of the indicated
Cursor.

Write—writes a logical value into the
cell specified by the column and
currently selected row of the indicated
Cursor.

A.txt.1 — IV.txt.64 text

yes yes

Specifies column names (for
example, A.txt, B. txt, C. txt, ... IV.txt)
or specifies column names and
associated cursor numbers (such as,
A.txt.1,B. txt.1, A. txt.2, B. txt.2, and
SO on.)

Read—returns a text value from the
cell specified by the column and
currently selected row of the indicated
Cursor.

Write—writes a text value into the
cell specified by the column and
currently selected row of the indicated
Cursor.

A1 -1V10000 numeric

yes yes

Specified cell interpreted as numeric
value

Al.logical —
IV10000.logical

logical

yes yes

Specified cell interpreted as logical
value

Al.txt -IV10000.txt text

yes yes

Specified cell interpreted as text value
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Table 2-12. DataTable Data Members (Continued)

Data Members

Type

Read

Write

Description

Cursor.1 — Cursor.64

numeric

yes

yes

Specifies the currently selected row of
the indicated cursor.

enable

logical

yes

yes

If TRUE (the default), enables DDE.
If FALSE, disables DDE. The default
value is on. The input is ignored for
non-DDE TextEntry objects.

export

logical

no

yes

When this input transitions from false
to true, the Lookout data table is
exported to the designated
spreadsheet file.

import

logical

no

yes

When this input transitions from false
to true, the Lookout data table imports
data from the designated spreadsheet.

mdcursor

numeric

yes

yes

Updates a cell or a row in a data table
without an event from Lookout. For
example, with the ordinary cursor,
changing rows only updates those
cells where the connected value has
changed. If you use mdcursor, all
cells update when the cursor changes.

Modified

logical

yes

no

Pulses TRUE when any cell value in
the DataTable changes.

Update

logical

yes

no

Pulses each time the cursor changes
rows. Often used to “call up” a control
panel.

Related Objects DdeTable, DdeLink
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DdeLink

DdeLink creates a unidirectional Dynamic Data Exchange (DDE) link to
another application. The other application could be running on the same
computer or on another computer over a network. DdeLink objects provide
an easy way to import remote values into Lookout. Refer to Chapter 5,
Dynamic Data Exchange, in the Lookout Developer’s Manual for more
information about DDE. For each DdeLink object you define, Lookout
creates a separate link to the other application. If you need to import large
quantities of data, you should use the DdeTable or DataTable object. Refer
to the DdeTable section and the DataSocket section for more information
about using these objects.

DdeLinks on Same Computer

If you are importing values from another application running on the same
computer, your DDE parameters will look similar to the ones in the
following illustration.

Create DdeLink E

M ame: |DDE‘I

DDE p :

Service: lExceI—
Topic: W
Item: l”d—

QK | Cancel | Help |

Figure 2-17. DdeLink Definition Parameters Dialog Box (Same Computer)

Service specifies the application name, Topic specifies the file, and Item
points to the individual value (rlcl refers to the cell at row1, columnl.
Unfortunately, Excel does not support the more convenient Al cell
references with DDE).

DdeLinks to Remote Computer

If you are importing values from another application running on a remote
computer, your DDE parameters will look similar to the ones in the
following illustration.
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Create DdeLink E

M ame: |DDE‘I

DDE p

Service: I\EomputerName\NDDE$
Tapic: IProcessFiIe$
Item: Iname

Cancel | Help |

Figure 2-18. DdeLink Definition Parameters Dialog Box (Remote Computer)

Notice the differences in the Service, Topic, and Item parameters.

The backslashes (\\) and dollar signs ($) are standard requirements for
making network connections in Microsoft Windows. ComputerName
specifies the network name of the computer you are connecting to. If you
are connecting to a value in another Lookout application, ProcessFile is
the Lookout file name running on the remote computer, and Name refers to
the name you are linking to.

DdeLink Data Members

Table 2-13. DdeLink Data Members

Data Members Type Read | Write Description

(implicit) numeric yes no DDE link interpreted as numeric
value.

enable logical yes yes If TRUE (the default), enables DDE.
If FALSE, disables DDE. This input
is ignored for non-DDE TextEntry
objects.

hot logical yes no Status of DDE link.

logical logical yes no DDE link interpreted as logical value.

txt text yes no DDE link interpreted as text value.

Related Objects DdeTable, DataSocket
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DdeTable

DdeTable creates a unidirectional Dynamic Data Exchange (DDE) link to
another application. The other application could be running on the same
computer or on another computer over a network. Refer to Chapter 5,
Dynamic Data Exchange, in the Lookout Developer’s Manual for more
information about DDE. You can use DdeTable to import large quantities
of data from other applications. The table format is much more efficient at
transferring data than the Link format because a table can contain hundreds
or even thousands of data points that all share a single link. On the other
hand, the link format can only transfer a single value per link—and every
link requires a certain amount of CPU overhead. If you are only importing
a relatively small amount of data, you may find the DdeLink technique
easier to implement.

DdeTable on Same Computer

If you are importing values from another application running on the same
computer, your DDE parameters will look similar to the ones in the
following figure.

Create DdeT able E

M ame: |DDE‘I

DDE p -
Service: lExceI—
Topic: W
Item: l”d—

QK | Cancel | Help |

Figure 2-19. DdeTable Definition Parameters Dialog Box (Same Computer)

Service specifies the application name, Topic typically specifies the file,
and Item specifies the particular data item name.
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The following example shows an Excel spreadsheet with the highlighted
range named Data.

Data = Pressures

Pressures [@ICIERIGINE Times

NG| N BN =

You can now display any value in the range Data with this Lookout
DdeTable object.

Select Insert»Expression... and then choose the DdeTable data member
corresponding to the Excel spreadsheet cell containing the value you want
to display. Make sure that the type of data member you select matches the
type data in the spreadsheet cell.

Insert expression E
|DDET. 41 bt
Dizplay Type: Itext 'l Path Mode: IHeIative j
— Signals:
Paste | DODET.AT kxt
IE paroikoz. dy.natinst. com j Contents:
L3 implicit
bE” 4116384
" % Allogicalv16384 logical
D7 A1 taV1E384 et
P8 enatle
W hat
DdeT able text

Cancel Help

Figure 2-20. Inserting a DdeTable Expression
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Notice the reference for the displayed item in the Lookout status bar.

_EI_-Lookoul - [Process1 =] - [Control Panel] M= 3
File Edit Options Alams  Window Bun  Help = |ﬁ'|1|
Pressuresl

|osAo11:58 | Administrator |National Instrurnents Internal Use Only | = | = | 1 alarms

DdeTable to Remote Computer

Using the DdeTable object over a network is somewhat different from the
previous example.

Create DdeT able E

M ame: |DDE‘I

DDE p 8
Service: l\\[ﬁomputeer
Topic: W
Itemn: W

QK I Eancell Help |

Figure 2-21. DdeTable Definition Parameters Dialog Box (Remote Computer)

Notice the differences in the Service, Topic, and Item parameters.

The backslashes (\\) and dollar signs ($) are standard requirements for
making network connections in Windows. ComputerName specifies the
network name of the computer you are connecting to. If you are connecting
to a DdeTable or DataTable in another Lookout application, ProcessFile
is the Lookout file name running on the remote computer, and
LocalTablel refers to the DdeTable or DataTable object you are
linking to.
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DDETable Data Members

Table 2-14. DdeTable Data Members

Data Members Type Read | Write Description

(implicit) numeric yes no Cell Al interpreted as a numeric value

Al -1V16384 numeric yes no Specified cell interpreted as a numeric
value

Al.logical — logical yes no Specified cell interpreted as a logical

IV16384.1ogical value

Al.txt —IV16384.txt text yes no Specified cell interpreted as a text
value

enable logical yes yes If TRUE (the default), enables DDE.
If FALSE, disables DDE. This input
is ignored for non-DDE TextEntry
objects.

hot logical yes no Status of DDE link

Related Objects DataSocket, DdeLink
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DelayOff is an adjustable delay timer. When On/off signal transitions
to off, the Timer delay begins to count down. At the end of the delay
countdown, the output signal turns off. On/off signal must remain off
during the time delay period for the output signal to turn off. The output
immediately turns on when the On/off signal turns on.

Timer delay can range from 0.0 seconds to several years, and the effective
resolution is 0.1 seconds over the entire range. The timer display digitally
shows the time delay remaining, and is updated approximately once per
second. If the On/off signal is high, the timer display shows on. If the
Timer delay period has expired, the display shows of£.

Mame: W

On/off signal = W
Timer delay = |U15—
Dizplay format: lm

Cancel | Help |

Figure 2-22. DelayOff Definition Parameters Dialog Box

The On/off signal is a logical expression while Timer delay is a numeric
expression. Normally, this is a simple time constant such as 0:20—twenty
seconds. Refer to the Numeric Data Members section of Chapter 2, How
Lookout Works, in the Getting Started with Lookout manual for information
about entering time constants.

DelayOff Data Members

Table 2-15. DelayOff Data Members

Data Member

Type Read | Write Description

(implicit)

logical yes no Logical timer value

Comments The DelayOff timer can prevent a pump from short-cycling.

Related Objects DelayOn, Interval, OneShot, Pot, TextEntry

© National Instruments Corporation 2-73 Lookout Object Reference Manual



Chapter 2 Lookout System Objects

DelayOn

DelayOn is an adjustable delay timer. When On/off signal transitions
to on, the Timer delay begins to count down. At the end of the delay
countdown, the output signal turns on. On/off signal must remain on
during the time delay period for the output signal to turn on. The output
immediately turns off when the On/off signal turns off.

Timer delay can range from 0.0 seconds to several years, and the effective
resolution is 0.1 seconds over the entire range. The timer display digitally
shows the time delay remaining and is updated approximately once per
second. The timer display shows of £ when the On/off signal is low. If the
Timer delay period has expired, the display shows on.

Create DelayOn timer: | ]
Ta: IPumpRun

On/off signal = IPumpSwitch

Timer delay = ID:15|

Display format: IMM:SS j

Ok I Cancel |

Figure 2-23. DelayOn Definition Parameters Dialog Box

The On/off signal is a logical expression while Timer delay is a numeric
expression. Normally, this is a simple time constant such as 0:20—twenty
seconds. Refer to the Numeric Data Members section of Chapter 2, How
Lookout Works, in the Getting Started with Lookout manual for more
information about entering time constants.

DelayOn Data Members

Table 2-16. DelayOn Data Members

Data Member

Type Read | Write Description

(implicit)

logical yes no Logical timer value

Comments The DelayOn timer can be used to prevent pumps from cycling too often,
to allow one operation to complete before another begins, or to require a condition to
exist for a period of time before an alarm is activated.

Related Objects

Lookout Object Reference Manual

DelayOff, Interval, OneShot, Pot, TextEntry
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Derivative

Derivative can also be called a rate of change object—it calculates the rate
of change of the incoming numeric input signal. You can use this class to
calculate the rate at which a tank is filling or draining, or to convert a

changing totalized flow value into a flow rate. The output units are in Input

Units/Time Unit.
M ame: IDerivative‘I
Input = ||
Update = I
Time unit: I
QK | Cancel | Help |

Figure 2-24. Derivative Definition Parameters Dialog Box

The previous example calculates the rate of change in the water level of a
tank. Lookout polls the RTU connected to the tank level transmitter every
5 minutes, so this example uses the RTU update data member as the Update
pulse for the Derivative object. Tanklevel is in feet and Time unit is

1 minute, so the output result is in feet per minute.

Input is the numeric expression you are monitoring for rate of change.

Update can be a logical expression or numeric constant. If you specify
Update as a numeric constant, it creates an internal pulse timer with a pulse
period of the specified time and a pulse duration of zero. Refer to the
Numeric Data Members section of Chapter 2, How Lookout Works, in the
Getting Started with Lookout manual for more information about entering
time constants. If you specify Update as a logical variable, the variable
should pulse at the frequency you want to use.

The Update expression triggers the calculation of a new rate-of-change
based on the Input value at the prior Update, and the current Input value.
The current Input value is then stored as the prior Input value for the next
calculation. The Update period should be greater than the refresh rate of
the incoming signal; or if the Input is generated directly by external 1/O,
the update data member generated by the PLC object should be used. If
the Update period is less than the Input refresh rate, the rate of change
calculation fluctuates erratically between zero and a high value.
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Time unit is a numeric expression used as the basis for unit time on the
Input signal. For instance, if the rate of change should be in feet per minute,
the Input signal would be feet, and Time unit would be one minute (entered
as 1:00). Typically the Time unit is one second (0:01), one minute (1:00),
one hour (1:00:00), or one day (1:00:00:00). However, you can specify any
unit, such as 5:23 (a rate of change in Input units per five minutes and

23 seconds).

Derivative Data Members

Table 2-17. Derivative Data Members

Data Member

Type Read | Write Description

(implicit)

numeric yes no Rate of change

Comments Derivative performs the inverse function of Integral—you can
theoretically run a signal through an Integral object and then a Derivative object
(or vice versa) and you would end up with the original signal. (Discretization of the
time calculations by the computer may cause the final and original signals to differ

somewhat).

Related Objects

Lookout Object Reference Manual

It is important to consider the resolution of the process variable measured
by the PLC when determining the Update period for this object. For
instance, if a pressure transmitter connected to a PLC only has a resolution
of 0.5 psi and you want to measure rates down to 1 psi/minute, the Update
pulse must be greater than 30 seconds even if the PLC is polled once per
second (i.e., 0.5 psi/l psi/min. = 30 sec.). For this application, the Update
pulse should probably be about two minutes.

Integral
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DialGauge

The DialGauge object class displays a numeric signal as a sweeping needle
on an analog gauge or dial.

Mew dial gauge E
M ame: IDiaI‘I

Sighal = IAirPressure]
Minirriurm: ID
I awimurn: I‘IDD

Dial needle p

Starting angle: 225 degrees clockwizse from vertical

Fiotational sweep: |2?D degrees clockwize
QK I Eancell Help |

Figure 2-25. DialGauge Definition Parameters Dialog Box
Signal is a numeric expression.

Starting angle indicates the position of the needle when the Signal is at its
Minimum value. As shown here, you specify the starting needle position
by counting the degrees clockwise from vertical.

0()
270°
225°
Default
Starting 180°
Angle

Rotational sweep specifies the number of degrees clockwise that the
needle will rotate as the Signal approaches the Maximum value. As shown
in the diagram here, you count the Rotational sweep in degrees clockwise
from the Starting angle.

© National Instruments Corporation 2-77 Lookout Object Reference Manual



Chapter 2 Lookout System Objects

o

™

Starting
Angle
180°

When you place a DialGauge on a panel, the Display dial gauge dialog box
appears, as shown in the following figure.

Display dial gauge E3
Heedle color:

[ CHEC .
LR ]

MNeedle thickness: I'I pisels(1-10]
MNeedle length: I'I i} 4

Canhicel |

Figure 2-26. DialGauge Display Parameters Dialog Box

Needle thickness defines how wide your needle will be. Thickness can
range from one pixel (hairline) to 10 pixels wide.

Needle length specifies the length of the needle as a percent of the radius.
At 30 percent, for example, only the outer tip of the needle is visible—you
cannot see the part of the needle closest to the origin. At 100 percent, the
needle extends the full radius of the circle.

Lookout Object Reference Manual 2-78 ni.com




Chapter 2 Lookout System Objects
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DialGauge Data Members

Table 2-18. DialGauge Data Members

Data Members

Type Read | Write Description
(implicit) numeric yes no Current value of signal parameter
graphicl-graphicN numeric yes no Denotes which display of this object
will appear on an HTML report. Only
one display is available for the
ActiveX object.
a0 eu 7
40 Ll
a0 a0
20 “ 100
10 110
120

Comments The DialGauge object class only displays a needle. You may wish to
enhance it with a corresponding scale or dial face as shown. You can create a scale or
dial face by importing one from a graphics package. Refer to the Creating Custom
Graphics section of Chapter 2, Graphics, in the Lookout Developer’s Manual for more

information about creating graphics in Lookout.
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@ Note If you choose to import a scale or dial face from an external package, you should use
a bitmap instead of a metafile.This makes the display refresh cleaner when the needle
changes position.

Related Objects (expression), Gauge
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ElapsedTime is an elapsed time meter or “hour meter” that totals the
amount of time the Enable expression is on. If Enable is the logical
constant ON, the meter reflects the time since the process was started. If a
Reset expression is specified, the meter resets to zero the moment Reset
transitions from off to on. The display always shows the elapsed time, and
is updated approximately once per second.

Create Elapsed-Time Meter: E
Mame:  [ETM1
Enable = ||
Reset = I
QK | Cancel | Help |

Figure 2-27. ElapsedTime Definition Parameters Dialog Box

ElapsedTime Data Members

Table 2-19. ElapsedTime Data Members

Data Member

Type Read | Write Description

(implicit)

numeric yes no Total elapsed time—updated once per
second, while meter is running

Comments ElapsedTime meters are used primarily to record the amount of time that
individual pieces of equipment have been running. It is also straightforward to set up
an alarm that sounds when a particular device has been operating for a certain time and
needs routine servicing. The plant operator could then perform the service and reset

the ElapsedTime meter with a pushbutton.

ElapsedTime can also record the amount of time a particular device

is operated each day and you can record the resulting time to a daily
Spreadsheet which you can then use to automatically reset the meter
after the data is permanently recorded.
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Event
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Event is a flexible and powerful object class you can use to define event
messages that are triggered based on a user-defined logical expression.
Lookout logs such events to the Citadel database and you can subsequently
print and archive them. Refer to Chapter 7, Logging Data and Events, in the
Lookout Developer’s Manual for more information about logging events.

M ame: IW
Trigger = IPLEPressure>1 a0
Trigger hi text = I"The water pressure just exceeded 150 P51
Trigger lo text = I"The water pressure just dipped below 150 PSI™
Cancel | Help |

Figure 2-28. Typical Settings for an Event

When the result of the Trigger logical expression transitions from FALSE
to TRUE, it logs the result of the Trigger hi text expression as an event in
the EVENT . DAT file. When the results of the Trigger expression transitions

from TRUE to FALSE, it logs the results of the Trigger lo text expression
as an event.

Event Data Members

Table 2-20. Event Data Members

Lookout Object Reference Manual

Data Member Type Read | Write Description
none — — — Event objects do not have data
members
Comments For each event logged, Lookout records the date and time, the name of the

user currently logged on, and the expression text.

Although event messages are shown for both Trigger hi text and Trigger
lo text, you do not have to include text in both fields.
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(expression)

Named expressions, shown as (expression)s, are flexible, powerful
real-time calculators. They create and calculate the result of
spreadsheet-style formulas that include a mixture of constants and signals
from other objects. There are over fifty built-in functions that you use in
expressions, including logical, mathematical, statistical, text and
trigonometric functions. Refer to Chapter 1, Expressions, in the Lookout
Developer’s Manual for more information about expressions and
expression functions.

Named expressions can be short and simple, or extremely complex with
several signal inputs, function calls, and multiple levels of parentheses.
A single expression may incorporate text, logical, and numeric
calculations. The variable type returned by the outermost function or
operator in the expression determines the signal type generated by the
expression.

Create expression E

Tag: IPump‘I Fun

Expression =

IF'ump‘ISpeed.Act:‘I 0OF [HOA=3 AMD PumplMeutralZone below)

Cancel |

Figure 2-29. Create Expression Dialog Box

E Note You typically use (expression) objects when you need to define a unique condition
that is used multiple times throughout your application.

When you define an (expression) object (as opposed to inserting an
intrinsic expression), you create a unique name for your expression and can
therefore reference the output signal generated from the expression in other
expressions or objects. Instead of defining the same expression in many
places, you create it one time and use its name any time you need this
expression.
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@ Note The expression may not express a condition.

Table 2-21. Expression Data Members

Data Member Type Read | Write Description
(implicit) numeric, yes no Value of expression. The variable type
logical, returned by the outermost function or
or text operator in the expression determines
the signal type generated by the
expression.
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Flipflop

Flipflop changes its logical output signal from on to off, or from off to on
when the Input signal goes high. The output signal does not change when
the signal goes low. Input is a logical expression.

Create Flipflop E
Mame: IFIiprop‘I
Input = I

QK | Cancel | Help |

Figure 2-30. Flipflop Definition Parameters Dialog Box

Flipflop Data Member

Table 2-22. Flipflop Data Member

Data Member Type Read | Write Description

(implicit) logical yes no Current state

Comments Flipflop can be used to alternate the operation of two pumps, or when
connected to a pushbutton, provides a pushbutton on/off control device.

Related Objects LatchGate
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Gauge

Lookout System Objects

Gauge displays the Signal expression in digital or bar graph format. Gauge
display parameters change depending on the values of the Conditional

expressions. Gauge determines which colors to display based on the order
and current status of your conditional expressions. For instance, if several
conditional expressions are true at once, Gauge displays the color

associated with the first true expression.

You can use the Transparent background style with numeric expressions
and gauges displayed as bar graphs. This means you can have bar graphs
with transparent backgrounds.

Lookout Object Reference Manual

New Gauge

Mame:  |[EEN[]

]

Signal = I

Conditional expressions:

F=

Elseif= |

Elseif= |

Elseif= |

Elseif= |

Elze

Gauge colors:

[ W CHNC ..
ENEEENE

N | (e
RN

| | |
EFENNE

[ W CHNC ..
ENEEENE

N | (e
RN

| | I

ETEEEEE

Flash when =

ok

[ Fast

| Cancel | Help

Figure 2-31. Gauge Definition Parameters Dialog Box
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Conditional expressions and Flash when are logical expressions while
Signal is a numeric expression. The Fast option instructs the Gauge to flash
faster when enabled than when disabled.

Gauge Data Members

Table 2-23. Gauge Data Members

Data Member Type Read | Write Description
(implicit) numeric yes no Numeric value of Gauge
graphicl-graphicN numeric yes no Denotes which display of this object

will appear on an HTML report. Only
one display is available for the
ActiveX object.

Comments You should use a Gauge object when you need a bar graph or digital
display to change colors and/or flash upon certain conditions. If you do not need either
of these capabilities, you should display a bar graph or digital value with the

Insert»Expression command.

© National Instruments Corporation
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Histogram

The Histogram object class is one of the Lookout Statistical Process
Control (SPC) tools and can play an important role in a Total Quality
Management (TQM) program. This object class displays the distribution
and/or relative distribution of a signal value. It shows the central tendency
and variability of the sampled data. It also calculates process capability
ratio (PCR), PCR confidence interval, mean, variance and standard
deviation.

Mame: IHistogram‘I

Sampled signal = ||

Sample tigger = I

Reset = I
— Bin setting

Murnber: IS

Minimurn = I

I awimum = I

— Categorize
& Al samples

" Most recentl zamples

LSL= |
usL = |

Confidence level: |95 % [90-995)

QK | Cancel | Help |

Figure 2-32. Histogram Definition Parameters Dialog Box

Sampled signal identifies the value that you are statistically monitoring.
Histogram reads and categorizes the Sampled signal any time Sample
trigger transitions from off to on.

You can either Categorize all samples since Reset last transitioned from

off to on, or you can Categorize a sliding window of the most recent
2 — 1000 samples.

Bin Settings define the Number of desired categories. The difference
between Minimum and Maximum determines the width of each bin or
category.
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The settings for the following Histogram graph call for eight bins. Because
the difference between Minimum and Maximum is 80 and because there
are eight bins, each class interval has a range of 10 (80/8 bins = 10). So bin;
contains sample values ranging from zero to less than 10; bin, contains
sample values ranging from 10 to less than 20, and so on.

This object always allocates two more bins than you request. These bins are
used for accumulating samples less than the Minimum and greater than the
Maximum. The lower bin is always data member £0. The upper bin is
fn+1, where n=Number in Bin Settings.

In the following example, Bin, (data member £0) contains all sample
values less than Minimum and bin9 contains all sample values greater than
or equal to Maximum.

Actual Frequency Distribution

bin 1 1|:||:|_ bin 8
?5—
A0
5
25 ¢ f6 7 8 f9
|:|_

1III 20 30 40 &0 BO ?EI BEI EIIII 1IIIIII
minimum \_ maximum

Figure 2-33. Graph from Inserting Ten Numeric Expression Barcharts
(Data Members f0 through f9 as Shown) and Two Scales

LSL and USL identify the lower and upper specification limits. These
limits generally define the range of acceptable sample values. Histogram
uses LSL and USL to calculate the process capability ratios (PCR

and PCRk).

The Confidence level expresses the degree of certainty or probability that
the actual value of PCR (the process capability ratio) falls within the
confidence interval (that is, between PCRL and PCRU). A typical value is
95 percent. The lower the confidence level, the tighter the interval.
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@ Note Histogram does not have a display parameters dialog box. However, you can easily
display the results of its output signals by referencing them in expressions.

Histogram Data Members

Table 2-24. Histogram Data Members

Data Member

Type

Read

Write

Description

f0 — 201

numeric

yes

no

Frequency of sampled signal values
falling within the identified bin

LSL

numeric

yes

no

Lower specification limit

mean

numeric

yes

no

Average of sampled values, where
PR
i=1

n

f:

PCR

numeric

yes

no

Process capability ratio measuring the
uniformity or variability of the
sampled signal using upper and lower
specification limits. This ratio
measures potential capability. If
standard deviation = 0, PCR = 0.
Otherwise

_ USL-LSL
60

PCR

PCRk

numeric

yes

no

One-sided process capability ratio for
an off-center process. This ratio takes
process centering into account,
measuring actual capability.

x—LSL USL—)?)
36~ 3o

PCRy = min(

PCRL

numeric

yes

no

Lower limit of the confidence interval

PCRU

numeric

yes

no

Upper limit of the confidence interval

rfO — rf201

numeric

yes

no

Relative frequency (percent) of
sampled signal values falling within
the identified bin
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Table 2-24. Histogram Data Members (Continued)

Data Member Type Read | Write Description
samples numeric yes no Number of sampled signal values
sdev numeric yes no Sample standard deviation, where

USL numeric yes no Upper specification limit
variance numeric yes no Sample variance, where
n _ 2
z (x; - X)
62 _ =l
n—1

Comments The confidence interval is the range of values determined by the limits
PCRL and PCRU.

Related Objects Average, Maximum, Minimum, Sample, XBarR

Related Functions Avg, Max, Min, Stdev, Stdevp, Sum, Var, Varp
Refer to Chapter 1, Expressions, of the Lookout Developer’s Manual for more
information about these functions.
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HyperTrend

Lookout Object Reference Manual

A HyperTrend object displays a trend graph on a control panel. It plots any
number of logical and numeric trend lines.

HyperTrends provide instant access to both real-time and historical data in
a single graph. For each plot line, they combine both real-time and

historical data into a seamless, contiguous trace of data. Refer to the Citadel
Historical Database section of Chapter 7, Logging Data and Events, in the
Lookout Developer’s Manual for more information about transmitting data.

In earlier versions of Lookout, creating a trend line in a HyperTrend object
automatically logged the requested data to the database.

In Lookout 4 and later, you must select the Log to historical database option
in the Edit Database dialog box for any data you want to display in a
HyperTrend object before you can display the data. This is because logging
must be configured in a Lookout Server process, while trending is typically
done in a separate Lookout client process.

You can log information by connecting to a symbolic link, but only if the
data source the symbolic link represents has had the Log to historical
database option selected.

You can pan and zoom both the X axis and the Y axis in the HyperTrend
plot, enabling dynamic adjustment of the vertical and horizontal resolutions
of each plot line on the graph. Using this feature, you can, for example,
zoom into a particular area of focus on the trend.

The graph scrolls from right to left, plotting current, real-time signals at the
right end of the graph.

The icon in the upper left of the display accesses a menu you can use to
change the group of traces being plotted, activate the cursor, and start or
stop scrolling. The arrow-shaped buttons make it easy for you to scroll the
trend graph forward and back in time. It provides instant access to data that
has scrolled off the left end of the graph (that is, historical data stored in the
Citadel database).
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B R ) L

[ ] Change Group
Hyper Curzor
Start / Stop

The button bar includes scroll arrows, a cursor button, date, time, and a stop
and go light. Use the scroll arrows to move back and forth through time-the
bigger the arrow button you select, the further the trend jumps in time. The
scroll arrows also function much like a horizontal slider. Click on them and
slide the mouse left and right while holding down the mouse button. The
further you slide the cursor from dead center, the faster the trend scrolls in
that direction.

Use the date and time indicators to choose a specific month, day, year, hour,
minute, or second. If you click on the lower part of the hour, for example,
it jumps back in time by one hour.

If you click on the upper part of the hour, it jumps ahead by one hour.

It works the same way for month, day, year, minute and second.

The stop & go light on the button bar is either red or green. If the light is
green, it indicates the far right edge of the trend window displays the
current time.

When you scroll back in time or if you click on the light when it is green,
it changes to red, indicating that the trend is temporarily frozen in time. The
date and time appears in the button bar indicating the exact time at the far
right edge of the trend window. As you scroll back and forth through time,
the data and time changes accordingly.

If you click on the light when it is red, the trend jumps back to current time
and starts scrolling while plotting real-time values.
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@ Note The Citadel database continues to log data no matter what state the HyperTrend is

in. You do not 1
is not scrolling

Lookout Object Reference Manual

ose any data when it is in "historical" mode (that is, when the HyperTrend
in real-time).

When you click on the cursor button, a vertical cursor bar appears in the
center of the graph along with an associated cursor dialog box. The dialog
box indicates the value of each trend line at the current location of the
cursor. As you drag the cursor bar left and right on the trend graph, the
values in the pop-up change to reflect the new cursor location.

You can select how the trend line values are shown by choosing a format
through the cursor control menu.

i HyperTrendl Cursor E
Time: IDBJD‘I /1993 12:40:14.3 ﬂ
Sparoikoz, dy.natingt comskiyServera avetorm. cozine wave 0 BBE

Find
( ﬂ ﬂlBreaka’Mina’Max |

Figure 2-34. HyperTrend Cursor Dialog Box

Time indicates the current location of the cursor bar. The increment and
decrement buttons beside the field move the cursor left and right in the
trend graph. Choose the size of the incremental move by clicking on the
desired portion of the date/time. The hour portion is selected in the previous
example, so each time you click on the increment or decrement button, the
cursor bar jumps ahead or back by an hour. It works the same way for any
portion of the date and time.

Use the Find combo box to search for a break in the trend line, a signal peak
or valley, or a specific value. For example, you can find the last instance in
which a process control limit value was exceeded. To find the last time a
trend line crossed a specific value, choose the desired trend line by clicking
on it in the list box, select Value in the Find combo box, enter the desired
value, and clock on the scroll back button.
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To create a hypertrend object, choose Object»Create or right-click on a
process in the object explorer and select New Object. Select HyperTrend.
The following dialog box appears.

Create HyperTrend
; Aidd [tern | Mame: IHyperTlend2 |

Ok

Cancel | Help I

E xpreszion

| Line Color | Min/Mas/Pas/Hat [

Back |
Farward |

First you must create a group of trends. Double-click on the AddGroup
button. The following dialog box appears.

Edit Group

MNarme IPumpStation‘I
Faper color

N[N | [
EEENa.

Grid color

[ [ W e .

AR

Mo labels

 Vetical

Trend Width

Timeling labels

& Horizontal
" Horizontal (zmall

© Vertical [small)

Horizontal grid style——

Major increments |1 i)
Minor increments |2

Cancel |

¥ Show Button bar

ID: a0:00

Configuring the group sets the appearance of the HyperTrend object when
it displays traces from that group. You can set different paper and grid
colors for different groups to help operators distinguish between them.

Give your group a name that clearly identifies it. Be sure to set the Trend
Width for the period of time you want under observation for that group.
Graphs may have a default width, or time span, of anywhere from two
seconds to four years. The default Trend Width in the example dialog box
indicates a time span of 1:00:00 or one hour. Refer the Numeric Data

© National Instruments Corporation
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Members section of Chapter 2, How Lookout Works, of the Getting Started
with Lookout manual for more information about entering time constants.
After creating the HyperTrend object, you can make the trend width
adjustable by connecting a numeric signal to the TrendWidth data member.

Major increments specifies the number of heavy horizontal grid lines on
a trend graph. This value is independent of the range of any trend
expressions.

Minor increments specifies the number of light horizontal grid lines
between the major increment grid lines on a trend graph. This value is
independent of the range of any trend expressions.

After you create a group, you must add individual items. Right-click on the
group you want to add a trace to. Select Add Item (or click on the Add
Item button). The following dialog box appears.

Add ltem [ ]
URL = |
Mumeric: minimum or Murneric rmaximum or
Logical base position: Logical TRUE height:
ID 100
Line color: [ Full-height Logical

[ [ N .
ECEENEE

oK | Cancel |

Right-clicking in the URL field displays the object selection dialog box
covering all the registered computers running Lookout on your network.
Select the computer and process generating the value you want to display
on your HyperTrend chart. Refer to the URLSs section for more information
on this type of Lookout connection.

Minimum and Maximum set the scale for the trace on your display. If you
are charting a logical data member, position and height set the base display
line and the height of the trace from that point when your signal goes
TRUE. Minimum is the bottom of the graph while Maximum is the top of
the graph, regardless of the range of the expression. These settings create
an imaginary vertical scale and affect each expression independently.

For example, take two numeric expressions, both of which range from 0 to
50. Set the Minimum and Maximum to 0 and 100 on the first expression,
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and —50 and 50 on the second. The first expression plots in the bottom half
of the chart while the second expression plots in the top half of the chart,

even though they both fluctuate between 0 and 50.

. i i :
0 143745 143500 143515 143530 143545 143900 143915 143935

This figure shows the imaginary scale of the first expression
(where min. = 0 and max. = 100). Because the expression ranges from 0 to

50, it is plotted in the bottom half of the graph.
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143745 143500 143515 143530 143545 143900 143915 14395

This figure shows the imaginary scale of the second expression (where
min. = —50 and max. = 50). Because the expression ranges from 0 to 50,

it is plotted in the top half of the graph.
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When both expressions are entered on a single trend graph, you get the
following effect. Notice the custom scales at either end of the graph.
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If you select Logical for the expression type, the minimum and maximum
settings changes to Position and Height. These two values now represent a
number between 0% and 100%, and determine the baseline location of the
trend line and its unit height when the expression goes TRUE. Check the
Full-height Logical option to plot logical data as a full-height bar on a

chart.

N\ / 7

12:45:10 12:45:15 12:45:20

The front-to-back order that trend one is displayed can be important, as
shown in the previous figure where the full-height logical trace is behind
the sine wave and the single line logical trace. The item listed at the top of
the Hypertrend property box is always furthest back in the display. Move
items behind or in front on the display by selecting the item and clicking
the Back or Forward button. Use Insert»Scale to label the values being
charted according to your minimum and maximum settings.

@ Tip HyperTrend objects access data from the Citadel database. Think of them as windows
into your historical database. Refer to Chapter 5, Developer Tour in the Getting Started
with Lookout manual, and Chapter 7, Logging Data and Events, in the Lookout
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Developer’s Manual, for more information about specifying a point to be logged to the
Citadel database. Use the Trend object to display data you do not want to log to the disk.

HyperTrends are updated as quickly as once per second, depending on
screen resolution, the size of the graph, and the trend width setting.
Computers with slow display adapters may slow down considerably when
you display a large trend graph. On slower computers with slow display
cards (no graphics coprocessor), consider limiting the size of your
HyperTrends to less than one fourth the screen size.

If you make a HyperTrend object too small, you may crowd the cursor
marker (shown in the following illustration) out of the HyperTrend control
bar. If your HyperTrend is not wide enough to display the HyperCursor
marker, the HyperCursor will not function. To fix this problem, resize your
HyperTrend object.

HyperTrend Data Members

Table 2-25. HyperTrend Data Members

Data Members

Type Read | Write Description

ActiveGroup

numeric yes yes Sets which of the HyperTrend trace
groups is active.

Enable1- Enable 999

logical yes yes When TRUE, the identified trend line
is visible. When FALSE, the trend
line hidden. The default value is
TRUE. Trend lines are identified by
the group number followed by the
item number, so Enablel.2 would
refer to item 2 in group 1.

graphicl-graphicN

numeric yes no Denotes which display of this object
will appear on an HTML report. Only
one display is available for the
ActiveX object.
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Table 2-25. HyperTrend Data Members (Continued)

Data Members Type Read | Write Description

Heightl — Height999 numeric yes yes Specifies the amplitude or height of
the identified trend line (distance
from baseline) when the logical
expression goes TRUE. Height
should be between 2 and (100 minus
position). Trend lines are identified by
the group number followed by the
item number, so Height1.2 would
refer to item 2 in group 1.

HideIfOff1.1- logical yes yes Affects only logical signals being
HideIfOff999.999 charted on the HyperTrend. When
TRUE, the logical signal does not
show up on the trace when OFF. This
results in logical items being charted
only when TRUE, or ON.

Max1 — Max999 numeric yes yes Specifies the top of the graph for the
identified numeric trend line (the
value of the trended line when it is at
100 percent of the Y axis). Trend lines
are identified by the group number
followed by the item number, so
Max1.2 would refer to item 2 in
group 1.

Minl — Min999 numeric yes yes Specifies the bottom of the graph for
the identified numeric trend line (the
value of the trended line when it is at
zero percent of the Y axis). Trend
lines are identified by the group
number followed by the item number,
so Minl.2 would refer to item 2 in
group 1.

Lookout Object Reference Manual 2-100 ni.com



Table 2-25

Chapter 2 Lookout System Objects

. HyperTrend Data Members (Continued)

Data Members

Type

Read

Write

Description

Pos1 — P0s999

numeric

yes

yes

Specifies the baseline location of the
identified logical trend line. Baseline
position should range should be 1-98.
(posl is associated with trend line 1)
Trend lines are identified by the group
number followed by the item number,
so Pos1.2 would refer to item 2 in
group 1.

TrendWidth

numeric

yes

yes

Specifies the span of time that the X
axis covers.

UseButtonBar

logical

yes

yes

When TRUE, the HyperTrend button
bar becomes visible on the control
panel. When FALSE, it is invisible.
The default value is TRUE.

Visible

logical

yes

yes

When TRUE, the HyperTrend
becomes visible on the control panel.
When FALSE, it is invisible. The
default value is TRUE.

Converting Lookout 3.xx HyperTrends to Lookout 4 and Greater

If you convert a process created in a version of Lookout earlier than 4.0
which contains a HyperTrend object that is displaying a complex
expression, Lookout automatically creates a named (expression) for the
converted HyperTrend to chart. To maintain your legacy HyperTrend
objects you must use or replace these (expression) objects.
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Integral

Integral is a totalizer—it totals the numeric Input signal. This class is
typically used to total a measured flow rate.

Mame: W
Input = ||
Update = I
Time unit: I
Reset = I
()8 | Cancel | Help |

Figure 2-35. Integral Definition Parameters Dialog Box
Input is the numeric expression that you want to totalize or integrate.

Update can be a logical expression or numeric constant. If you specify
Update as a numeric constant, it creates an internal Pulse timer with a pulse
period of the specified time and a pulse duration of zero. Refer to the
Numeric Data Members section of Chapter 2, How Lookout Works, of the
Getting Started with Lookout manual for information about entering time
constants. If you specify Update as a logical variable, the variable should
pulse at the desired frequency.

The Update expression extrapolates an interim total based on the current
total and the most recent Input value. The interim total is then sent out as
the output. The total is calculated using the trapezoidal numeric integration
technique, and the total is corrected any time the incoming signal is
refreshed.

Time unit is a numeric expression used as the basis for unit time on the
Input signal. For instance, if the Input rate is in units of gallons per minute,
the Time unit should be entered as one minute (1:00) so the totalized flow
is in gallons. Typically the Time unit is one second (0:01), one minute
(1:00), one hour (1:00:00), or one day (1:00:00:00). However, you can
specify any unit, such as 5:23 (a rate of change in Input units per five
minutes and 23 seconds).

Reset is a logical expression that resets the totalizer value to zero upon
transition from OFF to ON.
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E Note Integral does not have a display parameters dialog box. You can easily display the
result of the Integral output signal by referencing its data member in an expression.

Integral Data Members

Table 2-26. Integral Data Members

Data Member

Type

Read

Write

Description

(implicit)

numeric

yes

no

Totalized value

Comments The Update pulse forces the calculated total to continue changing between
Input signal updates. For example, if a remote RTU that is monitoring a flow rate is

polled every ten minutes, the Update pulse could be set at five seconds so the operator
can watch the totalized flow continue to change on the screen as an extrapolated value.
The corrected totalized value is calculated any time the Input signal refreshes—in this
case, every ten minutes.

If totalized values are logged to a spreadsheet on a daily basis, for example,
and the total should be reset at the end of every day, use the update pulse
generated by the Spreadsheet object to reset the total—this guarantees that
the total is recorded before the totalizer is reset. The example on the
previous page totalizes the hourly flow for permanent data logging by a
spreadsheet object named HourlySheet. Notice that the spreadsheet update
pulse HourlySheet . logged is used to reset the totalizer.

Related Objects Accumulator, Counter, Derivative
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Interpolate

Lookout Object Reference Manual

The Interpolate object class performs a linear interpolation between a set
of X,Y coordinate pairs to determine a corresponding output for any given
input. A single Interpolate object can have up to 1,000 coordinate pairs.
Although this object class can be used for any calculation requiring linear
interpolation, it is especially useful for tank strapping applications.

Create interpolate object: E
Name: lTank‘I— Entry Inputs(x] Ouputs(y]
a 5 3
MNewenty——————— | 1 4 4
Inpt{s): I 2 2 3
3 1 2
Ouput(y]: I 4 1] 1

Dete |

Mew entry |

5 entries
Input farmat: Input(x] multiplier =
I General =
Olutput format;: Olutput{y] multiplier =
I General j I

Sort order [inputs)
' Increasing ak. | Cancel | Help |
& Decreasing Mew =.p point added.

Figure 2-36. Interpolate Definition Parameters Dialog Box

The following diagram visually depicts the basic functionality of the
Interpolate object, and the set of coordinate pairs as entered.

Based on this graphical representation of the object, you can readily see
how different X inputs give corresponding Y outputs. Also notice that an
X input of 5.5 yields a Y output of 2.5—even though the last coordinate
pair was (5,3). Lookout uses straight line extrapolation at both end points
with a slope determined by the last two coordinate pairs.
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(4,4)<¢—— X,Y Coordinate Pairs
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The New entry parameter fields enable adding, modifying and deleting
Input(x) and Output(y) coordinate pairs. Input(x) and Output(y) are
numeric parameters.

Input format and Output format define the of the Input(x) and
Output(y) coordinate pairs displayed in the definition dialog box.

Sort order (inputs) specifies whether the dialog box lists X,Y coordinate
pairs in Increasing or Decreasing order. The sort order has no bearing on
output calculations or the values of the readable data members.

The Input(x) multiplier and the Qutput(y) multiplier are numeric
expressions. These two parameters are useful for the more advanced
calculations often found in tank strapping applications. They can be used
for such things as temperature, pressure, density, and product correction
factors. As their names imply, Lookout multiplies the corresponding
Input/Output by the respective multiplier. If you specify an Input(x)
multiplier, the object multiplies the input by the appropriate multiplier
before calculating an interpolated output. If you specify an Output(y)
multiplier, the object multiplies an interim output by the appropriate
multiplier before calculating the final output value.
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Step through a simple example using the preceding diagram to clarify this
concept. Use an Input(x) multiplier of 1.5, and a Output(y) multiplier
of 2. Assume the variable input is currently 2. The object first multiplies
2 by 1.5 to produce 3. It then uses the coordinate pairs to find the
appropriate output value for an input of 3. As you can see, the interim
output would be 3.5. Because you specified an output multiplier, it must
first multiply 3.5 by 2 to give a final output of 7.

Situations may arise where you want multiple inputs going through a single
Interpolate object, giving multiple respective outputs. Instead of creating an
Interpolate object for each input, Lookout can connect multiple inputs to a
single object and read their corresponding outputs. The inputs are writable
data members (X0 — X999). For each input, there is a corresponding
readable output (YO — Y999 respectively). The following diagram shows a
numeric signal called TankLevel connected to an input, X0.

Tank1 connections E

Select object... |

— Select member:

‘wiitable members: Existing connections:

7 RD1339
WAR(INE: !

Select | |><U

Tank1.x0 = TarkLevel
Mew numeric connection
— Signals:
Tags: Pot Path Mode: IHeIative j
I IE paroikos dy.nafinist.com j Contents [readable]: numeric
6l $Keyboard [implicit]
gy $5ystem value

Process1

&3y $dlarm
-y Panell
-l Tankl

Cluit |

Paste | TarkLevel Help |

The Interpolate object now multiplies the X0 input by the Input(x)
multiplier, find the two coordinate pair parameters that X0 falls between,
interpolate, and multiply the interim output by the Output(y) multiplier,
then send the resulting value to the YO readable data member.

@ Note The Interpolate object class does not have a display parameters dialog box.
However, you can easily display the result of its output signals by referencing its data

members in expressions.
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Interpolate Data Members

Table 2-27. Interpolate Data Members

Data Members Type Read | Write Description
X0 -X999 numeric yes yes Input value
Y0 -Y999 numeric yes yes Output value. For a given input, Xn,

the object outputs the result of the
interpolation as a corresponding Yn
value.

Comments If you want to interpolate another input using the same coordinate pair
parameters and multipliers (that is, the same Interpolate object), connect to another
input like X23, and read its corresponding output, Y23.

Because Xn and Yn data members are both readable and writable, the
object can also act as a bi-directional interpolator. For example, you can
connect a numeric signal to a Yn data member, and read the corresponding
interpolated X» data member. A real-world example of this could be a
typical tank strapping problem. Normally, you would use a tank level as an
input to X0, and read the interpolated output YO as the corresponding tank
volume. Hence you begin with a level and end up with a volume. However,
you might also be monitoring the volume and would like to use that value
to calculate a corresponding level. In that case, you might want the
Interpolate object to be bi-directional, which it is. If YO ever changes, the
object divides Y0 by the Output(y) multiplier, interpolate between the two
closest Qutput(y) parameters, calculate a corresponding input value based
on the two closest Input(x) parameters, divide it by the Input(x)
multiplier, and send the resulting value to the X0 data member.

© National Instruments Corporation 2-107 Lookout Object Reference Manual



Chapter 2 Lookout System Objects

Interval

Interval is an adjustable delay timer. When On/off signal transitions to on,
its output turns on and the Timer delay begins to count down. At the end
of the delay countdown, the output signal turns OFF. If On/off signal is
dropped at any time, the output signal turns OFF, and the timer is reset.

Timer delay can range from 0.0 seconds to several years, and the effective
resolution is 0.1 seconds over the entire range. The timer display digitally
shows the time delay remaining. It is updated approximately once per
second. If the On/off signal is low, or the time delay period has expired, the
timer display shows OFF.

Create Interval timer: E
Mame: Timerl

On/off signal = I
Timer delay = I
Dizplay format: I Mk:S5 - l

Ok | Cancel | Help |

Figure 2-37. Interval Definition Parameters Dialog Box

The On/off signal is a logical expression while Timer delay is a numeric
expression. Normally, this is a simple time constant such as 0:20 (twenty
seconds). Refer to the Numeric Data Members section of Chapter 2, How
Lookout Works, of the Getting Started with Lookout manual for more
information about entering time constant.

Interval Data Members

Table 2-28. Interval Data Members

Data Member

Type Read | Write Description

(implicit)

logical yes no Logical timer value

Comments The Interval timer can be used to enforce a maximum run time for a pump.

Related Objects

Lookout Object Reference Manual

DelayOff, DelayOn, OneShot, Pot, TextEntry

2-108 ni.com



Joystick

Chapter 2 Lookout System Objects

Use the Joystick object to enable a joystick connected to your computer to
control your Lookout processes. Create a joystick object using the
following dialog box.

Create Joystick E
Mame Jopstick:
IJ opstick] Joystick 1

Poll rate [mg] |50 ¥ Use Dead Zone

QK I Cancel | Help |

Select from up to 16 different joysticks connected to your computer. Set the
Poll rate to determine how rapidly your joystick values are updated. Select
Use Dead Zone to expands the range for the neutral position of the joystick.
This range is called the dead zone. The joystick driver returns a constant
value for all positions in the dead zone.

The joystick X and Y axis positions are reported as 32,500 when the
joystick is in the neutral position. When the joystick is at the extreme left
or extreme upper position, the axis position are reported as 65,000. When
the joystick is in the extreme right or lower positions, the axis reports as 0.

For the Z axis and the fourth, fifth, and sixth axis, the numeric value ranges
are the same as for the X and Y axis, but the control orientation -- left
rudder, for instance, depends on the input device. Calibrate your joystick
input carefully before using this object.

Joystick Data Members

Table 2-29. Joystick Data Members

Data Member Type Read Write Description
Btnl - Btn32 logical yes no Returns status of the selected joystick
button.
Connected logical yes no TRUE when joystick is connected to
computer and active; FALSE if
joystick cannot be detected.
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Table 2-29. Joystick Data Members (Continued)

Data Member Type Read Write Description

ID numeric yes no Reports joystick number that you set
in the create object dialog box.

NumButtons numeric yes no Set this to reflect the number of
buttons the joystick has.

PollRate numeric yes yes Lookout expression that determines
the device polling frequency.

POVPos numeric yes no Point Of View position that returns
number which you can convert into a
point-of-view angle.

RPos numeric yes no Current position of the rudder or
fourth joystick axis.

UPos numeric yes no Current fifth axis position.

VPos numeric yes no Current sixth axis position.

XPos numeric yes no Current X-coordinate.

YPos numeric yes no Current Y-coordinate.

ZPos numeric yes no Current Z-coordinate.
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Junction receives up to nine numeric values, each of which could be the
result of a complex numeric expression. It outputs the value of the last
Additional input that changed (event driven). Notice, however, that it will
not output a value until the Initializing input has changed. After that, any
change in any input is immediately output.

Mew Junction E
M ame:

Initializing input =

Additional inputs =

QK | Cancel | Help |

Figure 2-38. Junction Definition Parameters Dialog Box

Junction Data Members

Table 2-30. Junction Data Members

Data Member

Type Read | Write Description

(implicit)

numeric yes no The value of the input that most
recently changed

Comments Junction is a unique class that should be used only in rare circumstances.
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$Keyboard is a global object. Its data members represent the keyboard
function keys. Unlike other object classes in which you can create several
objects of the same class, you cannot create or delete $Keyboard objects,
but you can use the one supplied.

You can use the $Keyboard global object to perform such functions as
calling a particular control panel, activating a batch sequence, or
acknowledging alarms by pressing a key.

Think of $Keyboard data members (which represent function keys on the
keyboard) as Lookout pushbuttons. Just as you can connect a pushbutton to
the activate data member of a panel, you can also connect a $Keyboard data
member to the activate data member of a panel. Such a connection is shown
in the following illustration.

Panell connections E
Select object... |

— Select member:

‘wiitable members: Existing connections:

activate

masimize
minirnize
print

Gelect | Iactivate

Parell. activate =

5. \$Keyboard i5

Mew logical connection il
— Signals:
Tags: [Flass]  Path Mode: I Relative =

Ir: IE paroikoz. dy.natinst. com

j Contents [readable]: logical

-3 $Keyboard " chil1-24
oy $5ystem " Mz4
|, Process " shift.f1-24

Quit |
Help |

Paste | 4. M$keyboard. F

Figure 2-39. Edit Connections Dialog Box

The logical expression, $Keyboard.F1 calls up Panell any time a user
presses the F1 key on the keyboard. Similar connections could be made to
other panels. You can easily connect a different panel to each function key.
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Just as easily, you can connect a function key to a batch process trigger.
When the key is pressed, (that is, when the $Keyboard data member goes
TRUE) the batch is activated—reading batch ingredients from a recipe
object, opening and closing valves, starting mixers, bottling finished
material, and so on.

You might also connect a function key to $Alarm.ack. This would enable
users to acknowledge alarms through a single keystroke.

$Keyboard Data Members

$Keyboard has 72 readable data members. Each data member represents a
unique key sequence, described in the following table.

Table 2-31. $Keyboard Data Members

Data Member Type Read | Write Description

Ctrl-F1 - Ctrl-F24 logical yes no Each of these 24 data members
represent a function key, F1 —
F24—when pressed in conjunction
with the Ctrl key. A given data
member returns logical TRUE when
the Ctrl key and function key are
pressed together and FALSE when the
keys are released.

F1 - F24 logical yes no Each of these 24 data members
represent a function key, F1 — F24. A
given data member returns a logical
TRUE when its associated function
key is pressed and FALSE when the
key is released.

Shift-F1 - Shift-F24 logical yes no Each of these 24 data members
represent a function key, F1 —
F24—when pressed in conjunction
with the Shift key. A given data
member returns logical TRUE when
the Shift key and function key are
pressed together and FALSE when the
keys are released.
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Comments $Keyboard function keys are global in nature. Any time F1 is pressed, the
$keyboard.F1 signal goes TRUE—regardless of what panel the user is looking at. If
you want a function key to be unique from one control panel to the next, use the Panel
object class function key data member. Refer to the Panel object class definition for

more information.

Related Objects L3Pushbutton, Pushbutton
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L3Pot

@ Note L3 objects are for backward compatibility when using Lookout versions previous to
Lookout 4.0.

L3Pot is a potentiometer that you use to change numeric setpoint values.
You can display pots on a control panel as a knob, vertical slider, horizontal
slider, increment/decrement pushbuttons, or digital entry. You can also use
pots as multiple-position switches.

If you change the background color of a panel and add a Pot object
displayed as a slider, its color is always gray. To change the background
color of a Pot to match your panel, select the Pot object, then pick
Change»Background Color from the menu.

Tag: IPressSetPoint
inimum: 125
|
Maxirnurm: |1?5
Cancel |
Fesolution: |.1

—Position source

 Local
o+ Remote
Position = IPLC1.HiPressAIarm

' DDE

EEfIEE I
i I
[teri I

Contral security level: ID V¥ Log evants

Figure 2-40. L3Pot Definitions Parameters Dialog Box
Minimum is the lowest value signal the Pot will generate.
Maximum is the highest value signal the Pot will generate.

Resolution is the smallest increment of change, or detent spacing the Pot
supports.
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Position source determines where the value of the Pot resides. Local
indicates the value of the Pot lies within the object itself—on the control
panel.

Remote pots get their values from a remote source, often the register on a
controller they are connected to. Adjusting the Pot changes the value in the
register, and changing the value in the register adjusts the Pot. In effect, the
Pot is tracking a remote value. This is especially useful when you want to
prevent Lookout from changing the value of setpoints or registers upon
initial startup, or reconnection of lost communication. When you use this
style Pot you are creating a kind of looped signal. Half the loop is formed
when you connect the controller register to the Pot with the Position
expression, while the second half is formed when you connect the Pot
output signal to the controller register. Position is a numeric expression.
Do not forget to complete the second half of the loop with the Object»Edit
Connections... command.

Much like Remote Pots, DDE (Dynamic Data Exchange) Pots get their
values from a remote source. This could be a cell in a spreadsheet, another
DDE aware application, or a second copy of Lookout running on the
network. The last DDE parameters used on any object automatically
become the default values for any new DDE object. Refer to Chapter 5,
Dynamic Data Exchange, of the Lookout Developer’s Manual for more
information about Service, Topic, and Item parameters.

Control security level specifies the minimum security level operators must
have to gain access to this individual object, and thus control it.

The Log events option creates a permanent audit trail for the object—who
did what and when. All adjustments of the Pot are logged to disk, including
the time of the adjustment, the operator account name, and what adjustment
was made. Refer to Chapter 7, Logging Data and Events, in the Lookout
Developer’s Manual for more information about event logging.
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Insert: PressSetPoint | ]

BEE

() K] (2] (4

Cancel |

Figure 2-41. L3Pot Display Parameters Dialog Box

@ Note You can modify the background color on vertical and horizontal sliders with the
Change»Background color menu command, or by right-clicking the object. You can
modify the font and font color of digital pots the same way.

L3Pot Data Members

Table 2-32. L3Pot Data Members

Data Member Type Read | Write Description
(implicit) numeric yes no Current value
decrement logical no yes When this data member value

transitions from FALSE to TRUE, the
implicit value of the Pot object
decreases by the Pot Resolution
amount.

enable logical no yes If TRUE (the default), enables DDE.
If FALSE, disables DDE. The default
value is on. This input is ignored for
non-DDE TextEntry objects.
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Table 2-32. L3Pot Data Members (Continued)

Data Member Type Read | Write Description

enter Value logical no yes Under specific circumstances, when
this value transitions from FALSE to
TRUE, pops up a Enter new value
dialog box for an operator to use in
entering a value for the pot. Refer to
the note following the table for more
detailed information.

The enterValue data member is
designed for use under unusual
circumstances, in particular when
pointing devices are not available on a
computer running Lookout. Because
of its unusual operation, this data
member should not be used unless it is
necessary for hardware reasons.

increment logical no yes When this data member value
transitions from FALSE to TRUE,
the implicit value of the Pot object
increases by the Resolution amount.

visible logical no yes When FALSE, the Pot object cannot
be seen on the display panel. When
TRUE, the Pot can be seen and
controlled.

@ Note When the enterValue input transitions from FALSE to TRUE, and
if the Pot is visible,
if Lookout is not in edit mode, and
if the Pot has at least one digital display,

The Enter new value dialog box pops up so an operator can input a value, just as if he had
clicked on the digital display.

The numeric format and position used for the dialog box are based on the digital display
for a pot.

Even if the panel containing the Pot digital display is inactive, the Enter new value dialog

box will pop up. You can prevent this by predicating the entervalue input on the panel’s
active data member.
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Comments Potentiometers are one of the most common control objects used in process
controls. Using Pots, a plant operator can make setpoint changes with the mouse.
L3Pots also work well as HOA switches. To create an HOA switch with a Pot, specify
the minimum as 1, the maximum as 3, and the resolution as 1.

The increment and decrement data members enable quick connection of
pot objects to $Keyboard and Panel function keys, and screen Pushbuttons.
These are often used to control Pot objects when Lookout is running on an
industrial PC platform that has restricted or no mouse functionality.
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L3Pushbutton

@ Note L3 objects are for backward compatibility when using Lookout versions previous to
Lookout 4.0.

L3Pushbutton generates a logical signal for receipt by other objects.

A pushbutton changes state when you position the cursor over it and press
the mouse button, trackball, touchscreen, or space bar. The pushbutton
remains depressed and the output signal remains high until you release the
button. If a Verify on message is defined, the operator must first
acknowledge the message, then the output signal goes high, but only
momentarily.

Create pushbutton | ]

Tag: IMotorStanPb

Button text: IStart

“erify on = I“DD wou want to start kotar 27"

—Position source
 Local

o+ Remote
Position = |PLC.C101

' DDE

EEfIEE I
i I
[teri I

Contral security level: ID V¥ Log evants

oK I Cancel |

Figure 2-42. L3Pushbutton Definitions Parameters Dialog Box

Button text displays the specified text on the pushbutton.
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Use Verify on to create a dynamic text expression to be displayed in a
message dialog box. Refer to Chapter 6, Security, in the Lookout
Developer’s Manual for more information about security.

MotorStartPb =]

@ Do you want to start Maotor 27

[ila] |

Figure 2-43. Verification Message Dialog Box

Position source determines where the value of the pushbutton resides.
Local indicates the value of the pushbutton lies within the pushbutton
itself—on the control panel. If the pushbutton is not depressed its signal
is OFF, if depressed its signal is ON.

Remote pushbuttons get their values from a remote source, often the
register in a controller they are connected to. Depressing the pushbutton
changes the status of the register, and changing the status of the register
depresses the pushbutton.

The Remote option is especially useful when you want to prevent Lookout
from changing the value of setpoints or registers upon initial startup, or
reconnection of lost communication. When you use this style of pushbutton
you are creating a sort of looped signal. Half the loop is formed when you
connect the controller register to the pushbutton with the Position
expression, while the second half is formed when you connect the
pushbutton output signal to the controller register. Position is a logical
expression. Do not forget to complete the second half of the loop with the
Object»Edit Connections... command.

When you select the Remote option, you can choose whether or not the
pushbutton latches its output. The Latch output check box configures
Lookout for controlling a latching-relay.

When a user clicks on a pushbutton that has latching selected, the
pushbutton remains depressed, sending an ON signal (TRUE or high) until
the Remote Position signal turns ON. Assume for example that an operator
clicks on MotorsStartPb, configured previously. The pushbutton remains
pushed in, sending a TRUE signal, until PLC.C101 goes TRUE. As soon
as PLC.C101 goes TRUE, the pushbutton releases.
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Much like Remote pushbuttons, DDE (Dynamic Data Exchange)
pushbuttons get their values from a remote source. This could be a cell in a
spreadsheet, another DDE aware application, or a second copy of Lookout
running on the network. Refer to Chapter 5, Dynamic Data Exchange, in
the Lookout Developer’s Manual for more information about the Service,
Topic, and Item parameters.

Control security level specifies the minimum security level operators must
have to gain access to this individual object, and thus control it. Refer to
Chapter 6, Security, in the Lookout Developer’s Manual for more
information about security.

The Log events option creates a permanent audit trail for the object—who
did what and when. Any depression of the pushbutton is recorded to disk,
including the time the button was depressed, and the operator’s account
name. Refer to Chapter 7, Logging Data and Events, in the Lookout
Developer’s Manual for more information about logging events.

L3Pushbutton Data Members

Table 2-33. L3Pushbutton Data Members

Data Members Type Read | Write Description
(implicit) logical yes no Value of object (TRUE when button is
depressed)
enable logical no yes If TRUE (the default), enables DDE.

If FALSE, disables DDE. The default
value is on. This input is ignored for
non-DDE TextEntry objects.

visible logical no yes When FALSE, the pushbutton cannot
be seen on the display panel. When
TRUE, the button can be seen and
controlled.
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L3Switch

@ Note L3 objects are for backward compatibility when using Lookout versions previous to
Lookout 4.0.

L3Switch generates a logical signal for receipt by other objects. Switches
change state when you click on them with a mouse button, trackball,
touchscreen, or space bar on your keyboard.

- —Position source
Tag: ISW|tch1
) .  Local
Action wverification messages —
On = I“Are You Sure?" Position = IPLC1 Purnp?4|
off= | - DDE

EEfIEE I
i I
Ok I Cancel | lterm: I—

Control security lewvel: I? IV Log events

Figure 2-44. L3Switch Definition Parameters Dialog Box

Use Action verification messages to create dynamic text expressions to be
displayed in message dialog boxes. Refer to Chapter 6, Security, in the
Lookout Developer’s Manual for more information about security.

Switch1 =]

@ Are You Sure?

Figure 2-45. Verification Message Dialog Box

Position source determines where the value of the switch resides. Local
indicates the value of the switch lies within the object itself—on the control
panel. If the switch is up the signal is ON, if down the signal is OFF.

Remote switches get their values from a remote source, often the register
on a controller they are connected to. Flipping the switch changes the status
of the register, and changing the status of the register flips the switch.
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The Remote option is especially useful when you want to prevent Lookout
from changing the value of setpoints or registers upon initial startup, or
reconnection of lost communication. When you use this style switch, you
are creating a sort of looped signal. Half the loop is formed when you
connect the controller register to the switch with the Position expression,
while the second half is formed when you connect the switch output signal
to the controller register. Notice Position is a logical expression. Do not
forget to complete the second half of the loop with the Object»Edit
Connections... command.

Much like Remote switches, DDE (Dynamic Data Exchange) switches get
their values from a remote source. This could be a cell in a spreadsheet,
another DDE aware application, or a second copy of Lookout running on
the network. Refer to Chapter 5, Dynamic Data Exchange, in the Lookout
Developer’s Manual for more information about the Service, Topic, and
Item parameters.

Control security level specifies the minimum security level operators must
have to gain access to this individual object, and thus control it.

The Log events option creates a permanent audit trail for the object—who
did what and when. All adjustments of the switch are logged to disk,
including the time the switch was flipped, the operator’s account name,
and the direction the switch was flipped. Refer to Chapter 7, Logging Data
and Events, in the Lookout Developer’s Manual for more information
about event logging.

Display switch: Switchl | ]
¢ Standard

X

n Off

oK I Cancel |
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You can replace the standard switch types with custom graphic symbols.
If you decide to use custom graphics, you must specify both symbol
parameters, On and Off. Refer to Chapter 2, Graphics, in the Lookout
Developer’s Manual for more information about creating custom graphic
symbols and the use of Transparent pixels.

L3Switch Data Members

Table 2-34. L3Switch Data Members

Data Members Type Read | Write Description
(implicit) logical yes no L3Switch Position
enable logical no yes If TRUE (the default), enables DDE.

If FALSE, disables DDE. The default
value is ON. This input is ignored for
non-DDE L3TextEntry objects.

visible logical no yes When FALSE, the switch object
cannot be seen on the display panel.
When TRUE, the switch can be seen
and controlled.

Comments If a switch with more than two positions is needed, use a Radiobutton
object instead.

Related Objects L3Pushbutton, L3Pot, Pushbutton, Pot
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L3TextEntry

@ Note L3 objects are for backward compatibility when using Lookout versions previous to

Lookout 4.0.

Lookout Object Reference Manual

With L3TextEntry you can manually enter textual notes with the keyboard.
These notes may contain any combination of numeric and alphanumeric
characters; however, the result of your entry is converted to a text value.
Just like any other text expression in Lookout, your note can be logged to
disk, connected to other data members that accept text signals, and so on.
The note is saved and displayed as a single line entry—you cannot embed
carriage returns into the message.

New TextEntry: | ]

Tag: ITextE ntryl

Entry prompt:

IReason for Setpoint change

— Textsource

& Local
- Remote

EasiticEn = I

i DDE

EEfIEE I
i I
[teri I

Contral security level: ID V¥ Log evants

Ok I Cancel |

Figure 2-46. TextEntry Parameters Dialog Box

Entry prompt is the text that appears at the top of the text entry dialog box
when an operator selects the text entry pushbutton.

Text source determines where the user-entered text resides. Local
indicates the user-entered text lies within the object itself—on the control
panel.
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Remote indicates that the user-entered text resides in a remote source,
such as a text expression or another TextEntry object.

Much like Remote TextEntry objects, DDE TextEntry objects get their
values from a remote source. This is the option you use to tie the text to a
cell in a spreadsheet, a database lookup table, or any DDE aware
application—including a second copy of Lookout running on the network.
Refer to Chapter 5, Dynamic Data Exchange, in the Lookout Developer’s
Manual for more information about Service, Topic and Item.

@ Note The last DDE parameters used on any object automatically become the default
values for any new DDE object.

Control security level specifies the minimum security level operators must
have to gain access to this individual object, and thus control it.

The Log events option creates a permanent audit trail for the object—who
did what and when. When selected, all text entries in this object are logged
to disk. Each entry includes the time of the entry, the operator’s account
name, and what entry was made. Refer to Chapter 7, Logging Data and
Events, in the Lookout Developer’s Manual for more information about
event logging.

Lookout presents the following display parameters dialog box after you
define the object. It lets you define the text font and presentation style.

L3TextEntry Data Members

Table 2-35. L3TextEntry Data Members

Data Members Type Read | Write Description
(implicit) text yes no Current, user-entered text
enable logical no yes If TRUE (the default), enables DDE.

If FALSE, disables DDE. The default
value is ON. This input is ignored for
non-DDE TextEntry objects.
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LatchGate

LatchGate is latched on and off by two incoming signals. It retains the state
of the signal that most recently went high, regardless of the state of the
other signal. When the Turn Off signal transitions from OFF to ON, the
LatchGate output goes OFF until the Turn On signal transitions from OFF
to ON. The output signal does not change when either incoming signal
transitions from ON to OFF. Both Turn Off and Turn On are logical

expressions.
Create LatchGate E
M ame: ILatchGate‘I
Tumn On = ||
Tum Off = |
QK | Cancel | Help |

Figure 2-47. LatchGate Definition Parameters Dialog Box

LatchGate Data Members

Table 2-36. LatchGate Data Members

Data Member Type Read | Write Description

(implicit) logical yes no Logical output signal value

Comments Two pushbuttons connected to the Turn On and Turn Off expressions of
a LatchGate create pushbutton start/stop controls for a pump or other device.

Related Objects Flipflop
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Loader

Use the Lookout Loader to load or unload a Lookout process in response to
a logical trigger. Using a Loader object in conjunction with a Monitor
object is how you create failover redundancy with Lookout. Refer to
Chapter 10, Redundancy, in the Lookout Developer’s Manual for more
information about redundancy.

@ Note Unlike most Lookout objects, the Loader object is disabled while Lookout is in
Edit mode.

Create Loader E
Mame: I Process Mame: I
Process File: I Browse. .. |

— State Information:
' Save State File with Process Fils
7 Save State File in Lookout Folder (Based on Process Mame)
™ Save Standby State Fil:

I Browse.. |

V' Save state file(s) every IBD [1-1440) minutes.

— Citadel D atabase:
V' Use Default Values
Eomputer Hame:

JSANJEEY

LEitadel|latabase Falder:
Id:\lookout4.0 betaZ?hdatabase

Load = I Unload = I
QK I Cancel | Help |

You may notice that the information in the State Information and Citadel
Database sections of this dialog box are the same as those areas in the
Create Process dialog box and, in the case of the Citadel Database
section, the System Options dialog box. Just as the Citadel Database
section of the Create Process dialog box overrides the system database
location settings for a particular process, any settings you make in the
Loader object for database location or saving of state files override both
system defaults and whatever settings you may have made when you
created the process being loaded.

Process Name is the name that the process runs under when you open the
Process File. You can use a process name other than the one used when the
process file loaded was created.
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Process File is the name of the file this Loader object will load when
activated. You must enter a complete path to the file. You can specify a file
from another computer on your network, but you must map the location on
the remote computer as a network drive on your own computer first.

The State Information section of this dialog box lets you set where
Lookout saves state files for the process just loaded, and under what name
the files are saved.

Select Save State File with Process File to save the state file in the location
where the process file was opened.

Select Save State File in Lookout Folder to save the state file in the
Lookout folder of the copy of Lookout your are currently running. The state
file name is the same as the process name.

Select the Save Standby State File check box to save one or more extra
copies of the state file in a location of your choosing. Enter a complete path,
including state file name, to each location you want to save a state file.

If you are saving the state file to more than one backup or alternative
location, separate the paths with the vertical bar (|) operator symbol.

Check the Save State File(s) every NNnw (1-1440) minutes option to set
the frequency with which Lookout saves the state file. The Lookout default
is 60 minutes.

The Citadel Database section sets the location of the Citadel database that
Lookout logs data to for the process you load. If you check the Use Default
Values check box, Lookout uses the default location set in the System
Options dialog box of any instance of Lookout running the process.

If you enter a computer name and a path on that computer to a specific
folder, Lookout logs data to that location on that computer, no matter what
computer is running the process.

To designate a specific computer and path for your process to log data to,
enter the fully qualified network name for the target computer in the
Computer Name field, and the complete path to the target database
directory in the Citadel Database Folder field.

Load is the logical signal you use to activate the Loader and load the
process.

Unload is the logical signal you use to activate the Loader and unload the
process you loaded earlier.
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The Loader can only load one process at a time, and can only load a process
to run inside the instance of Lookout currently running the process that
contains the Loader.

To load multiple processes with one trigger, you must use multiple Loader

objects.

Loader Data Members

Table 2-37. Loader Data Members

Data Member Type Read | Write Description

SaveWithProcess logical yes no When TRUE, Lookout saves a state
file in the same location as the process
file it contains the state for.

DatabaseComputer text yes no Sets the computer on which Lookout
saves Citadel database files.

DatabaseFolder text yes no Sets the folder in which Lookout
saves Citadel database files.

Failure logical yes no Monitor this data member to be
alerted if a load attempt fails.

Failuretext text yes no Returns the reason for a failure to load
the process designated by the loader.

Load logical yes yes Triggers the loader to load the
designated process file.

ProcessFile text yes no Name of the process the loader loads
when activated.

ProcessName text yes no Specifies the process name a loaded
process runs under.

SavePeriod numeric yes no Sets how often, in minutes, that
Lookout saves the state file for the
loaded process.

SaveWithLookout logical yes no When TRUE, Lookout saves the state
file in the Lookout directory, using
ProcessName as the name for the
state file as well.
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Table 2-37. Loader Data Members

Data Member Type Read | Write Description
StandbyFile text yes no Complete path to the location in
which you want Lookout to save
copies of the state file.
Unload logical yes yes Triggers the loader to unload the
designated process.

Loader Error Messages

Lookout Object Reference Manual

Load: No process file specified

Specify a process file in the ProcessFile field.

Load: No process name specified
Name your process in the ProcessName field.

Load: Process already exists: loadername.processname

The process specified by your Loader object is already running under that
name in this instance of Lookout. Only one process may run under each
process name.

Load: No state file specified

You must specify state file information for any process you load with a
Loader object.

Load: Invalid process name

You have chosen an invalid process name. Refer to the Object Names
section in Chapter 4, Using Lookout, of the Getting Started With Lookout
manual for more information about valid Lookout process and object
names.

Load: Invalid database computer name

The computer name you have entered in the ComputerName field is not
registered as being a part of your Lookout network. Check the spelling of
the name or register the computer through the Lookout Object Explorer or
the Lookout Connection Browser.

Load: Invalid database folder

Check the path you have entered in the Citadel Database Folder field to
make sure the path you entered does exist on the computer specified in the
ComputerName field.
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Load: Can't open process file processfilename

Lookout was unable to open the file processfilename. Check to see that
the file exists in the specified location and has not been corrupted.

Unload: No process name specified

Enter the name of the process you want to unload in the Process Name
field.

Unload: Process not found

Lookout must be running a process with the name specified in the Process
Name field for the Loader to unload a process. If no process with the
specified name is running when the Loader attempts to unload a process,
Lookout returns this error message.
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Use the Mailer object to send e-mail messages to one or more recipients.

Create Mailer E

MName: IM ailert

Fiecipients=

Subject=

Meszage=

Send=

V' Generate event on succesful send ™ ‘word wrap message

Unsent Mal—————— From address= I
[V Buffer unsent messages o l—
SErVEr
Fietry attempts: |5_
_ Timeout: |1D seconds
Fietry delay: IT minutes
Mailer alarm pricrity: IS_

Cancel |

Recipients is the list of people that will receive the Message. Enter a list of
e-mail addresses separated by commas. As with other strings used in
Lookout, you should enclose the entire list with double quotes.

The Subject field is the subject line of the e-mail.

Enter the body of the message in the Message field. Use the pipe (I)
character to force new lines in the message. To make the e-mail interactive,
connect the message parameter to a TextEntry object, which now has
multiple line entry capability.

Send the e-mail manually by connecting a switch to the Send parameter, or
automatically by entering an expression that evaluates to TRUE when
specific conditions are met.

Select Generate event on successful send to set Lookout to report when
the Mailer object succeeds in sending your message.

Select the Word wrap message option to wrap the message at 70
characters

Select Buffer unsent messages to set Lookout to store messages that were
not successfully sent. If you select this option, Lookout will try to send the
mail message the number of times specified in the Retry attempts field.
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Lookout will retry at the interval specified in the Retry delay ficld. If you
set Retry attempts to 5 and Retry delay to 10, Lookout will make five tries
to send the message, one try every ten minutes. After the fifth time Lookout
removes the message from the buffer.

Each retry attempt generates an alarm if Lookout is not able to send the
message.

E Note Lookout buffers mail that can not be sent for reasons that might resolve within a
reasonable period of time, such as the mail server being down or extremely busy. If your
mail server returns a message that mail is undeliverable for some reason, Lookout discards
the mail without buffering it.

Enter the e-mail address for people to respond to in replying to your
message in the From address field.

@ Note There are some mail sending errors that can not be caught at the SMTP level, such
as a misspelled recipient address. Such mail will appear to have sent successfully, because
Lookout has no way of detecting this circumstance. When the mail is ultimately recognized
as undeliverable, an "Undeliverable message" E-mail is sent to the return address. The
SMTP server, not the mailer object does this. For this reason, enter a valid e-mail address
in the From address field as an extra safeguard.

Enter the name of your SMTP server. STMP is an internet protocol. The
Mailer object sends mail to internet e-mail addresses only. If you do not
know the name of your mail server, consult your system administrator or
ISP (Internet Service Provider).

Timeout is how long Lookout waits for a response from your SMTP server
before buffering or discarding a message.

Alarm priority determines the priority level of the alarms generated by the
Mailer object.
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Mailer Object Data Members

Table 2-38. Mailer Data Members

Data Member Type Read Write Description

attachment text no yes Connect to a TextEntry object or an
expression containing a file path to a file
on your computer. That file will be
attached to the e-mail. Send multiple
attachments by using a
comma-separated lists of path names.
Notice that sending a large file can take
longer than sending a short message. If
you intend to use this feature to send
large files, increase your timeout
parameter accordingly.

CommPFail logical yes no Object-generated signal that is on if
your mail could not be sent.

from text no yes E-mail return address displayed in the
message.

message text no yes The body of the message.

recipient text no yes E-mail addresses of recipients. This can

be a comma-separated list.

send logical no yes The mailer sends the e-mail when the
connection to this data member goes
TRUE.

subject text no yes The subject line of the e-mail.
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Maximum actively calculates the maximum value of Data over time.
Maximum is only active when the Enable expression is TRUE. It resets to
zero when the Reset expression transitions from OFF to ON. Maximum
also maintains an array of up to 35 previous maximum values. If Enable is
left blank, the object always actively calculates the maximum. Data is a
numeric expression while Reset and Enable are logical expressions.

Marme: W
Data = I
Reset = I
Enable = I
ok | Cancel | Help |

Figure 2-48. Maximum Configuration Parameters Dialog Box

5

Note Maximum does not have a display parameters dialog box. However, you can easily

display Maximum by referencing it in an expression.

Maximum Data Members

Table 2-39. Maximum Data Members

Data Members Type Read | Write Description

(implicit) numeric yes no Current maximum value

1-35 numeric yes no Previous maximum values. Signal 1 is
the most recent prior maximum since
the Reset expression went high.

DataReset logical no yes Upon transition from FALSE to
TRUE, resets to zero all data
members—including the current
maximum value and all previous
maximum values.
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Comments The Reset interval could be a regular pulse interval created by a
TimeOfxxxx timer, so that the pulse is synchronized to the top of the hour or day.
For example, if you want to calculate the daily maximum flow rate, use the output
signal from a TimeOfDay timer or a daily Spreadsheet object to reset the maximum
calculation at the beginning of each day.

Related Objects Average, Minimum, Sample, SampleText
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Minimum actively calculates the minimum level of Data over time.
Minimum is only active when the Enable expression is TRUE. It resets to
zero when the Reset expression transitions from OFF to ON. Minimum
also maintains an array of up to 35 previous minimum values. If Enable is
left blank, the object is always actively calculating the minimum. Data is a
numeric expression while Reset and Enable are logical expressions.

M ame: IMinimum‘I

Data = I

Reset = I

Enable = I

ok |

Cancel | Help |

Figure 2-49. Minimum Configuration Parameters Dialog Box

5

Minimum value referencing it an expression.

Minimum Data Members

Note Minimum does not have a display parameters dialog box. You can easily display the

Table 2-40. Minimum Data Members

Data Members Type Read | Write Description

(implicit) numeric yes no Current minimum value

1-35 numeric yes no Previous minimum values. Signal 1 is
the most recent prior minimum since
the Reset expression went high.

DataReset logical no yes Upon transition from FALSE to
TRUE, resets to zero all data
members—including the current
minimum value and all previous
minimum values.
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Comments The Reset interval could be a regular pulse interval created by a
TimeOfxxxx timer, so that the pulse is synchronized to the top of the hour or day.
For example, if you want to calculate the daily minimum flow rate, use the output
signal from a TimeOfDay timer or a daily Spreadsheet object to reset the minimum
calculation at the beginning of each day.

Related Objects Average, Maximum, Sample, SampleText
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The Lookout Monitor object is integral to Lookout redundancy. The
Monitor object maintains a connection with a data member in any process
you want to watch from another computer or process. If the data flow from
that source stops, the Monitor signals the halt, allowing you to respond.

Using a Monitor object in conjunction with a Loader object is how you
create failover redundancy with Lookout. Refer to Chapter 10,
Redundancy, in the Lookout Developer’s Manual for more information
about redundancy.

Create Monitor:

Marne: IMonitor'I

Output goes high if quality of expression

iz bad for more than IBD seconds.

Cancel | Help |

In the Output goes high field enter a data member in the process you want
to monitor. If the data quality of that expression goes bad for more than the
number you enter in the seconds field, the monitor goes high (TRUE),
letting you know there is a problem with the process.

Monitor Data Members

Table 2-41. Monitor Data Members

Data Member Type Read | Write Description

(implicit) logical yes no Goes TRUE when the data member
the Monitor is watching cannot be
accessed after a specified length
of time.

Delay numeric yes yes How long to delay before the output
goes high, or TRUE.

Status text yes no Reports the status of the monitored
data point.
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Mouse

The Lookout Mouse object is a special use object that reports to location of
the mouse cursor on your Lookout panel. Create a mouse object using the
Create Mouse dialog box, as shown in the following figure.

Create Mouse E

Mame IMouse‘I

.

Cancel | Help |

When enabled, the mouse object reports the X and Y coordinate locations
of the mouse cursor on your computer screen as long as the mouse is over
the Lookout Window. The mouse is easiest to use when the Lookout

windows is maximized.

Mouse Data Members

Table 2-42. Mouse Data Members

Data Member Type Read Write Description

Enable logical yes yes When true, data on mouse location
and button state is reported through
the readable data members.

LeftButton logical yes no Reports click status of the left mouse
button.

RightButton logical yes no Reports click status of the right
mouse button.

X numeric yes no Reports Y-coordinate location of the
mouse cursor on your computer
screen inside your Lookout window.

Y numeric yes no Reports Y-coordinate location of the
mouse cursor on your computer
screen inside the Lookout window.
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Multistate

Multistate displays different graphics on a control panel as dictated by the
values of Conditional expressions. You can use up to six Graphic files,
but at least one is required. Multistate determines which graphic to display
based on the order and current status of your Conditional expressions.

If several Conditional expressions are true at once, Multistate displays the
graphic associated with the first true expression.

New Multistate

M ame: IMS‘I

Conditional expressions:

Else if = I

Else if = I

Else if = I

Ekeif= |

Elze

QK I Eancell Help |

Figure 2-50. Multistate Configuration Parameters Dialog Box

Conditional expressions must result in logical values (TRUE or FALSE).
Refer to the Animator section for more information about constructing
logical statements. Double-click in a Graphic file box to select the graphic
you want to use.

@ Note If you use both .wmf and .bmp images in graphic selections for the Multistate, the
.wmf images will take the size of the largest . bmp image, and you will not be able to resize
them. The .bmp images will not resize.
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Multistate Data Members

Table 2-43. Multistate Data Members

Data members

Type

Read

Write

Description

graphicl-graphicN

numeric

yes

no

Denotes which display of this object
will appear on an HTML report. Only
one display is available for the
ActiveX object.

Comments By creating several graphic images that depict a sequence of events,
Multistate can be used to create animation sequences on control panels such as

hydraulic pistons moving back and forth. A more typical use of Multistate is for
three-color pilot lights, where green represents running, red represents stopped,
and yellow represents failed, for example.

For smooth, high speed animations, use the Animator object.

Related Objects Animaror
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Neutralzone

Neutralzone is an ON/OFF Controller. It functions the way a home air
conditioning thermostat does; if the temperature rises above a certain level,
the above data member goes TRUE (turning the A/C on). When it drops
below a lower temperature, the below data member goes TRUE (turning
the A/C off).

When the incoming Signal value rises above both Low limit and High
limit, the data member above turns on, and the data member below turns
off. When the incoming Signal value drops below both Low limit and High
limit, above turns off, and below turns on. The above and below data
members do not change state when the signal value falls back within the
two limits (within the neutral zone). Signal, High limit, and Low limit are
all numeric expressions.

M ame: IW
Signal = ||
High limit = |
Low limit= |
QK | Cancel | Help |

Figure 2-51. Neutralzone Definition Parameters Dialog Box

The previous discussion assumes numeric constants for both limits.
However, you could use variable setpoint signals from Pot objects so an
operator could dynamically adjust Neutralzone behavior.

E Note Neutralzone does not have a display parameters dialog box. You can easily display
the result of Neutralzone output signals by referencing its data members in an expression.
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Neutralzone Data Members

Table 2-44. Neutralzone Data Members

Data Members

Type

Read

Write

Description

above

logical

yes

no

ON if signal is greater than both
limits, OFF if signal is less than both
limits, and does not change if signal is
between both limits

below

logical

yes

no

ON if signal is less than both limits,
OFF if signal is greater than both
limits, and does not change if signal is
between both limits

Comments You can use this object to turn pumps on and off or open and close valves
based on line pressures or tank levels. Neutralzone objects prevent pumps from cycling
on and off around a single setpoint, just as an air conditioning thermostat prevents your
home air conditioner from incessantly starting and stopping.

Lookout Object Reference Manual

Often the term deadband is mistakenly used to describe a neutral zone.
However, deadbands refer to the amount of change a numeric value must
travel in the reverse direction before the output numeric value begins to

change.
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Numeric Format

At this time use the Numeric Format object class to control the numeric
format of data you export from Lookout to your HTML report page.

Mame: INumForm‘I

Mumeric format:

QK I Cancel | Helg |

When you create this object you set the numeric format as you would for
any Lookout numeric display. You then connect the NF data members, such
as ValueNF, from the Report object to the single data member, format.
Output from the corresponding item data member will take the format you
chose when it appears on an HTML report page.

@ Note Numeric Formats are represented internally in Lookout by a number. This object
outputs that number for the selected format, to be used by other Lookout objects.

Numeric Format Data Members

Table 2-45. Numeric Format Data Members

Data Members Type Read | Write Description

Format numeric yes no Use to set the numeric format of a
Lookout number.
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OneShot

OneShot is an adjustable delay timer. When On/off signal transitions to on,
the output signal goes TRUE and the Timer delay begins to count down.
At the end of the delay countdown, the output signal goes FALSE.

Unlike the Interval timer, the OneShot timer output remains on for the
Time delay period even if On/off signal goes FALSE. So a OneShot timer
requires only a momentary signal to begin the Timer delay period. Pulsing
the On/off signal during the time delay period does not extend the time
delay period of a OneShot timer.

Create OneShot timer: E
Mame: Timerl

On/off signal = I
Timer delay = I
Dizplay format: I Mk:S5 - l

Ok | Cancel | Help |

Figure 2-52. OneShot Definition Parameters Dialog Box

The On/off signal is a logical expression while Timer delay is a numeric
expression. Normally, this is a simple time constant such as 0:20 (twenty
seconds). Refer to the Numeric Data Members section of Chapter 2, How
Lookout Works, of the Getting Started with Lookout manual for more
information about time constants.

Timer delay can range from 0.0 seconds to several years. The effective
resolution is 0.1 seconds over the entire range.

The object is represented on a control panel by showing the time delay
remaining in the format defined by the Display format parameter. It is
updated approximately once per second. If the delay period has expired,
it shows OFF.
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Table 2-46. OneShot Data Members

Data Member Type Read | Write Description
(implicit) logical yes no Logical timer value
CommPFail logical yes no Object-generated signal that is on if

Lookout cannot communicate with
the device.

Comments You can use the OneShot timer to hold a valve open for a set period of time
after a pushbutton is pressed, or to prevent pump starts from occurring too rapidly in

succession.

Related Objects DelayOff, DelayOn, Interval, Pot, TextEntry
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2-149

Lookout Object Reference Manual



Chapter 2

Pager

Lookout System Objects

Pager is an object class Lookout uses to contact a numeric or alphanumeric

pager through a modem, sending a message to the pager.

Create Pager E

Mame: IF'ager‘I

Pager type: INumeric Only vl

Fager number = |“555'5555“
I"Lookout numberic Page 123-4567"

Meszage =

Mumeric Only p

Drelay: I‘I 2 zeconds

Baud rate: I‘I 0 > l
Serial port: ICDM'I j
I_

Communication alam priority: |2

QK I Cancel | Help |

Figure 2-53. Numeric Only Pager Definition Parameters Dialog Box

Create Pager E

Mame: IF'ager‘I

Pager type: IAlphanumeric A l

Fager number = |“555'5555“
I"Lookout numberic Page 123-4567"

Meszage =

Alphanumeric p

Terminal number: |392250594

Fietry attempts: I4 Feceive timeout: 2000 MEecs

Baud rate: |12DD 'l
Serial port: ICDM'I j

Communication alarm pricrity: I8

QK I Cancel | Help |

Figure 2-54. Alphanumeric Pager Definition Parameters Dialog Box

Pager type determines whether the Pager object operates in numeric only
or alphanumeric mode. A detailed description of the operation of these two

modes follows.
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Pager number is the phone number of the pager you want to contact.
When the Pager object is in Alphanumeric mode, this number corresponds
to the pager ID number.

Message is the message you want to send to the pager. Notice that in
Numeric Only mode only numeric characters are sent.

Delay is how long the Pager object waits after dialing the pager number
before it dials the message number. This parameter is valid in Numeric
Only mode only.

Terminal number is the phone number of the remote paging terminal you
want to contact. This parameter is valid in Alphanumeric mode only.

Retry attempts specifies the consecutive number of times Lookout
attempts to establish communications with a device if it is not getting a
valid response. After it tries the number of Retry attempts specified, the
Pager object generates an alarm and releases the COM port. Refer to
Chapter 3, Serial Port Communication Service, in the Lookout Developer’s
Manual for more information. This parameter is valid in Alphanumeric
mode only.

Receive timeout is the time delay Lookout uses in waiting for a response
from a device before retrying the request. This parameter is valid in
Alphanumeric mode only.

Baud rate indicates the baud rate Lookout uses to communicate with the
modem and paging terminal.

Serial port specifies which COM port Lookout uses to communicate with
your modem. You must have this COM port configured as dial-up under
Options»Serial Ports.

Communication alarm priority determines the priority level of alarms
generated by the Pager object. You can relate such alarms to
communications with the modem or with the remote paging terminal.
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Pager Data Members

Table 2-47. Pager Data Members

Data Member Type Read | Write Description
Message text no yes Pager message
Phone text no yes Individual pager phone number or Page ID
number
Send logical no yes Sends the message on transition from FALSE
to TRUE

Pager Object Modes

Numeric Only

In Numeric Only mode, the Pager object establishes a connection with
your local modem. Once this connection has been established and the pager
number dialed, the Pager object waits for the time specified by Delay, then
dials the number that is the message. Because the Message data member is
a text value, the Pager object in Numeric Only mode omits any
non-numeric characters from the message when it is sent.

Alphanumeric Mode

In Alphanumeric mode, the Pager object actually establishes a connection
with a remote paging terminal, then transmits an alphanumeric message
using Telocator Alphanumeric Protocol (TAP) version 1.8. TAP is an
industry standard protocol for paging terminals that accept alphanumeric
pages. Alphanumeric messages are limited to 250 characters. The text
value in the Message data member will be truncated to this length if it is
longer.

Pager Serial Port Settings

Notice that there are two different retry settings that affect the operation
of the Pager object in Alphanumeric mode. The retry settings in the Pager
object dialog box govern serial communications with the remote paging
terminal. This means that after the two modems have connected and
finished handshaking, and the serial transaction is underway, each
individual frame is timed by the Receive timeout setting, and retried

the number of times specified by Retry attempts.
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These retry settings will not dial the phone number again if the remote
paging terminal for some reason does not answer or is busy, which happens
occasionally. This setting and other important modem settings (including
the AT initialization string that the Pager object must use on your modem)
can be found in Option»Serial Ports, and should be chosen carefully.
These settings are important in both Pager object modes.

@ Note You may have to increase your Receive Gap setting from its default of 5 to
something closer to 20 or 25. You must also have your COM port configured as dial-up.

Pager Queueing

The Pager object queues up to 10 messages in either mode. If the object is
in the process of sending out a page and the Send data member goes high
again, the current value of the Message data member will be queued and

sent out when the Pager object has time. Messages that are already in the

queue will not be duplicated.

Pager Status Messages

Paging terminal refused logon

Alphanumeric only error code

Paging terminal forced disconnect

Alphanumeric only error code

Paging terminal NAKed block transmission
Alphanumeric only error code

Paging terminal abandoned block transmission

Alphanumeric only error code

No response within timeout period

This means that the modem is not responding to Lookout requests.

Queue full

The paging queue currently has 10 pages in it, and will not accept any more
until at least one of those pages is successfully sent.

Garbled response

A response from the modem was corrupted or in an unrecognizable form.
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Panel

Lookout Object Reference Manual

Panel is a unique object class that accepts display members of other objects.
Panels (Control panels) are a window into your process you can use to
monitor and control your system by flipping switches, depressing
pushbuttons, and turning knobs.

There is no limit as to the number of control panels you can create in
Lookout or the number of objects or graphics that you can display on a
given panel. Control panels can be any size, and you can display them
within the Lookout workspace in various states (maximized, normal,
minimized).

Create control panels with the Object»Create... command or with the

Insert»Control panel... command. Both commands deliver the same
result.

New Control Panel

M ame: e
Title: IControl Panel
—Panel type Backaround color:

' Normal I_D.I_I_..I_;I
e Popup EFEEeE._

" Popup no icon

— Security levels—
’ — widh: [512
Wigwing:
tevnd Height. [364 Cancel |
Cantral: IEI

Figure 2-55. Panel Definition and Display Parameters Dialog Box
There are three distinct panel types: Normal, Popup, and Popup no icon.

A Normal control panel can be maximized, normal size, or minimized
within the Lookout workspace. When you activate a Normal panel it
appears at the size defined by its Height and Width. When you maximize
a Normal panel, it fills the Lookout workspace. When you minimize a
Normal panel it appears as an icon. The Normal option is typically
selected for full-sized control panels.

Popup control panels can either be in a popup state or minimized (they
cannot be maximized). When you activate a Popup panel it appears at
the size defined by its Height and Width. When a Popup control panel is
activated, it remains on top of all other panels until it is minimized. When
you minimize a Popup panel it appears as a bar at the bottom of the
Lookout screen.
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Popup no icon control panels are identical to Popup panels except they are
not represented by icons when minimized. When you minimize a Popup no
icon panel it disappears from the Lookout workspace.

@ Note Because Popup no icon control panels are not represented by icons, they use less
memory. (Microsoft Windows allocates a fixed amount of memory to each icon.) If you are
experiencing memory problems when running a Lookout application that has many control
panels, consider converting your Popup panels to Popup no icon.

Normal panels and Popup panels can be chosen by selecting their icon,
using the Window menu command. Popup no icon control panels cannot;
they can only be accessed by triggering their activate data member.

The Security levels settings are globally applied to a given control panel.
The Control security level works in conjunction with all individual object
security levels on that panel. The higher security level of the two is used to
determine if an operator has control over the object. For example, consider
a single Switch object with a security level of 4 that is displayed on two
panels. The first panel has a control level of 6 and the second panel has a
control level of 2. Only level 6 and higher operators are able to flip the
switch on the first panel; however, level 4 and higher operators have control
over the same switch on the second panel.

Viewing security can hide entire control panels from low level operators.
This parameter affects the entire control panel. As an example take a
control panel with a viewing security level of 6. If a level 5 (or lower)
operator logs on, he is unable to see the control panel. In fact, he does not
even know it exists because it is not listed in the Window menu and it is
not shown as an icon. If a level 6 (or higher) operator logs on, the control
panel instantly becomes available for display. This feature is useful for
hiding panels that are rarely used or that contain sensitive information.
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h- Lookout - [Process1 =]

File Edit Options Alams  Window Bun  Help

[™ Mormal Panel

[FPopun i FIWET
084101315 Administratar Mational Instruments Internal Use Only | <& | = 1 alarms

This example shows a Normal control panel in a normal state and a Popup
control panel in a minimized state. The Normal panel could easily be
minimized or maximized by hitting the appropriate arrow button.

The following example is a typical scenario involving full screen control
panels with multiple popup panels displayed at once.

This configuration maximizes the amount of information that you can
display at once; and it allows you to have any number of different
combinations of control panels displayed on your monitor.

h- Lookout - [Frocess1 =] - [Normal Panel] M= 3
File Edit Options Alams  Window Bun  Help = |ﬁ'|1|
[ Popup #1 = B3
A Popup #2

|o8A0135 | Administrator | Mational Instruments Intemal Use Only | <2 | = | 1 alarms
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This example displays a Normal control panel in a maximized state and
two Popup control panels in a “popped up” state.

Manipulating Panels

Panel Switching

© National Instruments Corporation

Lookout control panels utilize the Microsoft standard Multiple Document
Interface (MDI) techniques. You manipulate Lookout windows the same
way you do other windows in the Microsoft Windows environment.

It is common to have several or even dozens of control panels. Creating
a methodology for moving between your panels can be as simple or as
elaborate as you want. One effective method utilizes pushbuttons that
invoke other control panels. You connect the pushbutton output signal to
the activate or maximize data member of the control panel(s) you want to
affect. When the button signal goes high the respective panel(s) appear.

The following example shows a single pushbutton and X with its output
signal connected to two Popup control panels. The pushbutton is inserted
on a third maximized panel.

Pop_Up1 connections E
Select object... |

— Select member:

‘wiitable members: Existing connections:

activate

masimize
minirnize

print

Gelect | Iactivate

Pop_Up1.activate = Pl
Mew logical connection Clear |
— Signals:
Tags: Pushbutton  path tMode: IHeIative j
In: IE paroikos. dy. natinst. com e e ]
E|-- Process1 ;I [implicit]
-y $larm wvalue

Quit |
Help |

- Paste | Fb1

2-157 Lookout Object Reference Manual



Chapter 2 Lookout System Objects

When you toggle out of Edit Mode and depress the button, both Popup
control panels instantly appear, as shown in the following illustration.

Of course you could have connected the pushbutton to another Normal
panel instead, and it would have appeared as the new maximized panel.

_EI_-Lookoul - [Process1 =] - [Normal Panel] M= 3
File Edit Options Alams  Window Bun  Help = |ﬁ'|1|
[} Popup #2 S =] Jeas |Pop Up Panels 1 and 2|
1 1

|osAoi3:20 | Administrator | Mational Instruments Intemal Use Only | <2 | = | 1 alarms

Lookout Object Reference Manual

As you can imagine, there is no limit to the number of connections between
various signals and control panels. In fact, you can create complex
expressions/alarms that automatically call up specific control panels.

Another way to move between panels is through the use of function keys.
Like the $Keyboard object, each panel has its own set of data members
representing the function keys F1 — F24. The following example shows the
F2 data member of Panell connected to the activate data member of Panel2.
The F2 data member of Panel2 is also connected to the activate data
member of Panel3. This way an operator can depress F2 to page forward
through several panels.

Panell Panel2 Panel3

Panel3 Panell

:'\X
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In similar fashion, the F1 data member of Panel3 is connected to

the activate data member of Panel2 and the F1 data member of Panel2
is connected to the activate data member of Panell. So now,
Panel2.activate = Panell.F2 OR Panel3.F1. An operator
can depress F2 to page forward through the control panels and F1 to
page back through the control panels.

Special Considerations for “Home Panel”

To ensure users do not get lost when switching between panels, you might
define one panel as your master control panel, or home panel or computer
main menu. You could connect the activate data member of your home
panel to $Keyboard.Shift.F1, or perhaps to a pushbutton object.

If connected to the function key, any time the user presses <SHIFT-F1>
(no matter what panel he or she is looking at), the home panel is called,
returning the operator to a familiar control panel.

You might also want the home panel to maximize upon startup. If you have
already created a pushbutton to call the home panel, you can connect it to
the maximize data member.

The exclamation point (!) instructs Lookout to use the opposite of the
pushbutton value. At startup, the pushbutton is not depressed so its value is
FALSE. But because you are using the opposite of the pushbutton value,
Panell.maximize is TRUE at startup. Any time a user depresses
CallHomePb after this connection is made, nothing happens until the
pushbutton is released—at which time the panel is called.

Programmable Control of Panels

Lookout allows you to control the size and location of your control panels
programmatically.

The default size for a control panel is set with the parameters for height and
width in the New Control Panel dialog box. The default location for a
control panel is where the panel was located when it was last moved or
resized in edit mode. Once you connect the size and location data members,
however, these defaults are overridden by the values input through the
connections.

Size and location values are interpreted as pixels. If your Lookout window,
or your PC screen resolution, is smaller than the number of pixels input,
your control panel may become too large to fit in the Lookout window, or
may travel out of the window and be lost from view. Take the screen
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Panel Print

@ Note

resolution and the size of your Lookout window into consideration when
setting limits on the location data member inputs.

You can easily print a control panel using the Print Panel command.
This function works equally well for both Normal and Popup panel types.

Print the contents of a panel by clicking on the panel control menu and then
on Print Panel, or by connecting a logical expression to the Print data
member of the desired control panel. A panel does not have to be visible to
be printed.

Certain metafiles look different on the printed page than they do on the display

screen. This means that parts of layered objects sometimes appear opaque on the screen,
but translucent when drawn on paper.

@ Note When you print a Normal panel, it is printed at its defined Height and Width
parameters. If you define a panel whose Height and Width are at the default
400 x 300 pixel setting, maximize the panel, and then add graphic elements to the full
panel, those elements outside of the default 400 x 300 pixel range are not shown when the
panel is printed. To print all the elements on a maximized panel, modify the Width and
Height of the panel to match the full-screen dimension of the panel.

You can modify an existing control panel by toggling into edit mode and
right-mouse clicking on its title bar. You can also modify a panel with the
Object»Modify... menu command just like any other object.

Screen Resolution and Lookout Graphics

Lookout Object Reference Manual

Lookout graphics and control panels appear different, depending on the PC
you are using and the resolution of your screen driver. When you position
a graphic (or any other display element) onto a control panel, Lookout
identifies the position you selected by recording the specific pixel position
of the graphic. (A pixel is the smallest possible dot on the screen.) Lookout
actually counts the number of pixels that the graphic is from the upper
left-hand corner of the screen. When you subsequently recall a panel,
Lookout knows the exact location to place the graphic.

The reason to bring this up is because different computer screen drivers
have different screen resolutions. VGA screens are 640 x 480 pixels. Super
VGA screens typically range from 800 x 600 pixels to 1024 x 768 pixels.
A panel created at 640 x 480 pixel resolution does not fill the screen of a

2-160 ni.com



Chapter 2 Lookout System Objects

1024 x 768 super VGA monitor. A panel created at 1024 x 768 pixel
resolution will overflow the screen of a 640 X 480 VGA monitor.

It is best to create your panels using the display driver resolution of the
computer on which you intend to run Lookout. If you are creating panels
for use on multiple computers, consider developing panels using the
display driver resolution of the most common resolution monitor (if you
have a dozen Super VGA computers and one VGA computer, develop your
panels in Super VGA, not VGA). You will then have to modify the panels
slightly to fit on the less common resolution computer(s).

You can usually change the resolution of your screen from VGA to Super
VGA by changing System Settings in Windows Setup. Refer to your
Microsoft Windows manual for more information.

Panel Data Members

Table 2-48. Panel Data Members

Data Members

Type Read | Write Description

<CTRL-F1> -
<CTRL-F24>

logical yes no Each of these 24 data members
represent a function key, <F1> —
<F24>—when pressed in conjunction
with the <CTRL> key. Returns TRUE
when the panel is active and its
associated function key is pressed in
conjunction with the <CTRL> key.

<F1> - <F24>

logical yes no Each of these 24 data members
represent a function key, <F1> —
<F24>. Returns TRUE when the
panel is active and its associated
function key is pressed.

<SHIFT-F1> through
<SHIFT-F24>

logical yes no Each of these 24 data members
represent a function key, <F1> —
<F24>—when pressed in conjunction
with the <SHIFT> key. Returns
TRUE when the panel is active and its
associated function key is pressed in
conjunction with the <SHIFT> key.
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Table 2-48. Panel Data Members (Continued)

Data Members Type

Read

Write

Description

activate logical

no

yes

Upon transition from FALSE to
TRUE, calls control panel to focus or

Pop up.

active logical

yes

no

Returns TRUE when the panel is the
currently selected panel (i.e., it is
active).

graphicl-graphicN numeric

yes

no

Denotes which display of this object
will appear on an HTML report. Only
one display is available for the
ActiveX object.

Height numeric

yes

yes

Height of the dialog box in pixels.
Once connected, this data member
overrides the Height parameter
entered in the New Control Panel
dialog box.

maximize logical

no

yes

Upon transition from FALSE to
TRUE, maximizes control panel,
replacing existing maximized control
panel.

minimize logical

no

yes

Upon transition from FALSE to
TRUE, minimizes control panel to
icon state.

print logical

no

yes

Upon transition from FALSE to
TRUE, sends the control panel to the
Windows Print Manager.

Width numeric

yes

yes

Width of the dialog box in pixels.
Once connected, this data member
overrides the Width parameter
entered in the New Control Panel
dialog box.

Lookout Object Reference Manual
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Table 2-48. Panel Data Members (Continued)

Data Members

Type

Read

Write

Description

numeric

yes

yes

Horizontal coordinate of the upper
left corner of the control panel. The
upper left corner of the Lookout
window is the O point.

numeric

yes

yes

Vertical coordinate of the upper left
corner of the control panel. The upper
left corner of the Lookout window is
the O point.
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Pareto

The Pareto object class is one of the Lookout Statistical Process Control
(SPC) tools and can play an important role in your Total Quality
Management (TQM) program. This object class displays a frequency
distribution of occurrences sorted by category so that you can identify the
most frequently occurring anomalies or defects in your process.

The Pareto object class displays weighted and/or unweighted Pareto charts.
The charts can be interactive, automatic, or a combination of both.

An optional percentage line, showing cumulative percentage of factors,
may be displayed. The number of factors to display, which may be less than
the total number of factors defined, is user selectable. The chart background
color, as well as the label, weight, and color of each factor, can be defined
by the user.

The Pareto chart object definition dialog box is shown in the following
illustration.

Create Pareto E

Mame:  |EEEE]

Reset = I

[ Allow Interactive Choice [~ Allow Decrement Caunt

Birs to displap = I

—Binz
MNofactors  Mew factor = Factor I 1
Label =

Accept | I
elEte | \'\I\f‘le.ighh

Fresvious | Calor: I_I_-I_I_--I_
(=508 | -.--.--I_il

QK I Eancell Help |

Figure 2-56. Pareto Definition Parameters Dialog Box

Reset is a logical expression that, on transition from FALSE to TRUE,
resets all of the factor counts to zero.

Use Allow Interactive Choice to indicate whether the operator can
increment (and possibly decrement) factor counts by clicking the mouse
cursor on the Pareto chart object.
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Allow Decrement Count indicates whether the operator can decrement the
factor counts if you enable interactive choice.

Bins to display is the number of factor bins to display in the Pareto chart.
This can be a numeric expression or a constant.

Bins parameters enable adding, modifying, or deleting factors to and from
the Pareto chart. Label is the descriptive title for the factor. It can be a text
constant or expression. Weight is the bias you can apply for a factor if you
are going to display a weighted Pareto chart. It can be a numeric constant
or expression. Color is the color of the bar for the factor. Factor ID is a
number generated by the object to uniquely identify the current factor count
when it is being saved to or restored from the Lookout state file. It is a
visual indication to the user that a factor count is associated with a
particular Factor ID, and not with the Label.

The Pareto display dialog box is shown in the following illustration.

Create Pareto Digplay: Paretol E3

Paper calar:
= ,..,|
[ (] [ (S

v ‘weighted Pareto

Curmulative percentage options
¥ Show percentage line

rrlrrllr:J
HTEE ..

Line zalar:

Caticel |

Figure 2-57. Pareto Display Parameters Dialog Box

Show percentage line determines whether a cumulative percentage line
will be displayed in the color selected by Line color.

Weighted Pareto determines whether the Pareto is displayed as a weighted
chart or an unweighted chart.
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Weighted or Unwei

ghted Charts

Using the same Pareto object, you can display weighted or unweighted
Pareto charts. An unweighted Pareto chart shows which factors occur most
frequently. If the factors are of approximately equal importance, an
unweighted chart is a good indication of trouble spots.

100 Total: 118 Unweighted Pareto Total shown: 118

90
80
70

30
20

29/ 24.6% 18 7 15.3%

50.0% 68.6% 84.7%
factor 5 (29) factor 1 (20) factor 2 (10) factor 4 (200) factor 3 (30)

[ 25.4%

Lookout Object Reference Manual

Figure 2-58. Unweighted Pareto Chart

If some factors are much more serious than others, using a weighted Pareto
chart to ascertain the cost or exposure of a factor is a much more effective
tool for identifying problem areas. For example, in the unweighted Pareto
chart in Figure 2-58, factor 1 and factor 5 together account for 50 percent
of the defect occurrences. However, as you can see on the weighted Pareto
chart in Figure 2-59, factor 4 alone accounts for 60.8 percent of the total
expense of all defects.
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100 Total: 6250 Weighted Pareto Total shown: 6250
_______________________________________________________ E——

900 / 14.4% 750 / 12.0% 580 /9.3% 220 / 3.5%

75.2% 87.2% 96.5%
factor 4 (200) factor 3 (30) factor 5 (29) factor 1 (20) factor 2 (10)

Figure 2-59. Weighted Pareto Chart

Incrementing Factor Counts

You can use a Pareto chart to interactively or automatically increment

factor counts. In fact, the object can accept any combination of automatic
and interactive inputs.

If you select the Allow Interactive Choice option in the object definition
dialog box, the operator can manually increment factor counts. To do this,
the operator clicks the mouse cursor on the Pareto chart object. This pops
up box that lists all the possible factors you can choose. The factor that the
cursor is on when the operator clicks on the chart determines which factor

is highlighted when the dialog box pops up. In this example, the mouse
cursor was over the factor 2 bin.

Choose the factor

factor 2 [10]
factor 3 [50)
factor 4 [200]
factor 5 [25])

If you select the Allow Decrement Count option in the object definition
dialog box, the Decrement button is displayed in the pop-up, allowing the
operator to decrement a factor count. Operators with a high enough security
level can correct errors if necessary.
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Pareto Data Members

The Pareto object can use external connections to trigger the factor counts
automatically. You can connect a pushbutton, an alarm, an expression, a

PLC output, and so on, to a factor trigger to increment a factor count on a
transition from FALSE to TRUE. The following table lists data members
of the Pareto object class.

Table 2-49. Pareto Data Members

Data Members Type Read | Write Description

count.sorted1 — 1000 numeric yes no The count in the respective
sorted-by-count factor bin.

count.weighted.sorted numeric yes no The weighted count in the respective

1-1000 sorted-by-weighted-count factor bin.

count.weighted]l — 1000 | numeric yes no The weighted count in the respective
unsorted factor bin.

countl — 1000 numeric yes no The count in the respective unsorted
factor bin.

factorl — 1000 logical no yes On transition from FALSE to TRUE,
increment the respective factor count
by 1.

graphicl - graphicN numeric yes no Denotes which display of this object
will appear on an HTML report. Only
one display is available for the
ActiveX object.

label.sorted1 — 1000 text yes no The label of the respective
sorted-by-count factor bin.

label.weighted.sorted text yes no The label of the respective

1-1000 sorted-by-weighted-count factor bin.

labell — 1000 text yes no The label of the respective unsorted
factor bin.

percent.sortedl — 1000 numeric yes no The percent of the total count in the
respective sorted-by-count factor bin.

percent.weighted.sorted | numeric yes no The percent of the total weighted

1-1000 count in the respective
sorted-by-weighted-count factor bin.
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Table 2-49. Pareto Data Members (Continued)

Data Members Type Read | Write Description
percent.weighted numeric yes no The percent of the total weighted
1-1000 count in the respective unsorted

factor bin.
percent]l — 1000 numeric yes no The percent of the total count in the

respective unsorted factor bin.

total numeric yes no The total of all unweighted factor
counts in all defined factors.

total.shown numeric yes no The total of all unweighted factor
counts in all currently displayed
factors.

total.shown.weighted numeric yes no The total of all weighted factor counts

in all currently displayed factors.

total.weighted numeric yes no The total of all weighted factor counts
in all defined factors.

visible logical yes yes When TRUE, the Pareto chart
becomes visible on the control panel.
When FALSE, it is invisible. The
default value is TRUE.
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PID

The PID object compares a Process Variable to a Setpoint. If there is a
difference, it calculates the error and adjusts its output to compensate until
the Process Variable is equal to the Setpoint.

PID stands for Proportional-Integral-Derivative. These are three factors in
the equation that can be applied against the calculated error. You specify
Gain which is the proportional factor, Reset (the integral factor), and Rate
(the derivative factor) to define how the object responds to the error.

@ Note The way in which the PID object responds to your process can vary greatly
according to the parameters you enter and the process you are controlling. Any discussion
regarding tuning of a PID loop falls outside of the topics addressed in this manual.

Lookout Object Reference Manual

Create PID Controller E
Name: |F'ID1 Type IPosition j

Process Yariable = I

Min Max

Setpoint = I ID_ W
Manual Dutput = I IU_ W
Sample Pulse = l— Resst = l—
Gain = I Rate = l—
Autornatic Enable = l— Wtaut Tiime: W
LovrlbnitsEratie = ID”— ¥ Add proportional incremet
HighLint Enatble= JB | [ Fresze Enable

QK I Cancel | Help |

Figure 2-60. PID Definition Parameters Dialog Box

Type selects either positional control or velocity control. Detailed
descriptions of both control modes are provided in the following sections.

Process Variable (PV) is typically the numeric signal from the field that
you want to control. The PID loop equation does not expect this value to be
normalized; rather the PID object performs the scaling of loop input and
output values from engineering units.

Setpoint (SP) is typically the value of a Pot object, a constant numeric
value, or the output signal from another PID object in a cascaded loop. Like
the process variable, the setpoint is also scaled internally by the PID object.
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Setpoint Min and Max are numeric constants that specify the range of SP
and PV in engineering units.

Manual Output is a numeric parameter that specifies the output of the
object when it is in manual mode; that is, when the Automatic Enable
expression is FALSE. Users typically enter either a constant, or the name
of a Pot object in this field.

Output Min and Max are numeric constants that specify the range of the
object output signal. The output is often referred to as the manipulated
variable (MV).

Sample Pulse indicates the frequency at which the PID object executes.
This parameter field can contain either a numeric constant or a logical
variable. If you use a numeric constant (like 0: 01 for one second), the
object calculates a new output value at the defined frequency. If you use a
logical variable, then the variable should pulse at some desired frequency.
Any time the pulse transitions from FALSE to TRUE, the object calculates
a new output value. It is very important not to over-sample your data. Start
with a slow sample rate.

Gain (K,) is a numeric parameter that determines the overall sensitivity
of the PID loop to changes in error. A gain value of 1.00 changes the
proportional increment of the PID equation by 50 percent when there is a
50 percent change in error. A gain value of 0.25 changes the proportional
increment by 12.5 percent with a 50 percent change in error.

Reset (7)) also referred to as integral time, is a numeric parameter that
specifies the amount of time it takes for the integral sum increment of the
PID loop equation to react to a given change in error. For example, if the
error suddenly changes by 20% and reset = 0:10 (10 seconds), the integral
increment of the PID loop increases at a rate of 0.5 percent per second until
it has changed by 20 percent after 40 seconds. This 20 percent contribution
is multiplied by the gain, so if the gain is 2.0, the integral term contributes
40% to the loop output in this example. In other words, the shorter the reset
time, the faster the object output responds to a change in either PV or SP.

Rate (7)) also referred to as derivative time, is a numeric parameter that
dampens loop response. It is calculated based upon the rate of change of PV
and adds an increment to the output that attempts to anticipate and slow the
change in PV. As an example, if PV is increasing by 10 percent per minute,
and rate is 0:30 (0.5 minutes), the derivative increment is calculated as
—(10%/min. x 0.5 minutes)= —5% (or —0.05). So the derivative term would
contribute —5% to the output if the gain is 1.0.
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Automatic Enable specifies whether the loop controller is operating in
automatic mode or manual mode. When it is ON, controller is operating in
automatic mode and the output signal is being calculated using the PID
algorithm. In manual mode, the output signal is equal to the Manual
Output input signal.

The PID object provides bumpless transfer from manual to automatic
operation—when the controller is switched from manual to automatic,
its output begins changing from the current manual output setting.
Contrast this with a loop controller without bumpless transfer. When
such a controller is in manual, the integral term continues to accumulate.
When the controller is switched to automatic, the loop controller would
immediately go to a high or low output.

Add proportional increment specifies whether the loop equation adds
the proportional increment of the PID equation to MV. This value is
typically ON.

Freeze Enable specifies whether the loop bias should be frozen or actively
back-calculated when the controller output signal goes out of range. In
either case, the loop controller is protected from integral wind-up, but if
Freeze Enable is OFF (recommended setting), the bias is actively
back-calculated to prevent controller overshoot when PV comes back into
range.

The PID object protects against integral windup in one of two selectable
ways: It either freezes the bias term when the controller output goes out

of range, or it actively back-calculates the bias so the controller responds
smoothly with less chance of overshoot when its output returns to range.

Output Time is a numeric constant that specifies the time domain of the
controller output when operating in velocity mode. For example, if the
object output controls a value with dimensions of inches per minute, output
time would be 1:00 (one minute).

Low Limit Enable is used in velocity control mode. It is an optional
logical signal that clips the PID output to a value grater than or equal to
zero when TRUE. This input can be used to signal the controller that the
low limit switch on the controlled device has been activated.

High Limit Enable is used in velocity control mode. It is an optional
logical signal that clips the PID output to a value less than or equal to zero
when TRUE. This input can be used to signal the controller that the high
limit switch on the controlled device has been activated.
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PID Positional Control

When you select Position, the PID object calculates the output as
follows:

MV = K_ (e, + integral sum, - T;/dT(Pv,—Pv,_,))
where:
dT = time increment between current and previous calc.
MYV = controller output (manipulated variable)
K. = controller gain (units: % output / % error)
e, = error at sample n (error = SP — Pv,)
integral sum, = integral sum,_; + dT / T; (e, — e,_) also called bias
T4 = rate, or derivative time
Pv, — Pv,_; = change in PV from previous to current calculation

PID Velocity Control

The output of the velocity form of the PID equation is the velocity or rate
of change of the output signal. The velocity form of the PID equation is the
first derivative of the position form of the PID equation with respect to
time, so the result is the rate of change of the controller position.

When you select Velocity, the object calculates the output as follows:
dMV = MV, -MV, =K .((e,—-e,_)+Te,/T;+Ty/T,(Pv,-2PV, _,+PV, )

where:

MYV = controller output position (manipulated variable)

dMV = contoller output velocity

K. = controller gain (units: % output / % error)

e, = error at sample n (error = SP — Pv,)

T4 = rate, or derivative time

PV = process variable
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PID Data Members

Table 2-50. PID Data Members

Data Members

Type Read | Write Description

Error

numeric yes no This is the difference between the
Setpoint (SP) and the Process
Variable (PV).

Output

numeric yes no This is the PID controller output
value, also called MV, or the
manipulated variable. This value is
either the result of the PID loop
equation or the Manual Output,
depending on the state of Automatic
Enable.

Comments

The proportional term of the PID equation contributes an amount to the

output equal to the error multiplied by the Gain. This provides an immediate output
compensation when the error value changes.

Lookout Object Reference Manual

The integral term of the PID equation calculates a running total of the error
summed (or integrated) over time—think of this increment as adding the
area under the curve of a plot of error versus time. While SP is greater than
PV, the integral term is increasing, and while PV is greater than SP, the
integral term is decreasing. The sensitivity of the integral output is set by
the gain and the reset variables. Integral action can be eliminated by setting
Reset to a higher number. At least some Integral action is required,
however, for the loop controller to operate properly with bias adjustment.
If you do not use any Integral, you may experience offset, a condition in
which the output is adjusted to compensate for the error, but not enough to
correct the error.

The derivative term of the PID equation acts to dampen the change in PV
by adding a negative value for a positive-going PV and a positive value for
a negative-going PV. Because PV is subject to sudden small changes and
signal noise in many process loops, derivative action can cause a loop to
respond erratically. Rate can be set to 0, especially when initially tuning the
loop, to eliminate derivative action. Derivative action dampens process
loops that tend to oscillate around the setpoint and thus provide better loop
response. Rapidly changing loops such as liquid flow control in a pipe may
not benefit from derivative action, but more sluggish loops that tend to build
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momentum, such as temperature control, benefit from derivative action by
preventing overshoot and dampening oscillatory action.
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Pipe

Pipe displays different color rectangles (pipes) on a control panel as
defined by the values of Conditional expressions. Pipe determines which
color rectangle to display based on the order and current status of your
Conditional expressions. If several Conditional expressions are TRUE
at once, Pipe displays the color associated with the first TRUE expression.
Conditional expressions must result in logical values.

Mew Pipe [ %]

MName:  |(E=

Conditional expressions:

Fipe colors:

[ W CEEC ..

=

ECETNEE

Elseif= |

.I_I_II_E=II_J

Elseif= |

Elseif= |

.llll;=ll_J

[ W CEEC ..

Elseif= |

Elze

ECETNEE

[ W CEEC ..
EFEENEE

QK | Cancel | Help |

Pipe Data Members

Figure 2-61. Pipe Definition Parameters Dialog Box

Table 2-51. Pipe Data Members

Data Members

Type

Read

Write

Description

graphicl - graphicN

numeric

yes

no

Denotes which display of this object
will appear on an HTML report. Only
one display is available for the
ActiveX object.

Comments You can easily create a complex piping network scheme (including
changing colors) with a single Pipe object. Display the object on a control panel and
copy the pipe display with the shift-drag method to create additional pipes with the
same parameters. You can then move, resize, and group the pipes as you choose.
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Playwave connects Microsoft standard wave form files (. wav) to events in
Lookout. Playwave plays the audio file specified by Wave file when Play
when transitions from off to on. Play when is a logical expression and
might range from a simple pushbutton, to a digital input from a PLC, to an
alarm generated in Lookout. You can also create your own custom audio
files with various software products. Therefore, you can connect individual
alarms to custom wave files to be played each time an alarm goes TRUE.

Playwave Data Members

Create Playwave: E

M ame:

Flay when = I

W ave file: I

Browse... |

ok |

Cancel |

Help |

Figure 2-62. Playwave Definitions Parameters Dialog Box

Table 2-52. Playwave Data Members

Data Members

Type

Read | Write

Description

none

Playwave does not have any data

members

Comments Many computers do not come equipped with quality speakers built in.
If this is the case, your wave files may sound distorted or may even be inaudible.
If you want to take advantage of the Playwave feature, you may need to buy additional
hardware, in particular a Microsoft Windows compatible sound board (with Windows
driver) and external speakers.
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Pot is a potentiometer that you use to change numeric setpoint values.
You can display Pots on a control panel as a knob, vertical slider,
horizontal slider, increment/decrement pushbuttons, or digital entry.
You can also use Pots as multiple-position switches.

If you change the background color of a panel and add a Pot object
displayed as a slider, its color is always gray. To change the background
color of a Pot to match your panel, select the Pot object, then pick
Change»Background Color from the menu.

Mew poltentiometer: E
MName: |(EL0]

Minirriurm: ID

I awimurn: |1 0o

Resolution: |1
— Position source

@ Local

 Femate
’VUHL:=|
= DDE
SEnyiGe: l—
Tapie: l—
IEerm: l—

Control security level: ID ¥ Log events

QK I Eancell Help |

Figure 2-63. Pot Definitions Parameters Dialog Box
Minimum is the lowest value signal the pot will generate.
Maximum is the highest value signal the pot will generate.

Resolution is the smallest increment of change, or detent spacing the
Pot supports.

Position source determines where the value of the Pot resides. Local
indicates the value of the Pot lies within the object itself—on the control
panel.
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Remote Pots get their values from a remote source, often the register on a
controller they are connected to. Adjusting the Pot changes the value in
the register, and changing the value in the register adjusts the Pot. In effect,
the Pot is tracking a remote value. This is especially useful when you want
to prevent Lookout from changing the value of setpoints or registers upon
initial startup, or reconnection of lost communication.

The Remote option calls for a URL to locate the data member you want to
connect to. The URL field is green, and you cannot use a complex
expression as a URL. If you need to use one RadioButton for several
purposes, you can use a Symbolic Link to make a more complex connection
than that possible with a URL.

You can right-click in the URL field and use the URL Editor dialog box
to assemble the URL, in the same way you use the Lookout expression
editor.

A remote position source connection is completely reciprocal. A change in
your Lookout control changes the data member that control is remoted to.
Any change in that data member also changes the control. It is not
necessary, and is incorrect, to use the Edit Connections dialog box to
connect a control object to its controlled data member.

Because the remote connection is reciprocal, you can only make such a
connection to a data member that is either writable, or readable and
writable.

When a process with remoted controls first opens, those controls take their
initial values by following the URL to read the data members they are
remoted to. The control will be covered by a red X to indicate that the
remote connection is not functioning.

@ Note You should use Remeote to connect a control in a client process to a data member
in a server process. Connections inside a single process can be made using Object»Edit
Connections.

Because complex expressions are read-only values, you cannot remote
directly to them. For the same reason, you cannot remote one control to
another control’s (intrinsic) data member (though you can remote a
control to another control’s value data member).
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Much like Remote Pots, DDE (Dynamic Data Exchange) Pots get their
values from a remote source. This could be a cell in a spreadsheet, another
DDE aware application, or a second copy of Lookout running on the
network. The last DDE parameters used on any object automatically
become the default values for any new DDE object.

Control security level specifies the minimum security level operators must
have to gain access to this individual object, and thus control it.

The Log events option creates a permanent audit trail for the object—who
did what and when. All adjustments of the Pot are logged to disk, including
the time of the adjustment, the operator account name, and what adjustment
was made.

Inzert: Potl E2

\\\\‘“‘\\ hiry \\\
O - \ \\ e

\m\\\\\\ \\\\\\&\\
B

\\\& N

knob
[~ Use as default

Cancel |

Figure 2-64. Pot Display Parameters Dialog Box

@ Note You can modify the background color on vertical and horizontal sliders with the
Change»Background color... menu command. You can modify the font and font color of
digital Pots using Change commands.

Pot Data Members

Table 2-53. Pot Data Members

Data Member Type Read | Write Description
(implicit) numeric yes no Current value
decrement logical no yes When this data member value

transitions from FALSE to TRUE, the
implicit value of the Pot object
decreases by the Pot Resolution
amount.
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Table 2-53. Pot Data Members (Continued)

Data Member Type Read | Write Description

enable logical no yes If TRUE (the default), enables DDE.
If FALSE, disables DDE. The default
value is on. This input is ignored for
non-DDE TextEntry objects.

enter Value logical no yes Under specific circumstances, when
this value transitions from FALSE to
TRUE, pops up a Enter new value
dialog box for an operator to use in
entering a value for the Pot. See the
note following the table for more
detailed information.

The enterValue data member is
designed for use under unusual
circumstances, in particular when
pointing devices are not available on a
computer running Lookout. Because
of its unusual operation, this data
member should not be used unless it is
necessary for hardware reasons.

graphicl-graphicN numeric yes no Denotes which display of this object
will appear on an HTML report. Only
one display is available for the
ActiveX object.

increment logical no yes When this data member value
transitions from FALSE to TRUE,
the implicit value of the pot object
increases by the Resolution amount.

reset logical no yes While this value equals TRUE, the
control will be set to the value in
resetvalue.

resetvalue numeric no yes Sets the value a control will take when
the reset data member transitions
from FALSE to TRUE.
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Table 2-53. Pot Data Members (Continued)

Data Member Type Read | Write Description

value

numeric yes yes The current value of the control. If
you have remoted this control, then
value is the current value of the
position source.

visible

logical no yes When FALSE, the Pot object cannot
be seen on the display panel. When
TRUE, the Pot can be seen and
controlled.

5

Note When the enterValue input transitions from FALSE to TRUE, and if the Pot is
visible, if Lookout is not in edit mode, and if the Pot has at least one digital display, the
Enter new value dialog box pops up so an operator can input a value, just as if the operator
had clicked on the digital display.

The numeric format and position used for the dialog box are based on the digital display
for a Pot. Even if the panel containing the Pot digital display is inactive, the Enter new
value dialog box will pop up. You can prevent this by predicating the entervalue input
on the panel's active data member.

Comments Potentiometers are one of the most common control objects used in process
controls. Using Pots, a plant operator can make setpoint changes with the mouse. Pots
also work well as H-O-A switches. To create an HOA switch with a Pot, specify the
minimum as 1, the maximum as 3, and the resolution as 1.

The increment and decrement data members enable quick connection of
Pot objects to $Keyboard and Panel function keys, and screen Pushbuttons.
These are often used to control Pot objects when Lookout is running on an
industrial PC platform that has restricted or no mouse functionality.
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Pulse is a timer that generates a periodic pulse of a specified duration.
When On/off signal transitions to ON, the output signal turns on for the
pulse duration time and then turns off for the remainder of the period. The
output signal immediately turns off when the On/Off signal goes low.

Timer period is the time interval for the full pulse cycle, and Timer
duration is the width of each pulse. These parameters can range from
0.0 seconds to several years, with an effective resolution of 0.1 seconds
over the entire range. Timer duration should always be less than Timer
period.

The object is represented on a control panel by showing the time remaining
before the output changes state. It is depicted in the format defined by the
Display format parameter. It is updated approximately once per second.
If the On/Off signal is FALSE, it shows OFF.

Create Pulse timer: E
Mame: Timerl

On/off signal = l—
Timer period = l—
Timer duration = I

Dizplay format: lm

Ok | Cancel | Help |

Figure 2-65. Pulse Definition Parameters Dialog Box

The On/off signal is a logical expression while Timer period and Timer
duration are numeric expressions. Normally, these are simple time
constants such as 0:20 (twenty seconds). Refer to the Numeric Data
Members section of Chapter 2, How Lookout Works, of the Getting Started
with Lookout manual for information about entering time constants.

Pulse Data Members

Table 2-54. Pulse Data Members

Data Members

Type Read | Write Description

(implicit)

logical yes no Logical timer value
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Comments Pulse can be used to periodically open a valve for a specified time duration.
It can also act as a flasher to turn text and graphic signals on and off for display

purposes.

Related Objects DelayOff, DelayOn, Interval, OneShot, TextEntry
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Pushbutton

Pushbutton generates a logical signal for receipt by other objects. A
pushbutton changes state when you position the cursor over it and press the
mouse button, trackball, touchscreen, or space bar. The pushbutton remains
depressed and the output signal remains high until you release the button.
If a Verify on message is defined, the operator must first acknowledge the
message, then the output signal goes high, but only momentarily.

Create pushbutton E

M ame: (=

Buttan text: |

Werify on = I
- Position source—————————————————
@ Local

i Remate ————
E |

I | Lt cutput

" DDE

SEnyiGe: I
Tapie: I
IEerm: I

Control security level: IU ¥ Log events

QK | Cancel | Help |

Figure 2-66. Pushbutton Definitions Parameters Dialog Box

Button text displays the specified text on the pushbutton.
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Use Verify on to create a dynamic text expression to be displayed in a
message dialog box. See Chapter 6, Security, in the Lookout Developer’s
Manual for more information on security.

MotorStartPb =]

@ Do you want to start Maotor 27

Mo |

Figure 2-67. Verification Message Dialog Box

Position source determines where the value of the Pushbutton resides.
Local indicates the value of the Pushbutton lies within the Pushbutton
itself—on the control panel. If the pushbutton is not depressed its signal
is OFF, if depressed its signal is ON.

Remote Pushbuttons get their values from a remote source, often the
register in a controller they are connected to. Depressing the pushbutton
changes the status of the register, and changing the status of the register
depresses the pushbutton.

The Remote option calls for a URL to locate the data member you want to
connect to. The URL field is green, and you cannot use a complex
expression as a URL. If you need to use one RadioButton for several
purposes, you can use a Symbolic Link to make a more complex connection
than that possible with a URL.

You can right-click in the URL field and use the URL Editor dialog box
to assemble the URL, in the same way you use the Lookout expression
editor.

A remote position source connection is completely reciprocal. A change in
your Lookout control changes the data member that control is remoted to.
Any change in that data member also changes the control. It is not
necessary, and is incorrect, to use the Edit Connections dialog box to
connect a control object to its controlled data member.

Because the remote connection is reciprocal, you can only make such a
connection to a data member that is either writable, or readable and
writable.
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When a process with remoted controls first opens, those controls take their
initial values by following the URL to read the data members they are
remoted to. The control will be covered by a red X to indicate that the
remote connection is not functioning.

@ Note You should use Remote to connect a control in a client process to a data member in
a server process. Connections inside a single process can be made using Object»Edit
Connections.

Because complex expressions are read-only values, you cannot remote
directly to them. For the same reason, you cannot remote one control to
another control’s (intrinsic) data member (though you can remote a
control to another control’s value data member).

When you select the Remote option, you can choose whether or not the
Pushbutton latches its output. The Latch output check box configures
Lookout for controlling a latching-relay.

When a user clicks on a Pushbutton that has latching selected, the
pushbutton remains depressed, sending an ON signal (TRUE or high) until
the Remote Position signal turns ON. Assume for example that an operator
clicks on MotorStartPb, configured above. The pushbutton remains
pushed in, sending a TRUE signal, until PLC.C101 goes TRUE. As soon
as PLC.C101 goes TRUE, the pushbutton releases.

Much like Remote Pushbuttons, DDE (Dynamic Data Exchange)
Pushbuttons get their values from a remote source. This could be a cell in a
spreadsheet, another DDE aware application, or a second copy of Lookout
running on the network. See Chapter 5, Dynamic Data Exchange, in the
Lookout Developer’s Manual for information on Service, Topic, and Item
parameters.

Control security level specifies the minimum security level operators must
have to gain access to this individual object, and thus control it. See
Chapter 6, Security, in the Lookout Developer’s Manual for more
information on security.
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Pushbutton Data Members

The Log events option creates a permanent audit trail for the object—who
did what and when. Any depression of the Pushbutton is recorded to disk,
including the time the button was depressed, and the operator’s account
name. See Chapter 7, Logging Data and Events, in the Lookout
Developer’s Manual for more information on logging events.

Table 2-55. Pushbutton Data Members

Data Members

Type

Read

Write

Description

(implicit)

logical

yes

no

Value of object (TRUE when button is
depressed)

enable

logical

no

yes

If TRUE (the default), enables DDE.
If FALSE, disables DDE. The default
value is on. This input is ignored for
non-DDE TextEntry objects.

graphicl-graphicN

numeric

yes

no

Denotes which display of this object
will appear on an HTML report. Only
one display is available for the
ActiveX object.

reset

logical

no

yes

While this value equals TRUE, the
control will be set to the value in
resetvalue.

resetvalue

numeric

no

yes

Sets the value a control will take when
the reset data member transitions
from FALSE to TRUE.

snapdelay

numeric

yes

yes

Sets how long Lookout holds a

control in a new position before
snapping back to agree with an

unchanged source.

value

numeric

yes

yes

The current value of the control. If
you have remoted this control, then
value is the current value of the
position source.

visible

logical

no

yes

When FALSE, the Pushbutton cannot
be seen on the display panel. When
TRUE, the button can be seen and
controlled.
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You may at times make a remote source connection of a Lookout
Pushbutton or Switch to a PLC or some other object that refuses to change
value when you operate your control. In this situation you can use the new
snapDelay data member.

Use the SnapDelay data member to set how long Lookout will hold the
Pushbutton or Switch in a new position before snapping back to agree with
the value in the unchanged remote source. Setting the SnapDelay to 0
disables the SnapDelay data member, so your remoted switch will not snap
back.

The SnapDelay will also operate if the lag in reporting a change from your
remoted object exceeds the SnapDelay time.

If the value to which your Pushbutton or Switch is remoted changes before
the SnapDelay time has passed, the control operation is confirmed and the
snap does not occur. If you set the SnapDelay data member to 0, your
control responds to any further change in the remote source value.

As with all Lookout measures of time, the SnapDelay data member
operates in terms of fractions of a day. You should make sure to scale inputs
to this data member appropriately.

If you do not set the SnapDelay data member, Lookout defaults to 10
seconds.

When you operate a Pushbutton or Switch that has been set to a remote
source, the (implicit) and value data members do not change until and
unless they receive a new value from the remote source.

Any time the state of a Pushbutton or Switch changes, an event is logged
that includes the source of the change in the event description.
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RadioButton

Lookout Object Reference Manual

The RadioButton object creates a set of radio buttons on your panel.
You can have from 2 to 40 buttons in a set. Only one button at a time can
be activated in each radio button group.

Create Radio Buttons E

Name: IHadio1

Buttons [2-40]): |3

Button labels [comma separated):

one, two, three]

Pasition Source
@ Local

" Remote
’VUHL:= f
V Logevents Security level: IU

QK I Eancell Help |

Figure 2-68. RadioButton Definition Parameters Dialog Box

Set the Buttons (2-40) in each set. You can have as many as 40 buttons in
each group, but you must have at least 2.

Position source determines where the value of the RadioButton resides.
Local indicates the value of the RadioButton lies within the object
itself—on the control panel.

The Remote option tells Lookout to initialize the RadioButton value from
a remote source. Adjusting the RadioButton changes the value in the
register, and changing the value in the register adjusts the RadioButton.
In effect, the RadioButton is tracking a remote value. This is especially
useful when you want to prevent Lookout from changing the value of
setpoints or registers upon initial startup, or reconnection of lost
communication.

The Remote option calls for a URL to locate the data member you want to
connect to. The URL field is green, and you cannot use a complex
expression as a URL. If you need to use one RadioButton for several
purposes, you can use a Symbolic Link to make a more complex connection
than that possible with a URL.
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You can right-click in the URL field and use the URL Editor dialog box
to assemble the URL, in the same way you use the Lookout expression
editor.

A remote position source connection is completely reciprocal. A change in
your Lookout control changes the data member that control is remoted to.
Any change in that data member also changes the control. It is not
necessary, and is incorrect, to use the Edit Connections dialog box to
connect a control object to its controlled data member.

Because the remote connection is reciprocal, you can only make such a
connection to a data member that is either writable, or readable and
writable.

When a process with remoted controls first opens, those controls take their
initial values by following the URL to read the data members they are
remoted to. The control will be covered by a red X to indicate that the
remote connection is not functioning.

@ Note You should use Remote to connect a control in a client process to a data member in
a server process. Connections inside a single process can be made using Object»Edit
Connections.

Because complex expressions are read-only values, you cannot remote
directly to them. For the same reason, you cannot remote one control to
another control’s (intrinsic) data member (though you can remote a
control to another control’s value data member).

E Note You cannot break a group of radio buttons into multiple rows.

Enter any text for the buttons in the Button labels field. Separate each
button label with a comma. If you need to include a comma or a backslash
in any button text, precede that character with a backslash(\). If you want
to leave a button blank, you can enter two commas without any text or
numbers between the commas. You do not have to enter a label for every
button. Lookout will leave each button after your last label entry blank.

If you enter more labels than you have set buttons, your labels will be
preserved but not displayed.

To log changes in button state, check the Log Events check box.

Security level sets the minimum security level an operator must have to
change the radio buttons.
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Create Display:

— Style
" Standard F'ushbuttnn

Selest MM araphics |
Select HERE graphic&l

— Juztification
& Left

" Center
" Right

Orientation——
* Yertical
€ Horizontal

Text Color:

BMarsrnia [

Fort... | 10 pt &rial Bold

— Preview
On \\ E\\
O \ E\\
Frame style
* Mone white ( Black ‘
Background Colar: [ Transparent
(I | [
I (] | (S
I—I Cancel |

Figure 2-69. RadioButton Display Parameters Dialog Box

Create Display:

~ Style
" Standard Pushbutton
" Radio Button

& Cystomized Button

Select OM graphics |
Select OFF graphicsl

— Preview

\\ \

On

]

" Right

— Justification Orientation——
&+ Left * Vertical
" Center " Horizontal

Frame style
{* Mane

" White Black ‘

Text Colaor:

Background Color: [ Triansparent

.I_I_II_I_III_J I_I_Elll_l_lll_
ErEEEEE EFEENEET
Font.. | 10 pt Arial Bold

Figure 2-70. RadioButton Display Parameters Dialog Box with
Custom Graphics Chosen

Cancel |

You can use a standard Lookout pushbutton, standardized radio buttons,
or custom graphics for your radio button groups.
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Notice that you cannot enter text in the Create Display dialog box. You
must enter any text you intend to use in the RadioButton Definition
Parameters dialog box. You can change font and text size in the Create
Display dialog box. The first text label you entered for your radio button is
displayed in the Preview field so you see the effect of font changes.

The default display uses a standard Radio Button display. You can adjust
text and background color for any of your display choices.

Selecting Standard Pushbutton displays standard on/off buttons in your
radio button array.

Select Customized Button for a free range of choices from the Lookout
graphics library, or create your own ON/OFF indicators for a radio button
array. See the Creating Custom Graphics section of Chapter 2, Graphics,
in the Lookout Developer’s Manual for detailed information on creating
your own graphics for use on a Lookout control panel.

Set the Orientation of the radio button array to horizontal or vertical by
checking the appropriate check box. Set label text Justification and button
Frame style in the appropriate fields.

RadioButton Data Members

Table 2-56. RadioButton Data Members

Data Member Type Read Write Description

1-40 logical yes no Reports ON/OFF status of each button in a
radio button set.

current numeric yes no Reports which radio button is active in a set.

graphicl- numeric yes no Denotes which display of this object will

graphicN appear on an HTML report. Only one display
is available for the ActiveX object.

(implicit) numeric yes yes Radiobutton value.

value numeric yes yes Number of the currently active radiobutton.

visible logical yes yes Controls visibility of a radio button set.

Default=TRUE.

Related Objects L3Pot, L3Pushbutton, L3Switch, Pot, Pushbutton, Switch
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Recipe

Recipe objects are an efficient means of importing large arrays of data
(namely recipes and their ingredients) into Lookout using an Excel (.x1s)
spreadsheet. Once created and implemented, the operator can easily and
quickly change the current recipe with the click of the mouse, thus selecting
a new set of ingredients.

The best way to describe how the Recipe class works is to step through a
typical example, in this case involving cookie manufacture.

There are two steps to creating and implementing a recipe object. First,
you define your recipes with their respective ingredients in a spreadsheet
program such as Excel (anything that creates an .x1s file will
work—including Lotus 123). You can define up to 1,000 recipes in a single
.x1s file. Each recipe can have up to 255 ingredients. Three cookie recipes
are defined in this spreadsheet.

@ Note The spreadsheet must be saved in Excel 4.0 format.

Lookout Object Reference Manual

X Microsoft Excel - Cookies.xls
ﬁEile Edit %iew |nsert Format Tools Data DAQ  Serial GFIE  Window

Help TR
Nl &lale] |- o|es| =5 81Z L
Mz Sans Serif = o 5] Bl[lgl glglgll $|%| y |*_I
a? =
A |B|c|D|E|F|G|H|I1|J|K|[L|M|N|O]|T
E
. = = 1]
5 %2 2 = g 2
a2 £, GE L EZ
[ = ] =]
sef2its a8 gL
1 CEfdTacLsSSasadsH
2 |Chocolate Chip 100 50 60 10 8 5 6 3 8 7 0 0 60 43
3 |Oatmeal 120 45 50 15 14 3 5 4 7 550 0 0 51
4 |Ginger Snap 110 40 40 8 11 4 4 5 9 8 057 0 68
5
|l i cookIES |« ILIJJ
Ready | Sum=0 | | | | [ 4

The first row of the spreadsheet is reserved for ingredient names. They
begin in column B. These ingredient names later become alias data
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members of the Recipe object. Therefore, ingredient names must be
unique. They cannot have the same name as a native data member (see
the Recipe Data Member table for data member names). Also, you cannot
name an ingredient missing; this is a reserved word. Valid characters in
an ingredient name include A —Z, 0 — 9, the dollar sign ($), and a period
(.).If youenter Hi @#! ! There as an ingredient name, Lookout names the
alias HiThere. Alias names are case sensitive.

Beginning in Row 2, Column A lists the names of the various recipes.
Recipes follow the same naming convention as ingredients. Each recipe is
followed by its unique ingredient values.

Ingredient values can represent process inputs, parameters, and outputs.
Process inputs typically represent raw materials and other inputs consumed
in the batch process. Examples include the number of eggs consumed,
amount of flour used, amount of energy consumed, possibly even work
hours required or amount of traceable fixed costs consumed.

Another type of ingredient value is a process parameter. Process parameters
identify operational settings such as furnace cooling time, an air pressure
setpoint, or a Low pH alarm limit. Process parameters might also include
identifications of specific equipment to be used during the batch process.

The third type of ingredient value is a process output. Such an ingredient
value might represent the number of finished cookies expected from the
batch, amount of byproduct expected, or a cost variance calculation based
on the selected recipe.

Ingredient value quantities may be specified as constants or as equations
based on other formula parameters such as batch size.

The second part of defining a recipe involves defining a recipe object in

Lookout.
Mame: IEookieH ecipe

Security levels

Chooze recipe: |2
Load recipe file: IS

V Logevents

QK I Eancell Help |

Figure 2-71. Recipe Definition Parameters Dialog Box
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The first recipe dialog box defines security and event data logging.

Choose recipe security level specifies the minimum security level an
operator must have to be able to select a recipe from all the recipes listed
in the currently selected spreadsheet file.

Load recipe file security level specifies the minimum security level an
operator must have to be able to select a different spreadsheet file.

The Log events option creates a permanent audit trail for the object—who
did what and when. Any selection of a different recipe or recipe file is
logged to disk, including the time the action occurred and the operator’s
account name. See Chapter 7, Logging Data and Events, in the Lookout
Developer’s Manual for more information on logging events.

After defining security and event data logging, Lookout presents you with
afile selection dialog box. Remember that Lookout only accesses Excel 4.0
and compatible files.

CookieRecipe EHE

Look in: IaSamples j gl l_

File name: ICDDkies.xIs Open |
Files oftype:  |MS Excelfilas(*xls) =l Cancel |

Select the cookies.x1s spreadsheet file because it has the three batch
recipes in it.
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Once a file is selected, Lookout presents a list of recipes.

CookieRecipe | ]

IChDCDIate Chip Presimns

d

Mext
Ginger Snap

Cancel |
—recipe file
File: chprogram fileshnational Lemal |
instrumentshlookoutsamplesicookies xls
Yersion loaded: Fri Dec 12 12:18:52 1997
Contains 3 recipes x 14 ingredients

As you can see, the recipe names come from column A of the spreadsheet.
You can use the Previous and Next buttons to identify a recipe from among
the list, or type the name in the data entry field above the list. (This same
dialog box appears later when an operator clicks on the pushbutton
representing this object.) Click on OK to choose the recipe you want to use.
Select the recipe for oatmeal cookies.

The recipe file Load button invokes the file list dialog box, described
previously. Click on this button to select a new .x1s file.

@ Note If the recipe is changed in the spreadsheet, the change is noted in the recipe file
dialog box—but the values currently resident in the object data members remain intact.
The operator must load the spreadsheet again to update the copy of the recipe file in
Lookout. If you select a new .x1s file to load but click on the Cancel button, it does not
update! You must select OK for the recipe to actually be loaded.
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To display the recipe, drag the Recipe object, not the (implicit) data

member, from the Object Explorer to the panel you want the display to

appear on. The Display recipe dialog box appears, as shown in the

following figure.

Revize recipe dizplay: CookieRecipe

Tewt colar

[ CHEC ..
IR Il | (e

Backaround color

N CHNT ..

HEEEENENT_

© Justifp left & Justify centered

Backaround style Frame style
& Plate " Black

" Inset " white

" Rectangle & Mone

" Tranzparent

£ Juistify right

Chocolate Chip

Fort.. |‘|D|:|t.-’-‘n.riaIBDId

Cancel |

Figure 2-72. Recipe Object Display Parameters Box

After you choose the object display parameters, you can paste it into the

panel.

When you select a new recipe, Lookout writes the ingredient values for the

selected recipe into the corresponding data members of the object.
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The actual number of data members that a recipe object has is based on the
number of ingredients within it. This is best demonstrated by looking at the
Insert Expression dialog box.

Insert expression E
IEookieHecipe.Butter
Dizplay Type: Inumeric 'l Path Mode: IHeIative j
— Signals:
Paste | CookieR ecipe. Butter
IE paroikos. dy.natinst. com j Contents:
ity AlarmS =] BrownSugar. unavail -
ity AlarmB o Butter
iy AlarmHelpPanel Butter.lagical
-y AlamHelpPh Butter.tat
-y AlamHelpPbl Butter. unavail
-y CockiePanel Chocalate
¥y CoockiePanelPb Chocaolate. lagical
-y CockieRecipe Chocaolate.tst
-~y Count Chocolate. unavail
-y Data_cav Cinnaman
-~y DatalogTrend Cinnaman. logical
by Flow Cinnaman.txt
-~y FoatCount x| ¥4 Cinnaman. unavyai x|
Recipe hUMmeric
Cancel | Help |

Notice that there are four data members for each defined ingredient. Actual
data member names vary from object to object, depending upon your recipe
ingredients. However, the four readable data member types for each

ingredient are consistent.

Recipe Data Members

Table 2-57. Recipe Data Members

Data Member Type Read | Write Description

(implicit) text yes no Name of currently selected recipe

B-1V numeric yes no Each letter, B through IV, represents a
column in the spreadsheet. The value
of the data member is the numeric
amount of the ingredient for the
currently selected recipe.
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Table 2-57. Recipe Data Members (Continued)

Data Member Type Read | Write Description
B.logical through logical yes no Each letter, B through IV represents a
IV.logical column in the spreadsheet. Returns

TRUE (ON) if the amount of the
ingredient in the spreadsheet cell for
the selected recipe is greater than
zero. Returns FALSE if the specified
amount for the ingredient is zero.

B.txt — IV.txt text yes no Each letter, B through IV represents a
column in the spreadsheet. The value
of the data member is the textual
amount of the ingredient for the
currently selected recipe.

B.unavail through logical yes no Each letter, B through IV represents a
IV.unavail column in the spreadsheet. Returns
TRUE if the spreadsheet cell is empty.
Returns FALSE if the cell contains
data.

pickl through pick1000 | logical no yes Upon transition from FALSE to
TRUE, chooses the respective recipe
within the spreadsheet. When used
with pushbutton objects, these data
members can eliminate the need for
operators to use the recipe list dialog
box.

Comments The recipe object reads a block of continuous columns. Therefore, the
ingredient names should be a contiguous list in Row 1. If a recipe does not use a
particular ingredient, just leave the respective cell blank.

When Lookout encounters a blank cell in Column A, it ignores the entire
row. Thus, you can easily annotate your recipes by leaving a cell in
Column A blank and adding text to the cell in Column B of the same row.
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Report

Use the new Report object to generate an HTML page that you can put up
on a Web server to allow people to access the reported information.

Unlike the Lookout Web Client, the data on a report page is not live; the
report page features a snapshot of the data as it existed when the page was
generated. The advantage of this is that no downloading is necessary for
someone to browse the HTML page this object creates, and no Lookout
objects can be manipulated or changed by those browsing the page.

You can set your report object up so that it generates updated pages at
regular intervals and under special circumstances.

Create an HTML report using the Create Report dialog box, as shown in
the following figure.

Create Report E
Narne: IF‘EDUWI Background calor= [~ ariable
) § ™ Wariable Dl_ll_l_lll_ o
ogo = ‘
SN\ I ] [ |
Text color = ™ Wariable

g

Ouptut directary = Link color = v g’\u"ariableE

IDxDDDDFF
Output file = I
Alarm priority = I

QK I Eancell Helg |

The Create Report dialog box does not have parameters in the same way
as most Lookout Create object dialog boxes. Except for the name of the
Report object, all of the entries in the Create Report dialog box are
actually data members. You can create a Report object in Lookout by filling
only the Name field, and using data members to accomplish remaining
tasks.

You also have the choice of making some of the elements on the Create
Report dialog box variables instead of constants. For example, because the
elements are variables, you can use a text entry to select a Logo to appear
at the top left of your report page and select a specific graphic.
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If you use a Logo, enter a title to appear next to the Logo in the Title field.
Set the directory for the web page to be built in using the Qutput directory
field, and define the file name in the Output file field.

You can select the colors for the report page background, for the text, and
for links from the color selection boxes, or you can enter hexadecimal
values in the form of 0x000000. This is an Red Green Blue (RGB) setting
where the first two digits of the hexadecimal number set the level of red, the
second two digits set the level of green, and the third pair of digits set the
blue levels. The color blue, for instance, would be 0xO000FF, and red
0xFF0000. White is OxFFFFFF and black is 0x000000. You can use a Pot
or some other numeric input to alter the colors.

Use the Report object data members to determine what objects will be
placed on your report page, and what order those elements will appear in.

The elements you can use on report pages are:
e Background image

*  Lookout display elements, such as a Pot slider, a HyperTrend chart, or
even a Lookout panel with all its contents

e Graphics from the Lookout graphics collection

e Text or messages you create in Lookout while your processes are
running

e Inclusions, from preexisting text files, including HTML coded text
e Links to other HTML pages

¢ Ordered lists

 HTML tables

e  Unordered lists

e Data direct from Lookout data members

Placing Elements on the Report Page

If you use a Logo, it will always be at the upper left corner of the report
page, with the title immediately to the right.

The rest of the elements set to appear on the page appear in order of their
extension number, so that Display1l will appear before Displays.
When different elements have the same extension number they appear in
the following order:

1. Raw HTML
2. HTML links
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Values

Ordered Lists
Unordered lists
Tables

Includes

® NN kW

Graphics

The results will be more predictable if you use a unique extension number
for each element on the report page.

You place Lookout displays, such as indicators, HyperTrends, or Pots by
connecting the Report Display connector to the Graphic data member now
available in all Lookout objects that have a displayable component. Also
notice that when you place a display component on the Lookout panel, the
name of the object and its display number, such as
HyperTrend2.displayl, appears in the status bar at the bottom of the
Lookout workspace. Other displays from that same HyperTrend object will
be noted as HyperTrend2 .display?2, and so on. Use this feature to make
sure the correct display is connected. A connection to make the second
display taken from HyperTrend2 appear as the first element on your report
page would take the form Report1.Displayl =
HyperTrend2.graphic2.

Generating the Report Page

To generate a report page, connect a pushbutton or some other logical input
to the Generate data member. Each time the input goes high (changes to
TRUE) Lookout will generate the report page using the current data.

Making A Report Page Available

As with the Lookout Web Client, you must have the HTML report page
present on a computer running web server software for people to access
your report from across a local network from the Internet. Consult your web
server documentation for specific information about setting up a web
server.
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Report Data Members

Table 2-58. Report Data Members

Data Member Type

Read

Write

Description

AlarmPriority numeric

yes

yes

Sets the priority of an alarm
generated by this object.

BG color numeric

yes

yes

Background color of your report
page. Set through the create
object dialog box, or use an RGB
hexadecimal variable.

BGImage text

yes

yes

Background image for your
report page. Use a well formed
Lookout path, relative to the
graphics directory, to the . BMP
or .WMF file you want to use as
the background image for your
report page.

Displayl - numeric

Display 100

no

yes

Places a display on your report
page, in the order of the numeric
component of the data member.
Activate this feature by
connecting the DisplayN data
member to the Graphic data
member of any Lookout object
that has a displayable
component, such as a switch, a
HyperTrend, and so on.

Generate logical

yes

yes

Connect a logical input to this
data member. When the
connection changes to TRUE
(goes high), Lookout will
generate a web report page using
the current data.
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Table 2-58. Report Data Members (Continued)

Data Member Type

Read

Write

Description

Graphicl - text
Graphic100

yes

yes

Places a graphic on your report
page in the order of the number
component of the data member.
Use a well formed Lookout path,
relative to the graphics
directory, to the .BMP or WMF
file you want to use.

HTML]1- text
HTML100

yes

yes

This is a text connection to
Lookout text sources. You can
enter plain text or HTML
encoded text. If the text file is
HTML encoded, it will display
properly on your report page.

Includel - text
Include100

yes

yes

This data member will include a
text file as text on your report
page. Use a well formed Lookout
path (full path) to the text file you
want to add to your page. If the
text file is HTML encoded, it will
display properly on your report
page.

LinkColor numeric

yes

yes

Sets the color for links to other
URLs. Set through the create
object dialog box, or use an RGB
hexadecimal variable.

LinkText1 - text
LinkText100

yes

yes

Connect to a Lookout text source
to put a URL link on your web
page. A LinkText data member
must be paired with a LinkURL
data member to work. That is, the
LinkText data member must
have the same number as the
LinkURL data member carrying
the URL the text activates.
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Table 2-58. Report Data Members (Continued)

Data Member

Type

Read

Write

Description

LinkURLI -
LinkURL100

text

yes

yes

Connect to a Lookout text source
to put a URL link on your web
page. A LinkURL data member
must be paired with a LinkText
input. Thatis, the LinkText data
member must have the same
number as the LinkURL data
member carrying the URL the
text activates.

Logo

text

yes

yes

A special graphic placement
category you can set from the
create object dialog box or
through the data member. The
Logo graphic is always placed at
the top left of your report page. It
can be left empty if you choose.
Use a well formed Lookout path,
relative to the graphic
directory, to the .BMP or . WMF
file you want to use.

OListl.1 -
OList100.99

polymorphic

yes

yes

Ordered list element (an ordered
listis a list in which each element
is assigned a number). You can
have as many as 100 lists with as
many as 99 items in each. This
data member can accept any
Lookout data type.

OListNF1 -
OListNF100.99

text

yes

yes

Numeric formatting for the
ordered list. Connect this data
member to a Numeric Format
object, which you then use to set
the numeric format for the
corresponding item in an ordered
list.

OutDir

text

yes

yes

The directory the report object
will build your HTML page in.
This should be a pre-existing
directory.
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Table 2-58. Report Data Members (Continued)

Data Member Type Read Write Description

OutFile text yes yes Name of the file you want to save
your report page in.

Tablel.Al - polymorphic yes yes HTML table. You can have up to
Table100.299 100 tables. Each cell of your
table has a unique extension,
beginning with A1 for the upper

left cell.
TableNF1.A1 - numeric yes yes Numeric formatting for the
TableNF100.299 HTML table. Connect this data

member to a Numeric Format
object, which you then use to set
the numeric format for the
corresponding table cell.

TextColor numeric yes yes The default color for text on your
HTML report page. Set through
the create object dialog box, or
use an RGB hexadecimal
variable.

Title text yes yes Title is a special text string for
your report page. The title is
always placed to the left of the
Logo, if room permits and if
there is a Logo.

UListl.1 - polymorphic yes yes Unordered list element (an
UList100.99 unordered list is a list in which
each element is preceded by a
bullet or some other symbol).
You can have as many as 100 lists
with as many as 99 items in each.
This data member can accept any
Lookout data type.
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Table 2-58. Report Data Members (Continued)

Data Member

Type

Read

Write

Description

UListNF1.1 -
UListNF100.99

text

yes

yes

Numeric formatting for the
unordered list. Connect this data
member to a Numeric Format
object, which you then use to set
the numeric format for the
corresponding item in an
unordered list.

Valuel - Valuel100

polymorphic

yes

yes

Inserts the Lookout value
connected to it onto your report

page.

ValueNF1 -
ValueNF100

numeric

yes

yes

Numeric formatting for a
Lookout value. Connect this data
member to a Numeric Format
object, which you then use to set
the numeric format for the
corresponding value.
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You can use Run objects to start an external program file from within
Lookout. When the result of the Run when logical expression goes TRUE,
the object executes the Command line.

M ame: lF!un‘I—

Run when = ITimer‘I

Command line = I"E:\Excel\ExceI.exe Report].«ls'|
Start program

Alarm priority: |5
QK I Eancell Help |

' lconic
& Marmal
' Maximized

Figure 2-73. Run Definition Parameters Dialog Box

In this example, Lookout runs an Excel macro called REPORT1 . XLM when
the logical value returned by Timer1 goes TRUE. Timer1 is a TimeofDay
object that triggers the report to run every day at 8:00 a.m.

The Command line text expression must be enclosed in quotation marks
as shown. Notice that the example includes the full path name of the
executable file. Ensure that your command line meets DOS syntax
requirements. Because this is an expression data field, the command could
be the result of a text expression.

Passing arguments in the Run Object in Lookout requires proper use of
double quotes depending on how many arguments you are passing and
whether or not those arguments have spaces in the path.

If your argument has no spaces in the path, you need only insert double
quotes before and after the argument.

If your argument has spaces in the path, you must insert two double quotes
at the beginning and the end of that argument to define it as a single
argument. These two double quotes are in addition to the double quotes you
must use in passing any argument.
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For example, when passing a single argument the following examples
demonstrate the correct use of double quotes (spaces are exaggerated for
effect):

"o \my excellautoexec.xlg"""

"c:\excel\excel .exe"

When passing two or more arguments, you follow the same rules for each
argument, as illustrated in the following examples:

"nre:\program files\msoffice\excell\excel.exe"" c:\autoexec.xlg"
nnrne:\program files\excel\excel.exe"" ""c:\my excellautoexec.xls"""
"c:\excel\excel.exe c:\working\autoexec.xls"

You can specify how an application presents itself when you activate it
with the Start program selections. If you select Normal, the application
window appears in front of the open Lookout window when it is activated.
If you want to reduce the application to an icon each time you start it, select
Iconic. If you select Maximized, the application window replaces the
Lookout window on the screen. (Lookout is still running; you just cannot
see it. Press <Alt+Tab> to switch between applications.)

Table 2-59. Run Data Members

Data Member Type Read | Write Description

none — — — Run does not have any data members

Comments If the application does not automatically shut down, multiple instances of
the program may be running because of previous starts. Over time, this can snowball
to the point where Windows performance is severely hampered.

If you want to execute DOS commands from within Lookout, put the

commands in a DOS batch file (. bat) and then identify the batch file in the
Command Line.
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Sample

The Sample object samples and holds data. Any time the Sample
expression transitions from OFF to ON and the Enable expression is
TRUE, the Sample object samples and stores a Data expression. Sample
maintains an array of up to 35 previous samples. If Enable is left blank it
is assumed to be TRUE. Data is a numeric expression while Sample and
Enable are logical.

Mame: W
[rata = ||
Sample = I
Enable = I
ok | Cancel | Help |

Figure 2-74. Sample Configuration Parameters Dialog Box

@ Note Sample does not have a display parameters dialog box. You can display the result of
a Sample output signal by using its data member in an expression.

Sample Data Members

Table 2-60. Sample Data Members

Data Member Type Read | Write Description

(implicit) numeric yes no Current Data value—tracks Data
input value.

1-35 numeric yes no Previous samples. Signal 1 is the most
recent sample since Sample went
high. If you display Sample, you
display the current and active value
for the object—that is, the (implicit)
value. If you display Sample.1, you
display the least complete value.

DataReset logical no yes Upon transition from FALSE to
TRUE, resets to zero all data
members—including the current
value and all previous samples.
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Comments The Reset expression can be a regular pulse interval created by a
TimeOfxxxx timer. For example, if you want to sample the temperature every hour of
the day, use the output signal from a TimeOfHour timer in the Reset expression to
sample the temperature at the beginning of each hour.

Related Objects Average, Maximum, Minimum, SampleText
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SampleText

SampleText samples and stores the result of the Data expression any time
the Sample expression transitions from OFF to ON and the Enable
expression is TRUE. SampleText maintains an array of up to 35 previous
samples. If Enable is left blank it is assumed to be TRUE.

Mame: W
Data = I
Sample = I
Enable = I
ak. | Cancel | Help |

Figure 2-75. SampleText Definition Parameters Dialog Box

Data is a text expression while Sample and Enable are logical expressions.

@ Note SampleText does not have a display parameters dialog box. You can display the
result of a Sample object output signal by using its data member in an expression.

SampleText Data Members

Table 2-61. SampleText Data Members

Data Member Type Read | Write Description

(implicit) text yes no Current Data value. Tracks Data
input value.

1-35 text yes no Previous samples. Signal 1 is the most
recent sample since Sample went
high.

DataReset logical no yes Upon transition from FALSE to

TRUE, resets all data
members—including the current
value and all previous samples.

Related Objects Sample, L3TextEntry, TextEntry
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Scale

You can use the Scale object to create dynamic scales—that is, scales
whose ranges and divisions can change based on numeric parameter
expressions.

@ Note If you want to create a simple scale that does not change dynamically (which is
normally the case), use the Insert»Scale command.

Create Scale E

Absalute Minimurn: ID

Absolute M aximurm: 100
Minimurn = ID
I awimum = |1 0o
Major unit = |1 1]
Minar unit = |2.5
QK I Cancel | Help |

Figure 2-76. Scale Definition Parameters Dialog Box

Absolute Minimum and Absolute Maximum are numeric constants.
They define the fullest possible range that the scale can show. These values
act as clamps, restricting Minimum and Maximum.

Minimum and Maximum are numeric expressions you can use to change
the minimum and maximum values on the scale. In the preceding example,
the highest value of the scale (Maximum) is 400 if pot1 is less than 400,
1600 if Pot 1 is greater than 1600 (because of the Absolute Maximum), or
equal to the value of Potl.

Major unit specifies the number of units between major tick marks. Minor
unit specifies the number of units between minor tick marks.
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When you place a Scale on a panel, the Display Scale dialog box appears.

Display Scale: Scalel E=

Qrientation——————————————
10 :

nans!
DJ o 1m Cancel |
3
10
left side, increasing up ¥ Minar tick marks

ol [ [N CHEE
ECEEEEE

v Labels Label format:
Label font... | IEl j
10 pt Arial Bold

Figure 2-77. Scale Display Parameters Dialog Box
Specify Orientation, Color, Label format, and Label font as you choose.

You can remove minor tick marks by deselecting the Minor tick marks
check box and you can remove label numbers from your scale altogether by
deselecting the Labels check box. (Only major units have numeric labels.)

Scale Data Members

Table 2-62. Scale Data Members

Data Member Type Read | Write Description

graphicl-graphicN numeric yes no Denotes which display of this object
will appear on an HTML report. Only
one display is available for the
ActiveX object.

visible logical no yes When TRUE, the Scale becomes
visible on the control panel. When
FALSE, it is invisible. The default
value is TRUE.

Comments Many people use this object class in conjunction with HyperTrends that
are configured for a variable Y axis. They configure the Minimum and Maximum
parameters of the Scale object to follow the same values as the Max and Min data
members of the HyperTrend Object.
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Sequencer

The Sequencer object is a method for cycling through a collection of up to
100 differently configured ON/OFF states for your process.

Each Sequencer state has 26 logical outputs. Outputs left blank are
considered OFF.

You set each output to ON or OFF for each state. You can also create jumps
to skip from one state to another, or activate immediate jumps to a
designated state.

Create Sequencer E

MName: (T Statez: [7

[1-100)

State Time Limit Outputs

Mo Label HHMMSS) 4 B CDEFGH I JKLMNOPARSTUYVWXYZ
1 | ol o oo o oo oo
o o oo o oo oo
o o oo o oo oo
o o oo o oo oo

o o oo o oo oo

o o oo o oo oo
ol o oo e e e o e e e o

~ M = L) R

QK I Cancel | Help |

Figure 2-78. Sequencer Definition Parameters Dialog Box

The States field activates the states you want in your sequence loop. If you
set States to 5, the sequence object will pass through states 1 through 5 and
then return to state 1 to repeat the cycle.

Notice that unused states can still be configured. In this way you can
preconfigure special states, create subroutines, and so on. See the
Programming the Sequencer section for further information on using this
object.

Use Label to label each state.

The Time Limit parameter determines how long the Sequencer holds each
state. If you leave this parameter blank, the Sequencer halts on that state
until a Goto or Jump is activated, or the Time Limit parameter is changed.
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@ Note When you set the Time Limit expression to reference a Lookout control, you must
make sure the output of that control is either in HH:MM:SS format, or in days.

Outputs are the ON/OFF settings for each state.

Programming the Sequencer

Left unmodified, the Sequencer cycles through the states selected in the
States field of the Sequencer parameter configuration dialog box,
beginning with state 1. If you enter 4 in the States field, the Sequencer will
cycle through states 1—4 continuously, spending the amount of time in
each state set by the Time limit.

Use the Goto data members to jump to a given state of the Sequencer
immediately. Use the Jump data member to skip automatically from one
state to a target state.

There is a tiny lag in state transition when you use the Jump data member.
For instance, if you have a sequence cycling through states 1—8, and under
some circumstances you want to skip states 5 and 6, moving directly from
state 4 to state 7, set the jump5 . 7 data member to TRUE. When the
Sequencer reaches the end of the state 4 Time limit, it switches to state 5,
and then immediately jumps to state 7. State 5 will be active for a brief
period (about 10 ms), however, which you should take into account in
designing your sequences.

You can use sequential jumps if you choose. When you activate a jump
from state 1 to state 5, for example, and also a jump from state 5 to state 9,
the Sequencer skips from state 1 to state 9 with a 10 ms delay at state 5.

If you use a Jump or Goto data member to activate a state outside the
number you selected in your States field, the Sequencer will continue to
cycle through any states following the target state, until it either reaches a
state with no set Time limit, or state 100.

If the Sequencer reaches a state with no set Time limit, it remains in that
state until a Goto or Jump is activated, or until the Time Limit parameter
is changed.

If the Sequencer reaches state 100, and if state 100 has a Time Limit set,
the Sequencer cycles to state 1 at the end of that time, resuming its cycle
inside the states defined by the States parameter.
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If you use a Goto or Jump data member to activate a state outside the
ordinary cycle of a Sequencer object, you must use the Jump or Goto data
members to return the sequence to its automatic cycle.

Sequencer Data Members

See the Programming the Sequencer section for detailed information on
using Sequencer data members.

Table 2-63. Sequencer Data Members

Data Member Type Read Write Description
A-7Z logical yes no Sequencer outputs
Gotol — Goto100 logical no yes When activated, forces Sequencer to go

to the indicated state

Jumpl.1 — logical no yes When activated, jumps from the state

Jump100.100 indicated by the first number to the state
indicated by the second number

StateName text yes no Reports the currently active state name
(Label)

StateNumber text yes no Reports the sequence number (State

No.) of the current state

Time numeric yes no Reports the current length of time the
Sequencer has been in the current state

TimeLimit numeric yes no Reports the length of time set for the
Sequencer to hold the current state
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Sort

The Sort object sorts up to 1000 numbers (numeric values) in ascending or
descending order. It also gives the rank of these sorted numbers relative to
their original position in the unsorted list.

Mame: IEDrt'I

Sort Order
' Ascending
" Descending

0K | Cancel | Help |

Sort Order options define how the numbers are to be sorted: ascending
order or descending order. This list sorts when you activate the SortNow
data member.

The logical SortNow member sorts the list when the signal connected to it
goes TRUE. The following table shows an unsorted list, the same list after
sorting it in descending order, and the ranks of each sorted value.

Sorted
Unsorted (Descending) Rank
3 9 2
9 3
5 4 4
4 3 1

To create this table as a display on a Lookout panel, drag the val data
members (val0—val3) to the panel as a display for the Unsorted column,
the sorted data members (sorted0—sorted3) for the Sorted column,
and the rank data members (rank0—rank3) for the Rank column.

E Note Do not leave any intermediate values unconnected. For instance, the previous
unsorted numbers need to be connected consecutively to data members valo through val3
with no omissions. The presence of duplicate numbers does not affect sorting or the ranks.
In such situations, the duplicate numbers get sorted and ranked depending on their original
positions.
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Sort Data Members

Table 2-64. Sort Data Members
Data Member Type Read Write Description

rankO — rank999 | numeric yes no Rank of the sorted numbers with
respect to their original positions in the
unsorted list

sorted0 — numeric yes no Sorted values in ascending or

sorted999 descending order

SortNow logical no yes When TRUE, sorts the list

val0 — val999 numeric yes yes Original unsorted values
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Spinner

Spinner is a small, rotating disk. Its rotation speed can be variable, to
represent the magnitude of a numeric Signal, or its rotation can be turned
on or off based on the logical signal, Spin.

Mew Spinner E

% Logical [on/off)

Spin = I

Speed when spinning []: |1 oo
" Numeric
Sighal = I

Signallvalue &t 5 speed; ID

Sigrallvalive &b 00 speed; (100

QK | Cancel | Help |

Figure 2-79. Spinner Definition Parameters Dialog Box

Logical (on/off) and Numeric choose whether the spinner responds to a
logical signal or a numeric signal. Choose Logical if you want to be able
to turn the spinner on and off. Choose Numeric if you want the speed and
direction of the spinner to change depending on a numeric variable.

Spin is a logical expression. When the result of the logical expression is
TRUE, the spinner rotates at the rate defined by the Speed when spinning
(%) field. Speed when spinning (%) is a numeric constant, ranging from
-100 to 100.

Connecting the spinner to a positive value rotates the spinner in a
counterclockwise direction. A negative value rotates the spinner in a
clockwise direction.

Signal is a numeric expression. The result of this expression dictates the
spin speed based on the linear range defined by Signal value at 0% speed
and Signal value at 100% speed.
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Spinner Data Members

Table 2-65. Spinner Data Members

Data Members

Type

Read

Write

Description

graphicl-graphicN

numeric

yes

no

Denotes which display of this object
will appear on an HTML report. Only
one display is available for the
ActiveX object.

Comments Spinners are typically used to represent flow through a line or to show a

motor running.
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Spreadsheet permanently stores data to disk in spreadsheet files. You can
log data on even and uneven intervals, when a data value changes, when

an event occurs, or when any one of these things happen. Hence, you can
implement complex logging criteria to meet almost any data storage need.

After each log, a new row is automatically added to the spreadsheet file.
Lookout can log a new row of data approximately 10 times per second;
however, the time stamps associated with each row are rounded to the
nearest second.

Each spreadsheet file may store any number of data signals. Each data
signal is assigned a spreadsheet column, beginning with column number
two. The first column contains the date and time. The first row contains the
expressions associated with the data in each column. You may create any
number of Spreadsheet objects for a given process.

Create spreadsheet storage object E
M ame: ISheet‘I

— File configuration

— Mechanizms to tigger data logging
Interval logging

Mame =

lSheet‘I— Interval = [30:00

[hh:mm: sz, 35 or variable]

Type: Icsv 'l Lomgim= Ion

Directory tree location
' Daily
& Monthly
 VYearly
' Perpetual

[turnz interval logging on and off]

Log now = I
[log data every time signal goes tue]

™ Logon every data change

— Data field .
Mo data fields:

Ok

Editing field 01 fnew field] = Lo

SavE: | I

Delet Faormat: Field:
ﬂl IGeneraI vl |1

il

Help

Figure 2-80. Spreadsheet Configuration Parameters Dialog Box
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Lookout Object Reference Manual

Name is the filename used to create a spreadsheet file. Lookout assigns a
DOS filename to each spreadsheet file by adding the Type extension to the
Name. Currently, Lookout supports only one Type: comma separated
value format (. csv). Most database and spreadsheet programs including
Microsoft Excel directly read the . csv file format.

Because the Name parameter is a text expression field, you can create new
.csv files with unique names dynamically. This is especially useful for
recording batch processing data. The definition dialog box Figure 2-76 is
configured so that an operator can enter a batch name using a TextEntry
object before the batch is started. The text expression appends the filename
to the specified path, C: \BATLOG\. So if the operator enters a file name like
BATCH71, then the full path name would be C: \BATLOG\BATCH71.CSV.
When the BatchRun logical signal goes TRUE, Lookout creates the new
.csv file and begins writing to it. When BatchRun goes FALSE, logging
ends, leaving a comprehensive log of all data associated with the batch.

This example forces Lookout to store the . csv file in a particular directory
because it specifies a full path name. If you enter a relative path name like
"\BATLOG\ "&TextEntry1l, the file is located in that subdirectory of the
identified Directory tree location. So, for example, the full path name of
the file might be C: \LOOKOUT\1995\SEP\BATLOG\BATCH71 .CSV.

If you enter just a filename such as "DATA", the file location is based on the
Lookout directory. For example, the full path name of the file might be
C:\LOOKOUT\1995\SEP\DATA. CSV.

If you select Daily, Lookout creates a new file and subdirectory every day
in which to store the data. If you select Monthly, Lookout creates a new file
and subdirectory every month in which to store the data. If you select
Yearly, Lookout creates a new file and subdirectory every year. Perpetual
files are stored in the root directory as specified by your Data files location
parameter.
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The following examples are the DOS filenames and directory trees created
by Lookout for a spreadsheet file named, DATA.

Daily Yearly
c:\lookout\1993\sep\09\data.csv c:\lookout\1993\data.csv

\sep\1l0\data.csv \1994\data.csv

\sep\ll\data.csv \1995\data.csv

Monthly Perpetual

c:\lookout\1993\sep\data.csv c:\lookout\data.csv

\oct\data.csv

\nov\data.csv

The Mechanisms to trigger data logging are a set of tools used to create
a simple or complex logging scheme, as desired. Use these parameters to
log data based on a timer, event, or any combination of the two. When the
spreadsheet is triggered, all data in the Data fields is logged to disk.

Interval is a numeric expression used to create a Pulse timer with a pulse
period of the specified time period and a pulse duration of zero. Normally
this is a time formatted constant value such as 15:00 (fifteen minutes),
for example.

Logging is a logical expression that turns the Interval parameter on and
off. It could be a switch on a control panel, a logical input from an external
device, or a more complex expression. Normally this is a constant value,
ON or OFF.

Log now is a logical expression. When Log now transitions from OFF to
ON, Lookout logs the data. A transition from ON to OFF has no effect. This
expression could be a pushbutton on a control panel, a logical signal from
a device, or a more complex expression.

The Log on every data change option should be used with care. When
turned on, it triggers the logging of data any time any one of the data fields
experiences a change. This is normally used to log the starting and stopping
of pumps, opening and closing of valves, or other similar events. If your
data fields contain even a single analog value that changes often, you could
end up triggering the logger thousands of times. Or if they contain a logical
value that changes frequently, you could have the same problem.

© National Instruments Corporation 2-225 Lookout Object Reference Manual



Chapter 2 Lookout System Objects

The Data fields window lists all expressions that have been entered for
logging in the order of their field number.

The Save button saves your new or modified expression in the Data fields
window along with a new field number if any. Normally, Data fields
contain simple expressions like PL.C1 . Tanklevel.

The Delete button deletes the currently selected expression from the data

fields list.

The Format option specifies the numeric format assigned to the currently
selected numeric expression when it is logged to disk. This has no effect on
logical or text expressions.

Field indicates the number of the currently selected data field.

@ Note Field numbers should not be modified after data has been stored or the data will not
appear under correct headers until a new file is created.

Spreadsheet Data Members

Table 2-66. Spreadsheet Data Members

Data Members Type Read | Write Description
logged logical yes no Spreadsheet file update pulse. The
Spreadsheet object generates this
logical pulse with a pulse duration of
zero after each successful log.
Lookout Object Reference Manual 2-226 ni.com



Chapter 2 Lookout System Objects

SqlExec

SqlExec is an object Lookout uses to communicate with the ODBC driver.
ODBC allows Lookout to connect to any database that supports ODBC.

SqlExec connects to ODBC using the standard ODBC calls, and queries the
database using SQL statements. The data, if any, is returned in the object
data members.

Create Sql E
Mame: I
D ata Source=
S0L=
Alarm priority: IS_
™ Buffer SOL
QK I Cancel | Help |

Figure 2-81. SqlExec Configuration Parameters Dialog Box

Data Source specifies the Data Source Name (DSN) as well as any other
parameters needed by the ODBC driver to make the connection to the data
source. For example if you want to connect to Excel 4.0, use:

"DSN=Excel Files; DBQ=C:\pathname;"
SQL is the SQL string you want to pass to the ODBC driver.
Alarm Priority determines the priority level of object-generated alarms.

Buffer SQL tells the SqlExec object to buffer any entries that fail for that
object. An entry consists of the Data Source string and the SQL string.
While Lookout does install a Lookout ODBC driver, you must manually
create your own data source in order to access the Citadel database using
ODBC. Consult Chapter 8, Structured Query Language, of the Lookout
Developer’s Manual for information on how to create your Lookout data
source.
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@ Note Some applications are not completely ODBC compliant. If you plan to use
Microsoft Query, Microsoft Access, or Microsoft Visual Basic, ensure that the maximum
column name length does not exceed 62 characters. These applications cannot handle
longer names. Applications that are completely ODBC-compliant can handle names up to
126 characters long. All traces whose names exceed the maximum column name length are
excluded from queries.

Because Lookout objects may include network path information in their names, and
because you can arrange Lookout objects in hierarchies inside your processes, you may
find it easy to exceed the 62 and 126 character limitations of ODBC. Consideration given
to naming and organizing objects can minimize the risk of encountering this difficulty.

SqlExec Data Members

Table 2-67. SqlExec Data Members

Data Member Type Read | Write Description

cl —c65535 numeric yes no Value of the nth column in the row
returned by ODBC.

cl.logical — logical yes no Value of the nth column in the row

¢65535.]logical returned by ODBC.

cl.txt — c65535.txt text yes no Value of the nth column in the row
returned by ODBC.

Execute logical no yes Executes the submitted SQL
statement when it receives a change
from low to high.

Failure logical yes no High if the last submitted query
failed.

QueryString text yes no SQL Query String

ReadOnly logical yes yes If TRUE, opens the file in read only
mode.

If FALSE, opens the file in read write
mode.

Status logical yes no High when the object is processing a
query.
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SqlExec Comments

The placement of the data in the data members is determined by the SQL
string. If you submit the SQL string

"select Album, Artist, NumTracks from cdTable
where NumTracks>5"

the return value for Album is contained in the data member c1 . txt, Artist
in c2. txt, and NumTracks in c3. This value is displayed according to the
data member you choose—Text, Logical, or Numeric. If you connect both
to c1 and c1.txt, you are connecting to the same value twice. In these
circumstances, the value is represented in a different form.

A select statement only returns the first row that it encounters with the
matching criteria. An update statement updates all the rows it encounters
with the matching criteria.

If you connect your SqlExec object to a timer that pulses faster than several
times per second, Lookout may become so busy handling SQL queries that
it becomes unresponsive to user input from the mouse or keyboard.

Comma Separated Value (CSV) files are supported in ODBC. You can
append data to them using the SQL insert command, but you cannot update
records using the SQL update command. This is a limitation of the CSV file
format.

»  Excel files are accessible through ODBC, but they do have some
unusual properties.

* If you use SqlExec to update an Excel 5.0 or greater workbook, the
workbook must be closed and have multi-user editing turned off.

» Ifyou are just trying to read from a workbook using a select query, then
multi-user editing can be on, and the file can be opened or closed.

* If you try to access an Excel 5.0 or greater workbook while it is open
and multi-user editing is off, Lookout locks up until the Excel file is
closed. This is caused by a problem in the Excel ODBC driver.

* If you are using Excel 4.0 you can update or read from the worksheet
only when it is closed. If you try to access an Excel 4.0 worksheet
while it is open, you will receive an alarm in Lookout.

Citadel is also accessible through ODBC, but is opened exclusively in
read-only mode to protect the integrity of the data.

The following table lists a few sample DSN and SQL strings for connecting
to different types of databases through ODBC. Notice that they differ
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slightly from database to database. Remember that Data Source and SQL
are expressions. If you enter a string into the expression box, the string must
be properly set off by quotes. The strings in the following table appear
exactly as you would type them into Lookout.

Database Type Data Source String SQL String
CSV DSN=Text Files; "select Priority, ""Date &
DBQ= c:\ldev\ald2csv; Time," "Description from
alarm.csv where
Priority = 4"
Excel 4.0 DSN=Excel Files; select Priority," "Date &
DBQ= c:\ldev\ald2csv; Time," "Alarm Codes
(Set :Reset :Acknowledge",
"Description from alarm.xls
alarm where Priority = 4"
Excel 5.0 DSN=Excel Files; "select Priority," "Date &
Time," "Alarm Code
(Set:Reset:Acknowledged) , "
"Description from Tablel
where Priority = 4"
MS Access DSN=MS Access 7.0 "select Title, AlbumID,
Database; Length from tracks where
DBQ=c:\My Documents\ TrackID = 7"
compact .mdb;
Citadel DSN=Citadel 4.0 database; | "select Interval,

LocalTime," "Waves.Square"
"from Traces where
Interval = 0:1 and
LocalTime >" "2/14/97
14:34:30"

SQL Command Buffering

The SQLExec object can create a buffer for SQL commands so that
commands are not lost if the connection to the database is temporarily lost.
Buffering stores failed commands in a file so that they can be resubmitted
once the connection to the database is reestablished.

If you check the Buffer SQL check box in the Create SQL dialog box, the
object buffers entries that fail for the following reasons.

¢ Unable to connect to data source: error code 08001.

e Connection in use: error code 08002.
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e Communication link failure: error code 08SO1.

e Drivers SQLAIllocEnv failed: error code IM004.

¢ Drivers SQLAllocConnect Failed: error code IM0O0S5.
*  Unable to load translation DLL: error code IM009.

Entries are not buffered for any other error codes. This is to prevent entries
that always cause an error from being buffered, such as a syntax error in an
SQL string.

You should only enable buffering for SqlExec objects that are inserting new
data into a database, such as an SQL insert command.

When entries are being buffered, they are buffered according to the data
source with which they are trying to connect. This prevents an SqlExec
object being buffered for an Excel data source from blocking an SqlExec
object connected to an MS Access data source.

Separating the buffers by data source also keeps entries from different
SqlExec objects trying to connect to the same data source in their proper
chronological order.

If an SqlExec object has to buffer data, it keeps the data in a directory called
dsndata in your Lookout data directory. The data is kept in a . csv file,
you can view in Excel. Do not try to view these files while Lookout is
running.

Once an object starts buffering, it buffers all subsequent entries to that data
source for all objects that have buffering turned on. Because of this, an
entry with a syntax or other error that should not be buffered, can be
buffered. If this occurs, the buffering system discards that entry after the
entry is passed to ODBC and ODBC returns an error. You are not notified
when the entry is discarded.

If an object has buffering turned off, and that data source is currently being
buffered, then that entry bypasses the buffer entirely. It then either succeeds
or fails according to the state of the connection to the data source.

If a data source has buffered data, the buffering system automatically tries
to reconnect to the data source periodically. Once it connects, it clears the
buffer by periodically de-queuing the first few entries and sending them
to ODBC.

During buffering, the Failure data member has a slightly different
meaning. If it is high, then the first entry in the buffer failed and was kept
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in the buffer. If it is low it means that the first entry in the buffer was
successfully submitted to ODBC, and objects are still being buffered until
the buffer can be cleared.

If you are creating and testing a process file, you may accumulate a large
amount of buffered data in the dsndata directory. You can safely delete

this directory when Lookout is not running. You will lose all the buffered
data, but the SqlExec objects then loads with no errors or alarms.

SqlExec Status Messages

Lookout Object Reference Manual

ODBC Environment not allocated. No buffering will occur

Indicates that memory could not be allocated for the connection to ODBC.
This only occurs if your system is about to run out of memory. No buffering
occurs if this alarm is set. Data that has already been buffered is not lost.

ODBC(32).DLL Not loaded

Indicates that the DLL could not be loaded. No buffering can occur if this
alarm is set. Data that has already been buffered, is not lost.

Data Source Name: Objects are being buffered for this data source

This indicates which data sources are being buffered. Once the buffered
entries have been cleared, the alarm ceases.

Incorrect data source string, check syntax

This means that the Data Source string is missing the DSN=driver name;
pair.

SqlExec displays any error messages that it receives from ODBC as an
alarm. If the error is an error that should cause buffering, the status message
indicates whether the entry was buffered or not buffered. Each message
returned by ODBC belongs to the ODBC group. Some of the more common
ODBC error messages are:

[Not Buffered] 37000/-3100: [Microsoft][Driver Name] Syntax error in
query expression ¢ ...’

The SQL string has a syntax error in it.

[Not Buffered] S1000/-1811 [Microsoft][Driver Name]Couldn’t find
file ‘(unknown)’

This usually means that your data source expression is incorrect, or you
have ODBC configured incorrectly for that data source expression, such as
trying to connect to an Excel 5.0 workbook your ODBC Excel driver set up
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for Excel 4.0 worksheets. Check the data source expression and the
configuration of the ODBC driver.

[Not Buffered] 42000/-1809 [Microsoft][Driver Name]can’t update.
Database or object is read-only.

The file has been opened in read-only mode, but you are trying to write to
it. If you have the data member ReadOnly set to TRUE, set it to FALSE.
For some drivers, you can specify in the ODBC administration tool that all
files opened by that driver should be opened in read-only mode. Check the
ODBC configuration if you have ReadOnly set to FALSE and are still
getting this error. For some ODBC drivers (such as Citadel) the file is
always opened in read-only mode to protect the integrity of the files.
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Switch

Switch generates a logical signal for receipt by other objects. Switches
change state when you click on them with a mouse button, trackball,
touchscreen, or space bar on your keyboard.

o - Position source—————————————————
ame:
@ Local
Action verification messages——— " Femote
On= [ WRIE= |
Off =  DDE
SEnyiGe: I
Control security level: ID ¥ Log events :
Tapie: I
IEerm: I
QK | Cancel | Help |

Figure 2-82. Switch Definition Parameters Dialog Box

Use Action verification messages to create dynamic text expressions to be
displayed in message dialog boxes. See Chapter 6, Security, in the Lookout
Developer’s Manual for more information on security.

Switch1 =]

@ Are You Sure?

Figure 2-83. Verification Message Dialog Box

Position source determines where the value of the Switch resides. Local
indicates the value of the Switch lies within the object itself—on the control
panel. If the switch is up the signal is ON, if down the signal is OFF.

Remote Switches get their values from a remote source, often the register
on a controller they are connected to. Flipping the Switch changes the status
of the register, and changing the status of the register flips the switch.

The Remote option is especially useful when you want to prevent Lookout
from changing the value of setpoints or registers upon initial startup, or
reconnection of lost communication.

The Remote option calls for a URL to locate the data member you want to
connect to. The URL field is green, and you cannot use a complex
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expression as a URL. If you need to use one RadioButton for several
purposes, you can use a Symbolic Link to make a more complex connection
than that possible with a URL.

You can right-click in the URL field and use the URL Editor dialog box
to assemble the URL, in the same way you use the Lookout expression
editor.

A remote position source connection is completely reciprocal. A change in
your Lookout control changes the data member that control is remoted to.
Any change in that data member also changes the control. It is not
necessary, and is incorrect, to use the Edit Connections dialog box to
connect a control object to its controlled data member.

Because the remote connection is reciprocal, you can only make such a
connection to a data member that is either writable, or readable and
writable.

When a process with remoted controls first opens, those controls take their
initial values by following the URL to read the data members they are
remoted to. The control will be covered by a red X to indicate that the
remote connection is not functioning.

E Note You should use Remote to connect a control in a client process to a data member in
a server process. Connections inside a single process can be made using Object»Edit
Connections.

Because complex expressions are read-only values, you cannot remote
directly to them. For the same reason, you cannot remote one control to
another control’s (intrinsic) data member (though you can remote a
control to another control’s value data member).

Much like Remote Switches, DDE (Dynamic Data Exchange) Switches get
their values from a remote source. This could be a cell in a spreadsheet,
another DDE aware application, or a second copy of Lookout running on
the network. See Chapter 5, Dynamic Data Exchange, in the Lookout
Developer’s Manual for more information on Service, Topic, and Item
parameters.

Control security level specifies the minimum security level operators must
have to gain access to this individual object, and thus control it.

The Log events option creates a permanent audit trail for the object—who
did what and when. All adjustments of the Switch are logged to disk,
including the time the Switch was flipped, the operator’s account name,
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and the direction the Switch was flipped. See Chapter 7, Logging Data and
Events, in the Lookout Developer’s Manual for more information on event

logging.

Display switch: Switchl | ]

¢ Standard

7

COn

NS

N

&«

N
\\\\\\\\\\\\\\

Cancel |

You can replace the standard switch types with custom graphic symbols.
If you decide to use custom graphics, you must specify both symbol
parameters, On and Off. See Chapter 2, Graphics, in the Lookout
Developer’s Manual for more information on creating custom graphic
symbols and the use of transparent pixels.

Switch Data Members

Table 2-68. Switch Data Members

Data Members

Read | Write Description

Type

(implicit)

logical yes no Switch Position

enable

If TRUE (the default), enables DDE.
If FALSE, disables DDE. The default
value is ON. This input is ignored for
non-DDE TextEntry objects.

logical no yes

graphicl-graphicN

Denotes which display of this object
will appear on an HTML report. Only
one display is available for the
ActiveX object.

numeric yes no
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Table 2-68. Switch Data Members (Continued)

Data Members Type Read | Write Description

reset logical no yes While this value equals TRUE, the
control will be set to the value in
resetvalue.

resetvalue numeric no yes Sets the value a control will take when
the reset data member transitions
from FALSE to TRUE.

snapdelay numeric yes yes Sets how long Lookout holds a

control in a new position before
snapping back to agree with an
unchanged source.

value numeric yes yes The current value of the control. If
you have remoted this control, then
value is the current value of the
position source.

visible logical no yes When FALSE, the switch object
cannot be seen on the display panel.
When TRUE, the Switch can be seen
and controlled.

Comments If a switch with more than two positions is needed, use a Pot object instead.

Related Objects Pushbutton, Pot
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Symbolic Links
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A Symbolic Link is a Lookout object you use to make certain kinds of
remote connections easier and more efficient. This object can also be used
to manage failover redundancy in Lookout 4. (Redundancy is not
implemented in the Lookout 4 Preview.)

The Symbolic Link serves as a flexible intermediary between separate
processes whether they are running on one computer or on different
computers.

Create a Symbolic Link using the Lookout object browser. Right-click on
the process or folder into which you want to insert the new Symbolic Link.
The following dialog box appears.

Create Symbolic Link E

M ame: I

Source

% Static

URL = |

' Dynamic

Erpi= I

()8 I Cancel |

The Symbolic Link can represent either a static or a dynamic source. The
Static source is a URL pointing to a computer, process, folder, or object
running in some instance of Lookout on your network. A typical Symbolic
Link set to a process appears in the following illustration.
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Obiject Explorer

y Unlverse -
Hetnork]
E| parolkos dy.natingt. com
I % $Keyboard
I {;&3— $System

o $darm
=8 I‘ [ServeriLink]

3% Server_1_Main_Panel
% Server_1_PLCY

<3 Server_1_Patl

-6y Server_1_wWavefarml
-8 Call_Reset_Values_Panel_PB
-8 Choose_Trends_Rbtn

-8 Client_1_Main_Panel

-8 Client_1_Reset_alues_Panel
(-4 Client_Pot1

Lot Clioer Dotd

As you can see, all the objects in the Server 1 process are represented in
the Symbolic Link [Link to Serverl]. You can drag and drop any of
the objects or data members onto a panel in the process containing the
Symbolic Link, where they will appear as expressions.

The Dynamic source must always be an expression that evaluates as a text
string. When you select this option, you can use text strings and text
variables to prepare the Symbolic Link to be used by a control for remote
connections that cannot be made directly.

For example, you cannot use a complex expression in a Pot control remote
source URL. You can, however, construct a complex expression as the
dynamic source in a Symbolic Link, and then set the URL to connect to that
Symbolic Link.

For instance, the following expression evaluates as two different URLs
depending on the position of Switchl (line breaks inserted for clarity).

tif (Switchil,
"\\.\server 1\Server 1 Waveforml.sinewave",
"\\.\Server2\Server2 Waveform.sinewave")

If you connect a HyperTrend item to the Symbolic Link containing this
dynamic source, changing the switch changes which server provides the
wave form being plotted on the HyperTrend graph.

As another example, because Lookout data is now polymorphic, you can
construct strings using both text and numeric inputs.
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For example, if you create Pot1l with a minimum of 0, a maximum of 9,
and an interval of 1, you can use the expression

"Modbusl1.4001" & Potl

as the entry for the Dynamic option in a Symbolic Link.

You can then use the Symbolic Link to connect a control to Modbus data
members 40010-40019, depending on the setting of Pot1.

While you could not directly remote your control to that range of Modbus
data members, you can make a remote connection from that control to the
Symbolic Link using that dynamic expression.

If you connect the Dynamic expression to a data table, you have a nearly
unlimited ability to have one object control a large number of data
members, either through a cursor control or a radio button control.

Symbolic Link Connection Persistence

Lookout Object Reference Manual

If you use the Symbolic Link object to switch control between a number of
different processes, you may have experienced some difficulty in the
operation of certain remote source connections (related to the length of
time Lookout keeps track of a Symbolic Link connection after you make a
change). Lookout 4.0.1 features a default setting for persistence of values
that should eliminate difficulty for most circumstances.

If necessary, you can change the time a Symbolic Link keeps track of values
after you switch focus, though the need to make such an adjustment should
be rare.

To change the default operation, create a [network] group in the
Lookout.INI file and insert the key SymlinkCacheSeconds.

The default setting for the SymlinkCacheSeconds key is 600 (meaning 600
seconds, or 10 minutes). This is the time after a switch in focus for a
Symbolic Link that Lookout will keep track of values from the previous
Symbolic Link focus. If your Symbolic Link switches back to the original
focus before the time expires, Lookout continues keeping track of values
without interruption, and without having to reestablish connections.

See Appendix C,.INI File Settings for Lookout, in the Lookout Developer's
Manual for more information on using the Lookout .INI file. You can also
refer to the Lookout.INT file topic in Lookout Help for added information.
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$System is a global object. It makes global Lookout data such as the
currently logged in user name and security level available for use in your
process. You can use $System data members just like other object data
members.

The seclevel data member is always an integer value between 1 and 10. This
number represents the Lookout security level of the user currently logged
in. For more information about Lookout security levels, see Chapter 6,
Security, in the Lookout Developer’s Manual.

The time data member represents the current date and time of the system.
Like all time values in Lookout, this is a floating point number in which the
integer represents the date and the fraction represents the time of day. You
can use the various Lookout date and time numeric formats to view this
value in the most convenient format. This data member updates itself every
minute, on the minute. It also updates itself immediately after it is created
or when its process is opened.

The username data member is the account name of the user currently
logged in. For more information about Lookout security accounts, see
Chapter 6, Security, in the Lookout Developer’s Manual.

$System Data Members

Table 2-69. $System Data Members

Data Member Type Read | Write Description

NetworkStatus text yes no Reports the status of the last network
transaction of your computer. You
may need to use this data member in
conjunction with a Sample object to
keep track of high levels of network
activity with many I/O points.

seclevel numeric yes no Security level of the user currently
logged in

time numeric yes no Current operating system time

username text yes no Name of the user currently logged in
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TextEntry
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With TextEntry you can manually enter textual notes with the keyboard.
These notes may contain any combination of numeric and alphanumeric
characters; however, the result of your entry is converted to a text value.
Just like any other text expression in Lookout, your note can be logged to
disk, connected to other data members that accept text signals, and so on.
The note is saved and displayed as a multi-line entry, in which you can use
carriage return. Click the » button to expand the field to multi-line size.

Mew TextEntry: E

[REINE T extEntry

Entry prompt:

— Test source
@ Local

 Femate
’VUHL:= |
 DDE

SEnyiGe: I
Tapie: I
IEerm: I

Contral security level: ID V Logevents

QK I Eancell Help |

Figure 2-84. TextEntry Parameters Dialog Box

Entry prompt is the text that appears at the top of the text entry dialog box
when an operator selects the text entry pushbutton.

Text source determines where the user-entered text resides. Local
indicates the user-entered text lies within the object itself—on the control
panel.

Remote indicates that the user-entered text resides in a remote source,
such as a text expression or another TextEntry object.

The Remote option calls for a URL to locate the data member you want to
connect to. The URL field is green, and you cannot use a complex
expression as a URL. If you need to use one RadioButton for several
purposes, you can use a Symbolic Link to make a more complex connection
than that possible with a URL.
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You can right-click in the URL field and use the URL Editor dialog box
to assemble the URL, in the same way you use the Lookout expression
editor.

A remote position source connection is completely reciprocal. A change in
your Lookout control changes the data member that control is remoted to.
Any change in that data member also changes the control. It is not
necessary, and is incorrect, to use the Edit Connections dialog box to
connect a control object to its controlled data member.

Because the remote connection is reciprocal, you can only make such a
connection to a data member that is either writable, or readable and
writable.

When a process with remoted controls first opens, those controls take their
initial values by following the URL to read the data members they are
remoted to. The control will be covered by a red X to indicate that the
remote connection is not functioning.

@ Note You should use Remote to connect a control in a client process to a data member
in a server process. Connections inside a single process can be made using Object»Edit
Connections.

Because complex expressions are read-only values, you cannot remote
directly to them. For the same reason, you cannot remote one control to
another control’s (intrinsic) data member (though you can remote a
control to another control’s value data member).

Much like Remote TextEntry objects, DDE TextEntry objects get their
values from a remote source. This is the option you use to tie the text to a
cell in a spreadsheet, a database lookup table, or any DDE aware
application—including a second copy of Lookout running on the network.
See Chapter 5, Dynamic Data Exchange, in the Lookout Developer’s
Manual for more detailed information on Service, Topic and Item.

@ Note The last DDE parameters used on any object automatically become the default
values for any new DDE object.

Control security level specifies the minimum security level operators must
have to gain access to this individual object, and thus control it.

The Log events option creates a permanent audit trail for the object—who
did what and when. When selected, all text entries in this object are logged
to disk. Each entry includes the time of the entry, the operator’s account
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name, and what entry was made. See Chapter 7, Logging Data and Events,
in the Lookout Developer’s Manual for more information on event logging.

Lookout presents the following display parameters dialog box after you
define the object. It lets you define the text font and presentation style.

Display TextEntry: TextEntrypl

Tewxt color

I—I—.I—I—..I— % ti‘hac:kgr-:un-:l style I;ame style
.......I_ P Plate Blagk
 Inget  wihite
Background color " Rectangle " Mane
I_D.I_I_..I_ :':. ™ Transparent
ECEEFRERE
™ Justify left & Justify centered € Justify right

[

Fort... |1DptAliaIBo|d

Cancel |

Figure 2-85. TextEntry Display Parameters Dialog Box

TextEntry Data Members

Table 2-70. TextEntry Data Members

Data Members Type Read | Write Description

(implicit) text yes no Current, user-entered text

enable logical no yes If TRUE (the default), enables DDE.
If FALSE, disables DDE. The default
value is ON. This input is ignored for
non-DDE TextEntry objects.

graphicl-graphicN numeric yes no Denotes which display of this object
will appear on an HTML report. Only
one display is available for the
ActiveX object.

reset logical no yes While this value equals TRUE, the
control will be set to the value in
resetvalue.
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Table 2-70. TextEntry Data Members (Continued)

Data Members

Type

Read

Write

Description

resetvalue

numeric

no

yes

Sets the value a control will take when
the reset data member transitions
from FALSE to TRUE.

value

numeric

yes

yes

The current value of the control. If
you have remoted this control, then
value is the current value of the
position source.
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TimeOfxxxx
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TimeOfxxxx are timers that generate a periodic pulse of a specified
duration. The timers are turned on and off by On/off signal. The time
period is defined by the type of timer used—a TimeOfMinute timer has a
one-minute period, a TimeOfYear timer has a one-year time period, and so
on. The output of these timers goes high after the specified Timer offset
has elapsed in the current period and remains high for the specified Timer
duration.

Create TimeDfDay timer: E
Mame: Timerl

On/off signal = l—
Timer offset = l—
Timer duration = I

Dizplay format: lm

Ok | Cancel | Help |

Figure 2-86. TimeOfDay Definition Parameters Dialog Box

The Timer offset and Timer duration can range from 0.0 seconds to a
year, and the effective resolution is 0.01 seconds over the entire range. The
Timer offset plus the Timer duration should always be less than or equal
to the time period.

The object display shows the time remaining before the output changes
state and is updated approximately once per second. It is shown in the
selected Display format. If the On/off signal is OFF, the display
shows OFF.

The On/off signal is a logical expression while Timer offset and Timer
duration are numeric expressions. Normally, these are simple time
constants such as 6:10:20 (six hours:ten minutes:twenty seconds). See
Numeric Data Members in Chapter 2, How Lookout Works, in the Getting
Started with Lookout manual for more information on entering time
constants.
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Table 2-71. TimeOfxxxx Data Members

Data Members

Type

Read

Write

Description

(implicit)

logical

yes

no

Logical timer value

Comments TimeOfxxxx can be used in place of Pulse objects when the pulse needs to
be synchronized with the clock—if a pump should only be allowed to run between the
hours of 8:00 and 17:00 each day, the TimeOfDay timer should be used.

Related Objects DelayOff, DelayOn, Interval, OneShot, Pot
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A Trend object displays a real-time trend graph on a control panel with any
number of logical and numeric trend lines. The Trend graph scrolls from
right to left, with current signal levels at the right end of the graph and the
oldest values scrolling off the left end of the graph.

Unlike the HyperTrend, a Trend object can not display data from the
Citadel Historical database. It can only display data in real time, therefore
it is not necessary to log data to Citadel in order to display it on a Trend
object. See the HyperTrend object class definition for more information on
the HyperTrend.

[X]

Create trend window

M ame: I
Trend width: I
Sample interval; I

 Trendlines
Ma lines Mew ling expression = " Logical ™ Mumeric
Accept | I
Delete | inirmum: b asirnuim:
o 100
Freyiaus |
Lire color
ERY e me o
EFENEEE_
0K | Cancel | Help |

Trend width is the width of the graph in units of time. Graphs may have a
width, or time span, of anywhere from two seconds to one year. The Trend
width in the example dialog box indicates a time span of 1:00:00 or one
hour. See Numeric Data Members in Chapter 2, How Lookout Works, of the
Getting Started with Lookout manual for more information on entering time
constants.

Sample interval specifies the frequency at which values are captured for
plotting. The Trend object divides Sample interval into Trend width to
determine how many data points to temporarily save for each trend line.
Lookout stores these data points within the trend object, in RAM. For this
reason, you should carefully choose Sample interval. Typically, no more
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than 100 to 200 points need to be stored for each trend line, less for data
that does not change rapidly. Because most computer display resolutions
cannot take advantage of more than about 800 data points, it is rarely
necessary to exceed that limit.

The Trendlines parameters are used to add, modify, or delete expressions
from the trend graph. The data field to the right of the Accept button is used
to enter logical and numeric expressions for plotting. The Logical and
Numeric selections must be set to correspond with the current expression
result.

Line color specifies the color of the trend line for the current expression.

Minimum and Maximum settings determine where on the trend graph the
expression is plotted. Minimum is the bottom of the graph and Maximum
is the top of the graph, regardless of the range of the expression. These
settings create an imaginary vertical scale and affect each expression
independently, so that you can plot trend lines on any section of a trend
graph.

For example, take two numeric expressions, both of which range from 0 to
50. Set the Minimum and Maximum to 0 and 100 on the first expression,
and —50 and 50 on the second. The first expression is plotted in the bottom
half of the chart while the second expression is plotted in the top half of the
chart, even though they both fluctuate between 0 and 50.
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This shows the imaginary scale of the first expression, where min.=0 and
max.=100. Because the expression ranges from 0 to 50, it is plotted in the

bottom half of the graph.
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This figure shows the imaginary scale of the second expression, where
min.=—50 and max.=50. Because the expression ranges from 0 to 50, it is

plotted in the top half of the graph.

When both expressions are entered on a single trend graph, you get the
following effect. Notice the custom scales on either end of the graph.
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If Logical is selected for the expression type, the minimum and maximum
settings change to Position and Height. These two values now represent a
number between 0% and 100%, and determine the baseline location of the
trend line and its unit height when the expression goes TRUE.
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@ Note Full-height logical plotting is not available in the Trend object. For full-height
logical plot display, use the HyperTrend object class.

When you finish entering or modifying the trend line parameters, click the
Accept button. This adds the expression to the Trendlines list. The Delete
button is used to delete the current expression from the trend graph.

The Previous and Next buttons navigate through a list of the expressions
named for the current trend object.

You can display trend graphs in various colors with different teemingly
styles and grid spacing. Right-click a trend object to modify the chart
appearance.

Timeline labels determine where and how the date and time are to be
displayed on the trend graph.

Major increments specifies the number of heavy horizontal grid lines
on a trend graph. This value is independent of the range of any trend
expressions.

Minor increments specifies the number of light horizontal grid lines
between the major increment grid lines on a trend graph. This value is
independent of the range of any trend expressions.
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Trend Data Members

Table 2-72. Trend Data Members

Data Members

Type Read | Write Description

graphicl—graphicN

numeric yes no Denotes which display of this object
will appear on an HTML report.

visible

logical no yes When TRUE, the trend becomes
visible on the control panel. When
FALSE, the trend is invisible. The
default value is TRUE.

Any number of trend lines can be displayed on a given trend, but too many
lines can confuse the information you are trying to display. Consider this
when deciding how many lines to show on one Trend.

Trends should usually be displayed with custom scales along the vertical
axes. Trend displays are updated as quickly as once per second, depending
on screen resolution, the size of the trend graph, and the trend width setting.
Computers with slow display adapters may be slowed down considerably
when a large trend graph is displayed that is being updated once per second.
On slower computers with slow display cards (no graphics coprocessor),
consider limiting the size of fast-moving Trends to less than one fourth the
screen size.

Trend objects save trend line data points to the Lookout state file (.L4T)
periodically as defined in the System Options dialog box, and any time you
close your process file or exit Lookout. For this reason, you do not lose the
plot lines shown on your trends if you exit Lookout or if your computer
crashes.
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The Waveform object generates cosine, sine, square, sawtooth, triangle,
and random waveforms.

Create Waveform

Taa:

—Waveform Parameters

Period = |u:u1
Amplitude = |1
Offzat = Ig
Phase =
[degrees] IEl

— Sample Parameters

Sample Rate = IU:UU.'I

Sample = I

Ok | Catcel |

The Waveform object produces output by sampling the desired waveform
at the specified Sample Rate. The Period (in days), Amplitude, Offset
(level shift), and Phase (in degrees) of the generated waveforms can be set
to any numerical expression. A single Waveform object can be used to
generate multiple waveforms of varying relative phases, all with the same
Period, Amplitude, Offset and absolute Phase.

Lookout samples a waveform when the logical expression Sample
transitions from FALSE to TRUE. This can be a simple expression like the
signal from a pushbutton, or it can be a complex algorithm.

Sample Rate is a numeric expression that determines how often to sample
the waveform. Lookout converts the numeric value of Sample Rate into a
time signal that represents days and fractions of a day. The Waveform
object then samples the waveforms at the specified time interval. Normally,
this will be a simple time constant such as 0:01 (one second).
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When the Period of the waveform is changed, the waveform must be phase
shifted so that there is a smooth transition to the new frequency. This is
handled internally by the Waveform object and does not effect the Phase
parameter.

As aresult, multiple waveform objects will not be in phase with each other
if one or more have had their Periods changed. To reset a waveform so that
it will again be in phase with other waveforms, use the Reset connection.
See Waveform Comments for a more detailed discussion of phase.

Each waveform output (except random) has 361 separate data members for
generating waveforms of different relative phase shifts. For example,
cosine0 (or just cosine) is a cosine wave of 0-degree relative phase shift,
cosine90 is a cosine wave with +90 degrees relative phase shift, and
cosine_90 is a cosine wave with —90 degrees relative phase shift.

Waveform Data Members

Table 2-73. Waveform Data Members

Data Members Type Read | Write Description
cosine_180 — cosine180 numeric yes no Cosine waveform output.
random numeric yes no Random waveform output.
Reset logical no yes Resets the phase shift to zero

when changed from OFF to ON.
(See comments on phase in
Waveform Comments.)

Sample logical no yes When this transitions from false
to true, the waveform is sampled.

SampleRate numeric no yes Specifies the rate at which the
waveform will be automatically
sampled.

saw_180 — saw180 numeric yes no Sawtooth waveform output.

sine_180 — sine180 numeric yes no Sine waveform output.

square_180 — square180 numeric yes no Square waveform output.
triangle_180 — triangle180 | numeric yes no Triangle waveform output.
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Waveform Comments

A waveform is a function of time whose values repeat every period. The
total phase shift of the waveform determines where, in its cycle, the
waveform starts at time t = 0 (midnight on the morning of the January 1,
1900 for Lookout). Two waveforms that start at the same place in their
cycle at t = 0 (that is, same total phase shift) are said to be “in phase” with
each other.

For a waveform generated by a Waveform object, the total phase shift is
equal to the absolute phase shift as specified by the Phase parameter, and
by the relative phase shift specified by the selection of a particular data
member (for example, cosine 90). Because the phase is defined in terms of
absolute time, two waveform objects with the same Period and Phase will
generate waveforms that are in phase with each other.

However, if the Period of one of the waveforms is variable (for example, if
it is connected to a Pot object) and changes, the absolute phase of the
waveform will be changed. This additional phase shift is handled internally
by the Waveform object, and is only noticeable by the fact that it can
produce an undesirable phase shift between two Waveform objects that
have the same Period. For this reason, you may want to use the Reset data
member to reset this internal phase shift.

@ Note The Phase parameter is in degrees. A Phase of 180 degrees will shift the waveforms
one half period ahead. For example if the Period is 1 day and the Phase is 180 degrees,
then the shift will be one-half day.

Phase . 180°

1
W X Period = W X 1d61y— Eday
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XBarR

The XBarR object class is one of the Lookout Statistical Process Control
(SPC) tools and can play an important role in your Total Quality
Management (TQM) program. This object class graphically displays an
X-Bar chart and/or an R chart for a given signal. These control charts
(also called mean and range charts, respectively) enable you to track your
process to determine if it is about to go out of control and needs corrective
attention.

Create X-Bar/R Chart E

M ame:

0K

Observed signal = I
Cancel

Observed trigger = |

L

Reset = I Help

Sample Set

Mumber of zamples to display = IBD

Mumber of observations per sample = |5

H-bar Chart Lirnit R Chart Lirrit:

UCL = I— UCL = I—
CL= I— CL= I—
LCL = I— LCL = I—

Figure 2-87. XBarR Definition Parameters Dialog Box

The XBarR object reads the Observed signal value any time the Observed
trigger transitions from OFF to ON. When the object collects the specified
Number of observations per sample (2 — 25), it calculates the mean and
range and plots them on their respective charts. Each chart plots the
specified Number of samples to display.

X-bar Chart limits and R Chart limits can be specified or calculated, as
you choose. The object continually calculates chart limits based on new
samples as they are accumulated. These calculated limits enable you to
track your process for a time to determine limit settings that your process
is capable of operating within. Once you know what limits your process can
normally handle, you can specify the chart limit parameters by entering
them directly.

LCL and UCL chart limits identify the lower and upper control limits.
These outer limits generally define the range of process acceptability.
CL identifies the centerline. For the X-bar chart, the centerline is the mean
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of sample means. For the R chart, the centerline is the average of the sample
ranges.

You can display X-bar charts and R charts in various colors with different
label styles and grid spacing.

Display X-Bar/R Chart: XbarR1
Chart Type———
+ ¥Bar
R

Paper calar

Grid colar

Lire colar

[ .

ErETEEE

Cantral it line color

[ [ ..
HTEE ..

Sample labels

Harizontal grid style

™ Vertical .
b ajor increments |1D
 ertical [small) l

© Harizantal tinar increments |2
" Horizontal [small]
Mo labels

Canicel |

Figure 2-88. XBarR Display Parameters Dialog Box

When you enter the LCL, UCL and CL chart limit parameters for a chart,
the entered values represent the limits shown on the chart. The following
X-Bar Chart shows upper control limit, center line, and lower control
limit entered as constants. The chart shows that the majority of the last

30 samples are running a bit under the centerline, suggesting that the
process may need to be adjusted. The calculated control limits, shown
below the graph, indicate new limits that might be used based on the current
plotted samples.
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Figure 2-89. X-Bar Chart Showing Upper Control Limit, Center Line,
and Lower Control Limits

If you leave one or more of the limit parameters blank for a chart in the
definition parameters dialog box, the chart shows its calculated limits.
As you can see in the following R chart, the calculated limits and the

plotted limits are the same.

Figure 2-90. R Chart Showing Upper Control Limit, Center Line, and
Lower Control Limits as Calculated Based on Plotted Samples
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XBarR Data Members

Table 2-74. XBarR Data Members

Data Members Type Read | Write Description

graphicl-graphicN numeric yes no Denotes which display of this object
will appear on an HTML report. Only
one display is available for the
ActiveX object.

R_ChartMax numeric yes no Identifies the top of the Range chart
graph (the value of the plotted line
when it is at 100 percent of the

Y axis). The object recalculates this
value as each new sample is read to
ensure that the plotted line is always
visible on the graph.

R_ChartMin numeric yes no Identifies the bottom of the Range
chart graph (the value of the plotted
line when it is at zero percent of the
Y axis). The object recalculates this
value as each new sample is read to
ensure that the plotted line is always
visible on the graph.

R_CL numeric yes no Centerline of range chart showing
average of sample ranges calculated

as follows:
2R
R =izl

n

R_LCL numeric yes no Lower control limit of Range chart,
calculated using the sampled data as
follows:

LCL=D;R

where Dj is from any standard
3-sigma control factors table
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Table 2-74. XBarR Data Members (Continued)

Data Members Type Read | Write Description

R_Sample numeric yes no Calculated range, R, of the last
completed sample of observations,
defined as the difference between the
maximum and minimum observations
in the sample.

R_UCL numeric yes no Upper control limit of Range chart,
calculated using the sampled data as
follows:

UCL = D,R

where D A is from any standard
3-sigma control factors table

Visible logical yes yes When TRUE, the X-bar and R charts
become visible on the control panel.
When FALSE, they are invisible. The
default value is TRUE.

Xbar_ChartMax numeric yes no Identifies the top of the X-bar chart
graph (the value of the plotted line if
itis at 100 percent of the Y axis). The
object recalculates this value as each
new sample is read to ensure that the
plotted line is always visible on the
graph.

Xbar_ChartMin numeric yes no Identifies the bottom of the X-bar
chart graph (the value of the plotted
line if it is at zero percent of the

Y axis). The object recalculates this
value as each new sample is read to
ensure that the plotted line is always
visible on the graph.

Xbar_CL numeric yes no Centerline of X-bar chart showing the
mean of sample means, calculated as
follows:
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Table 2-74. XBarR Data Members (Continued)

Data Members

Type

Read

Write

Description

Xbar_LCL

numeric

yes

no

Lower control limit of X-bar chart,
calculated as follows:

LCL=%-A,R

where A, is from any standard
3-sigma control factors table

Xbar_Sample

numeric

yes

no

Calculated mean of the last completed
sample of observations, where

Xbar_UCL

numeric

yes

no

Upper control limit of X-bar chart,
calculated as follows:

UCL=X+A,R

A, .
where * 2 is from any standard
3-sigma control factors table

Related Objects Average, Histogram, Maximum, Minimum, Sample

Related Functions Avg, Max, Min, Stdev, Stdevp, Sum, Var, Varp
Refer to the Lookout Developer’s Manual for more information.
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XChart

Lookout Object Reference Manual

The XChart object class graphically plots the value of an observed signal
on a chart in response to a trigger signal.

Create X Chart E

M ame:

Observed signal = I

Observed trigger = |

Reset = I

Mumber of zamples to display = IBD
# Chart Control Limits———————
UCL = I—
CL= I—
LCL = I—

QK | Cancel | Help |

Figure 2-91. XChart Definition Parameters Dialog Box

The XChart object reads the value of the Observed signal any time the
Observed Trigger transitions from OFF to ON.

Xchart plots the specified Number of samples to display. When it reaches
the limit set by that parameter, it removes the oldest point before plotting

the newest one. Number of samples to display must be between 2-4000.
All the points on the chart are cleared any time Reset transitions from OFF
to ON.

XChart Control Limits can be specified or calculated as you choose. If
you leave the values in this section of the dialog box open, the object
continually calculates chart limits based on new values as they are
accumulated. You can watch your process for a time with XChart
calculating limits to determine the ranges of normal operation, and then
you can set the chart limits directly. Once set, XChart displays limit lines
at the specified settings.

UCL and LCL identify the upper and lower control limit lines. CL defines
the centerline.
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You can display Xcharts in various colors and styles with different vertical
and horizontal grid spacing.

Display X Chart: XChartl E3

Paper color

N (O [ (e

ENENNE.
Grid color

(N [ [

ENEN .
Line color

[ [ . ..

ENETNE.

Catitral limit line colar

[ B ..

HTEE .

Sample labels Haorizontal grid style

" Vertical o
bajor increments |1U
" Wertical [small l

" Harizontal tinar increments |2
¥ Harizontal [zmall]
™ Mo labels

Cancel |

Figure 2-92. XChart Display Parameters Dialog Box

XChart Data Members

Table 2-75. XChart Data Members

Data Members Type Read | Write Description

ChartMax numeric yes no Identifies the top of the chart graph
(the value of the plotted line when it
is at 100 percent of the Y axis)

ChartMin numeric yes no Identifies the bottom of the chart
graph (the value of the plotted line
when it is at zero percent of the

Y axis)
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Table 2-75. XChart Data Members (Continued)

Data Members Type Read | Write Description
CL numeric yes no Centerline of the chart, showing the
mean of the sample, calculated by the
formula:

n

S

CL = =1
n
graphicl-graphicN numeric yes no Denotes which display of this object

will appear on an HTML report. Only
one display is available for the
ActiveX object.

LCL numeric yes no Lower control limit of the chart
(3 standard deviations below CL),
calculated by the formula:

n 2
n in
z (x,')2 —i=l 2 :’11

LCL = CL-3l|=1

n—1

Sample numeric yes no Value of the last sample recorded
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Table 2-75. XChart Data Members (Continued)

Data Members

Type

Read

Write

Description

UCL

numeric

yes

no

Upper control limit of chart. When
calculated, is drawn 3 standard
deviations above CL, using the
following formula:

n 2

n zxi
Z (xi)2 R :;l

UCL = CL+ 3/ =1

n-1

Visible

logical

yes

yes

When TRUE, XChart become visible
on the control panel. When FALSE,
XChart is invisible. The default value
is TRUE.
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XYChart
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The XY Chart object class graphically plots X and Y points on a chart in

response to a trigger signal.

Create X/Y Chart E

M ame:

—#45 Setting

x|

v

Trigger = |

— Chart Setting:

Min % = Jo

Man ¥ = J100

Min'y = Jo

Max' = |1DD

Mumber of points = |1 i}

Reset = I

0K

Cancel | Help |

Figure 2-93. XYChart Definition Parameters Dialog Box

The XYChart object reads the value of the X and Y signals any time
Trigger transitions from OFF to ON and plots the corresponding X/Y point
on the chart in relation to the chart ranges Min X, Max X, Min Y, and

Max Y.

XY Chart plots the specified Number of points. When it reaches that limit,
it removes the oldest point before plotting the newest one. Number of
points must be between 2-4000. All the points on the chart are cleared any

time Reset transitions from OFF to ON.
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You can display X/Y charts in various colors and styles with different
vertical and horizontal grid spacing.

Display XY Chart: XYChartl E
— Chart Type
¥ Paints

¥ Lines

Paper color

L W ..

Line/paint ICD_|DI I_-I_I_--I_ +%
e ] i

Harizantal grid style

Grid color

Wertical grid style

Major increments I'ID Major increments |1U
Minar increments |2 Minar increments |2

Cancel |

Figure 2-94. XYChart Display Parameters Dialog Box

XYChart Data Members

Table 2-76. XYChart Data Members

Data Members Type Read | Write Description

ChartXMax numeric yes no Identifies the right most point of the
chart graph (the value of the plotted
line when it is at 100 percent of the
X axis).

ChartXMin numeric yes no Identifies the left most point of the
chart graph (the value of the plotted
line when it is at zero percent of the
X axis).

ChartYMax numeric yes no Identifies the top of the chart graph
(the value of the plotted line when it is
at 100 percent of the Y axis).
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Table 2-76. XYChart Data Members (Continued)

Data Members Type Read | Write Description

ChartYMin numeric yes no Identifies the bottom of the chart
graph (the value of the plotted line
when it is at zero percent of the

Y axis).

graphicl-graphicN numeric yes no Denotes which display of this object
will appear on an HTML report. Only
one display is available for the
ActiveX object.

Visible logical yes yes When TRUE, X/Y chart become
visible on the control panel. When
FALGSE, it is invisible. The default
value is TRUE.
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Protocol Objects

This chapter describes Lookout Driver and protocol object classes, listed
in alphabetical order. Input parameter syntax and data members are
documented for each object class, along with a description of the
functionality of each object class.
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AB-Logix
AB_PLC2,
AB_PLC5,
AB_SLC500

Lookout uses the AB object classes to communicate with the Allen-Bradley
family of PLC controllers using a variety of interfaces.

Lookout can communicate with a member of the PLC-2 family in the
following ways:

Through a Data Highway Plus (DH+) connection to an Allen-Bradley
1785-KA3 PLC-2 adapter module using an Allen-Bradley 1784-KT,
1784-KTx, or 1784-PCMK card, or an S-S Technologies 5136-SD
direct-link interface card installed in the computer,

Through the serial port using an Allen-Bradley KF2 module (which
converts serial DF1 to DH+) to an Allen-Bradley 1785-KA3 PLC-2
adapter module, or

Through a direct DF1 serial connection to the PLC programming port.

Lookout can communicate with a member of the PLC-5 family in the
following ways:

Through a direct Ethernet connection to the PLC AUI port,

Through a direct DH+ connection using a 1784-KT, 1784-KTx,
1784-PCMK, or 5136-SD card installed in the computer,

Through the serial port via a KF2 module which converts serial DF1 to
DH+, or

Through a direct DF1 serial connection to the PLC programming port.

Lookout can communicate with a member of the SLC-500 family in the
following ways:

Lookout Object Reference Manual

Through a direct DH+ connection using a 1784-KT, 1784-KTx,
1784-PCMK, or 5136-SD card installed in the computer,

Through the serial port via a KF2 module which converts serial DF1
to DH+,

Through the serial port using an Allen-Bradley 1747-KE card
(which plugs into the SLC chassis and converts DF1 to DH 485),

Through the serial port using a stand-alone Allen-Bradley 1770-KF3
communication interface module which converts DF1 to DH 485,
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*  Through a direct DF1 serial connection to a SLC 5/03 or SLC 5/04
programming port, or

*  Through a direct DH485 connection using a 1784-PCMK card in
conjunction with either a 1747-AIC or 1761-NET-AIC module.

Lookout can communicate with MicroLogix 1500 through a client
DF/serial connection to the PLC.

Create Allen-Bradley PLC-5 E
Mame: FLC Address [0 - 77):
Jagn Jn octal

Interface:

CC R

PLC maodel:
o -5
—1784-KT card setting

I PLCEAS A l
|' Card rumber

G1(‘2(‘3(‘4(‘5(‘8("?("8|

Memory address: Part: MNode address:

|D4DD 'l |250 Vl IU octal

[ Card exists in this computer Baud rate:
57.6k A

IRG: 3 C4 C§
[alleards) 10 11 1

PollFiate = |0:01
Pall = |

Communication alarm priority: IS

Fietry attempts: |4 Feceive timeout: (500 msecs

Skip every |5 poll requests after comm failure

Ok I Eancell Help |

Figure 3-1. Allen-Bradley Parameter Dialog Box

PLC Address refers to the PLC network node address setting as
configured on the physical device. If devices share a common Interface,
they require unique addresses. When using DF1 protocol (serial
communications), valid addresses range from 0 to 254 decimal. When
using DH+, valid addresses range from 0 to 77 octal.

PLC Model specifies the particular type of PLC or SLC you are
representing with this object. The PLC Model you select determines
what native data members comprise the object.

PollRate is a numeric expression that determines how often to poll the
device. Lookout polls the device at the specified time interval. Normally,
this is a simple time constant such as 0:01 (one second). See Numeric Data
Members in Chapter 2, How Lookout Works, of the Getting Started with
Lookout manual for information on entering time constants.
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Poll is a logical expression. When this expression changes from false to
true, Lookout polls the device. You can use a simple expression like the
signal from a pushbutton, or a complex algorithm.

Communication alarm priority determines the priority level of the
alarms generated by the AB object.

Retry attempts specifies the consecutive number of times Lookout
attempts to establish communications with a device if it is not getting a
valid response. After it tries the number of Retry attempts specified, the
object generates an alarm and begins to Skip every n poll requests after
comm failure. Once Lookout reestablishes communications, it polls the
device on its regular cycle, as defined by PollRate.

Receive timeout is the time delay Lookout waits for a response from a
device before retrying the poll request.

Interface identifies the type of communication hardware you are using.
The selection you make here determines what protocol parameters you
have to specify. The paragraphs that follow describe interface-specific
protocol parameters.

Allen-Bradley Serial Port Interface Parameters

Lookout Object Reference Manual

The KE/KF/Serial Interface selection enables serial port
communication via a KE card, a KF3 module or KF2 module. When
using your serial port, Lookout employs the Allen-Bradley full-duplex
(peer-to-peer) DF1 protocol. Figure 3-1 shows an Allen Bradley object
configured for serial communications.

Serial port specifies which RS-232C port the object uses for
communication to the physical device.

Data rate, Parity, and Error detection reference the settings on the
hardware device. The AB object classes support both BCC (block check
character) and CRC (cyclic redundancy check) error detection. BCC
provides a medium level of data security. CRC ensures a higher level of
data security. Choose the settings as configured on your PLC or SLC.

Phone number specifies the number to be dialed if the serial port setting
is configured for dial-up. This number only applies to the individual object.
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Allen-Bradley DH+ Interface Parameters

5

Note When you configure an AB_ PLC2, AB PLCS5, or AB_SLC500 for DH+, Lookout
creates a file called ALLBRAD. INI. This file contains the configuration settings that you
enter for your KT card(s). If you plan to run the process file on a Lookout Runtime System,
be sure to copy the INI file along with your process (. 1kp) file to the target computer.

The 1784 -KT, 1784 -KTx, 1784-PCMK, and S-S 5136-SD Interface
selections enable direct connection of your computer to a DH+ network.
The following illustration shows an AB_SLC500 configured for DH+
communications using a 1784-KTx card.

Mame: FLC Address [0 - 31
Jagn Jn decimal
Interface: PLC maodel:

1704- 1H485]
—1784-KT card setting

I SLCE/A3 A l
|' Card rumber

G1(‘2(‘3(‘4(‘5(‘8("?("8|

Memary address:  Max node address: Mode address:

|D4DD 'l |31 decimal ID decimal

[ Card exists in this computer Baud rate:
|192DD 'l

IRG: 3 C4 C§
[alleards) 10 11 1

PollFiate = |0:01
Pall = |

Communication alarm priority: IS

Fietry attempts: |4 Feceive timeout: (500 msecs

Skip every |5 poll requests after comm failure

Ok I Eancell Help |

Figure 3-2. AB_SLC-500 Definition Parameters Dialog Box Configured
for DH+ Communications

Card number selects which network interface card that the PLC is
connected to in case your computer has multiple KT or S-S cards.

Card DH+ node address identifies the address of the interface card in the
DH+ network. Valid addresses range from 0 to 77 octal. The node address
of the card must be unique—that is, it must not be the same as the address
of any other device on the DH+ network.

Memory address specifies the base address location of the selected
interface card memory. Your selection should match the settings on the
card. If you are using multiple interface cards, be sure each card has a
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unique address. The network interface cards use dual-ported memory.
For this reason, if you are using a memory manager such as EMM386 it
is important to add a memory exclusion statement to your CONFIG.SYS
file. The table on the following page lists base memory address selections
and corresponding exclusions for all legal memory addresses for the
1784-KT card.

Use Max node address to maximize the performance of a DH485 network
by assigning addresses to nodes on the network using consecutive numbers
starting with zero. Set the Max node address to the maximum of the
assigned node addresses. By default, the value of this variable is 31, which
is the largest legal address for any node on a DH485 network.

The 1784-KT interface card has on-board network termination resistors.
If you are using such a card and if your computer is the last node on the
network and if the cable does not already have a terminating resistor on it,
then select the Enable link termination resistor check box.

Use the Card exists in this computer check box to instruct Lookout
whether or not to look for the interface card in the computer. Be sure to
check this box when you are ready to start polling your PLCs. When you
check this box and select OK, Lookout initializes the card, activates its
self-test, and downloads its driver firmware. Then polling begins. Leave
the Card exists in this computer check box deselected (this is the default
setting) if the card is not in your computer (for example, if you are
developing a process on a computer different from the one that will be
running the process) or if you do not want to poll any PLC connected to
the card.

If you deselect the Card exists in this computer check box, you are

disabling communications using this interface card with all PLCs
connected to it.
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Table 3-1. Allen-Bradley DH+ Interface Memory Addresses
AB 1784-KTx
Memory AB 1784-KT 1784-PCMK SS-5136-SD
Address Exclude Exclude Exclude* Recommendation

A000 A300-A3FF A000-AOFF A000-A3FF Typically used by VGA
drivers. Use if no other

A400 AT700-A7FF A400-A4FF A400-A7FF . .
option is available.

A800 ABOO-ABFF A800-A8FF A800-ABFF

ACO00 AF00-AFFF AC00-ACFF ACO00-AFFF

B000 B300-B3FF B000-BOFF B000-B3FF Used by MDA & CGA
drivers. Use if no Dxxx

B400 B700-B7FF B400-B4FF B400-B7FF . .
option is available.

B800 BBO00-BBFF B800-B8FF B800-BBFF

BCO00 BF00-BFFF BCO00-BCFF BCO00-BFFF

C000 C300-C3FF CO000-COFF C000-C3FF Typically used by BIOS.
Use if no D tion i

C400 C700-CTFF | C400-CAFF | C400-C7FF s¢ I 10 DXXX OPHOILIS
available.

C800 CBO00-CBFF C800-C8FF C800-CBFF

CCO00 CFO00-CFFF CC00-CCFF CCO00-CFFF

D000 D300-D3FF DO000-DOFF D000-D3FF Normally available. Try to
use one of these first.

D400 D700-D7FF D400-D4FF D400-D7FF

D800 DBO00-DBFF D800-D8FF D800-DBFF

DC00 DF00-DFFF DCO00-DCFF DCO00-DFFF

* The 5136-SD memory exclusions recommended here are based on 16K memory mapping. Because you are using the

SS card to emulate the KT card, there is no advantage to using its 32K memory access capability.

Baud rate (1784-KTx, 1784-PCMK, 5136-SD only) selects the baud rate
of the DH+ network. The default is 57.6k baud. Before selecting a higher
baud rate, be aware of that only a few PLCs (such as the SLC5/04) support
higher baud rates; that every node on a DH+ network must support the baud
rate used on that network; that the maximum network cable length is

smaller for higher baud rates; and that the correct values for the termination
resistors at the ends of the network cable are different for higher baud rates.
Consult the manuals that came with your hardware for more detailed

information.

© National Instruments Corporation
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IRQ (all cards) identifies the interrupt setting of all DH+ interface cards
installed in the computer. This selection should match the IRQ settings
on all of the interface cards.

Assigning an interrupt to the interface card(s) improves overall computer
performance somewhat. Any time one of the cards receives an input, it
generates an interrupt recognized by Lookout.

Caution Be sure to verify that no other drivers or cards are mapped to the selected memory
address or use the same interrupt.

Allen-Bradley Ethernet Interface Parameters

The Ethernet Interface selection enables direct communication between
your computer and a PLC using a standard Ethernet network. The
following diagram shows an AB_PLC5 configured for Ethernet

communications.
Create Allen-Bradley SLC-500 E

M ame:
IAB1
Interface: PLC maodel:
~| [sicsios -
— Ethernet setting

IP address: I
PollFiate = |0:01
Pall = |
Communication alarm pricrity: IS
Fietry attempts: |4 Feceive timeout: (500 msecs
Skip every |5 poll requests after comm failure

Ok I Cancel | Help |

Figure 3-3. AB_PLC5 Definition Parameters Dialog Box Configured
for Ethernet Communications

IP address specifies the Internet protocol address of the PLC. An Internet
protocol address consists of four numbers, separated by periods. Each
number ranges from zero to 255 decimal. Thus, a typical Internet address
might be 128.7.9.231. Ensure that the IP address you enter matches the
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Internet protocol address of the PLC your object represents. You can also
enter the IP address by name.

Using the 5136-SD card from S-S Technologies, Inc.

© National Instruments Corporation 3-9

To use the 5136-SD card, select the S-S 5136-SD interface in the Create

Object dialog box. It is not necessary to run the sdinst . exe program that
ships with the card because Lookout downloads the KT-emulation module
automatically as part of the initialization process. It is, however, necessary
to tell Lookout the port address specified by the switch settings on the card.

Create Allen-Bradley PLC-5 E

Mame: FLC Address [0 - 77):
Jagn Jn octal
PLC maodel:

Interface:

—1784-KT card setting

I PLCEAS A l
|' Card rumber

G1(‘2(‘3(‘4(‘5(‘8("?("8|

Memory address: Part: MNode address:
|D4DD 'l |250 Vl IU octal

[~ Card eists in this computer Baud rate:
57.6k A

IR0: 3 4 CF 7 49

lalcards) 90 11 12 C 15 & none

PollRate = [0:01

Pall = |

Communication alarm priority: IS

Fietry attempts: |4 Feceive timeout: (500 msecs

Skip every |5 poll requests after comm failure

Ok I Eancell Help |

Figure 3-4. AB_PLC5 Definition Parameters Dialog Box Configured
for the 5136-SD card
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Allen-Bradley Register Addressing

Lookout has adopted a sequential, flat addressing scheme for the
Allen-Bradley PLCs. The addresses are sequential by data type, having
nothing to do with the actual slot number. For example, consider the
following slot configuration:

PLC slot Location Type of Module in PLC Slot Channel Address in Lookout
slot 1 16 channel analog input L.O-I:16
slot 2 16 channel analog output 0:0-0:16
slot 3 8 channel input, 8 channel output 1:17-1:24, O:17-0:24
slot 4 16 channel analog input [:25-1:32

You can see from the example, the slot number of the module is irrelevant
to Lookout, and the input channels follow consecutive numbers as the
output channels follow their own consecutive numbers.

Allen-Bradley Data Members

Each AB object contains a great deal of data. All readable and writable
members (inputs/outputs) are bundled with the object. As soon as you
create an AB object you immediately have access to all the object data
members.

The AB object classes automatically generate an efficient read/write
blocking scheme based on the inputs and outputs you are using in your
process file. You are not required to build your own I/O blocking table.
However, you can ensure peak performance by organizing your PLC data
into contiguous groups.

Table 3-2. AB MicroDenotes which display of this object will appear

on an HTML report.Logix Data Members

Data Member Type Read | Write Description
B:0 - B255:255 numeric yes yes 16-bit signed binary word ranging from
-32,768 to +32,767.
B:0_0- logical yes yes One bit within a 16-bit binary word.
B255:255_15
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Table 3-2. AB MicroDenotes which display of this object will appear
on an HTML report.Logix Data Members (Continued)

Data Member Type Read | Write Description

B_O- logical yes yes | One bit within the specified data file. For

B255_4095 example, B3_32 specifies datafile 3, word 2,
bit 1.

C:0.ACC numeric | yes yes Counter accumulated value. Two-byte signed

-C255:255.ACC word ranging from -32,768 to +32,767.

C:0.PRE - numeric yes yes Preset counter value. Two-byte signed word

C255:255.PRE ranging from —32,768 to +32,767.

C:0_CU - logical yes yes | Counter up-enable bit.

C255:255_CU

C:0_DN - logical yes yes Counter done bit.

C:255:255_DN

C:0_OV - logical yes yes Counter overflow bit.

C255:255_0V

C:0_UA - logical yes yes Counter update accumulation bit (HSC in

C255:255_UA fixed controller only).

C:0_UN - logical yes yes Counter underflow bit.

C255:255_UN

C:0_CD - logical yes yes Counter down-enable bit.

C255:255_CD

CommPFail logical yes no Object-generated signal that is ON if, for any
reason, Lookout cannot communicate with the
PLC.

1.0 -1:30 numeric yes yes Unsigned 16-bit input value ranging from O to
65,535.

1:0_0 - logical yes yes One bit within a 16-bit input word.

I:30_15

N:O - numeric yes yes | 16-bit signed integer value ranging from

N255:255 —-32,768 to +32,767.

N:0_0 - logical yes yes One bit within a 16-bit signed integer word.

N255:255_15
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Table 3-2. AB MicroDenotes which display of this object will appear
on an HTML report.Logix Data Members (Continued)
Data Member Type Read | Write Description

0:0-0:30 numeric yes yes Unsigned 16-bit outp.ut value ranging from 0
to 65,535

0:0_0-0:30_15 logical yes yes One bit within a 16-bit output word.

OffHook logical no yes When TRUE, instructs the PLC to retain
exclusive use of its assigned communication
port. This prevents Lookout from hanging up
between polls, saving the redial overhead. This
also prevents other blocks from
communicating over the same channel.

Poll logical no yes When transitioned from FALSE to TRUE, the
Lookout object polls the PLC device.

PollRate no yes Specifies the frequency at which the Lookout

numeric object polls the PLC device.

R:0_FD - logical yes yes Control “found” single-bit logical indicator.

R255:255_FD

R:0.LEN - numeric yes yes Control “length” signed integer ranging from

R255:255.LEN -32,768 to +32,767.

R:0.POS - numeric yes yes Control “position” signed integer ranging

R255:255.POS from —32,768 to +32,767.

R:0_DN - logical yes yes Control “done” single-bit logical indicator.

R255:255_DN

R:0_EM - logical yes yes Control “empty” single-bit logical indicator.

R255:255_EM

R:0_EN - logical yes yes Control “enable” single-bit logical indicator.

R255:255_EN

R:0_ER - logical yes yes Control “error” single-bit logical indicator.

R255:255.ER

R:0_EU - logical yes yes Control “enable unloading” single-bit.

R255:255_EU

R:0_IN - logical yes yes Control “inhibit comparison” flag single-bit

R255:255.IN logical indicator.
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Table 3-2. AB MicroDenotes which display of this object will appear
on an HTML report.Logix Data Members (Continued)

Data Member Type Read | Write Description
R:0_UL - logical yes yes Control “unload” single-bit logical indicator.
R255:255_UL
S:0 - S:96 numeric yes yes PLC status file containing a signed integer
ranging from —32,768 to +32,767 (see
Allen-Bradley documentation).
S:0_0-S:96_15 logical yes yes | Individual PLC status bits (see Allen-Bradley
documentation).
T:0.ACC - numeric yes yes Accumulated timer value ranging from
T255:255.ACC -32,768 to +32,767.
T:0.PRE - numeric yes yes Preset timer value ranging from —32,768 to
T255:255.PRE +32,767.
T:0_DN - logical yes yes Timer “done” single-bit logical indicator.
T255:255_DN
T:0_EN - logical yes yes Timer “enabled” single-bit logical indicator.
T255:255_EN
T:0_TT - logical yes yes Timer “timing” single-bit logical indicator
T255:255_TT Update logical yes no Object-generated signal
that pulses each time the object polls the
device.
Table 3-3. AB_PLC2 Data Members
Data Member Type Read | Write Description
0-7777 numeric yes yes 16-bit signed binary word ranging
from -32,768 to +32,767
0_0-7777_17 logical yes no One bit within a 16-bit binary word
CommPFail logical yes no Object-generated signal that is ON if,
for any reason, Lookout cannot
communicate with the PLC.
© National Instruments Corporation 3-13 Lookout Object Reference Manual
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Table 3-3. AB_PLC2 Data Members (Continued)

Data Member Type Read | Write Description

OffHook logical no yes | When true, instructs the PLC to retain
exclusive use of its assigned
communication port. This prevents
Lookout from hanging up between
polls, saving the redial overhead. This
also prevents other blocks from
communicating over the same channel.

Poll logical no yes When transitioned from false to true,
the Lookout object polls the PLC
device

PollRate numeric no yes Specifies the frequency at which the
Lookout object polls the PLC device

Update logical yes no Object-generated signal that pulses
each time the object polls the device

Table 3-4. AB_SLC500 Data Members
Data Member Type Read | Write Description

B:0 - B255:255 numeric yes yes 16-bit signed binary word ranging
from —32,768 to +32,767

B:0_0-B255:255_15 logical yes yes One bit within a 16-bit binary word

B_0 - B255_4095 logical yes yes One bit within the specified datafile.
For example, B3_32 specifies datafile
3, word 2, bit 1.

C:0.ACC - numeric yes yes | Counter accumulated value. Two-byte

C255:255.ACC signed word ranging from —32,768 to
+32,767

C:0.PRE - numeric yes yes | Preset counter value. Two-byte signed

C255:255.PRE word ranging from —32,768 to +32,767

C:0_CU - (C255:255_CU | logical yes yes | Counter up-enable bit.

C:0_DN - logical yes yes Counter done bit.

C:255:255_DN

C:0_OV - (C255:255_0V | logical yes yes Counter overflow bit.
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Table 3-4. AB_SLC500 Data Members (Continued)

Data Member Type Read | Write Description
C:0_UA - logical yes yes Counter update accumulation bit
C255:255_UA (HSC in fixed controller only)
C:0_UN - logical yes yes Counter underflow bit.
C255:255_UN
C:0_CD -C255:255_CD | logical yes yes Counter down-enable bit.
CommPFail logical yes no Object-generated signal that is ON if,

for any reason, Lookout cannot
communicate with the SLC.

F:0-F255:255 numeric yes yes | Floating point value

I:0 - I:30 numeric yes yes | Unsigned 16-bit input value ranging
from O to 65,535

[.0_0-1:30_15 logical yes yes One bit within a 16-bit input word

N:0 - N255:255 numeric yes yes 16-bit signed integer value ranging
from —32,768 to +32,767.

N:0_0 - N255:255_15 logical yes yes One bit within a 16-bit signed integer
word

0:0- 0:30 numeric yes yes | Unsigned 16-bit output value ranging
from O to 65,535

0:0_0-0:30_15 logical yes yes One bit within a 16-bit output word

OffHook logical no yes | When true, instructs the PLC to retain

exclusive use of its assigned
communication port. This prevents
Lookout from hanging up between
polls, saving the redial overhead.

This also prevents other blocks from
communicating over the same channel.

Poll logical no yes | When transitioned from false to true,
the Lookout object polls the SLC
device

PollRate numeric no yes Specifies the frequency at which the

Lookout object polls the SLC device

© National Instruments Corporation 3-15 Lookout Object Reference Manual



Chapter 3 Lookout Driver and Protocol Objects

Table 3-4. AB_SLC500 Data Members (Continued)

Data Member Type Read | Write Description

R:0_FD - R255:255_FD | logical yes yes | Control “found” single-bit logical
indicator

R:0.LEN - numeric yes yes Control “length” signed integer

R255:255.LEN ranging from —32,768 to +32,767

R:0.POS - numeric yes yes Control “position” signed integer

R255:255.POS ranging from —32,768 to +32,767

R:0_DN - logical yes yes Control “done” single-bit logical

R255:255_DN indicator

R:0_EM - logical yes yes | Control “empty” single-bit logical

R255:255_EM indicator

R:0_EN -R255:255_EN | logical yes yes | Control “enable” single-bit logical
indicator

R:0_ER - R255:255.ER | logical yes yes | Control “error” single-bit logical
indicator

R:0_EU - R255:255_EU | logical yes yes Control “enable unloading” single-bit

R:0_IN - R255:255.IN logical yes yes Control “inhibit comparison” flag
single-bit logical indicator

R:0_UL - R255:255_UL | logical yes yes Control “unload” single-bit logical
indicator

S:0 - S:96 numeric yes yes SLC status file containing a signed

integer ranging from —32,768 to
+32,767 (see Allen-Bradley
documentation)

S:0_0-S:96_15 logical yes yes | Individual SLC status bits (see
Allen-Bradley documentation)

ST9:0 - ST255:255 text yes yes String, limited to 83 characters in
length. See the note on Allen-Bradley
string data members at the end of this

table.
T:0.ACC - numeric yes yes Accumulated timer value ranging
T255:255.ACC from —-32,768 to +32,767
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Table 3-4. AB_SLC500 Data Members (Continued)

Data Member Type Read | Write Description

T:0.PRE - numeric yes yes | Preset timer value ranging from

T255:255.PRE -32,768 to +32,767

T:0_DN - T255:255_DN | logical yes yes Timer “done” single-bit logical
indicator

T:0_EN - T255:255_EN | logical yes yes Timer “enabled” single-bit logical
indicator

T:0_TT - T255:255_TT | logical yes yes Timer “timing” single-bit logical
indicator

Update logical yes no Object-generated signal that pulses
each time the object polls the device

5

Note There is no Allen-Bradley default file type associated with strings. You must

configure your Allen-Bradley device to have a string file. See your Allen-Bradley
documentation for details on this configuration procedure.

The string data member only works with the SLC 500 Enhanced series of PLCs, including
the SLC 5/03; OS301 and SLC 5/04., and with the PLC 5 Enhanced series, PLC 5/11, PLC

5/20, PLC 5/30, PLC 5/40, PLC 5/60, PLC 5/80.

Table 3-5. AB_PLC5 Data Members

Data Member Type Read | Write Description

B:0 - B999:999 numeric yes yes 16-bit signed binary word ranging
from -32,768 to +32,767

B:0_0-B999:999_15 logical yes yes One bit within a 16-bit binary word.

B_0 - For B999_15999 | logical yes yes One bit within the specified datafile;
for example, B3_32 specifies datafile
3, word 2, bit 1.

C:0.ACC - numeric yes yes Counter accumulated value. Two-byte

C999:999.ACC signed word ranging from —32,768 to
+32,767

C:0.PRE - numeric yes yes | Preset counter value ranging from

C999:999.PRE -32,768 to +32,767.

C:0_CD-C999:999_CD | logical yes yes Counter down-enable bit.
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Table 3-5. AB_PLC5 Data Members (Continued)

Data Member Type Read | Write Description
C:0_CU-C999:999_CU | logical yes yes | Counter up-enable bit.
C:0_DN - logical yes yes Counter done bit.
C:999:999_DN
C:0_OV -C999:999_OV | logical yes yes | Counter overflow bit.
C:0_UA - logical yes yes Counter update accumulation bit
C999:999 _UA (HSC in fixed controller only).
C:0_UN - logical yes yes | Counter underflow bit.
C999:999_UN
CommPFail logical yes no Object-generated signal that is ON if,

for whatever reason, Lookout cannot
communicate with the PLC.

F:0-F999:999 numeric yes yes | Floating point value.

I.0 - I.277 numeric yes yes Unsigned 16-bit input value ranging
from O to 65,535.

I.0_0-I:277_17 logical yes yes One bit within a 16-bit input word
(octal).

N:0 - N999:999 numeric yes yes 16-bit signed integer value ranging
from —32,768 to +32,767.

N:0_0 - N999:999_15 logical yes yes | One bit within a 16-bit signed integer
word.

0:0 - 0:277 numeric yes yes | Unsigned 16-bit output value ranging
fromO to 65,535.

0:0_0-0:277_17 logical yes yes | One bit within a 16-bit output word
(octal).

OffHook logical no yes When true, instructs the PLC to retain

exclusive use of its assigned
communication port. This prevents
Lookout from hanging up between
polls, saving the redial overhead. This
also prevents other blocks from
communicating over the same channel.
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Table 3-5. AB_PLC5 Data Members (Continued)

Data Member Type Read | Write Description
Poll logical no yes | When transitioned from false to true,
the Lookout object polls the PLC
device.
PollRate numeric no yes Specifies the frequency at which the

Lookout object polls the PLC device.

R:0.LEN - numeric yes yes Control “length” signed integer

R999:999.LEN ranging from —32,768 to +32,767.

R:0.POS - numeric yes yes Control “position” signed integer

R999:999.POS ranging from —32,768 to +32,767.

R:0_DN - logical yes yes Control “done” single-bit logical

R999:999 DN indicator.

R:0_EM - logical yes yes Control “empty” single-bit logical

R999:999 EM indicator.

R:0_EN - R999:999_EN | logical yes yes Control “enable” single-bit logical
indicator.

R:0_ER - R999:999.ER | logical yes yes Control “error” single-bit logical
indicator.

R:0_EU - R999:999_EU | logical yes yes Control “enable unloading” single-bit
logical indicator.

R:0_FD - R999:999_FD | logical yes yes Control “found” single-bit logical
indicator.

R:0_IN - R999:999.IN logical yes yes Control “inhibit comparison” flag
logical indicator.

R:0_UL - R999:999_UL | logical yes yes Control “unload” single-bit logical
indicator.

S:0 - S:127 numeric yes yes | PLC status file containing a signed

integer ranging from —32,768 to
+32,767 (see Allen-Bradley
documentation).

S:0_0-S:127_15 logical yes yes Individual PLC status bits (see
Allen-Bradley documentation).
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Table 3-5. AB_PLC5 Data Members (Continued)

Data Member Type Read | Write Description

ST9:0 - ST255:255 text yes yes String, limited to 83 characters in
length. See the note on Allen-Bradley
string data members at the end of this
table.

T:0.ACC - numeric yes yes Accumulated timer value ranging from

T999:999.ACC —-32,768 to +32,767.

T:0.PRE - numeric yes yes Preset timer value ranging from

T999:999.PRE -32,768 to +32,767.

T:0_DN -T999:999_DN | logical yes yes Timer “done” single-bit logical
indicator.

T:0_EN - T999:999_EN | logical yes yes | Timer “enabled” single-bit logical
indicator.

T:0_TT - T999:999_TT | logical yes yes | Timer “timing” single-bit logical
indicator.

Update logical yes no Object-generated signal that pulses
each time the object polls the PLC
device.

@ Note There is no Allen-Bradley default file type associated with strings. You must
configure your Allen-Bradley device to have a string file. See your Allen-Bradley
documentation for details on this configuration procedure.

The string data member only works with the SLC 500 Enhanced series of PLCs, including
the SLC 5/03; OS301 and SLC 5/04., and with the PLC 5 Enhanced series, PLC 5/11, PLC

5/20, PLC 5/30, PLC 5/40, PLC 5/60, PLC 5/80.

Allen-Bradley Error Messages

Lookout Object Reference Manual

AB objects report the statuses of commands they issue to AB devices.
When Lookout receives a response from an AB device, it reads the status
(STS) byte and, if necessary, the extended status (EXT STS) byte to verify
the device executed the Lookout command properly. If the command was
not executed properly, Lookout reports the failure as an alarm containing
the status code and its meaning. The following is an example of such an

alarm:

EXT STS

3-20

OF: not enough levels in address

ni.com
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AB object classes can also generate alarms internally. The following is a list
of AB alarms generated by Lookout, their descriptions, and possible
responses. In the messages, KT is used to refer to any of the DH+ interface
cards (1784-KT, 1784-KTx, 1784-PCMK, or 5136-SD) and SS is used to
refer to the 5136-SD card.

Cannot resolve ip address: address

The AB object failed to find any node on the network that corresponds to
the given IP address. Confirm that the IP address entered in the Modify
Object dialog box is correct.

Cannot get session id from plc

The AB object sent a message to the PLC requesting a TCP/IP session and
failed to receive a satisfactory response.

Cannot communicate with device (code=dd)

The AB object timed out while waiting for a response (via TCP/IP) from
the PLC. If the code is 0, the object timed out while trying to establish the
TCP/IP connection; if the code is 1, the object timed out while waiting for
a session id from the PLC; if the code is 2, the object timed out while
waiting for a response to a poll request. Confirm that the IP address of the
PLC has been entered correctly and that the PLC is reachable over the
TCP/IP network.

Download of file sdipds.ss1 failed

Lookout was unable to write the KT-emulation program file to the 5136-SD
card physical memory. This could be due to either an invalid port or
memory address or to a faulty or improperly seated card.

Invalid memory address for card: O0xAAAA

The memory address specified for the card (for example, D400) is not
valid for this model of card. The address must be a multiple of 0x0100 and
lie in the range 0xA000 to 0xDF00. Moreover, the KT, KTx, PCMK, and
5136-SD cards support different sets of valid memory addresses. See the
documentation that shipped with the card for details.

Invalid node address for card: xx

Node addresses must be between 0 and 63 decimal.

Invalid port number for SS card: OxPPP

The port number specified for the 5136-SD card is invalid. See the
documentation that shipped with the card for the list of valid port addresses.
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Invalid port or memory address

Lookout was unable to write to the 5136-SD card physical memory. This
could be due to either an invalid port or memory address or to a faulty or
improperly seated card.

KT card failed to find resources
KT card receive mailbox is in an invalid state
KT card send mailbox is in an invalid state

You will probably never see one of these alarms. If you do, call National
Instruments and ask for technical support.

KT card dual-ported memory test failed at location xxxx

The interface card failed a memory test when it was first powered on.

The memory test reads, writes and rereads the dual-ported memory to
ensure memory access by the card. Verify that the card is configured for the
memory address that you specified. Verify that your memory manager
(like EMM386) excludes the appropriate portion of memory. Verify that
your card is not trying to use the same memory location as another card.
You may need to restart the card by calling up the AB object definition
dialog box and selecting OK. If that does not work try rebooting the
computer. Other causes can include memory conflicts, a bad interface
card, or a misbehaving driver.

KT card CTC test timed out
KT card CTC test failed with status code xx

The interface card failed the Counter Timer Circuit test when it was first
powered on. This test verifies proper functionality of the card timer and
counter modes over all CTC channels. You may need to restart, reseat,
or replace the interface card.

KT card timed out while loading protocol code
KT card failed with status code xx while loading protocol

Lookout was not able to transfer a loader file to the card and subsequently
download the card protocol firmware. Try to restart the interface card by
calling up the AB object definition dialog box and selecting OK. If that
does not work try rebooting the computer.

KT card is no longer responding

The Lookout AB object did not receive the interface card heartbeat within
the last second. Normally, the card generates a heartbeat any time it
receives the DH+ network token. If the alarm does not deactivate after

30 seconds, try to restart the card by calling up the AB object definition
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dialog box and selecting OK. If that does not work try restarting Lookout
or rebooting the computer.

KT card memory address conflicts with card n

Lookout found another interface card with the same memory address.

Be sure that the memory address on each interface card is different and that
the corresponding Memory address in the Lookout object matches the
card address.

KT card not present in this computer

The Card exists in this computer check box is deselected (this is the
default setting). Select Object»Modify to retrieve the PLC definition
parameters dialog box and select the Card exists in this computer check
box and OK to initialize the card.

KT card RAM test timed out
KT card RAM test failed with status code xx

The interface card failed a memory test when it was first powered on.
The memory test writes a pattern to on-board RAM and reads its content to
verify the card memory is working. Confirm that the memory address
specified in the Object»Modify dialog box is correct. You may need to
restart, reseat, or replace the card.

KT card signature test failed

The AB object does not recognize the card. Make sure that the interface
card is actually installed in the PC and that you indicated the correct
memory address in Lookout. You may need to reseat the card, or the
card may require repair. Also ensure that you did not identify more
Card Numbers than actual physical cards.

KT card SI0 test timed out
KT card SIO test failed with status code xx

The interface card failed the Serial Input Output test when it was first
powered on. You may need to restart, reseat, or replace the interface card.

KT card send mailbox timed out

The AB object timed out while waiting for the KT card to signal that it

is ready to be given a new message to send. This is most likely due to a
communication problem between the computer and the PLC. Confirm that
the network cable is properly installed and that the PLC is turned on.
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NAK response received

The AB object received a NAK (not acknowledged) response when it
polled the device. The device received a command from Lookout but it did
not accept the message. The command that the device received may be
incomplete or contain irregularities due to poor network performance. If
your Serial Port is configured for radio, you may need to adjust the RTS
delay off setting. Also consider increasing the number of Retry attempts.

No response — no ACK for our transmission

Lookout is not getting any response from the device. This could be caused
by just about anything. Verify that the Data rate, Parity, and Error
detection scttings are the same as the settings on the device. Make sure you
are using the proper Serial port on your computer. Verify that the device
interface module and other network equipment is connected and working
properly. If you are using a modem, verify that your object Phone number
and the serial port Dial-up settings are correct. This may also be caused by
low level noise or reflections on the highway, or marginal circuitry on

a card.

No response within timeout period
No response received after receiving ENQ

The AB object received an acknowledgment of its poll from the device. The
device accepted the command from Lookout. However, the device did not
appear to send anything else back in response. You may have to increase
Receive timeout to make sure Lookout allows enough time to receive the
message.

EOT response received

The AB object received an EOT (end of transmission) response when it
polled the device indicating that the device did not have a message ready to
give in response to the Lookout poll request. It is unlikely that you will ever
see this error message.

Received TSN does not match

Response message garbled -- bad CRC or bad BCC
Response message garbled -- no DLE EXT
Response message garbled -- bad DLE follower

The AB object is receiving messages from the device. However, the
messages may be failing the selected data integrity test. Verify that the
object Error detection setting is the same as the settings on the device.
Another cause may be that the last part of the message is actually getting
clipped off before it is completed. You may have to increase the Receive
gap Serial Port setting to ensure Lookout is receiving the entire message.
If your Serial Port is configured for radio this could be caused by an audible
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squelch tail occurring at the end of a radio transmission. You may need to
adjust the RTS delay off or the CTS timeout settings. Also consider
increasing the number of Retry attempts.

Socket communications error dd: msg

The AB object has encountered a problem while attempting to
communicate using TCP/IP. The error number dd and corresponding error
message msg give further information. Confirm that the IP address of the
PLC has been entered correctly and that the PLC is reachable over the
TCP/IP network.

SS card failed

This message is suffixed with an error message read from the card itself.
You may need to contact the vendor of your card for technical support.

SS card failed while performing diagnostics

Lookout successfully wrote the KT-emulation program to the 5136-SD
card, but the program failed to terminate. Try running the sdinst . exe
program that ships with the 5136-SD card, using the CHK option to
confirm that the card is working properly.

Unable to access physical memory at segment OxAAAA

Lookout was unable to access the memory at the given segment address.
The memory may already be in use by the operating system or by another
application. Either change the object memory address (which may involve
changing switch settings on the card itself) or, if you are using a memory
manager, make sure that it is excluding the correct portion of memory.

Unable to open port OxPPP for SS card

Lookout was unable to open the port number specified for the 5136-SD
card. Make sure that you have specified the port that is selected by the
jumper settings on the card. Make sure that port and the following two ports
(for example, 250, 251, and 252) are not in use by any other devices in your
computer.

Unexpected data response length
Unexpected response
Unhandled error

You will probably never see one of these alarms. If you do, call National
Instruments and ask for technical support.
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AdvantechPCL

The AdvantechPCL object class enables Lookout to communicate with the
Advantech PC-MultiLab Card, model PCL-711B. The MultiLab Card
installs in your computer and provides one analog output, eight analog
inputs, 16 digital inputs and 16 digital outputs.

Mew Advantech PC-Labcard E
M ame:

Card I/0 port address: | 220 -

Scanning interval: |5D

millizeconds
Communication alarm pricrity: IS

QK I Cancel | Help |

Figure 3-5. AdvantechPCL Definition Parameters Dialog Box

Card I/0 port address indicates the base I/O port address you chose using
DIP switch settings on the card. The Advantech card uses 16 consecutive
I/0O port address locations in your computer. So if you identify base address
220 (hex), it uses addresses 220 to 22F. Valid base addresses range from
000 to 3F0. If your computer does not have an Advantech card installed,
be sure to select no card.

@ Note I/O ports identify to the CPU the location of basic system components such as serial
ports, video cards, and disk controllers. Check your computer hardware manual and add-on
board configurations to be sure you are assigning a unique I/O port address to the
Advantech card.

Scanning interval is a numeric parameter that determines how often
Lookout scans the card for changed values. Valid intervals range from
10 to 1000 milliseconds.

Al gain specifies the input amplification gains of all analog input signals
(AIO — AI7). For the highest possible resolution, you should amplify the
input signals so that their maximum voltage swing equals their maximum
input range. The following table lists recommended settings.

If your maximum voltage range is... use Al gain...
+5V 1
+2.5V 2X
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If your maximum voltage range is... use Al gain...
+1.25V 4X
+0.625V 8X
+0.3125V 16X

Communication alarm priority determines the priority level of the alarms
generated by the AdvantechPCL object class.

AdvantechPCL Data Members

The table that follows lists data members supported by the AdvantechPCL
object class.

Table 3-6. AdvantechPCL Data Members

Data Member Type Read Write Description

AIO — AI7 Analog yes no Analog input where AI0 represents A/D 0
(pin 1 on CN1) and AI7 represents A/D 7
(pin 15 on CN1). Each input is a 12-bit
integer, ranging from O to 4095.

AOQ Analog no yes Analog output where AOOQ represents
D/A (pin 17 on CN1). This output is a
12-bit integer, ranging from 0 — 4095
(+5V or +10V, depending on jumper
JP1).

CommPFail logical yes no Object-generated signal that is on if, for
whatever reason, Lookout cannot
communicate with the card.

DIO - DI15 logical yes no Digital input where DIO represents pin 1
and DI15 represents pin 16 on CN4.
Returns False when a monitored signal is
open (>2.0V), True when the signal is
shorted (<0.8V).

DOO0 - DO15 logical no yes Digital output where DOO represents pin
1 and DO15 represents pin 16 on CN3.

Update logical yes no Object-generated signal that pulses each
time the object scans the device.
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Applicom

Lookout Object Reference Manual

Applicom is a set of object classes Lookout uses to communicate with a
series of devices and protocols, including the Applicom on-board database
(Local mode), April 1000, Klockner-Moeller, Otic Fischer & Porter,
Profibus DP, Profibus FMS, Profibus L2, SAIA-SBus, Siemens S7TMPI,
Siemens H1, Siemens S5 AS511, and Telemecanique.

The following illustration on the left is the dialog box for creating an
Applicom Local object. At right is the dialog box for creating an Applicom
Telemecanique object. The Telemecanique object has the same parameters
as all the other Applicom objects except for Applicom Local, and makes a
good representative sample for the group.

Create Applicom Local E Create Applicom Telemecanigue E
M ame: M ame:
Board Id: |1 Board Id: |1
Address of status word: I-I— Clnere] e ID
[-1 = no status word] Equipment Id: ID
Scanning interval [ms]: IED Scanning interval [ms]: IEDD
Communication alarm pricrity: IS Communication alarm pricrity: IS
Fietry attempts before Failure: |1 5
QK I Cancel | Help | QK I Cancel | Help |

Figure 3-6. Applicom Definition Parameters Dialog Boxes
Board ID identifies the board you are trying to address.

Address of status word is the address of the specific cyclic function of
your Applicom board that you want to interact with using this Applicom
Local object.

Channel ID identifies the Applicom channel your device is
communicating on.

Equipment ID is the Applicom equipment ID for the device you are
connecting to.

Scanning interval is the time period between polls. Valid range is
10 - 65535 (expressed in msec).
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Communication alarm priority determines the priority level of the alarms
generated by the object.

Retry attempts before failure specifies the consecutive number of times
Lookout attempts to establish communications with a device if it is not
getting a valid response. After it tries the number of Retry attempts
specified, the Applicom object generates an alarm and releases the
communication port back to the communications service which then moves
on to the next device in the polling queue (if any). Refer to Chapter 3, Serial
Port Communication Service, in the Lookout Developer’s Manual for more
detailed information.

Table 3-7. Lookout Applicom Object Classes and the Corresponding Protocols/Devices

Object Class Device/protocol
Applicom Local Any device or protocol supported by Applicom cards. See the Special
Instructions on Using the Applicom Local Object Class section, for
more detailed information on using this object.
Applicom JBUS Devices using Jbus protocol (mostly those made by April).
April 1000 April 1000 PLC using Ethway or Fipway protocols.

Klockner-Moeller

Klockner-Moeller SUCOS PS32 and PS316 PLC using the Sucoma
link.

Otic Fischer & Porter Otic Fischer & Porter controllers of series 2000, 5000, and 2000
supervisor using the DATALINK protocol.

Profibus DP Profibus DP with any I/O module or PLC that communicates on
a Profibus network using the Decentralized Periphery protocol
(includes some Siemens S5 PLCs).

Profibus FMS Profibus FMS protocol with any master or slave FMS device on a
Profibus network (includes most Siemens PLCs).

Profibus L2 Profibus L2 protocol with Siemens S5 PLC using Siemens France
messaging system. (The PLC must be running a program also
distributed with the Applicom hardware.)

SAIA-SBus SAIA SBus master protocol.

Siemens S7TMPI

Siemens MPI protocol with Siemens S7 PLCs.

Siemens H1

Sinec H1 protocol with various Siemens PLCs.
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Table 3-7. Lookout Applicom Object Classes and the Corresponding Protocols/Devices (Continued)

PLCs.

Object Class Device/protocol
Siemens S5 AS511 AS511 (programming port) protocol with Siemens S5 PLCs.
Telemecanique Uni-Telway, Ethway and Fipway protocols with all Telemecanique

Applicom Data Members

Table 3-8. Applicom Local Data Members

Data Member Type Read | Write Description

B0-B31999 logical yes yes | Output bits

CommPFail logical yes no Object-generated signal that is ON if
Lookout cannot communicate with the
device(s)

D0-D31998 numeric yes yes | Internal double words

DS0-DS31998 numeric yes yes Signed internal double words

FO-F31998 numeric yes yes | Internal floating words

00-013999 numeric yes yes | Internal bytes

0S0-0S13999 numeric yes yes Signed internal bytes

Update logical yes no Goes FALSE when a poll starts and
TRUE when a poll completes

W0-W31999 numeric yes yes | Output words

WS0-WS31999 numeric yes yes Signed output words

Table 3-9. Applicom JBUS Data Members

Data Member Type Read | Write Description
B0-B4294967295 logical yes yes | Internal bits
BI0-BI4294967295 logical yes no Input bits
BO0-B04294967295 logical yes yes Output bits
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Table 3-9. Applicom JBUS Data Members (Continued)

Data Member Type Read | Write Description
CommPFail logical yes no Object-generated signal that is ON if
Lookout cannot communicate with
the device(s)
D0-D4294967295 numeric yes yes Internal double words
FO0-F4294967295 numeric yes yes Internal floating words
00-04294967295 numeric yes yes Internal bytes
00.0-04294967295.7 logical yes yes | Bitin internal bytes
00.0-04294967295.7 logical yes yes Bit in internal bytes
0I0-014294967295 numeric yes no Input bytes
OIS0-0154294967295 numeric yes no Signed input bytes
000-004294967295 numeric yes yes Output bytes
00S0-00S4294967295 numeric yes yes Signed output bytes
0S0-084294967295 numeric yes yes Signed internal bytes
Update logical yes no Goes FALSE when a poll starts and
TRUE when a poll completes
WO0-W4294967295 numeric yes yes Internal words
WO0.0-W4294967295.15 logical yes yes Bits in internal words
WIO-WI14294967295 numeric yes no Input words
WIS0-WIS4294967295 numeric yes no Signed input words
WO0-W04294967295 numeric yes yes Output words
WOS0-W0S4294967295 | numeric yes yes Signed output words
WS0-WS4294967295 numeric yes yes Signed internal words
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Table 3-10. Applicom April 1000 Data Members

Data Member Type Read | Write Description

CommPFail logical yes no Object-generated signal that is ON if
Lookout cannot communicate with the
device(s)

FDO0-FD409598 numeric yes yes | Floating words in the data words

IX00000-1X96931 logical yes no Input bits

MD0-MD409598 numeric yes yes | Double words in the data words

MDS0-MDS409598 numeric yes yes Signed double words in the data words

MWO0-MW409599 numeric yes yes Data words

MWS0-MWS409599 numeric yes yes Signed data words

MX0-MX16383 logical yes yes | Not safeguarded internal bits

QX00000-QX96931 logical yes yes Output bits

RX0-RX8191 logical yes yes Safeguarded internal bits

Update logical yes no Goes FALSE when a poll starts and
TRUE when a poll completes

Table 3-11. Applicom Klockner-Moeller Data Members

Data Member Type Read | Write Description
B0-B4294967295 logical yes yes Internal bits
BI0-BI4294967295 logical yes no Input bits
BO0-B04294967295 logical yes yes Output bits
CommPFail logical yes no Object-generated signal that is ON if

Lookout cannot communicate with
the device(s)

D0-D4294967295 numeric yes yes | Internal double words
DS0-DS4294967295 numeric yes yes Signed internal double words
F0-F4294967295 numeric yes yes Internal floating words
00-04294967295 numeric yes yes Internal bytes
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Table 3-11. Applicom Klockner-Moeller Data Members (Continued)

Data Member Type Read | Write Description
00.0-04294967295.7 logical yes yes | Bitin internal bytes
0I0-014294967295 numeric yes no Input bytes
OIS0-0154294967295 numeric yes no Signed input bytes
000-004294967295 numeric yes yes Output bytes
00S0-00S4294967295 | numeric yes yes Signed output bytes
0S0-054294967295 numeric yes yes Signed internal bytes
Update logical yes no Goes FALSE when a poll starts and

TRUE when a poll completes
WO0-W4294967295 numeric yes yes Internal words
W0.0-W4294967295.15 logical yes yes Bits in internal words
WI0-W14294967295 numeric yes no Input words
WIS0-WI1S4294967295 numeric yes no Signed input words
WO0-W04294967295 numeric yes yes Output words
WOS0-W0S4294967295 | numeric yes yes Signed output words
WS0-WS4294967295 numeric yes yes Signed internal words

Table 3-12. Applicom Otic Fischer & Porter Data Members

Data Member Type Read | Write Description

B0-B65535 numeric yes yes | Bytes

B0.0-B65535.7 logical yes yes Bits in bytes

BS0-BS65535 numeric yes yes Signed Bytes

C0-C65535 numeric yes yes | Floating word on three bytes

CommPFail logical yes no Object-generated signal that is ON if
Lookout cannot communicate with the
device(s)

HO0-H65535 numeric yes yes | Floating word on five bytes
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Table 3-12. Applicom Otic Fischer & Porter Data Members (Continued)

Data Member Type Read | Write Description
LO0-L65535 logical yes yes | Bits
Update logical yes no Goes FALSE when a poll starts and
TRUE when a poll completes

Table 3-13. Applicom Profibus DP Data Members

Data Member Type Read | Write Description
B0-B4294967295 logical yes yes Internal bits
BI0-BI4294967295 logical yes no Input bits
BO0-B04294967295 logical yes yes Output bits
CommPFail logical yes no Object-generated signal that is ON if

Lookout cannot communicate with
the device(s)

DO0-D4294967295 numeric yes yes | Internal double words
DS0-DS4294967295 numeric yes yes Signed internal double words
FO0-F4294967295 numeric yes yes Internal floating words
00-04294967295 numeric yes yes | Internal bytes
00.0-04294967295.7 logical yes yes Bit in internal bytes
0I0-014294967295 numeric yes no Input bytes
OIS0-01IS4294967295 numeric yes no Signed input bytes
000-004294967295 numeric yes yes | Output bytes
00S0-0084294967295 numeric yes yes Signed output bytes
0S0-054294967295 numeric yes yes Signed internal bytes
Update logical yes no Goes FALSE when a poll starts and
TRUE when a poll completes
WO0-W4294967295 numeric yes yes | Internal words
WO0.0-W4294967295.15 logical yes yes | Bits in internal words
WI0-WI4294967295 numeric yes no Input words
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Table 3-13. Applicom Profibus DP Data Members (Continued)

Data Member Type Read | Write Description
WIS0-WI1S4294967295 numeric yes no Signed input words
WO0-W04294967295 numeric yes yes Output words
WOS0-W0S4294967295 | numeric yes yes Signed output words
WS0-WS4294967295 numeric yes yes Signed internal words

Table 3-14. Applicom Profibus FMS Data Members

Data Member Type Read | Write Description
BIDO-BID65535 logical yes yes Bits (simple variables)
BIDOSUBO-BID65535S logical yes yes | Bits
UB240
CommPFail logical yes no Object-generated signal that is ON if

Lookout cannot communicate with the
device(s)
DIDO0-DID65535 numeric yes yes | Doubles words (simple variables)
DIDOSUBO-DID65535S | numeric yes yes | Doubles words
UB60
DIDOSUBSO0-DID65535 | numeric yes yes | Doubles signal word
SUBS60
DIDS0-DIDS65535 numeric yes yes Double signed words
FIDO-FID65535 numeric yes yes | Floating words (simple variables)
FIDOSUBO-FID65535SU | numeric yes yes | Floating words
B60
OID0-0OID65535 numeric yes yes | Bytes (simple variables)
OIDOSUBO0-OID65535S | numeric yes yes | Bytes
UB240
OIDOSUBSO0-OID65535 | numeric yes yes Signed bytes
SUBS240
OIDS0-OIDS65535 numeric yes yes Signed bytes (simple variables)
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Table 3-14. Applicom Profibus FMS Data Members (Continued)

Data Member Type Read | Write Description
Update logical yes no Goes FALSE when a poll starts and
TRUE when a poll completes

WIDO0O-WID65535 numeric yes yes Words (simple variables)

WIDOSUBO-WID65535S | numeric yes yes Words

UB120

WIDOSUBSO-WID65535 | numeric yes yes Signed words

SUBS120

WIDS0-WIDS65535 numeric yes yes Signed words (simple variables)

Table 3-15. Applicom Profibus L2 Data Members
Data Member Type Read | Write Description
CommPFail logical yes no Object-generated signal that is ON
if Lookout cannot communicate
with the device(s)

DB1D0.0-DB255D255.15 logical yes yes Bits of DB word
DB1DDO0-DB255DD254 numeric yes yes Double words in DB
DB1DDOKG- numeric yes yes Floating words in DB
DB255DD254KG
DB1DDSO- numeric yes yes Signed double words in DB
DB255DDS254
DB1DWO0-DB255DW255 numeric yes yes Update pulse: words in DB
DB1DWS0-DB255DWS255 | numeric yes yes Signed words in DB
DX0D0.0-DX255D255.15 logical yes yes Bits of DX word
DX0DDO0-DX255DD254 numeric yes yes Double words in DX
DX0DDOKG- numeric yes yes Floating words in DX
DX255DD254KG
DX0DDSO0- numeric yes yes Signed double words in DX
DX255DDS254
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Table 3-15. Applicom Profibus L2 Data Members (Continued)

Data Member Type Read | Write Description
DX0DWO- numeric yes yes Update pulse: words in DX
DX255DW255
DX0DWSO0- numeric yes yes Signed words in DX
DX255DWS255
FO0.0-F255.7 logical yes yes Bits in flag bytes
FDO-FD255 numeric yes yes Double words in flag bytes
FDOKG-FD252KG numeric yes yes Floating words in flag bytes
FDS0-FDS255 numeric yes yes Signed double words in flag bytes
FWO0-FW254 numeric yes yes Words in flag bytes
FWS0-FWS254 numeric yes yes Signed words in flag bytes
FYO0-FY255 numeric yes yes Flag bytes
FYSO0-FYS255 numeric yes yes Signed flag bytes
10.0-1127.7 logical yes no Input bits
IBO-1B127 numeric yes no Input bytes
IBSO-IBS127 numeric yes no Signed input bytes
IWO0-IW126 numeric yes no Input words
IWS0-IWS126 numeric yes no Signed input words
Q0.0-Q127.7 logical yes yes Output bits
QWO0-QW126 numeric yes yes Output words
QWS0-QWS126 numeric yes yes Signed output words
QY0-QY127 numeric yes yes Output bytes
QYS0-QYS127 numeric yes yes Signed output bytes
S0.0-S4095.7 logical yes yes Bits in Sflags (internal bytes)
SDO0-SD4095 numeric yes yes Floating words in Sflags
SDOKG-SD4092KG numeric yes yes Floating words in Sflags
SDS0-SDS4095 numeric yes yes Signed double words in Sflags
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Table 3-15. Applicom Profibus L2 Data Members (Continued)

Data Member Type Read | Write Description
SWO0-SW4094 numeric yes yes Words in Sflags (internal bytes)
SWS0-SWS4094 numeric yes yes Signed words in Sflags (internal

bytes)
SY0-SY4095 numeric yes yes Sflags (internal bytes)
SYSO0-SYS4095 numeric yes yes Signed Sflags (internal bytes)
Update logical yes no Goes FALSE when a poll starts and
TRUE when a poll completes
Table 3-16. Applicom Siemens S5 H1 Data Members
Data Member Type Read | Write Description
CommPFail logical yes no Object-generated signal that is on if
Lookout cannot communicate with
the device(s)
DB1DO0.0 - logical yes yes Bits of DB word
DB255D255.15
DB1DDO - numeric yes yes Double words in DB
DB255DD254
DB1DDOKG - numeric yes yes Floating words in DB
DB255DD254KG
DB1DDSO - numeric yes yes Signed double words in DB
DB255DDS254
DB1DWO - numeric yes yes Update pulse: words in DB
DB255DW255
DB1DWSO - numeric yes yes Signed words in DB
DB255DWS255
DX0DO0.0 - logical yes yes Bits of DX word
DX255D255.15
DX0DDO - numeric yes yes Double words in DX
DX255DD254
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Table 3-16. Applicom Siemens S5 H1 Data Members (Continued)

Data Member Type Read | Write Description
DX0DDOKG - numeric yes yes Floating words in DX
DX255DD254KG
DX0DDSO - numeric yes yes Signed double words in DX
DX255DDS254
DX0DWO - numeric yes yes Update pulse: words in DX
DX255DW255
DXO0DWSO - numeric yes yes Signed words in DX
DX255DWS255
FDO - FD255 numeric yes yes Double words in flag bytes
FDOKG - FD252KG numeric yes yes Floating words in flag bytes
FDSO - FDS255 numeric yes yes Signed double words in flag bytes
FWO - FW254 numeric yes yes Words in flag bytes
FWSO0 - FWS254 numeric yes yes Signed words in flag bytes
FYO - FY255 numeric yes yes Flag bytes
FYSO - FYS255 numeric yes yes Signed flag bytes
10.0 - 1127.7 logical yes no Input bits
IBO - IB127 numeric yes no Input bytes
IBSO - IBS127 numeric yes no Signed input bytes
IWO0 - IW126 numeric yes no Input words
IWSO0 - IWS126 numeric yes no Signed input words
Q0.0 - Q127.7 logical yes yes Output bits
QWO - QW126 numeric yes yes Output words
QWSO - QWS126 numeric yes yes Signed output words
QYO0 - QY127 numeric yes yes Output bytes
QYS0-QYS127 numeric yes yes Signed output bytes
S0.0 - S4095.7 logical yes yes Bits in Sflags (internal bytes)
SDO - SD4095 numeric yes yes Floating words in Sflags

© National Instruments Corporation 3-39 Lookout Object Reference Manual

Lookout Driver and Protocol Objects




Chapter 3 Lookout Driver and Protocol Objects

Table 3-16. Applicom Siemens S5 H1 Data Members (Continued)

Data Member Type Read | Write Description
SDOKG - SD4092KG numeric yes yes Floating words in Sflags
SDS0 - SDS4095 numeric yes yes Signed double words in Sflags
SWO - SW4094 numeric yes yes Words in Sflags (internal bytes)
SWSO0 - SWS4094 numeric yes yes Signed words in Sflags (internal

bytes)

SYO - SY4095 numeric yes yes Sflags (internal bytes)
SYSO - SYS4095 numeric yes yes Signed Sflags (internal bytes)
Update logical yes no False during Polling sequence

Table 3-17. Applicom SAIA SBus Data Members

Data Member Type Read | Write Description

CommPFail logical yes no Object-generated signal that is
ON if Lookout cannot
communicate with the device(s)

DB0QO0-DB7999Q7999 numeric yes yes Floating data block

DBORO0-DB7999R7999 numeric yes yes Binary data block

DBORO0.0-DB7999R7999.31 | logical yes yes Bits in binary data block

DBORO0.0-DB7999R7999.31 | logical yes yes Bits in binary data block

FO-F8091 logical yes yes Flags

10-18091 logical yes no Input

00-08091 logical yes yes Output

Q0-Q4095 numeric yes yes Floating registers

RO-R4095 numeric yes yes Binary registers

R0.0-R4095.31 logical yes yes Bits in binary registers

RS0-RS4095 numeric yes yes Signed binary registers

Update logical yes no Goes FALSE when a poll starts
and TRUE when a poll completes
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Table 3-18. Applicom Siemens S5 AS511 Data Members

Data Member Type Read | Write Description
CommPFail logical yes no Object-generated signal that
is ON if Lookout cannot
communicate with the
device(s)
DB1D0.0-DB255D255.15 logical yes yes Bits of DB word
DB1DDO0-DB255DD254 numeric yes yes Double words in DB
DB1DDOKG-DB255DD254KG numeric yes yes Floating words in DB
DB1DDS0-DB255DDS254 numeric yes yes Signed double words in DB
DB1DWO0-DB255DW255 numeric yes yes Update pulse: words in DB
DB1DWS0-DB255DWS255 numeric yes yes Signed words in DB
DX0D0.0-DX255D255.15 logical yes yes Bits of DX word
DX0DDO0-DX255DD254 numeric yes yes Double words in DX
DX0DD0OKG-DX255DD254KG numeric yes yes Floating words in DX
DX0DDS0-DX255DDS254 numeric yes yes Signed double words in DX
DX0DWO0-DX255DW255 numeric yes yes Update pulse: words in DX
DX0DWS0-DX255DWS255 numeric yes yes Signed words in DX
F0.0-F255.7 logical yes yes Bits in flag bytes
FDO-FD255 numeric yes yes Double words in flag bytes
FDOKG-FD252KG numeric yes yes Floating words in flag bytes
FDS0-FDS255 numeric yes yes Signed double words in flag
bytes
FWO0-FW254 numeric yes yes Words in flag bytes
FWS0-FWS254 numeric yes yes Signed words in flag bytes
FY0-FY255 numeric yes yes Flag bytes
FYSO0-FYS255 numeric yes yes Signed flag bytes
10.0-1127.7 logical yes no Input bits
IBO-IB127 numeric yes no Input bytes
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Table 3-18. Applicom Siemens S5 AS511 Data Members (Continued)

Data Member Type Read Write Description
IBSO-IBS127 numeric yes no Signed input bytes
IWO0-IW126 numeric yes no Input words
IWS0-IWS126 numeric yes no Signed input words
Q0.0-Q127.7 logical yes yes Output bits
QWO0-QW126 numeric yes yes Output words
QWS0-QWS126 numeric yes yes Signed output words
QY0-QY127 numeric yes yes Output bytes
QYS0-QYS127 numeric yes yes Signed output bytes
S0.0-S4095.7 logical yes yes Bits in Sflags (internal bytes)
SD0-SD4095 numeric yes yes Floating words in Sflags
SDOKG-SD4092KG numeric yes yes Floating words in Sflags
SDS0-SDS4095 numeric yes yes Signed double words in
Stlags

SWO0-SW4094 numeric yes yes Words in Sflags (internal
bytes)

SWS0-SWS4094 numeric yes yes Signed words in Sflags
(internal bytes)

SY0-SY4095 numeric yes yes Sflags (internal bytes)

SYSO0-SYS4095 numeric yes yes Signed Sflags (internal bytes)

Update logical yes no Goes FALSE when a poll
starts and TRUE when a poll
completes

Table 3-19. Applicom Siemens S7 MPI Data Members
Data Member Type Read | Write Description
A0.0-A65535.7 logical yes yes Output bits
ABO0-AB65535 numeric yes yes Output bytes
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Table 3-19. Applicom Siemens S7 MPI Data Members (Continued)

Data Member Type Read | Write Description
ABS0-ABS65535 numeric yes yes Signed output bytes
AW0-AW65534 numeric yes yes Output words
AWS0-AWS65534 numeric yes yes Signed output words
CommPFail logical yes no Object-generated signal that is ON if

Lookout cannot communicate with

the device(s)
DB0.DBD0-DB32767. numeric yes yes | Double words in DB
DBD65532
DB0.DBDOF-DB32767. | numeric yes yes | Floating words in DB
DBD65532F
DB0.DBDS0-DB32767. | numeric yes yes Signed double words in DB
DBDS65532
DB0.DBW0-DB32767. numeric yes yes Words in DB
DBW65534
DB0.DBWS0-DB32767. | numeric yes yes Signed words in DB
DBWS65534
DBODBB0-DB32767. numeric yes yes | Bytesin DB
DBB65535
DBODBBS0-DB32767. numeric yes Signed bytes in DB
DBBS65535 yes
DB1.DBX0.0-DB8191. logical yes yes | Bitsin DB byte
DB65535.7
E0.0-E65535.7 logical yes no Input bits
EBO-EB65535 numeric yes no Input bytes
EBS0-EBS65535 numeric yes no Signed input bytes
EWO0-EW65534 numeric yes no Input words
EWS0-EWS65534 numeric yes no Signed input words
MO0.0-M65535.7 logical yes yes | Bits in flag bytes
MBO0-MB65535 numeric yes yes | Flag bytes
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Table 3-19. Applicom Siemens S7 MPI Data Members (Continued)

Data Member Type Read | Write Description

MBS0-MBS65535 numeric yes yes Signed flag bytes

MDO0-MD65532 numeric yes yes Double words in flag bytes

MDOF-MD65532F numeric yes yes Floating words in flag bytes

MDS0-MDS65532 numeric yes yes Signed double words in flag bytes

MWO0-MW65534 numeric yes yes | Words in flag bytes

MWS0-MWS65534 numeric yes yes Signed words in flag bytes

Update logical yes no Goes FALSE when a poll starts and
TRUE when a poll completes

Table 3-20. Applicom Siemens S7 PPI Data Members
Data Member Type Read | Write Description

A0.0-A65535.7 logical yes yes Output bits

ABO0-AB65535 numeric yes yes Output bytes

ABS0-ABS65535 numeric yes yes Signed output bytes

AWO0-AW65534 numeric yes yes Output words

AWS0-AWS65534 numeric yes yes Signed output words

CommPFail logical yes no Object-generated signal that is ON if
Lookout cannot communicate with
the device(s)

DB0.DBD0-DB32767. numeric yes yes Double words in DB

DBD65532

DB0.DBDOF-DB32767. | numeric yes yes Floating words in DB

DBD65532F

DB0.DBDS0-DB32767. | numeric yes yes Signed double words in DB

DBDS65532

DB0.DBW0-DB32767. numeric yes yes Words in DB

DBW65534
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Table 3-20. Applicom Siemens S7 PPl Data Members (Continued)

Data Member Type Read | Write Description
DB0.DBWS0-DB32767. | numeric yes yes Signed words in DB
DBWS65534
DBODBB0-DB32767. numeric yes yes Bytes in DB
DBB65535
DBODBBS0-DB32767. numeric yes yes Signed bytes in DB
DBBS65535
DB1.DBX0.0-DB8191. logical yes yes Bits in DB byte
DB65535.7
E0.0-E65535.7 logical yes no Input bits
EBO0-EB65535 numeric yes no Input bytes
EBS0-EBS65535 numeric yes no Signed input bytes
EW0-EW65534 numeric yes no Input words
EWS0-EWS65534 numeric yes no Signed input words
MO0.0-M65535.7 logical yes yes Bits in flag bytes
MBO0-MB65535 numeric yes yes Flag bytes
MBS0-MBS65535 numeric yes yes Signed flag bytes
MDO0-MD65532 numeric yes yes Double words in flag bytes
MDOF-MD65532F numeric yes yes Floating words in flag bytes
MDS0-MDS65532 numeric yes yes Signed double words in flag bytes
MWO0-MW65534 numeric yes yes Words in flag bytes
MWS0-MWS65534 numeric yes yes Signed words in flag bytes
Update logical yes no Goes FALSE when a poll starts and

TRUE when a poll completes
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Table 3-21. Applicom Siemens H1 Data Members

Data Member Type Read | Write Description
C1-C2097152 logical yes yes Bits
CommPFail logical yes no Object-generated signal that is
ON if Lookout cannot
communicate with the device(s)
DCP1-DCP65536 numeric yes yes Drum count preset
DSC1-DSC65536 numeric yes yes Drum step current
DSP1-DSP65536 numeric yes yes Drum step preset
K1-K2097152 numeric yes yes Constant words
K1.0-K2097152.15 logical yes yes Bits in constant words
KF1-KF2097151 numeric yes yes Floating constant words
KS1-KS2097152 numeric yes yes Signed constant words
STW1-STW65536 numeric yes yes System status words
TCC1-TCC65536 numeric yes yes Timer/counter current
TCP1-TCP65536 numeric yes yes Timer/counter preset
Update logical yes no Goes FALSE when a poll starts
and TRUE when a poll completes
V1-V2097152 numeric yes yes Internal words
V1.0-V2097152.15 logical yes yes Bits in internal words
VD1-VD2097151 numeric yes yes Internal double words
VDS1-VDS2097151 numeric yes yes Signed internal double words
VF1-VF2097151 numeric yes yes Floating words
VS1-VS2097152 numeric yes yes Signed internal words
WSY1-WYS2097152 numeric yes yes Signed output words
WX1-WX2097152 numeric yes yes Input words
WXS1-WXS2097152 numeric yes yes Signed input words
WY1-WY2097152 numeric yes yes Output words
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Table 3-21. Applicom Siemens H1 Data Members (Continued)

Data Member Type Read | Write Description
X1-X2097152 logical yes Input bits
Y1-Y2097152 logical yes yes Output bits
Table 3-22. Applicom Telemecanique Data Members
Data Member Type Read | Write Description

B0-B4095 logical yes yes Internal bits

CommPFail logical yes no Object-generated signal that is ON if
Lookout cannot communicate with the
device(s)

DWO0-DW32766 numeric yes yes Internal double words

DWS0-DWS32766 numeric yes yes Signed internal double words

FWO0-FW32766 numeric yes yes | Internal floating words

100.0-1F7.F logical yes no Input bits

IW00.0-IWF7.7 numeric yes no Words in input registers

IWS00.0-IWSF7.7 numeric yes no Signed words in input registers

000.0-OF7.F logical yes yes Output bits

OWO00.0-OWF7.7 numeric yes yes | Words in output registers

Special

OWSO00.0-OWSF7.7 numeric yes yes Signed words in output registers

Special

Update logical yes no Goes FALSE when a poll starts and
TRUE when a poll completes

WO0-W32767 numeric yes yes Internal words

WS0-WS32767 numeric yes yes Signed internal words
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General Information on Using the Applicom drivers for Lookout

The Applicom drivers for Lookout are all contained in APPLICOM. CBX
(16- or 32-bit) which is designed to work with the Applicom server
software distributed with every Applicom card. These drivers assume that
you have version 2.9 or later of the Applicom software installed on the
same computer under the same operating system as your copy of Lookout.
The ApPLICOM. CBX file presently supports 12 different object classes
corresponding to 12 different protocols or object types.

Before you start using Lookout with Applicom, you must follow certain
configuration and testing procedures to ensure that Lookout can
communicate with your devices. The steps include configuration, loading,
testing, and if you choose, cyclic function configuration.

First, however, take special notice of the two different modes for using the
Lookout Applicom driver-Image and Local. The distinction between these
two modes is crucial to using the Lookout Applicom object classes.

Applicom Local and Image Modes

You can configure the Applicom server software to constantly poll a
remote device and store data in a database onboard your Applicom card.
You use Local mode to access that data.

In Lookout, you address the data using a generic addressing scheme (as a
bit number, or word number, and so on.). The Applicom card takes care of
polling the device and writing out new values to registers on the device. If
there are any problems in communicating with the device, an error code
may be generated and stored in a specified database location. The Lookout
driver can then use the data at that location to generate alarms.

In Image mode you address data on the remote device according to the
addressing scheme commonly used with the particular class of devices.
In this mode, Lookout asks for data directly from a remote device and is
notified of communication errors when they arise. The Lookout Applicom
driver then retries the particular data transfer repeatedly, generating alarms
when the data transfer continues to fail.

You use the Applicom Local object class for local mode functionality,
and the other device- or protocol-specific object classes for image mode
functionality. You can use Applicom Local concurrently with any of the
other Applicom classes.
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The Image mode classes are the typical way to use the Applicom driver for
most applications. However, the Local mode provides a convenient way to
achieve two goals: providing access to data from multiple applications
(because any application may use the Applicom functions to access the
local mode database); and allowing inputs from one device connected to a
card to be written to outputs on another device connected to the same card
without the interference of the Windows operating system or the client
application (for example, Lookout).

Configuration of the Applicom Server

After you install the Applicom server software, you must first configure it
using the PCConf utility provided as part of the Applicom software. Refer
to the Software Installation section of your Applicom documentation for
details on using Applicom software. You use the PCConf utility to set the
basic types of devices connected to the Applicom card and the protocols
used to connect to them. You also set all the communication parameters
with this program.

While configuring your system with PCConf, make note of the Channel
number and Equipment number for the device(s) you are using Lookout to
communicate with. You will need these values as parameters when you
create Lookout objects in Image mode.

Loading of the Applicom Server

After you configure the Applicom Server, you must download the
appropriate firmware module to the card and then configure it. You do this
by running the Applicom program PCInit. The configuration software
notifies you at this time if there is any physical problem with the installation
of the card.

You must run PCInit every time you restart the computer if you plan to
communicate with the Applicom card and connected devices during that
session. Because of this, you may consider putting a shortcut to this
program in the Startup program group.

At this point, the Applicom server should be ready to communicate with
Lookout and with the remote devices connected to the card. Before starting
Lookout and attempting to communicate, you should first test the
connections using some of the Applicom programs.
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Testing the Applicom Server

The ReadWait program in the Applicom server group is a good example
of a program that can be used to test the connectivity of the Applicom card
with a remote device. You can also use WritWait, Essai, and Essaigb.
Try performing read or write operations using these programs to test
whether you can perform basic data transfer operations between the card
and the devices. If these tests fail, Lookout will not be able to communicate
with the devices either.

If your tests succeed and Lookout fails to communicate with the Applicom
devices, it is likely that the problem is in the Lookout object configuration.
Because the Applicom programs require you to use the channel and
equipment numbers from the PCConf program, testing helps you verify
that you have the correct numbers.

Creating the Cyclic Functions

There is only one more step before you start using the Lookout drivers, and
it is required only if you are planning to use the Applicom Local object
class. In that case, you must first configure the cyclic functions that
exchange data between the onboard database of the Applicom card and the
remote devices.

You do this by using either the Applicom CreateCyc or PCCyc utility
programs. These programs require that you enter a channel number, an
equipment number, and whether the required operation is a read or a write.
You also enter the address of the data on the remote device and the
requested address of the data in the database. Once you have created and
saved the cyclic functions, you can test them using the GetDB and SetDB
programs in the Applicom server.

After you verify that the card can communicate with the remote device, you
can start using Lookout. Create a Lookout object of the appropriate class,
enter the required parameters, and start communicating with the remote
device.
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Special Instructions on Using the Applicom Local Object Class

The Applicom Local object class behaves very differently from the Image
mode object classes. To use it, you must have configured cyclic functions
on your Applicom card using the Applicom PCCyc or CreateCyc
programs.

After you configure these functions, you can create one or more Applicom
Local objects in Lookout to read from or write to the Applicom database
directly. The syntax is a generic syntax which does not correspond with the
syntax you use with the PLC. The address you specify in Lookout must be
the address of the data on the Applicom board, not the address on the
remote device.

You can also specify a status word in the PCCyc program for each cyclic
function you create. You can then specify a single status address in the
object creation/modification dialog box for Applicom Local to get Lookout
alarms any time the corresponding cyclic function is unable to exchange
data successfully.

The Applicom Local object class is compatible with the other object classes
so that you can create multiple Applicom object classes of any type and use
them all at the same time.

Applicom Status Messages

The requested address is incorrect

You have requested data for an invalid address. Check the address and try
again. For further details check the Applicom documentation for an
explanation of error code 2.

Incorrect data type

The type of the data on the device is not compatible with the requested type.
This may occur for different reasons in different protocols. For further
details check the Applicom documentation for an explanation of error
code 3.

Irretrievable data

The data you are trying to access is irretrievable. Please check that the
device is connected and has all the appropriate models. For further details
check the Applicom documentation for an explanation of error code 4.
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Response timed out

The device did not respond to a message within the time-out period. Check
that the device is connected. For further details, check the Applicom
documentation for an explanation of error code 33.

Check word or parity fault

Check the channel and target equipment configuration and the wiring to the
equipment. For further details, check the Applicom documentation for an
explanation of error code 34.

Data not available in cyclic read

There was an error in reading from the card. Contact National Instruments
technical support if this error occurs.

Equipment not configured

Configure the equipment with PCConf. If you have already done so, check
that you are using the correct (logical) equipment ID, as configured in
PCConf.

Deferred read or write request when deferred request register is full

There was an error in writing to the card. Contact National Instruments
technical support if this error occurs.

Deferred request transfer attempt with transdif when request register
is empty

There was an error in writing to the card. Contact National Instruments
technical support if this error occurs.

Communication software not initialized

The Applicom board was not initialized using the PCInit software. Close
Lookout, run PClnit and try running Lookout again.

Board number not configured

The board number you are attempting to use is not one that has been
configured. Please check the configuration using PCConf.

No Applicom interface

There is no Applicom interface present. Check that PClnit executed
correctly.

Timeout elapsed. Message lost

A communication problem occurred that may be related to the
configuration of the remote equipment or the bus that the equipment is on.
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For further details, check the Applicom documentation for an explanation
of error code 55.

Negative acknowledgment (NAK) from equipment

A message was received by the destination equipment but not processed
due to lack of resources. For further details, check the Applicom
documentation for an explanation of error code 56.

Communication refused by the equipment.

The equipment is not responding to communication requests. This may
be caused by a misconfigured device or by a bad connection with the
Applicom card. Check the device configuration, check the Applicom
configuration and use the Applicom utilities to check that there is
communication between the two.

Bad frame received

The remote device is not behaving correctly. Check the configuration of the
device.

Errorcode ID: refer to Applicom documentation

Your application has returned an error specific to your Applicom device.
Consult your Applicom documentation for further information.
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Aquatrol

Lookout Object Reference Manual

Aquatrol is a protocol driver class Lookout uses to communicate with
Aquatrol W1500 controllers.

Create Aquatrol Secondary [<]
M ame: Agquatrall

Address: [100 | Madsk [wisoo =]
Communication Setting

Serial part: IEDM‘I 'l Drata bits: I? 'l
Baud Rate: |12DD 'l Stop bits: I‘I VI

Parity: INone j FPhone: I
FallR ate = Ig:m
Configuration |
Pall = I

Communication alarm pricrity: IS

Fietry attempts: |4 Feceive timeout: I‘IDDD MEecs

Skip every |5 poll requests after comm failure

QK I Cancel | Help |

Figure 3-7. Aquatrol Definition Parameters Dialog Box

Address is the address of the RTU as configured on the device. The address
can be in the range of 100 to 999 inclusive.

Model is W1500 only at this time.

Serial port specifies which port the object uses for communication to
the external device. This does not specify the communication type.
Communication type is determined by the Options»Serial Ports...
command.

Data rate, Parity, Data bits, and Stop bits reference the settings on the
hardware device.

Phone specifies the number to be dialed if the serial port setting is
configured for dial-up. This number only applies to the individual protocol
object.

PollRate is a numeric expression that determines how often to poll the
device. Lookout converts the numeric value of PollRate into a time signal
that represents days and fractions of a day. Aquatrol then polls the device
at the specified time interval. Normally, this is a time constant such as
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0:01 (one second). See the Numeric Data Members section in Chapter 2,
How Lookout Works, of the Getting Started with Lookout manual for
information on entering time constants.

Poll is a logical expression. When this expression changes from false to
true, Lookout polls the device. You can use a simple expression like the
signal from a pushbutton, or a complex algorithm.

Communication alarm priority determines the priority level of
object-generated alarms (0 — 10).

Retry attempts specifies the consecutive number of times Lookout
attempts to establish communications with a device if it is not getting a
valid response. After it tries the number of Retry attempts specified, the
Aquatrol object generates an alarm and releases the communication port
back to the communications service which then moves on to the next device
in the polling queue (if any).

Receive timeout is the time delay Lookout uses in waiting for a response
from a device before retrying the request.

The SKip every... setting instructs Lookout not to poll a device it has lost
communication with on every scheduled poll. Instead, Lookout skips the
device in the polling cycle accordingly. Once communications have been
reestablished, the device is polled on its regular cycle.

RTU Configuration Dialog Box

RTU Configuration | ]

In Ot Counters
Digitals R
Analogs |5— |5— Funtime ID—
Totalizers ID—

Fepeater address I (not used if blank)
Default Values | Cancel | oK I

Figure 3-8. RTU Configuration Dialog Box

You must configure Lookout to match the configuration in your Aquatrol
device.

Digital (In/Out) specifies configuration for the number of discrete I/O.
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Analogs (In/Out) specifies configuration for the number of analog I/O.
Totalizers specifies configuration for the number of totalizers.

Start specifies configuration for the number of start counters.
Runtime specifies configuration for the number of runtime counters.

Repeater Address is the final destination address if a repeater is
being used.

@ Note The Aquatrol must be configured with all I/O grouped together by kind. Digital
inputs must be the first physical inputs on the device, followed by digital outputs. Analog
inputs are next, followed by analog outputs. If you do not configure the I/O this way, you
can receive invalid data.

Aquatrol Data Members

All readable and writable members (inputs/outputs), polling instructions,
read/write blocking, serial port usage, and so on, are bundled with the
object. Therefore, as soon as you create an Aquatrol object you
immediately have access to all the object data members (see data
member list in Table 3-23).

@ Note Lookout protocol driver objects automatically generate an efficient read/write
blocking scheme based on the inputs and outputs being used in your process file. You are
not required to build your own I/O blocking table.

Table 3-23. Aquatrol Data Members

Data Member Type Read | Write Description

All-AI48 numeric yes no Analog Input, 16 bit.

AO1-AO48 numeric no yes Analog Output, 16 bit.

ColdRestart logical yes no True if the device power has cycled
on/off or the reset button has been
pushed.

CommPFail logical yes no True if serial communications have
failed.

Lookout Object Reference Manual 3-56 ni.com



Chapter 3 Lookout Driver and Protocol Objects

Table 3-23. Aquatrol Data Members (Continued)

Data Member Type Read | Write Description

ConfigError logical yes no True if the configuration of the device
does not match the configuration set
in the configuration dialog of the
Aquatrol device.

DataFail logical yes no True if the device has had a data
failure.

DI1-DI48 logical yes no Discrete Input, 1 bit.

DO1-DO0O48 logical no yes Discrete Output, 1 bit.

EEPROMerror logical yes no True if the device has an EEPROM
error.

LowBattery logical yes no True if the device has a low battery.

Poll logical no yes True initiates a Poll sequence.

PollRate numeric no yes Time interval of Polling sequence.

PowerFail logical yes no True if there is no power to the device.

R1-R48 numeric yes no Runtimes, 16 bit.

S1-S48 numeric yes no Starts, 16 bit.

T1-T48 numeric yes no Totalizers, 16 bit.

Update logical yes no False during Polling sequence.

WarmRestart logical yes no True if the device has been reset
locally.

Aquatrol Status Messages

No response within timeout period

No response within timeout period for repeated message. Lookout did not
received the expected response within the Receive timeout period. The
object sent an inquiry and received an acknowledgment, but the device did
not send an expected response to the request. This might happen if the
response was interrupted. You may have to increase Receive timeout.

Frame Error (garbled): Invalid destination address

Lookout has received a frame with an invalid return address. Make sure that
no duplicate addresses exist on the Aquatrol network.
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Frame Error (garbled): Invalid source address

Lookout has received a frame from a device that you are not actively
polling. Make sure that there is only one outstanding master request at
a time.

Frame Error (garbled): Invalid message length for configuration

Lookout has received a frame whose length conflicts with the length
expected based on the configuration settings in the Aquatrol device
configuration dialog box.

Frame Error (garbled): Invalid CRC

Lookout has received a frame with an invalid CRC (cyclic redundancy
check). Check for signal noise on Aquatrol network.

Invalid discrete address #: Check configuration settings
Invalid analog address #: Check configuration settings
Invalid runtime address #: Check configuration settings
Invalid start address #: Check configuration settings
Invalid totalizer address #: Check configuration settings

All these errors mean that a I/O point being either read or written is out of
range with respect to the configuration set in the Aquatrol device
configuration dialog box.
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ASCIl is a protocol driver class Lookout uses to communicate with any
serial device that accepts ASCII characters. This object is only available
with 32-bit versions of Lookout.

An ASCII object contains no predefined data points. When you create an
ASCII object, you must define your data request strings as well as the
template Lookout uses to parse the response frame.

Create ASCIl Secondary E
M ame:

Communication Setting
Serial port:  |COMT = [rata bits: IS 'l
Baud R ate: ISBDD 'l Stop bits: I‘I 'l
Parity: INone 'l

Phone numnber: |

Monitor serial port

Communication alarm pricrity: I8
Fietry attempts: |4 Feceive timeout: |250 | mzecs

Skip every |5 poll requests after comm failure

QK I Cancel | Help |

Figure 3-9. ASCII Definition Parameters Dialog Box

Serial port specifies which COM port the object uses for communicating
to the external device. This does not specify the communication type.
Communication type is determined by the Options»Serial Ports...
command.

Baud rate indicates the rate that Lookout uses to communicate with the
hardware device.

Data bits indicates the number of data bits that Lookout uses to
communicate with the hardware. This setting should match the selection
made on the physical device.

Stop bits indicates the number of stop bits that Lookout uses to
communicate with the hardware device. This setting should match the
selection made on the physical device.
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ASCII Data Membe

Parity indicates the parity that Lookout uses to communicate with the
hardware device. This setting should match the selection made on the
physical device.

Phone number specifies the number to be dialed if the selected serial port
is configured for dial-up. This number only applies to the individual
protocol object.

Monitor Serial Port specifies whether you can receive unsolicited frames.

Communication alarm priority determines the priority level of alarms
generated by the ASCII object. Such alarms are typically related to
communications with the physical device.

Retry attempts specifies the number of times Lookout attempts to
establish communications with a device if it is not getting a valid response.
After it tries the number of Retry attempts specified, the ASCII object
generates an alarm and releases the communication port back to the
communications service which then moves on to the next device in the
polling queue (if any). Refer to Chapter 3, Serial Communications, in the
Lookout Developer’s Manual for more information.

Receive timeout is the amount of time Lookout waits for a response from
a device before retrying the request.

The Skip every N poll requests after comm failure setting instructs
Lookout not to poll a device it has lost communication with on every
scheduled poll. Instead, Lookout polls the device only once in the specified
number of poll cycles. Once communication has been reestablished, the
device is polled on its regular cycle.

s

Table 3-24. ASCII Data Members

Data Member Type Read | Write Description

CommPFail logical yes no Object-generated signal that is on if
Lookout cannot communicate with
the device(s).

OffHook logical no yes Keeps the driver from releasing the
serial port.

Request text yes no Exact request frame sent.
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Table 3-24. ASCII Data Members (Continued)

Data Member Type Read | Write Description
RequestFormat text no yes Format used to create request frame.
Response text yes no Exact response frame received.
ResponseFormat text no yes Format used to parse response frame.
RQSum:1:1 - numeric yes no Request byte sum
RQSum?255:255
RQV1,RQV512 numeric no yes Variable list used to populate request

frame with numeric values.

RQVl.logical, logical no yes Variable list used to populate request

RQV512.logical frame with logical values.

RQV1.txt, RQV512.txt text no yes Variable list used to populate request
frame with text values.

RSFilter text no yes All characters in this string will be
filtered out of the incoming response
before processing.

RSSuml:1 - numeric yes no Response byte sum

RSSum?255:255

RSV1, RSV512 numeric yes no Variable list used to store values
retrieved from response frame.

RSVl1.logical, logical yes no Variable list used to store values

RSV512.1ogical retrieved from response frame.

RSV1.txt, RSV512.txt text yes no Variable list used to store values
retrieved from response frame.

Send logical no yes Sends request frame.

Update logical yes no Object-generated signal that pulses
low each time it polls the device.

RSVn, RSVn.txt and RSVn.logical all represent the same value in different forms
RQVn, RQVn.txt and RQVn.logical all represent the same value in different forms
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Request and Response Format Strings

The request and response format strings consist of static characters and
markers that control how the request and response frames respectively are
formatted or decoded. The request format string is used to create the
request frame, which is sent to the device, while the response format string
is used to decode the response frame, which comes from the device.

Static characters in the format strings are reproduced exactly in the request
or response frame. Markers specify the location within the frame and type
of data which should be found there, such as five characters read as an
unsigned integer, for example. The ASCII object constructs a request frame
by processing the sequence of static characters and markers in the request
format string, and including data from RQV data members.

The response format string decodes a response frame using an analogous
process, storing the results in RSV data members.

To construct a request frame, the ASCII object parses the request format
string character by character. Static characters are copied directly to the
request frame. When a marker is encountered the ASCII object reads a
value from the appropriate RQV variable and places it into the request
frame.

There are 512 RQV and RSV values provided for in the ASCII object data
member collection. The first marker in a format string uses the value from
RQV1 (or RQV1.txt or RQV1.logical), the next marker uses the value
RQV2, and so on. Values taken from Response strings are stored in RSV
data members in the same way.

Keep in mind that writing into RQV 1 changes the value both for RQV 1.text
and RQV1.logical. Their only difference is the format in which they are
represented. The same principle applies to the RSV data members.

@ Note There is no precedence to the order in which multiple objects connected to the same
variable number initialize upon opening the process file. Consider, for example, the case in
which a Pot object is connected to RQV1 while a TextEntry object is connected to
RQV1.txt. You should take care to initialize such variables to the proper value after
opening a process file.

To decode a response frame, the ASCII object compares the response frame
to the response format string character by character. The static characters in
the response frame must match those in the response format string or the
decoding process terminates. Static characters are, in effect, discarded
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by the ASCII object as they are matched between the response format
string and the response frame.

When the ASCII object encounters a marker, it places the data indicated by
the marker into the appropriate RSV data member.

The conversion of a portion of the response frame to a data type specified
by a marker in the response format string must be valid, or the process will
terminate.

If nothing halts the process, decoding terminates when the end of the
response frame string is reached.

There are examples of both request frames and response frames at the end
of this section, but for the examples to make sense, you must first
understand the ASCII object markers.

ACSII Object Markers

The general format for a marker is:
[ width][type]

Each field in the marker format is a single character or a number signifying
a particular format option.

The % sign denotes the beginning of the marker. For example, to specify
that a percent-sign character is a static character part of the frame, use %%.

Width is a positive decimal integer specifying the number of characters
that particular value occupies in the frame. By default ASCII pads the value
with blank spaces if the value takes up fewer characters than the value
specified by width. Including a 0 before the width value forces the ASCII
object to pad with zeroes instead of blank spaces.

Type determines whether the field is interpreted as a character, a string,
or a number.

Table 3-25. Data Types Allowed by ASCII

Character Data Type
c Character
d Decimal integer
0,0 Octal
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Table 3-25. Data Types Allowed by ASCII (Continued)

x, X Hexadecimal integer

u Unsigned decimal integer
e, f Floating-point

S String

b* Byte (binary)

*For the %b data type:
— Number of bytes can be specified, for example %3b, %2b.

— Response format can read as either signed or unsigned, for example %”b and %3"b are
signed and %D is unsigned.

— Endian order can be specified, for example %3~b is big endian and %3b is little endian.
%5~"b and %2"~b forms are also valid.

The simplest format specification contains only the percent sign and a type
character (for example, %s). That would place the value in the response
frame in the RSV1.txt data member.

Request Format
String RQV1 Request Frame
>%5d 34 > 34
>%05d 34 >00034

The request format string also has a precision value in the form

% [width].[precision][type]. This specifies the number of digits to the
right of the decimal point, if any, in the request frame. If you use a float (%f)
and do not specify a precision value, the ASCII object assumes a default
of 6.

Characters are converted and stored in RSV data members from response
frames in the order they are encountered in the response format. However,
fewer than [width] characters may be read if a white-space character
(space, tab, or newline) or a character that cannot be converted according
to the given format occurs before [width] is reached.

Values needed for request frames come from the RQV data members, and
are also used in the order in which they occur in the request format.
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To read strings not delimited by space characters, or that contain spaces,
you can substitute a set of characters in brackets ([ 1) s (string) type
character. The corresponding input field is read up to the first character that
does not appear in the bracketed character set. Using a caret (*) as the first
character in the set reverses this effect: the ASCII object reads input field
up to the first character that does appear in the rest of the character set.

Response Response
Format String RSV1.txt Frame
$%[A-Z,a—-12,1% Natl Inst $Natl Inst$

>%I[",s] days >day

Notice that %[a — z] and %[z — a] are interpreted as equivalent to
9|[abcde...z], and that the character set is case sensitive. Valid control
characters accepted include the list in the following table.

Control
Character ASCII Code Description

\a or \A 07 (0x0007) Alert (Bell)
\b or \B 08 (0x0008) Backspace
\t or \T 09 (0x0009) Horizontal Tab
\n or \N 10 (0x000A) New Line
\v or \V 11 (0x000B) Vertical Tab
\f or \F 12 (0x000C) Formfeed
\r or \R 13 (0x000D) Carriage Return

\\ 92 (0x005C) \

¥ 39 (0x0027) ¢

\? 34 (0x0023) “

\? 63 (0x003F) ?

Any ASCII character can be specified in the format string using \xbb or
\nnn masks. \xbb is a hexadecimal byte with each b representing a valid hex
character in the range (0...9, a...F), for example \xff or \x1a.
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\nnn is an octal byte with each n being a valid octal character in the range
0 to 7, for example \123 or \347. THis value may not exceed 255 as it is
meant to represent a single byte of data. These two features can be used to
create and compare static characters. These can also be specified in the
regular expression, for example %[\xff, \123, \a, \b] is a valid frame.

@ Note The brackets only work in response format strings. They have no effect in the request
format string.

The ASCII object scans each field in the response frame character by
character. It may stop reading a particular field before it reaches a character
for a variety of reasons:

e The specified width has been reached.
e The next character cannot be converted as specified.

*  The next character conflicts with a character in the response format
string that it is supposed to match.

*  The next character fails to appear in a given character set.

No matter what the reason, when the ASCII object stops reading a field,
the next field is considered to begin at the first unread character. The
conflicting character, if there is one, is considered unread and is the first
character of the next field.

Entering ASCII Object Format String

For a static connection to one of the format data members, enter your
format string in the yellow field box in the Edit Connections dialog box.
Remember to begin and end the format strings with quotation marks so that
Lookout accepts the string input.

You can also connect any valid text data member, such as a text entry object,
to the format data members.
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Request Frame Construction Examples

Request Request
Format String RQV Frame
<01%4u%s RQV1=1234 <011234Steph
RQV2.txt=Steph
<01%04u%s RQVI1=34 <010034Steph
RQV2.txt=Steph
<01% 4u%s RQVI1=34 <01 34Steph

RQV2.txt=Steph

A zero in front of the four pads with zeroes; a space pads with spaces.

Response Format Examples

Response Response
Frame Format String RSV
*(16.38: *(%52f: RSV1=16.38

Note The decimal point counts as a character when decoding floats (%f). Also, decimal

points denoting precision are not allowed when decoding a float in the response frame.

Response
Frame

Response
Format String

RSV

>>Test Text<<

>>%8<<

RSV1.txt=Test
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The space between the words terminates the conversion. See the preceding
bracketed character example in order to span a space or other special
characters.

Response Response
Frame Format String RSV
>>Test Text<< >>%s%s<< RSV 1.txt=Test
RSV2.txt=Text
>>DogCat<< >>%35%3s<< RSV1.txt=Dog
RSV2.txt=Cat

The response format uses a space as a delimiter.

Using Sum Data Members

The ASCII object includes summing data members you can use to calculate
checksum characters. This can be a checksum you want to write into an
outgoing request frame or a checksum you want to verify in an incoming
response frame.

For example, if you want to calculate a checksum for the request A00B,
you would use an RQSum (request sum) data member. In the case of A00B,
you would use RQSum1 : 4, which would give you a sum of the ASCII byte
values of characters 1 through 4. Once you have this sum, you can
manipulate it mathematically any way necessary for the checksum value
you need. You can then insert this value at the end of your frame as a byte
(%Db) or a series of bytes.

The same technique works in reverse for RSSum (response sum) data
members.

For example, consider the response zo0A@. You know that you are
expecting 4 bytes plus a checksum. Assuming that this checksum
calculation involves the first four characters, use RSSum1 : 4 to get the byte
sum of characters 1 through 4. After performing the appropriate
mathematical manipulation, you can compare this value with the actual
byte read from the frame, and determine when there is a checksum failure.

Note There are many different methods for calculating checksums, and these data
members cannot support all of them. Before attempting to use them for checksum
calculation, make sure your checksum can be calculated from a simple byte sum of
characters in the frame.
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ASCII Error Messages

No response from device within timeout period

Lookout received no response from the device within the Receive timeout
period. The ASCII object was able to establish a socket, but when it sent a
message to the device, the device did not respond—as if it were not there.
You may have to significantly increase Receive timeout (and Poll Rate) to
ensure Lookout is allowing enough time to receive the expected response.
Also, verify your cable connections, power, configuration settings, and IP
settings.

Not enough data to send a valid frame

This means that the ASCII object has not received enough data to fill in all
the variables in the Request Format frame. This could mean that you do not
have connections made to all of the RQVs that the ASCII object is
expecting.

Frame Error (garbled)

ASCII got a response frame, but static characters in the response did not
match up to the response format string.

Data type or length does not match format string

ASCII got a response frame, but certain characters in the response were not
in the format stated by the markers in the response format string.

Illegal control character

The request frame had a % modifier followed by an invalid control code.

Related Objects IPASCII
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Cutler-Hammer

Cutler-Hammer is a protocol driver class Lookout uses to communicate
with Cutler-Hammer devices using serial communications.

It supports reading and writing of all predefined data points allowed by
the particular Cutler-Hammer model. When you create a Cutler-Hammer
object, you have immediate access to all the object data members. See the
Cutler-Hammer Data Member Set table for more information on data
members for this object.

Create Cutler-Hammer Secondary [ %]

M ame: |cutham1

Addiess: |255 | PLE Madel D50 4|

Communication Setting
Serial part: IEDM‘I j Drata bits: IS j

Baud Rate: ISBDD j Stop bits I‘I j

Parity: m

Phone nurnber: I

PalRate = |g;g1

Pall = |

Communication alarm pricrity: IS
Fietry attempts: |4 Feceive timeout: IBDDD MEecs

Skip every |5 poll requests after comm failure

Cancel | Help |

Figure 3-10. Cutler-Hammer Definition Parameters Dialog Box

Address specifies which Cutler-Hammer device you are communicating
with using this object. This number is between 0 and 191, and is set on the
device. (An address number of 255 broadcasts to all devices connected to
the network.)

PLC Model specifies what model of Cutler-Hammer device you are using.
The only model supported now is the Cutler-Hammer D50.

Serial port specifies which comm port the object uses for communicating
to the external device. This does not specify the communication type.
Communication type is determined by the Options»Serial Ports
command.
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@ Note For Lookout to communicate correctly with the Cutler-Hammer D50, you must
configure your COM port as radio using the Options»Serial Ports command.

Data rate indicates the baud rate that Lookout uses to communicate with
the hardware device. This setting should match the selection made on the
physical device.

Data bits indicates the number of data bits that Lookout uses to
communicate with the hardware device. This setting should match the
selection made on the physical device.

Stop bits indicates the number of stop bits that Lookout uses to
communicate with the hardware device. This setting should match the
selection made on the physical device.

Parity indicates the parity that Lookout uses to communicate with the
hardware device. This setting should match the selection made on the
physical device.

Phone number specifies the number to be dialed if the selected serial port
is configured for dial-up. This number only applies to the individual
protocol object.

PollRate is a numeric expression that determines how often to poll the
device. Lookout converts the numeric value of PollRate into a time signal
that represents days and fractions of a day. The object then polls the device
at the specified time interval. Normally, this is a time constant such as
0:01 (one second). See the Numeric Data Members section in Chapter 2,
How Lookout Works, of the Getting Started with Lookout manual for
information on entering time constants.

Poll is a logical expression. When this expression changes from false to
true, Lookout polls the device. You can use a simple expression like the
signal from a pushbutton, or a complex algorithm.

Communication alarm priority determines the priority level of alarms
generated by the Cutler-Hammer object. Such alarms are typically related
to communications with the physical device.

Retry attempts specifies the consecutive number of times Lookout
attempts to establish communications with a device if it is not getting

a valid response. After it tries the number of Retry attempts specified,
the Cutler-Hammer object generates an alarm and releases the comm port.
See Chapter 3, Serial Port Communication Service, in the Lookout
Developer’s Manual for more information.
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Receive timeout is the time delay Lookout uses in waiting for a response
from a device before retrying the request.

The Skip every N poll requests after comm failure setting instructs
Lookout to not poll a device it has lost communication with on every
scheduled poll. Instead, Lookout skips the device in the polling cycle
accordingly. Once communications have been reestablished, the device is
polled on its regular cycle.

Cutler-Hammer Data Members

As with all Lookout drivers, you can access I/O points and other data
through data members. The following is a table of data members currently
supported by the Cutler-Hammer object class.

Table 3-26. Cutler-Hammer Data Member Set

Data Member Type Read | Write Description

CommPFail logical yes no Goes high if Lookout cannot
communicate with the device

K0000 - K0015 numeric yes yes Keep relay

K00000.logical - logical yes yes Keep relay

KO01515.1ogical

MO0000 - M0031 numeric yes yes Internal relay

MO00000.1ogical - logical yes yes Internal relay

MO03115.logical

Poll logical no yes When transitioned from low to high,
Lookout begins a poll cycle on the
device

PollRate numeric no yes Specifies the frequency at which

Lookout polls the device

R00000.logical - logical yes yes External inputs and outputs, and
R02915.1ogical special function registers
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Table 3-26. Cutler-Hammer Data Member Set (Continued)

Data Member

Type Read | Write Description

Update

logical yes no Goes high when Lookout begins a
poll cycle on the device

WO0000 - W2815

numeric yes yes Timers, counters, and word registers

For a more complete definition of the function of these data members, see Cutler-Hammer documentation.

Not all of these data members are valid for every Cutler-Hammer device. See Cutler-Hammer documentation to see which
data members are valid for your particular model number.

Cutler-Hammer Status Messages

No response within timeout period

Lookout received no response from a device within the Receive timeout
period. The Cutler-Hammer object is able to use the comm port, but when
it polls the device, it does not respond—as if it is not even there. If you have
daisy-chained several devices, you may have introduced an inherent delay.
You may have to significantly increase Receive timeout (and Poll Rate) to
ensure Lookout is allowing enough time to receive the expected response.
This increase has nothing to do with the processing capabilities of Lookout.
Rather it is based solely on Data rate and the number of devices on the
chain. Also, verify your baud rate settings, cable connections, power,
configuration settings, comm port settings, and polling addresses.

Invalid query acknowledge frame

This means that the query acknowledge frame sent from the PLC in
response to the command sent by Lookout out was invalid.

Invalid PLC address in response frame

This means that the address within the response frame from the PLC does
not match exactly the address in the command sent out by Lookout. You
may possibly be requesting an address that is outside the valid range from
Cutler-Hammer devices.

Invalid CRC in response

This means the checksum (CRC in this case) failed in a frame received by
Lookout. Check cabling or for two or more devices with the same address.

Garbled or invalid frame

Frame received without format characters in their proper positions. Check
the Receive gap setting.
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Invalid response frame

This means that the response frame from the PLC did not have the expected
number of bytes in it.

Invalid function code in response frame

This means that the function code within the response frame from the PLC
does not match the function code in the command sent out by Lookout.

Wrong query, length, or designation

This is an error returned as an error code frame from the Cutler-Hammer
device. This means that the device could not successfully interpret the
query you just sent it.

Designated range exceeded

This is an error returned as an error code frame from the Cutler-Hammer
device. It means you have requested an address beyond the valid range of
addresses.

Command too long in length

This is an error returned as an error code frame from the Cutler-Hammer
device. This means that the frame just sent has exceeded the maximum
amount information that can be transported in a single frame (256 bytes).

Abnormal communications command

This is an error returned as an error code frame from the Cutler-Hammer
device.

Cutler-Hammer models supported:
D50
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DeltaTau

DeltaTau is a protocol driver object class Lookout uses to communicate
with Delta Tau Data Systems PMAC Motion Controllers. Create a
DeltaTau object for each card installed in the computer.

This object class communicates with Delta Tau PMAC cards through
dual-ported memory, so be sure that your PMAC hardware includes the
dual-ported RAM option.

The following figure shows a Delta Tau card configured to use PC memory
beginning at address D00O.

Mew DeltaT au Controller E
Hame: Celtal aul
Card base address: IDDDD j

Scanning interval: |5D

millizeconds
Communication alarm pricrity: IS

QK I Cancel | Help |

Card base address specifies the beginning memory location of the dual
ported RAM address. It should match card settings.

Scanning Interval identifies the frequency that the DeltaTau object in
Lookout polls the PMAC Motion Controller. Intervals can range from
10 ms to 1,000 ms.

Communication alarm priority specifies the priority level of alarms
generated by the object.

DeltaTau Data members

Like other protocol driver objects, DeltaTau objects contain a great deal
of data. All readable and writable members (inputs/outputs), polling
instructions, and so on, are bundled with the object. Therefore, as soon as
you create a DeltaTau object you immediately have access to all the object
data members. The following table lists data members for the DeltaTau
object.
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Table 3-27. DeltaTau Data Members

Data Member Type Read | Write Description

DS0 - DS8190 numeric yes yes Signed 32-bit word ranging from
—2,147,483,648 to 2,147,483,647

DWO0 - DW8190 numeric yes yes 32-Bit double-precision word ranging
from O to 4,294,967,295

FO - F8188 numeric yes yes 32-bit IEEE floating point word

S0 —-S8190 numeric yes yes Signed 16-bit word ranging from
—-32,768 to 32,767

Update logical yes no Driver-generated signal that pulses
each time Lookout scans the PMAC
Motion Controller card

W0 - W8190 numeric yes yes 16-Bit word ranging from 0 to 65,535

WO0.0 - W8190.15 logical yes yes 1 Bitin a 16-Bit word
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DL205 and DL405 are protocol driver object classes Lookout uses to
communicate with Koyo 205 and 405 PLCs, and other devices that use
the CCM protocol.

Koyo sells the 205 and 405 models under private brand labels. PLCDirect
offers the units as the DirectLOGIC 205 and 405 PLCs, and Siemens offers
the 405 unit as the TI405 series.

The DL205 and DL405 object classes support the Koyos native protocol,
CCM, which is also called DirectNET by PLCDirect and HostLink by
Siemens. This documentation refers to this protocol as CCM.

The DL205 and DL405 object classes support both point-to-point and
multidrop configurations. You can connect Lookout to a PLC programming
port, built-in DirectNET/HostLink port, or to the PLC DCM (data
communication module). These PLC communication ports use two
different versions of the CCM protocol: K-sequence and N-sequence.
Lookout supports both.

I ame: FLC Address:
Jou |
odel Fratocal
I DL240 j I Lawer port [n] j
— Serial Setting:
Serial port:

D ata rate

IED'\‘” jv 38400
Parity Data bits f* 13200
" None 7 8 3600
" Ewen Stop bitz C 4800
& Odd ’76‘1 o ||

1200

Phone number: 300

PolFate = |0:01

Pall = I

Communication alarm pricrity: IS_

Fietry attempts: |4 Feceive timeout: lﬁ MEecs
Skip every |5_ poll requests after comm failure

Cancel | Help |

Figure 3-11. DL205 Parameters Configured for one PLC in a
Multidropped Configuration
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Protocol identifies the CCM port you use to communicate with the device.
If you are planning to connect Lookout to a single PLC in a point-to-point
configuration, choose the UPPER PORT (k) Protocol and use the PLC
programming port. It supports K-sequence CCM. With this version of the
CCM protocol you can write directly to logical outputs.

If you are planning to network multiple PLCs in a multidrop configuration
where Lookout is the host computer, you must use the built-in PLC
DirectNET/HostLink port, or its DCM. Choose the LOWER PORT (n) or
DCM (n) Protocol as appropriate. These ports support N-sequence
CCM. The N-sequence CCM protocol does not permit writes directly to
logical data members.

@ Note Although you can connect logical signals to data members such as YO in Lookout,
any time you attempt to write to such a data member using the N-sequence CCM protocol,
the write request is ignored. (This is due to the limitations of N-sequence CCM protocol.)
If you have to write out a logical value using N-sequence, consider parsing the
corresponding VU address into a binary number and setting the bit you want to use by
writing a corresponding decimal integer. If you write a zero or 65535 to the corresponding
VU-memory location, you will write all zeros or ones to every bit in the register.

PLC Address is a slave address and refers to the address setting as set on
the physical device. If you are connecting to the PLC programming port,
set PLC Address to 1. If multiple devices share a common line, enter the
unique addresses of the device (1 to 255).

Use Model to choose the PLC model you want to use. If you are using a
model not listed, select a model whose data set most closely fits the model
you are using.

Serial port specifies which COM port on your computer that the object
uses for communicating to the PLC. This does not specify the
communication type. Communication type is determined by the
Options»Serial Ports... command.

Data rate, Parity, Data bits, and Stop bits should match the PLC settings.

Phone number specifies the number to be dialed if the selected serial port
is configured for dial-up. This number only applies to the individual
protocol object.

PollRate is a numeric expression that determines how often to poll the
device. The object then polls the device at the specified time interval.
Normally, this is a simple time constant such as 0:01 (one second).
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See Numeric Data Members in Chapter 2, How Lookout Works, of the
Getting Started with Lookout manual for information on entering time
constants.

Poll is a logical expression. When this expression changes from false to
true, Lookout polls the device. You can use a simple expression like the
signal from a pushbutton, or a complex algorithm.

Communication alarm priority determines the priority level of alarms
generated by the object. Such alarms are typically related to
communications with the physical device.

Retry attempts specifies the consecutive number of times Lookout
attempts to establish communications with a device it does not get a valid
response from. After the object retries communications the specified
number of times, it generates a communication alarm and Lookout moves
on to the next device in the polling queue (if any). Refer to Chapter 3, Serial
Port Communication Service, in the Lookout Developer’s Manual for more
information.

Receive timeout is the time delay Lookout uses in waiting for a response
from a device before retrying the request.

The SKip every... setting instructs Lookout to not poll a device it has lost
communication with on every scheduled poll. Instead, Lookout skips the
device in the polling cycle accordingly. Once communications have been
reestablished, the device is polled on its regular cycle.

DL205 and DL405 Data Members

Protocol driver objects contain a great deal of data. V-memory addresses,
registers, inputs and outputs are all bundled with the object. Therefore, as
soon as you create a DL205 object you have immediate access to the entire
data member set of the object (see data member list in Table 3-28).

As with all Lookout drivers, you can access I/O points and other data
through data members. The DL.205 and DL405 object classes automatically
generate an efficient read/write blocking scheme based on the inputs and
outputs you are using in your process file. So, you do not have to build your
own I/O blocking table. When Lookout polls a device, it optimizes frame
exchange according to the data length required and overhead needed. The
maximum data frame size that these drivers request is 256 data bytes. The
drivers use LRC and parity error checking to validate data.
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The following is a table of data members currently supported by the DL.205
and DL405 object class.

Table 3-28. DL205 and DL405 Data Members

Data Member Type Read | Write Description

C0-C3777 logical yes yes Control Relays—addressed in octal
and mapped to V40600 — V40700.

CommPFail logical yes no Object-generated signal that is on if,
for whatever reason, Lookout cannot
communicate with the device.

CTO - CT377 logical yes yes Counter status bits—addressed in
octal and mapped to V41140 —
V41147.

OffHook logical no yes When TRUE, this flag instructs the

DL object to retain exclusive use of its
assigned communication port.

Poll logical no yes When this value transitions from
FALSE to TRUE, Lookout polls the
device.

PollRate numeric no yes Lookout expression that determines

the device polling frequency.

S0 -S1777 logical yes yes Stages—addressed in octal and
mapped to V41000 — V41037.

SPAO — SPA177 logical yes yes Lower special relays—addressed in
octal.

SPB320 - SPB717 logical yes yes Upper special relays—addressed in
octal.

TO - T377 logical yes yes Timer status bits—addressed in octal
and mapped to V41100 — V41107.

Update logical yes no Object-generated signal that pulses
low each time it polls the device.

V0 -V41230 numeric yes yes Signed V-memory register containing
16-bit integer ranging from —32768 to
32767 dec.
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Table 3-28. DL205 and DL405 Data Members (Continued)

Data Member

Type Read | Write Description

V0.0 - V41230.17

logical yes no Individual bits within V-memory
registers—the least significant bitis 0,
the most significant bit is 17 (octal).

VBCDO-VBDC41230

numeric yes yes V-memory as BCD.

VDO — VD41227

numeric yes yes Double—reads two adjacent
V-memory registers as a single 32-bit
integer ranging from O to

4,294,967,296.
VDBCDO- numeric yes yes V-memory double as BCD.
VDBCD41227
VFO — VF41227 numeric yes yes Float—reads two adjacent V-memory

registers as a single 32-bit floating
point value.

VU0 - VU41230

numeric yes yes Unsigned—V-memory register
holding 16-bit unsigned integer
ranging from 0 to 65535.

X0 -X1777"

logical yes yes Discrete input points—addressed
in octal and mapped to V40400 —
V40407.

Y0 -Y1777*

logical yes yes Discrete output points—addressed
in octal and mapped to V40500 —
V40507.

* 205 series PLCs are limited to 128 input and output points total. You can mix these addresses as necessary, but understand
that Y17 and X17 refer to the same memory location on DL205.

DL205 and DL405 Status Messages

No response within timeout period

Lookout did not receive the expected response within the Receive timeout
period. The object sent an inquiry and received an acknowledgment, but the
device did not send an expected response to the request. This might happen
if the response was interrupted. You may have to increase Receive timeout.
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No return inquiry response from secondary unit

Lookout received no response from the device within the Receive timeout
period. The driver object is able to use the COM port, but when it polls
the device, it does not respond—as if it is not even there. You may have to
increase Receive timeout to ensure Lookout is allowing enough time to
receive the expected response. Also, verify your baud rate settings, cable
connections, power, configuration settings, COM port settings, and polling
addresses.

Bad LRC

The object is receiving a poll response from the device, but it could not
decipher the response because it is garbled. Verify that all devices
connected to the COM port have unique addresses. The last part of the
message may actually be getting clipped off before it is completed.
Consider increasing the number of Retry attempts. You may have to
increase the Receive gap Serial Port setting to ensure Lookout is receiving
the entire message. If your Serial Port is configured for radio, this could be
caused by an audible squelch tail occurring at the end of a radio
transmission. Try adjusting RTS delay off and CTS timeout.

No acknowledgment for header frame

You sent an inquiry and some kind of data write or read, but the device has
not responded. The object was expecting an acknowledgment for an
instruction frame and did not receive it. You may be asking for an invalid
memory address. Recheck your PLC memory address configuration. Also
verify that the PLC communication port supports the CCM Protocol that
you selected.

Invalid request frame

You are probably trying to use an invalid memory address. Recheck your
PLC address configuration.
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DNP

Use the DNP driver to connect to specific devices using the Distributed
Network Protocol version 3.0.

Create DNP Secondary [ %]
Mame: ID MP1
Address: ID

Source Address: |255

Communication Setting

Serial port:  [COMT (= [rata bits: IS 'l
Baud R ate: ISBDD 'l Stop bits: I‘I 'l
Parity: INone 'l

Phone nurnber: I

FallR ate = Ig:m

Pl = I Cancel |
. . Help |
Communication alarm pricrity: I8

Retry attempts: |4 Receive timeout: [257  msecs

Skip every |5 poll requests after comm failure

Address specifies which device you are communicating with using this
object. This number is between 0 and 255, and is set on the device.

Source Address specifies the DNP address of the computer running
Lookout.

Serial port specifies which port the object uses for communication to the
external device. This does not specify the communication type. You set
communication type in the Serial Ports dialog box. Select Options»Serial
Ports to access this dialog box.

Baud Rate, Parity, Data bits, and Stop bits reference the settings on the
hardware device.

Phone number specifies the number to be dialed if the serial port setting is
configured for dial-up. This number only applies to the individual protocol
object.

PollRate is a numeric expression that determines how often to poll your
DNP device. The object then polls the device at the specified time interval.
Normally, this is a simple time constant such as 0:01 (one second).
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See Numeric Data Members in Chapter 2, How Lookout Works, of the
Getting Started with Lookout manual for more information.

Poll is a logical expression. When this expression changes from FALSE to
TRUE, Lookout polls your DNP device for data from the specified device.
You can use a simple expression like the signal from a pushbutton, or a
complex algorithm.

The Skip N poll requests after COM failure setting instructs Lookout to
not poll a device it has lost communication with on every scheduled poll.
Instead, Lookout skips the device in the polling cycle. Once
communications have been reestablished, the device is polled on its
regular cycle.

Retry attempts specifies the consecutive number of times Lookout
attempts to establish communications with a device if it is not getting a
valid response. After it tries the number of Retry attempts specified, the
DNP object generates an alarm and releases the communication port back
to the communications service which then moves on to the next device in
the polling queue (if any).

Receive timeout is the time delay Lookout uses in waiting for a response
from a device before retrying the request.

Communication alarm priority determines the priority level of alarms
generated by the object. Such alarms are typically related to
communications with the physical device.

DNP Data Members

Table 3-29. DNP Data Members

Data Member Type Read | Write Description
AINDWO- numeric yes no 32-bit analog input
AINDW65535 (object 30, variation 3)
AINFDWO- numeric yes no 32-bit analog input with flag
AINFDW65535 (object 30, variation 1)

AINFWO0-AINFW65535

numeric yes no 16-bit analog input with flag
(object 30, variation 2)

AINWO-AINW65535

numeric yes no 16-bit analog input
(object 30, variation 4)

Lookout Object Reference Manual
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Table 3-29. DNP Data Members (Continued)

Data Member Type Read | Write Description
AOUTFDWO0- numeric yes yes 32-bit analog output with flag
AOUTFDW65535 (object 40, variation 1)

AOUTFWO- numeric yes yes 16-bit analog output with flag
AOUTFW65535 (object 40, variation 2)
BINO-BIN65535 logical yes no Binary input (object 1, variation 1)
BINSO-BINS65535 logical yes no Binary input with status
(object 1, variation 2)
BOUTO0-BOUT65535 logical yes yes Binary output (object 10, variation 1)
BOUTSO0-BOUTS65535 | logical yes yes Binary output with status
(object 10, variation 2)
CNTDWO- numeric yes no 32-bit counter (object 20, variation 5)
CNTDW65535
CNTFDWO- numeric yes no 32-bit counter with flag
CNTFDW65535 (object 20, variation 1)
CNTFWO- numeric yes no 16-bit counter with flag
CNTFW65535 (object 20, variation 2)
CNTWO-CNTW65535 numeric yes no 16-bit counter (object 20, variation 6)
CommPFail logical yes no Object-generated signal that is on if,
for whatever reason, Lookout cannot
communicate with your DNP device.
DCNTDWO- numeric yes no 32-bit delta counter
DCNTDW65535 (object 20, variation 7)
DCNTFDWO- numeric yes no 32-bit delta counter with flag
DCNTFDWG65535 (object 20, variation 3)
DCNTFWO- numeric yes no 16-bit delta counter with flag
DCNTFW65535 (object 20, variation 4)
DCNTWO- numeric yes no 16-bit delta counter
DCNTW65535 (object 20, variation 8)
FLO-FL65535 numeric yes yes 64-bit float (object 100, variation 2)
FS0-FS65535 numeric yes yes 32-bit float (object 100, variation 1)
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Table 3-29. DNP Data Members (Continued)

Data Member Type Read | Write Description

Poll logical no yes When this value transitions from
FALSE to TRUE, Lookout polls the
device.

PollRate numeric no yes Lookout expression that determines
the device polling frequency.

TIMEDATE numeric yes no Device time and date (in Lookout
time format) (object 50, variation 1)

Update logical yes no Object-generated signal that pulses
low each time it polls the device.

Error Messages

Lookout Object Reference Manual

No response within timeout period

Lookout received no response from a device within the Receive timeout
period. The DNP object is able to use the COM port, but when it polls the
device, it doesn’t respond—as if it is not there. If you have daisy-chained
several devices, you have introduced an inherent delay. You may have to
significantly increase Receive timeout (and Poll Rate) to ensure Lookout
is allowing enough time to receive the expected response. This increase has
nothing to do with the processing capabilities of Lookout. It is based solely
on Baud rate and the number of devices on the chain. Also, verify your
baud rate settings, cable connections, power, configuration settings, COM
port settings, and polling addresses.

FT3 Error: No start bytes

The driver could not find the bytes that signify the beginning of a DNP
frame in a response received from the device. This kind of garbled frame
might be caused by bad communications settings.

FT3 Error: FCB fail

The Frame Count Bit (FCB) in the received frame was wrong. This bit
helps to ensure that messages are sent and received in the right order. If you
are consistently seeing this error you may have a lot of quiescent traffic on
the network that is disrupting the driver.

FT3 Error: Bad destination byte

The DNP driver received a message that was not addressed to it.
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FT3 Error: Bad source bytes

The DNP driver received a message that was not from the device that this
object is monitoring.

FT3 Error: CRC fail

One of the FT3 level checksums failed. If this happens consistently, verify
your communications link and settings.

FT3 Error: Bad transport header sequence number

The sequence number in the transport header in the received frame was
wrong. This number helps to ensure that messages are sent and received in
the right order. If you are consistently seeing this error you may have a lot
of quiescent traffic on the network that is disrupting the driver.

FT3 Error: Bad application control sequence number

The sequence number in the application control byte in the received frame
was wrong. This number helps to ensure that messages are sent and
received in the right order. If you are consistently seeing this error you may
have a lot of quiescent traffic on the network that is disrupting the driver.

FT3 Error: Bad DIR

The DIR bit identifies a message as from the master or from a slave. If you
get this error you may have multiple masters set up on your network.

FT3 Error: Bad PRM

The PRM bit identifies a message as from an initiating station or from a
secondary station. If you get this error you may have multiple masters set
up on your network.
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Dynamic

Dynamic is a protocol driver class Lookout uses to communicate with
equipment such as programmable logic controllers (PLCs), remote
terminal units (RTUs), or any other piece of equipment that uses Dynamic
as its communication protocol.

Protocol driver objects contain a great deal of data. All readable and
writable members (inputs/outputs), polling instructions, read/write
blocking, serial port usage, etc. are bundled with the object. Therefore,
as soon as you create a Dynamic object you immediately have access to
all the object data members (see data member list in this section).

The driver currently supports reading and writing of all predefined data
point types including analog input, state input, pulse count input, pulse
duration input, pulse period input, high speed accumulator inputs, state
outputs, pulse outputs, analog outputs, and AGA data.

The driver automatically configures the RTU database to match the data
points referenced in the Lookout process file and verifies that the points
specified in the process file actually exist on the RTU. If you reference
undefined or unavailable points, the driver posts an alarm message to the
Lookout alarm system.

The Dynamic protocol driver automatically takes advantage of the RTU
exception reporting capabilities to maximize communication efficiency.
The driver requires that the RTU be set for physical point addressing—refer
to the RTU hardware technical reference manual for the dipswitch locations
that set this parameter.

@ Note Lookout protocol driver objects automatically generate an efficient read/write
blocking scheme based on the inputs and outputs being used in your process file. You are
not required to build your own I/O blocking table.

Lookout Object Reference Manual

The Dynamic protocol driver was written for Texas Instruments Model
8635, 8640 and 8641 RTUs (Remote Terminal Units) with RTX 5.41
EPROMs—earlier releases of RTX have significant bugs and do not
operate correctly with the Lookout Dynamic driver.
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Mew Dynamic RTU: E
MName:  |FRITH

r— Communication Settings

Address: |1 Serial port: IEDM‘I 'l

Parity—— [~ Data bits
' Mone 7
& 0dd [Ol:}
 Even =
 Maik Stop bitz
" Space o
15
I
Defaults | 3
Alarm priority: |1 1]
Retries: |3
Phone numnber: I
PolRate= [0:01

Pall = |

QK I Eancell Help |

Figure 3-12. Dynamic Parameter Configuration Dialog Box

In this example Lookout is connected to a Dynamic-speaking RTU with an
address of 7. Lookout is using serial portl (which was previously
configured for Dial-up communications), and calling the specified phone
number. Each poll occurs every 1 hour or when the operator depresses
Pushbutton7.

Address refers to the PLC or RTU address setting as set on the device

dipswitches. If devices share a common line, they require unique addresses
(1 to 255).

Serial port specifies which port the object uses for communication to the
external device. This does not specify the communication type.
Communication type is determined by the Options»Serial Ports...
command.

Data rate, Parity, Data bits, and Stop bits reference the settings on the
hardware device.

The Defaults button replaces the current settings with default values.

Alarm priority determines the priority level of Dynamic-generated
alarms.
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Phone number specifies the number to be dialed if the serial port setting is
configured for dial-up. This number only applies to the individual protocol
object.

PollRate is a numeric expression that determines how often to poll the
device. Dynamic then polls the device at the specified time interval.
Normally, this is a simple time constant such as 0:01 (one second). See
Numeric Data Members in Chapter 2, How Lookout Works, of the Getting
Started with Lookout manual for information on entering time constants.

Poll is a logical expression. When this expression changes from false to
true, Lookout polls the device. You can use a simple expression like the
signal from a pushbutton, or a complex algorithm.

As with all Lookout drivers, you can access I/O points and other data
through data members. The following is a table of data members currently
supported by the Dynamic object class.

Dynamic Data Members

Table 3-30. Dynamic Data Members

Data Members Type Read | Write Description

AIO — AI239 numeric yes no Analog inputs—returns a normalized
numeric value that ranges from 0 to
32000 and spans the full input analog
range.

AOQ0 — AO239 numeric no yes Analog outputs—sets voltage level of
analog outputs, and accepts a
normalized number from 0 to 32000.

btul — btu4 numeric yes no AGA data

dpl —dp4 numeric yes no Differential pressure (psi). 1 — 4

specifies meter run being referenced.

HSAOQO - HSA127

numeric yes no High-speed accumulator
inputs—counts the number of digital
pulses on an HSA input. Rollover is
detected automatically by driver, so
maximum pulse count is 4.5 x 1013,

Lookout Object Reference Manual
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Table 3-30. Dynamic Data Members (Continued)

Data Members Type Read | Write Description
MeterCodel — text no yes First 8 characters of this text string are
MeterCode4 used to create a filename with a . csv

extension. Entire text string is used as
a field within the .csv file. 1 - 4
specifies meter run being referenced.

NoComm logical yes no Driver-generated signal that is on if
Lookout cannot communicate with
the device for whatever reason.

PCIO - PCI239 numeric yes no Digital pulse count inputs—counts
the number of times a digital state
input has transitioned from of £ to on.
Rollover is detected automatically by
driver, so maximum pulse count is
about 4.5 X 1013,

PDIO - PDI239 numeric yes no Digital pulse duration
inputs—measures a periodic pulse on
time with a 10 msec resolution. Pulse
period should be 15 seconds or less.
Returned time is in standard Lookout
time units of fraction of a day.

Poll logical no yes When this value transitions from
FALSE to TRUE Lookout polls the
device.

PollRate numeric no yes Lookout expression that determines
the frequency at which the device is to
be polled.

PPIO — PP1239 numeric yes no Digital pulse period
inputs—measures a pulse period with
a 10 msec resolution. Pulse period
should be 15.1 seconds or less.
Returned time is in standard Lookout
time units of fraction of a day.

Qel — Qe4 numeric yes no Energy rate 1 — 4 specifies meter run
being referenced.
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Table 3-30. Dynamic Data Members (Continued)

Data Members Type Read | Write Description

Qsuml — Qsum4 numeric yes no Accumulated flow over the last
60 minutes (cubic feet — CF). 1 — 4
specifies meter run being referenced.

Qsum_monthl — numeric yes no Accumulated flow over the last 30

Qsum_month4 days (cubic feet — CF). 1 — 4 specifies
meter run being referenced.

Qsum_yesterday 1— numeric yes no Accumulated flow over the last 24

Qsum_yesterday4 hours (cubic feet— CF). 1 —4 specifies
meter run being referenced.

Qvl -Qv4 numeric yes no Instantaneous flow rate (cubic
feet/hour — CFH). 1 — 4 specifies
meter run being referenced.

ReadHistory logical no yes When this value transitions from
TRUE to FALSE, Lookout polls the
device and reads the historical AGA
from the RTU, storing to disk.

S10 — S1239 logical yes no Digital state inputs

SO0 - S0239 logical no yes Digital state outputs. On the 8635,
state outputs and pulse outputs are
mapped to programmable I/0O (PIO)
points and range from SO8 to SO15.

spl —sp4 numeric yes no Static pressure (psi). 1 — 4 specifies
meter run being referenced.

tfl —tf4 numeric yes no Flowing temperature (deg. F). 1 — 4
specifies meter run being referenced.

Update logical yes no Driver-generated signal that pulses
each time the driver polls the device

VB0-VB65535 logical yes yes Bit in V register read as logical.

VF0-VF2047 numeric yes yes V register read as float on 4-byte
boundary.

VFNO-VFN2047 numeric yes yes V register read as float, no boundary.
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Data Members Type Read | Write Description
VWO0-VW4095 numeric yes yes V register read as a word on 2-byte
boundary.
VWNO-VWN4095 numeric yes yes V register read as a word, no
boundary.
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Fatek MA/MB/MC

Lookout Object Reference Manual

Use the Fatek driver object class to communicate with Fatek PLCs. While
each series has its own create object dialog box, all of the Fatek driver
object classes are configured in the same way.

Station sets the PLC address. Select the correct PLC Model from the
choices listed, which include FB-20MA, FB-28MA, FB-40MA,
FB-20MB, FB-28MB, FB-40MB, FB-20MC, FB-28MC, and FB-40MC.

Serial port specifies which COM port on the host computer that Lookout
object uses for communicating to the external device. This does not specify
the communication type. Communication type is determined by the
Options»Serial Ports command. See Chapter 3, Serial Port
Communication Service, of the Lookout Developer's Manual for more
information on configuring your serial ports for use with Lookout.

Data rate, Parity, Data bits, and Stop bits reference the settings on the
hardware device.

Phone specifies the telephone number to be dialed if the selected serial port
is configured for dial-up. This number only applies to the individual
protocol object.

PollRate is a numeric expression that determines how often to poll the
device. Lookout polls the device at the specified time interval. Normally,
this is a simple time constant such as 0:01 (one second). See Numeric Data
Members in Chapter 2, How Lookout Works, of the Getting Started with
Lookout manual for information on entering time constants.

Poll is a logical expression. When this expression changes from false to
true, Lookout polls the device. Use a simple expression like the signal from
a pushbutton, or a complex algorithm.

Communication alarm priority determines the priority level of the alarms
generated by the Fatek object.

Retry attempts specifies the consecutive number of times Lookout
attempts to establish communication with a device if it is not getting a valid
response. After the specified number of Retry attempts, the object
generates an alarm and begins to SKip every n poll requests after comm
failure. Once Lookout reestablishes communication, it polls the device on
the regular cycle specified in PollRate.
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Receive timeout is the time delay that Lookout waits for a response from
a device before retrying the poll request.

The Skip every setting instructs Lookout not to poll a device it has lost
communication with on every scheduled poll. Instead, Lookout polls the
device once in the specified number of poll cycles. Once communication
has been reestablished, the device is polled on the specified cycle.

Fatek Data Members

A few of the following data members are available only in MB and MC
series PLCs. This restriction is noted in the Description column.

Table 3-31. Fatek Data Members

Data Member Type Read Write Description

C0-C255 logical yes no Discrete counter.

CommPFail logical yes no Object-generated signal that is on
if Lookout cannot communicate
with the device.

CTRO-CTR199 numeric yes yes 16-bit register.

DCTRO-DCTR255 numeric yes no 32-bit register.

DHRO0-DHR3838 numeric yes yes 32-bit Data register.

DHSCR4096- numeric yes yes (MB and MC series PLCs only)

DHSCR4126 32-bit High speed counter register.

DIR3840- numeric yes no 32-bit Input register.

DIR3846

DOR3904- numeric yes yes 32-bit Output register.

DOR3910

DRORS5000- numeric yes no 32-bit Read-only register.

DRORS8070

DSR4136- numeric yes yes 32-bit Special register.

DSR4166

DTMRO- numeric yes yes 32-bit Timer register.

DTMR254

DWMO-DWN1368 numeric yes yes 32-bit Internal relay (DW).

DWS0-DWS968 numeric yes yes 32-bit Step relay (DW).
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Table 3-31. Fatek Data Members (Continued)

Data Member Type Read Write Description
DWSMI1912- numeric yes yes 32-bit Special relay (DW).
DWSM1968
DWX0-DWX128 numeric yes yes 32-bit Input (DW).
DWYO0-DWY128 numeric yes yes 32-bit Output relay (DW).
HRO-HR3839 numeric yes yes 16-bit Data register.

HSCR4096- numeric yes yes (MB and MC series PLCs only)

HSCR4126 16-bit High speed counter register.

IR3840-1R3847 numeric yes no 16-bit Input register.

MO0-M1399 logical yes yes Internal relay.

OffHook logical no yes When TRUE, this flag instructs the
Fatek object to retain exclusive use
of its assigned communication
port.

OR3904-OR3911 numeric yes yes 16-bit Output register.

Poll logical no yes When this value transitions from
FALSE to TRUE, Lookout polls
the device.

PollRate numeric no yes Lookout expression that
determines the device polling
frequency.

RORS5000- numeric yes no 16-bit Read-only register.

ROR8071

RTCR4128- numeric yes no (MB and MC series PLCs only)

RTCR4135 16-bit Real time clock register.

S0-S999 logical yes yes Step relay.

SM1912-SM2001 logical yes yes Special relay.

SR436-SR4167 numeric yes yes 16-bit Special register.

TO-T255 logical yes no Discrete timer.

TMRO-THR255 yes yes 16-bit Timer register.
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Table 3-31. Fatek Data Members (Continued)

Data Member Type Read Write Description

Update logical yes no Object-generated signal that
pulses low each time it polls the
device.

WMO0-WM1384 numeric yes yes 16-bit Internal relay (W).

WS0-WS984 numeric yes yes 16-bit Step relay (W).

WSM1912- numeric yes yes 16-bit Special relay (W).

WSM1984

WX0-WX144 numeric yes no 16-bit Input (W).

WYO0-WY144 numeric yes yes 16-bit Output relay (W).

X0-X159 logical yes no Discrete inputs.

YO0-Y159 logical yes yes Output relay.

Fatek Status Messages

Lookout returns the following status messages for the Fatek driver object.

No response from PLC

Lookout received no response from the device within the Receive timeout
period. The object was able to establish a connection, but when it sent a
message to the device, the device did not respond. Significantly increase
Receive timeout, and Poll Rate, to ensure Lookout is allowing enough
time to receive the expected response. Also, verify the cable connections,
serial port wiring, power supply, configuration settings, and IP settings.

Unexpected response from PLC

A response was received from the PLC, but it was not the response expected
according to the protocol.

Bad frame

A response frame was received from the PLC, but the frame is not valid
according to the protocol. This is usually caused by a truncated frame.
Increase the Receive Gap setting in the Options»Serial Ports dialog box.

Bad BCC

The BCC computed by the object for a received frame does not match the
BCC in the frame.
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PLC Alarms

The following alarms originate in the PLC, and are passed along
immediately by the object. There are no retry attempts. Consult the PLC
documentation for more details on these and other PLC errors:

Checksum error

Illegal value

Write protection

Illegal command format

Cannot run

Illegal address

Cannot back up as program contains password
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FisherROC

FisherROC is a protocol driver class Lookout uses to communicate with
a ROC364 (Remote Operations Controller) made by Fisher Controls. To
communicate with the ROC364, connect directly to its COM1 or COM2
port. Depending on the device configuration, these ports may be configured
for RS-232, RS-422/485 or Bell 202 modem communications.

Create one FisherROC object for each ROC364. This object class contains
a great deal of data. All point types including inputs, outputs, PID, AGA,
Tank, and their configuration signals are bundled with the object.
Therefore, as soon as you create a FisherROC object you immediately have
access to the object data member set.

Create Fisher ROC [x]
M ame:
ROC1 Group [0-255]: |2
Controller model: Address (0-255] |1_
IHDE384 vl
r— Communication Settings
Serial port:

D ata rate

IEDM‘I 'l

Parity

D ata Bits
' None CF7 &g

" Ewen "Stop Bitz

 Odd 1 g | [CE0
300

Phone number:

PolFate = |0:01

Pall = I
Communication alarm priority: IS

Fietry attempts: |4 Feceive timeout: [500  mzecs

Skip every |5 poll requests after comm failure

QK I Cancel | Help |

Figure 3-13. FisherROC Definition Parameters Dialog Box

Group is the group code to which the ROC station is assigned. This is
typically set to 2, but is configurable through the GV101 Configuration
software.

Address is the unit code (address setting) of the ROC station as defined
using the GV101 Configuration software. If multiple ROCs are members
of the same group, then they must have unique addresses (0 to 255). As the
host station, the Lookout computer is assigned Group 0, Address 1.
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Controller model identifies the type of Fisher remote operations controller
that the object represents. This object class supports ROC364.

Serial port specifies which COM port on the host computer that Lookout
object uses for communicating to the external device. This does not specify
the communication type. Communication type is determined by the
Options»Serial Ports... command.

Data rate, Parity, Data bits, and Stop bits reference the settings on the
hardware device.

Phone number specifies the number to be dialed if the selected serial
port is configured for dial-up. This number only applies to the individual
protocol object.

PollRate is a numeric expression that determines how often to poll the
device. The object then polls the device at the specified time interval.
Normally, this is a simple time constant such as 0:01 (one second). See
Numeric Data Members in Chapter 2, How Lookout Works, of the Getting
Started with Lookout manual for information on entering time constants.

Poll is a logical expression. When this expression changes from FALSE to
TRUE, Lookout polls the device. You can use a simple expression like the
signal from a pushbutton, or a complex algorithm.

Communication alarm priority determines the priority level of alarms
generated by the object. Such alarms are typically related to
communications with the physical device.

Retry attempts specifies the consecutive number of times Lookout
attempts to establish communications with a device if it is not getting a
valid response. After it tries the number of Retry attempts specified, the
object generates an alarm and releases the communication port back to the
communications service which then moves on to the next device in the
polling queue (if any). Refer to Chapter 3, Serial Port Communication
Service, in the Lookout Developer’s Manual for more information.

Receive timeout is the time delay Lookout uses in waiting for a response
from a device before retrying the request.

The Skip every... setting instructs Lookout to not poll a device it has lost
communication with on every scheduled poll. Instead, Lookout skips the
device in the polling cycle accordingly. Once communications have been
reestablished, the device is polled on its regular cycle.
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Table 3-32. FisherROC Data Members

Data Member Type Read | Write Description

AGAO.ha-AGA4.ha numeric yes yes Age high alarm
AGAO.la— AGA4.la numeric yes yes AGA low alarm EU value
AGF0.btud — AGF4.btud numeric yes no AGA Flow in units of MMBTU/Day
AGFO0.btut — AGF4.btut numeric yes no MMBTUs of AGA Flow today
AGFO0.btuy — AGF4.btuy numeric yes no MMBTUs of AGA Flow yesterday
AGFO0.mcfd — AGF4.mcfd | numeric yes no AGA Flow in units of MCF/Day
AGFO0.mcft — AGF4.mcft numeric yes no MCFs of AGA Flow today
AGFO0.mcfy — AGF4.mcfy | numeric yes no MCFs of AGA Flow yesterday
Al:Al.adh — AL:D16.adh numeric yes yes Analog input adjusted A/D 100%
AL:Al.adl — AI:D16.adl numeric yes yes Analog input adjusted A/D 0%
Al:Al.dla— AL:D16.dla numeric yes yes Analog input Delta Alarm EU
Al:Al.euh — AI:D16.euh numeric yes yes Analog input High Reading EU
Al:Al.eul — Al:D16.eul numeric yes yes Analog input Low Reading EU
AL:Al.feu — AI:D16.feu numeric yes yes Analog input Filtered EU value
AL A1.flt - AL:D16.f1t numeric yes yes Analog input Filter
Al:Al.ha— AL:D16.ha numeric yes yes Analog input High alarm limit
Al:Al.hha — AI:D16.hha numeric yes yes Analog input High-High alarm limit
Al:Al.la- AI:Dl16.1a numeric yes yes Analog input Low alarm limit
AL:Al.lla - Al:D16.1la numeric yes yes Analog input Low-Low alarm limit
Al:Al.raw — A:D16.raw numeric yes no Analog input Raw A/D input value
AO:Al.adh — AO:D16.adh | numeric yes yes Analog output Adjusted A/D 100%
AO:Al.adl - AO:D16.adl numeric yes yes Analog output Adjusted A/D 0%
AO:Al.eu— AO:Dl6.eu numeric yes yes Analog output EU output value
AO:Al.euh — AO:D16.euh | numeric yes yes Analog output High Reading EU

© National Instruments Corporation 3-101 Lookout Object Reference Manual



Chapter 3 Lookout Driver and Protocol Objects

Table 3-32. FisherROC Data Members (Continued)

Data Member Type Read | Write Description

AO:Al.eul - AO:D16.eul numeric yes yes Analog output Low Reading EU

CommPFail logical yes no Object-generated signal that is on if,
for whatever reason, Lookout cannot
communicate with the ROC

DI:Al.acc — DI:D16.acc numeric yes yes Discrete input accumulated value
DI:A1.flt — DI:D16.flt logical yes yes Discrete input filter
DI:Al.ha - DI:D16.ha numeric yes yes Discrete input high alarm

DI:Al.hha — DI:D16.hha numeric yes yes Discrete input high-high alarm

DI:Al.]la-DI:D16.1a numeric yes yes Discrete input low alarm
DI:Al.1la - DI:D16.11a numeric yes yes Discrete input low-low alarm
DI:Al.sts — DI:D16.sts logical yes no Discrete input status (value)
DO:Al.acc — DO:Dl16.acc | numeric yes yes Discrete output accumulated value

DO:Al.cth—DO:D16.cth | numeric yes yes Discrete output 100% count

DO:Al.ctl - DO:D16.ctl numeric yes yes Discrete output 0% count

DO:Al.ctm—-DO:D16.ctm | numeric yes yes Discrete output cycle time

DO:Al.eu - DO:D16.eu numeric yes yes Discrete output EU value

DO:Al.rdh - DO:D16.rdh | numeric yes yes Discrete output high reading EU

DO:Al.rdl - DO:D16.rdl numeric yes yes Discrete output low reading EU

DO:Al.sts — DO:D16.sts logical yes yes Discrete output status (value)
DO:Al.to — DO:D16.to numeric yes yes Discrete output time on
FST1.rgl — FST8.rgl0 numeric yes yes Function seq. table register value
FST1.rrg — FST8.1rg numeric yes yes Function seq. table result register
FST1.tm1 — FSTS.tm4 numeric yes yes Function seq. table timer value
PIDO.eu — PID15.eu numeric yes yes PID output EU value

PIDO.ost — PID15.0st numeric yes yes PID OVR sw setpoint

PIDO.pst — PID15.pst numeric yes yes PID PRI sw setpoint
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Table 3-32. FisherROC Data Members (Continued)

Data Member Type Read | Write Description

PIDO.set — PID15.set numeric yes yes PID setpoint value

PL:Al.acc — PL:D16.acc numeric yes yes Pulse input accumulated value

PL:Al.crt — PL:D16.crt numeric yes no Pulse input current rate

PL:Al.dla—PL:Dl16.dla numeric yes yes Pulse input delta alarm EU

PL:Al.eu—PL:DI16.eu numeric yes yes Pulse input value in engineering
units

PL:Al.ha—PL:D16.ha numeric yes yes Pulse input high alarm EU value

PL:Al.hha — PL:D16.hha numeric yes yes Pulse input high-high alarm EU
value

PL:Alla-PL:Dl6.]a numeric yes yes Pulse input low alarm EU value

PL:Al.lla-PL:Dl16.1la numeric yes yes Pulse input low-low alarm EU value

PL:Al.rpd - PL:D16.rpd numeric yes yes Pulse input rate period

Poll logical no yes When this value transitions from
FALSE to TRUE, Lookout polls the
device.

PollRate numeric no yes Lookout expression that determines
the device polling frequency.

SPT1.d1 - SPT32.d20 numeric yes yes Soft point parameter data number

TNKO.cfl - TNK7.cfl numeric yes no Tank current fluid level

TNKO.dis — TNK7.dis numeric yes no Tank barrels discharged

TNK2.dla — TNK7.dla numeric yes yes Tank delta alarm EU

TNKO.1sl — TNK7.1sl numeric yes no Tank last scan level

TNKO.man — TNK7.man numeric yes yes Tank manual entry—barrels

TNKO.ttl — TNK?7.ttl numeric yes no Tank total barrels hauled

TNKO.tvl — TNK7.tvl numeric yes no Today’s tank volume

TNKO.yvl - TNK7.yvl numeric yes no Yesterday’s tank volume

Update logical yes no Object-generated signal that pulses
low each time it polls the device

© National Instruments Corporation 3-103 Lookout Object Reference Manual



Chapter 3 Lookout Driver and Protocol Objects

Comments To

Compatibility Note

A correction in how Lookout indexes device registers for Fisher ROC
PLCs was made in Lookout versions 4.0.1 and later. In previous versions,
Lookout did not have any data members mapped to control device 0, but
did have data members mapped to a non-existent register 5.

The data members affected are:
—  All AGA members
—  All AGF members
—  All TNK members
—  All PID members
— FSTl.arg - FST8.rrg

For example Lookout previously used AGA data members numbered
AGA1-AGAS where the PLC registers are numbered AGAO-AGA4. In
Lookout 4.0.1, the AGAS5 data member has been removed, and an AGAQ
data member has been added.

read the raw value of an analog input located at I/O module socket 9 on

the third mounting rack, you would enter NAME . AT : C9 . raw, where

AT :C9.raw
Signal Type/I/ QParameter
Mounting Rack (A,B,C, or D) Socket Number (1-16)

FisherROC Status Messages

Lookout Object Reference Manual

No response within timeout period

Lookout received no response from the ROC device within the Receive
timeout period. The driver object is able to use the COM port, but when it
polls the device, it does not respond—as if it is not even there. You may
have to increase Receive timeout to ensure Lookout is allowing enough
time to receive the expected response. Also, verify your baud rate settings,
cable connections, power, configuration settings, COM port settings, and
polling addresses.
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Message Garbled—Bad CRC

The object is receiving a poll response from the device, but it cannot
decipher the response. Verify that all devices assigned to the device group
have unique unit codes. The last part of the message may actually be getting
clipped off before it is completed. Consider increasing the number of Retry
attempts. You may have to increase the Receive gap Serial Port setting
to ensure Lookout is receiving the entire message. If your Serial Port is
configured for radio, this could be caused by an audible squelch tail
occurring at the end of a radio transmission. Try adjusting RTS delay off
and CTS timeout.

Unexpected data response length

The object is receiving a poll response from the device, but the response is
too long. Verify that all devices connected to the COM port and assigned to
the same device group have unique unit codes. Devices with identical
addresses may be trying to respond at the same time. Also verify device
protocol settings.

Response too short

The object is receiving data of a length that does not meet the minimum
frame length requirements. Verify device protocol settings. You may have
to increase Receive timeout.

Return unit address incorrect
Return group address incorrect

The object sent a data write or data read request, but the ROC did not
respond. You may be asking for an invalid memory address. Recheck your
ROC address configuration.

Invalid module or point requested

You attempted a data type mismatch. For example, you may have tried
to write or read an analog value to or from a rack I/O socket that has a
discrete module installed, or visa versa. This is an addressing problem.
Verify that the type of I/O at the desired socket matches the signal type
of the address identified in the data member you are writing to.

Unexpected opcode in response: xx

The object is receiving a poll response from the device, but the response
was not expected. This might happen if the object receives a poll response
after the Receive timeout period expires. You may have to increase
Receive timeout. Another possibility is that the ROC is attempting an
unsolicited communication. The FisherROC object class currently does not
support unsolicited report-by-exception.
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GE_Series90

GE_Series90 is a protocol driver class Lookout uses to communicate with
GE Series 90-30 and GE Series 90-70 programmable logic controllers
(PLCs) using SNPX, a Series Ninety Protocol.

Figure 3-14. GE_Series90 Definition Parameters Dialog Box

Create Series 90 E

I ame: FLC Address:

|

odel Fratocal

Ja0-20 =l |shPx =l

— Serial Setting:
Serial port:

IEDM‘I 'l
Parity D1ata bits
' Mone 7 &8

" Ewen Stop bitz
& 0dd ’76"1 2

Phone number:

PolFate = |0:01

Pall = I
Communication alarm priority: IS

Fietry attempts: |4 Feceive timeout: |500 MEecs

Skip every |5 poll requests after comm failure

.

Cancel | Help |

PLC Address is a slave address and refers to the PLC address setting as
configured on the device. The address can be up to eight ASCII characters.

Model chooses either 90-30 or 90-70.

Interface selects the protocol. You can choose between SNPX and

Ethernet.

Serial port specifies which port the object uses for communication to

the external device. This does not specify the communication type.
Communication type is determined by the Options»Serial Ports...

command.

Data rate, Parity, Data bits, and Stop bits reference the settings on the

hardware device.
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Phone number specifies the number to be dialed if the serial port setting is
configured for dial-up. This number only applies to the individual protocol
object.

PollRate is a numeric expression that determines how often to poll the
device. GE_Series90 then polls the device at the specified time interval.
Normally, this is a simple time constant such as 0:01 (one second). See
Numeric Data Members in Chapter 2, How Lookout Works, of the Getting
Started with Lookout manual for information on entering time constants.

Poll is a logical expression. When this expression changes from FALSE to
TRUE, Lookout polls the device. You can use a simple expression like the
signal from a pushbutton, or a complex algorithm.

Communication alarm priority determines the priority level of
object-generated alarms (0 — 10).

Retry attempts specifies the consecutive number of times Lookout
attempts to establish communications with a device if it is not getting a
valid response. After it tries the number of Retry attempts specified, the
GE_Series90 object generates an alarm and releases the communication
port back to the communications service which then moves on to the next
device in the polling queue (if any). Refer to Chapter 3, Serial Port
Communication Service, in the Lookout Developer’s Manual for more
information.

Receive timeout is the time delay Lookout uses in waiting for a response
from a device before retrying the request.

The Skip every... setting instructs Lookout to not poll a device it has lost
communication with on every scheduled poll. Instead, Lookout skips the
device in the polling cycle accordingly. Once communications have been
reestablished, the device is polled on its regular cycle.

GE_Series90 Data Members

This protocol driver object contains a great deal of data. All readable
and writable members (inputs/outputs), polling instructions, read/write
blocking, serial port usage, and so on, are bundled with the object.
Therefore, as soon as you create a GE_Series90 object you immediately
have access to all the object data members (see data member list in
Table 3-33).
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@ Note Lookout protocol driver objects automatically generate an efficient read/write

blocking scheme based on the inputs and outputs being used in your process file. You are

not required to build your own I/O blocking table.

Table 3-33. GE_Series90 Data Members

Data Member

Type

Read

Write

Description

AI1-AI2048

numeric

yes

no

16-bit analog value encoded as
unsigned binary integers ranging
from 0 to 65535

AID1-AID2047

numeric

yes

no

16-bit analog value encoded as
unsigned binary integers ranging
from 0 to 65535

AQI1-AQ512

numeric

yes

yes

16-bit analog outputs encoded as
unsigned binary integers ranging
from 0 to 65535

AQDI-AQD511

numeric

yes

yes

16-bit analog outputs encoded as
unsigned binary integers ranging
from 0 to 65535

All — Al64

numeric

yes

yes

16-bit analog inputs encoded as
unsigned binary integers ranging
from 0 to 65535

AID1 - AID64

numeric

yes

yes

32-bit analog inputs encoded as
unsigned binary integers ranging
from 0 to 65535

AIF1-AIF2047

numeric

yes

no

32-bit analog output encoded as float

value

AIU1-AIU2047

numeric

yes

no

32-bit analog output encoded as

unsigned binary long ranging from 0

to OxFFFFFFFF

AQI — AQ64

numeric

yes

yes

16-bit analog outputs encoded as
unsigned binary integers ranging
from 0 to 65535

AQDI — AQD64

numeric

yes

yes

32-bit analog outputs encoded as
unsigned binary integers ranging
from 0 to 65535

Lookout Object Reference Manual

3-108

ni.com



Chapter 3 Lookout Driver and Protocol Objects

Table 3-33. GE_Series90 Data Members (Continued)

Data Member Type Read | Write Description
AQF1-AQF511 numeric yes no 32-bit analog output encoded as float
value
AQUI-AQU511 numeric yes yes 32-bit analog output encoded as
unsigned binary long ranging from 0
to OxFFFFFFFF
CommPFail logical yes no Object-generated signal that is on if,

for whatever reason, Lookout cannot
communicate with the PLC.

11-14096 logical yes no single-bit discrete input

I1-1512 logical yes no Single bit discrete inputs

M1 - M4096 logical yes yes Single bit discrete (Internal coil)
OffHook logical no yes When TRUE, this flag instructs the

GE object to retain exclusive use of its
assigned communication port.

Poll logical no yes When this value transitions from
FALSE to TRUE, Lookout polls the
device.

PollRate numeric no yes Lookout expression that determines

the device polling frequency.

Q1-Q4096 logical yes yes single-bit discrete output

Ql-Q512 logical yes yes Single bit discrete outputs

R1-R9999 numeric yes yes 16-bit holding registers encoded as
unsigned binary integers ranging
from 0 to 65535

RD1 - RD9998 numeric yes yes 32-bit holding registers encoded as
unsigned binary integers ranging
from 0 to 65535

RF1-RF9998 numeric yes no 32-bit holding registers encoded as
float value

RUI1-RU9998 numeric yes yes 32-bit holding registers encoded as
unsigned binary long ranging from 0
to OxFFFFFFFF
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Table 3-33. GE_Series90 Data Members (Continued)

Data Member Type Read | Write Description
S1-S32 logical yes no System fault
SA1 - SA32 logical yes no Special Contacts A
SB1 - SB32 logical yes no Special Contacts B
SC1 -SC32 logical yes no Special Contacts C
Update logical yes no Object-generated signal that pulses
each time the driver polls the device

GE_Series90 Status Messages

Lookout Object Reference Manual

No response within timeout period

Lookout did not received the expected response within the Receive
timeout period. The object sent an inquiry and received an
acknowledgment, but the device did not send an expected response to the
request. This might happen if the response was interrupted. You may have
to increase Receive timeout.

No return inquiry response from secondary unit

Lookout received no response from the device within the Receive timeout
period. The driver object is able to use the COM port, but when it polls the
device, it does not respond—as if it is not even there. You may have to
increase Receive timeout to ensure Lookout is allowing enough time to
receive the expected response. Also, verify your baud rate settings, cable
connections, power, configuration settings, COM port settings, and polling
addresses.

Bad LRC or BCC

The object is receiving a poll response from the device, but it could not
decipher the response because it is garbled. Verify that all devices
connected to the COM port have unique addresses. The last part of the
message may actually be getting clipped off before it is completed.
Consider increasing the number of Retry attempts. You may have to
increase the Receive gap Serial Port setting to ensure Lookout is receiving
the entire message. If your Serial Port is configured for radio, this could be
caused by an audible squelch tail occurring at the end of a radio
transmission. Try adjusting RTS delay off and CTS timeout.
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No attach response within timeout period

An attempt was made to establish communications with the PLC without
any response. Check your cabling and COM port selections, power,
configuration settings, and polling addresses.

Invalid response [x]

An error in the structure of a response frame was detected. You may have
two PLCs with the same address.

Incorrect response length [x]

A response was received with an unexpected length. You may have to
increase the Receive gap Serial Port setting to ensure Lookout is receiving
the entire message.

Incorrect response Address

A response was received with an address not matching the objects address.
You may have two master devices on the network.

SNPX ERROR—Major code: x Minor code: x

The response message contained an SNPX error code. Refer to your
GE documentation for the meaning of this particular error.

© National Instruments Corporation 3-111 Lookout Object Reference Manual



Chapter 3 Lookout Driver and Protocol Objects

Hitachi

Hitachi is a protocol driver class Lookout uses to communicate with
Hitachi devices using the H series serial communication protocol.

Mame:

Timeout [0 Model [CPUZ202HE x|
Loop: |255— Module:

Unit: |255— Fart:

Communication Setting

ID
ID
Senal port:  |COM1 | = Drata bits: IS 'l
Baud Rate: ISBDD 'l Stop bits: I‘I VI
Parity: lm

Phone numnber: I

FallR ate = Ig:m
Poll = I

Communication alarm priority: IS

Fietry attempts: |4 Feceive timeout: (250 msecs

Skip every |5 poll requests after comm failure

QK I Cancel | Help |

Figure 3-15. Hitachi Definition Parameters Dialog Box

Set the Hitachi device timeout in the Timeout field.

Loop specifies the Hltachi device loop. Set the Hitachi Module, Unit, and
Port values in the appropriate fields.

Serial port specifies which comm. port the object uses for communicating
to the external device. This does not specify the communication type.
Communication type is determined by the Options»Serial Ports...
command.

Data rate indicates the baud rate that Lookout uses to communicate with
the hardware device. This setting should match the selection made on the
physical device.

Data bits indicates the number of data bits that Lookout uses to
communicate with the hardware device. This setting should match the
selection made on the physical device.
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Stop bits indicates the number of stop bits that Lookout uses to
communicate with the hardware device. This setting should match the
selection made on the physical device.

Parity indicates the parity that Lookout uses to communicate with the
hardware device. This setting should match the selection made on the
physical device.

Phone number specifies the number to be dialed if the selected serial
port is configured for dial-up. This number only applies to the individual
protocol object.

PollRate is a numeric expression that determines how often to poll the
device. The object then polls the device at the specified time interval.
Normally, this will be a simple time constant such as 0:01 (one second).
See Numeric Data Members in Chapter 2, How Lookout Works, of the
Getting Started with Lookout manual for information on entering time
constants.

When the logical value Poll transitions from FALSE to TRUE, Lookout
polls the device. This can be a simple expression like the signal from a
pushbutton, or it can be a complex algorithm.

Communication alarm priority determines the priority level of alarms
generated by the Hitachi object. Such alarms are typically related to
communications with the physical device.

Retry attempts specifies the consecutive number of times Lookout
attempts to establish communications with a device if it is not getting a
valid response. After it tries the number of Retry attempts specified, the
Hitachi object generates an alarm and releases the communication port
back to the communications subsystem, which then moves on to the next
device in the polling queue (if any). Refer to Chapter 3, Serial Port
Communication Service, in the Lookout Developer’s Manual for more
information.

Receive timeout is the time delay Lookout uses in waiting for a response
from a device before retrying the request.

The Skip every... setting instructs Lookout to not poll a device it has lost
communication with on every scheduled poll. Instead, Lookout skips the
device in the polling cycle. Once communications have been reestablished,
the device is polled on its regular cycle.
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Hitachi Data Members

An Hitachi object contains a great deal of data. It supports reading and
writing of all predefined data points. When you create an Hitachi object,
you have immediate access to all the object data members.

As with all Lookout drivers, you can access I/O points and other data
through data members. The following is a table of data members currently
supported by the Hitachi object class.

Table 3-34. Hitachi Data Members (Address Ranges in Hexadecimal)

Data Member Type Read | Write Description

CommPFail logical yes no Object-generated signal that is ON if
Lookout cannot communicate with
the device(s).

CUO0 - CUS512 numeric yes yes Up Counter

DLO - DL1000 numeric yes yes Double-word CPU link area

DMO - DM1000 numeric yes yes Double-word data area

DRO - DR3E numeric yes yes Internal double-word output

DXO0 - DX10 numeric yes yes External double-word output

DY0-DY10 numeric yes no External double-word output

L0 — L4000 logical yes yes Bit CPU link area

MO — M4000 logical yes yes Bit data area

Poll logical no yes When this expression transitions from
FALSE to TRUE, Lookout polls the
device.

PollRate numeric no yes Lookout expression that determines
the device polling frequency.

RO - R7CO logical yes yes Internal bit output

TCO - TC512 numeric yes yes Timer counter elapsed time

TDO - TD512 logical yes yes On-Delay timer

Update logical yes no Object-generated signal that pulses
low each time it polls the device.

WLO - WL2000 numeric yes yes Word CPU link area
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Table 3-34. Hitachi Data Members (Address Ranges in Hexadecimal) (Continued)

Data Member Type Read | Write Description
WMO - WM2000 numeric yes yes Word data area
WRO - WR7C numeric yes yes Internal word output
WX0 - WX20 numeric yes yes External word output
WYO0-WY20 numeric yes no External word output
X0 —-X200 logical yes yes External bit input
YO0 -Y200 logical yes no External bit output

Hitachi Status Messages

no acknowledgment for data request
no within timeout period
PLC response frame timeout

The PLC is not responding to data requests. Check communications
settings, cables, and power.

Frame Error (Garbled): [Hitachi error code string]

Response frame was garbled. Check cabling and cable environment.

Hitachi frame error (RTC): [RTC error code string]

PLC received an invalid frame. Check communications settings.

Hitachi error message: [Hitachi error code string]

PLC received an invalid request. Check for a data member that is out of
range for the model of PLC configuration.
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IPASCII

IPASCII is a protocol driver class Lookout uses to communicate with any
IP device that runs standard TCP or UDP services.

An IPASCII object contains no predefined data points. When you create a
IPASCII object, you must define your data request strings as well as the
template Lookout uses to parse the response frame.

Mame 45
Mode: TCRP -
Local port: I

Ethernet setting

IP address: I
Fart: I

™ Accept Unsolicited Messages

Communication alarm pricrity: IS
Fietry attempts: |4 Feceive timeout: IEDD MEecs
Skip every |5 poll requests after comm failure

QK I Cancel | Help |

Local port specifies which local Ethernet I/O port the object uses for
communicating to the external device.

Mode indicates whether the object will use a TCP socket or a UDP socket.

IP address indicates the address of the device you wish to
communicate with.

Port indicates the Ethernet I/O port number on the remote device where the
object will try to establish a socket.

Accept Unsolicited Messages indicates whether or not the object will
report packets from the device that are not in response to a request that the
IPASCII object has sent it. This does not mean that the IPASCII object can
act as a server. It means that once the IPASCII object has established a
socket as a client, it reports unexpected data it receives from that point on.

Communication alarm priority determines the priority level of alarms
generated by the IPASCII object. Such alarms are typically related to
communications with the physical device.
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Retry attempts specifies the number of times Lookout attempts to
establish communications with a device if it is not getting a valid response.
After it tries the number of Retry attempts specified, the IPASCII object
generates an alarm and releases the socket.

Receive timeout is the amount of time Lookout waits for a response from
a device before retrying the request.

The SKip every ___ poll requests after comm failure setting instructs
Lookout not to poll a device it has lost communication with on every
scheduled poll. Instead, Lookout polls the device only once in the specified
number of poll cycles. Once communication has been reestablished, the
device is polled on its regular cycle. In the context of the IPASCII object,
this means that this number of Send commands will be ignored until
communication has been reestablished.

IPASCII Data Members

Table 3-35. IPASCII Data Members

Data Member Type Read | Write Description

CommPFail logical yes no Object-generated signal that is on if
Lookout cannot communicate with
the device(s).

Request text yes no Exact request frame sent.

RequestFormat text no yes Format used to create request frame.

Response text yes no Exact response frame received.

ResponseFormat text no yes Format used to parse response frame.

RQV1.logical— logical no yes Variable list used to populate request

RQV100.logical— frame with logical values.

RQVI1.txt—RQV100.txt | text no yes Variable list used to populate request
frame with text values.

RQVI—RQV100 numeric no yes Variable list used to populate request
frame with numeric values.

RSVl1.logical—RSV100 | logical yes no Variable list used to store values

Jlogical retrieved from response frame.

RSV1.txt— RSV100.txt | text yes no Variable list used to store values
retrieved from response frame.
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Table 3-35. IPASCII Data Members (Continued)

Data Member

Type Read | Write Description

RSV1—RSV100

numeric yes no Variable list used to store values
retrieved from response frame.

Send

logical no yes Sends request frame.

Update

logical yes no Object-generated signal that pulses
low each time it polls the device.

* RQVn, RQVn.txt and RQVn

Jogical all represent the same value in different forms.

* RSVn, RSVn.txt and RSVn.logical all represent the same value in different forms.

Request and Response Format Strings

Lookout Object Reference Manual

The request and response format strings consist of static characters and
markers that control how the request and response frames respectively
are formatted or decoded. The request format string is used to create the
request frame, which is sent to the device, while the response format string
is used to decode the response frame, which comes from the device.

Static characters in the format strings are reproduced exactly in the request
or response frame. Markers specify the location within the frame and type
of data which should be found there, such as five characters read as an
unsigned integer, for example. The IPASCII object constructs a request
frame by processing the sequence of static characters and markers in the
request format string, and including data from RQV data members.

The response format string decodes a response frame using an analogous
process, storing the results in RSV data members.

To construct a request frame, the IPASCII object parses the request format
string character by character. Static characters are copied directly to the
request frame. When a marker is encountered the IPASCII object reads a
value from the appropriate RQV variable and places it into the request
frame.

There are 100 RQV and RSV values provided for in the IPASCII object
data member collection. The first marker in a format string uses the value
from RQV1 (or RQV1.txt or RQV1.logical), the next marker uses the
value RQV2, and so on. Values taken from Response strings are stored in
RSV data members in the same way.
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Keep in mind that writing into RQV1 changes the value both for RQV1 . text
and RQV1.logical. Their only difference is the format in which they are
represented. The same principle applies to the RSV data members.

@ Note There is no precedence to the order in which multiple objects connected to the same
variable number will initialize upon opening the process file, such as the case in which a
Pot object is connected to RQV1 while a TextEntry object is connected to RQV1.txt. You
should take care to initialize such variables to the proper value after opening a process file.

To decode a response frame, the IPASCII object compares the response
frame to the response format string character by character. The static
characters in the response frame must match those in the response format
string or the decoding process terminates. Static characters are, in effect,
discarded by the IPASCII object as they are matched between the response
format string and the response frame.

When the IPASCII object encounters a marker, it places the data indicated
by the marker into the appropriate RSV data member.

The conversion of a portion of the response frame to a data type specified
by a marker in the response format string must be valid, or the process will
terminate.

If nothing halts the process, decoding terminates when the end of the
response frame string is reached.

There are examples of both request frames and response frames at the end
of this section, but for the examples to make sense, you must first
understand the IPASCII object markers.

Markers

The general format for a marker is:
Yo[width][type]

Each field in the marker format is a single character or a number signifying
a particular format option.

The % sign denotes the beginning of the marker. If the percent sign is
followed by a character that has no meaning as a format-control character,
that character and the following characters (up to the next percent sign) are
treated as static characters, that is, a sequence of characters that must match
the frame exactly. For example, to specify that a percent-sign character is a
static character part of the frame, use % %.
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Width is a positive decimal integer specifying the number of characters
that particular value occupies in the frame. By default IPASCII will pad the
value with blank spaces if the value takes up fewer characters than the value
specified by width. Including a 0 before the width value forces the IPASCIIL
object to pad with zeroes instead of blank spaces.

Type determines whether the field is interpreted as a character, a string, or
a number.

Table 3-36. Data Types Allowed by IPASCII

Character Data Type
d Decimal integer
X, X Hexadecimal integer
u Unsigned decimal integer
f Floating-point
s String
b Byte (binary)

The simplest format specification contains only the percent sign and a type
character (for example, %s). That would place the value in the response
frame in the RSV1.txt data member.

Request Format
String RQV1 Request Frame
>%5d 34 > 34
>%05d 34 >00034

The request format string also has a precision value in the form

% [width].[precision][type]. This specifies the number of digits to the
right of the decimal point, if any, in the request frame. If you use a float (%f)
and do not specify a precision value, the IPASCII object assumes a default
of 6.

Characters are converted and stored in RSV data members from response
frames in the order they are encountered in the response format. However,
fewer than [width] characters may be read if a white-space character
(space, tab, or newline) or a character that cannot be converted according
to the given format occurs before [width] is reached.

3-120 ni.com



Chapter 3 Lookout Driver and Protocol Objects

Values needed for request frames come from the RQV data members, and
are also used in the order in which they occur in the request format.

To read strings not delimited by space characters, or that contain spaces,
you can substitute a set of characters in brackets ([ 1) s (string) type
character. The corresponding input field is read up to the first character that
does not appear in the bracketed character set. Using a caret (") as the first
character in the set reverses this effect: the IPASCII object reads input field
up to the first character that does appear in the rest of the character set.

Response Response
Format String RSV1.txt Frame
$[A-Za-1z1% Natl Inst $Natl Inst$
>[s] days >day

Notice that %[a-z] and %][z-a] are interpreted as equivalent to
% |[abcde...z], and that the character set is case sensitive.

@ Note The brackets only work in response format strings. They have no effect in the request
format string.

The IPASCII object scans each field in the response frame character by
character. It may stop reading a particular field before it reaches a character
for a variety of reasons:

*  The specified width has been reached.
*  The next character cannot be converted as specified.

*  The next character conflicts with a character in the response format
string that it is supposed to match.

*  The next character fails to appear in a given character set.
No matter what the reason, when the IPASCII object stops reading an
field, the next field is considered to begin at the first unread character.

The conflicting character, if there is one, is considered unread and is the
first character of the next field.
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Entering the Format String

For a static connection to one of the format data members, enter your

format string in the yellow field box in the Edit Connections dialog box.
Remember to begin and end the format strings with quotation marks so that

Lookout will accept the string input.

You can also connect any valid text data member, such as a text entry object,

to the format data members.

Request Frame Construction Examples

RQV2.txt=Ross

Request Request
Format String RQV Frame
<01%4u%s RQVI1=1234 <011234Ross
RQV2.txt=Ross
<01%04u%s RQVI1=34 <010034Ross
RQV2.txt=Ross
<01% 4u%s RQVI1=34 <01 34Ross

A zero in front of the four pads with zeroes; a space pads with spaces.

Response Format Examples

@ Note

Response Response
Frame Format String RSV
*(16.38: *(%5.21: RSVI1=16.38

The decimal point counts as a character when decoding floats (%f). Also, decimal

points denoting precision are not allowed when decoding a float in the response frame.

Lookout Object Reference Manual

Response
Frame

Response
Format String

RSV

>>Test Text<<

>>Ps<<

RSV1.txt=Test
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The space between the words terminates the conversion. See the preceding
bracketed character example in order to span a space or other special
characters. The response format uses a space as a delimiter.

Response Response
Frame Format String RSV
>>Test Text<< >>%s%0s<< RSV 1.txt=Test
RSV2.txt=Text
>>DogCat<< >>%35%3s<< RSV1.txt=Dog
RSV2.txt=Cat

IPASCII Error Messages

No from device within timeout period

Lookout received no response from the device within the Receive timeout
period. The IPASCII object was able to establish a socket, but when it sends
its message to the device, it does not respond—as if it is not even there. You
may have to significantly increase Receive timeout (and Poll Rate) to
ensure Lookout is allowing enough time to receive the expected response.
Also, verify your cable connections, power, configuration settings, and IP
settings.

Not enough data to send a valid frame

This means that the IPASCII object has not received enough data to fill in
all the variables in the Request Format frame. This could mean that you do
not have connections made to all of the RQVs that the IPASCII object is
expecting.

Socket communications error

This alarm message will be followed by a Windows standard socket error
message. The most common reason you might see one of these errors is if
an error has occurred on the socket after a valid socket has already been
established.

Cannot communicate with device

This means that the IPASCII object was not able to establish a valid socket
with the remote device, and in fact did not get any kind of response from
the device.

Cannot resolve IP address
Check to make sure you have given IPASCII a valid IP address.
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Cannot resolve port

Check to make sure you have given IPASCII a valid port number on the
remote device.

Garbled or unexpected response

IPASCII got a response frame, but static characters in the response did not
match up to the response format string.

Illegally formatted string received

IPASCII got a response frame, but certain characters in the response were
not in the format stated by the markers in the response format string.

Related Objects ASCII
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Mitsubishi is a protocol driver class Lookout uses to communicate with
Mitsubishi devices using the serial communication protocol.

A Mitsubishi object contains a great deal of data. It supports reading and
writing of all predefined data points. When you create a Mitsubishi object,
you have immediate access to all the data members for that object.

Create A Series Secondary E
M ame:

Address: IU PLC Model: IADJ2 'l
Pratacal: I 'l Fai Mode: I 'l

Communication Setting

Serial part: IEDM‘I 'l Drata bits: IS 'l
Baud Rate: ISBDD 'l Stop bits I‘I VI
Parity: IDdd 'l

Phone numnber: I

FollRate = [0:01

Pall = I
Communication alarm priority: IS
Fietry attempts: |4 Feceive timeout: (250 msecs

Skip every |5 poll requests after comm failure

Create FX Series Secondary E
(T (Mt s Libishi

Address: IU PLC Model: IFX-24MF| 'l
Protocal: |1 'l Fe Mode: IDirect 'l

Communication Setting

Serial port: IEDM‘I l Data bits: I? 'l
|1 vl

Baud Rate: ISBDD 'l Stop bits
Parity: m

Phone numnber: I

FollRate = [0:01

Pall = I
Communication alarm priority: IS
Fietry attempts: |4 Feceive timeout: (250 msecs

Skip every |5 poll requests after comm failure

Figure 3-16. Mitsubishi Configuration Parameters Dialog Box

Cancel | Help | Cancel | Help |

Serial port specifies which COM port the object uses for communicating
to the external device. This does not specify the communication type.
Communication type is determined by the Options»Serial Ports...
command.

Data rate indicates the baud rate that Lookout uses to communicate with
the hardware device. This Data rate setting should match the selection
made on the physical device.

Data bits indicates the number of data bits that Lookout uses to
communicate with the hardware device. This Data bits setting should
match the selection made on the physical device.
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Stop bits indicates the number of stop bits that Lookout uses to
communicate with the hardware device. This Stop bits setting should
match the selection made on the physical device.

Parity indicates the parity that Lookout uses to communicate with the
hardware device. This Parity setting should match the selection made on
the physical device.

Phone number specifies the number to be dialed if the selected serial
port is configured for dial-up. This Phone number only applies to the
individual protocol object.

PollRate is a numeric expression that determines how often to poll the
device. The object then polls the device at the specified time interval.
Normally, this is a simple time constant such as 0:01 (one second). See
Numeric Data Members in Chapter 2, How Lookout Works, of the Getting
Started with Lookout manual for more information on entering time
constants.

Poll is a logical expression. When this expression changes from FALSE to
TRUE, Lookout polls the device. You can use a simple expression like the
signal from a pushbutton, or a complex algorithm.

Communication alarm priority determines the priority level of alarms
generated by the Mitsubishi object. Such alarms are typically related to
communications with the physical device.

Retry attempts specifies the consecutive number of times Lookout
attempts to establish communications with a device when it is not getting a
valid response. After it tries the number of Retry attempts specified, the
Mitsubishi object generates an alarm and releases the communication port
back to the communications subsystem. The subsystem then moves on to
the next device in the polling queue (if any). See Chapter 3, Serial Port
Communication Service, in the Lookout Developer’s Manual for more
information.

Receive timeout is the time delay Lookout uses in waiting for a response
from a device before retrying the request.

The Skip every... setting instructs Lookout not to poll a device it has lost
communication with on every scheduled poll. Instead, Lookout skips the
device in the polling cycle. Once communications have been reestablished,
the device is polled on its regular cycle.
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As with all Lookout drivers, you can access I/O points and other data
through data members. The following is a table of data members currently
supported by the Mitsubishi object class.

Chapter 3 Lookout Driver and Protocol Objects

@ Note The range of some data members may exceed what is available for your specific
hardware. Be sure to use data members that correspond to the range that is implemented

on your Mitsubishi hardware.

Table 3-37. Mitsubishi Data Members (A Series)

Data Member Type Read | Write Description

C0-C255 numeric yes yes Counter, 16-bit word.

CommPFail logical yes no Object-generated signal, ON if
Lookout cannot communicate with
the device(s).

D0-D1023 numeric yes yes Data register, 16-bit word.

MO0-M2047 logical yes yes Discrete coil, 1-bit.

Poll logical no yes When this expression transitions
from FALSE to TRUE, Lookout polls
the device.

PollRate numeric no yes Lookout expression that determines
the device polling frequency.

TO0-T255 numeric yes yes Timer, 16-bit word.

Update logical yes no Object-generated signal that pulses
low each time it polls the device.

WO0-W1023 numeric yes yes Data register, 16-bit word.

X0-X2047 logical yes no Discrete input, 1-bit.

Y0-Y2047 logical yes yes Discrete output, 1-bit.
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Table 3-38. MitsubishiFX Data Members (FX Series)

Data member Type Read | Write Description

C0-C255 numeric yes yes Counter, 16-bit word.

CommPFail logical yes no Object-generated signal that is ON if
Lookout cannot communicate with
the device(s).

D0-D2999 numeric yes yes Data register, 16-bit word.

MO0-M1535 logical yes yes Discrete coil, 1-bit.

Poll logical no yes When this expression transitions from
FALSE to TRUE, Lookout polls the
device.

PollRate numeric no yes Lookout expression that determines
the device polling frequency.

S0-S999 logical yes yes State, 1-bit.

sD8000—sD8255 numeric yes yes Special data register, 16-bit word.

sM0-sM255 logical yes yes Special discrete coil, 1-bit.

TO0-T255 numeric yes yes Timer, 16-bit word.

Update logical yes no Object-generated signal that pulses
low each time it polls the device.

X0-X377 logical yes no Discrete input, 1-bit.

Y0-Y377 logical yes yes Discrete output, 1-bit.

Mitsubishi Status Messages

Lookout Object Reference Manual

No response within timeout period

Lookout received no response from a device within the Receive timeout
period. The Mitsubishi object is able to use the COM port, but when it polls
the device, it does not respond—as if it is not even there. If you have
daisy-chained several devices, you have introduced an inherent delay. You
may need to significantly increase Receive timeout (and PollRate) to
ensure Lookout is allowing enough time to receive the expected response.
This increase has nothing to do with the processing capabilities of Lookout,
but is based solely on Data rate and the number of devices on the chain.

3-128

ni.com



Chapter 3 Lookout Driver and Protocol Objects

Also, verify your Baud rate settings, cable connections, power,
configuration settings, COM port settings, and polling addresses.

Incorrect frame check sum (FCS)

The frame was received with an invalid frame check sum. Check for two or
more devices with the same address.

Incorrect PC number in response

The frame received had an incorrect source address. Check for two or more
devices with the same address.

Incorrect command in response

The frame received had an incorrect command. Check for two or more
devices with the same address.

Garbled or Invalid frame

The frame was received without proper termination character (ETX).
Check the Lookout Receive Gap setting.

No acknowledgment for write frame

The write frame was not acknowledged by the PC. Check the address of
Mitsubishi object or the address range of the PC.

Mitsubishi errors reported in the response

These errors are reported by the Mitsubishi device, and are in turn reported
to the user in text form.

Mitsubishi Models Supported

A series:

A0J2, AOJ2H, A1, A1S, AIN, A1E, A2, A2n, A2C, A2E, A3, A3N,
A3E, A3H, A3M.

FX series:
All models through March, 1997.
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Mitsubishi CLM

Lookout Object Reference Manual

This driver object communicates serially with Mitsubishi A Series PLCs
using the A1SJ71UC24-R2 communications module, generally called
Computer Link Module (CLM).

Create Mitsubishi A Series CLM Secondary E

Mame: IMitsucom1

Address: IU PLC Model: IA‘I 'l

Communication Setting

Serial paort: IEDM‘I 'l Drata bits: IS 'l
Baud Rate: ISBDD 'l Stop bits I‘I VI
Parity: IDdd 'l

Fhone numnber: I

FollRate = [0:01

Pall = I
Communication alarm pricrity: IS
Fietry attempts: |4 Feceive timeout: (250 msecs

Skip every |5 poll requests after comm failure

Cancel | Help |

Use Address to specify the device number of the Mitsubishi PLC to
control. Specify the A-series model number of the PLC using the PLC
Model selection box.

Serial port specifies which COM port on the host computer that Lookout
object uses for communicating to the external device. This does not specify
the communication type. Communication type is determined by the
Options»Serial Ports command. See Chapter 3, Serial Port
Communication Service, of the Lookout Developer's Manual for more
information on configuring serial ports for use with Lookout.

Baud rate, Parity, Data bits, and Stop bits reference the settings on the
hardware device.

Phone number specifies the number dialed if the selected serial port is
configured for dial-up. This Phone number only applies to the individual
Mitsubishi object.

PollRate is a numeric expression that determines how often to poll the

device. Lookout polls the device at the specified time interval. Normally,
this is a simple time constant such as 0:01 (one second). See Numeric Data
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Members in Chapter 2, How Lookout Works, of the Getting Started with
Lookout manual for information on entering time constants.

Poll is a logical expression. When this expression changes from false to
true, Lookout polls the device. Use a simple expression like the signal from
a pushbutton, or a complex algorithm.

Communication alarm priority determines the priority level of the alarms
generated by this object.

Retry attempts specifies the consecutive number of times Lookout
attempts to establish communications with a device if it is not getting a
valid response. After the specified number of Retry attempts, the object
generates an alarm and begins to SKip every n poll requests after comm
failure. Once Lookout reestablishes communication, it polls the device on
the cycle defined by PollRate.

Receive timeout is the time delay that Lookout waits for a response from
a device before retrying the poll request.

Mitsubishi CLM Device Configuration and Equipment

Use a null-modem serial port cable, or a null modem adapter to
communicate with the Mitsubishi CLM.

Make the following physical setting on the Mitsubishi CLM hardware for
the Lookout Mitsubishi CLM object to function properly with the
hardware.

*  The Lookout Mitsubishi CLM object only uses control format 1. Set
the Mode switch on the CLM to 1.

*  Match the dip-switch settings on the CLM for baud and parity to the
Lookout Mitsubishi CLM object settings.

e Set the hardware dip-switch to enable checksum (sum check) to TRUE
because the Lookout Mitsubishi CLM driver implements checksum.

Mitsubishi CLM Data Members

Some data members that are HEX addresses in the PLC are addressed as
decimals in Lookout. For example, to use register D1F on the PLC, use the
D31 data member. Convert from hexadecimal to decimal where necessary
when using these data members.
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Table 3-39. Mitsubishi CLM Data Members

Data Member Type Read | Write Description
B0 -B1023 logical yes yes link relay B.
CCO - CC255 logical yes yes Counter (coil) C.
CNO - CN255 numeric | yes yes Counter (present value) C.
CommPFail logical yes no Object-generated signal that is on if Lookout

cannot communicate with the device.

CS0 - CS255 logical yes yes Counter (contact) C.

D0 -D8191 numeric yes yes Data register D.

FO — F255 logical yes yes Annunciator M.

L0 -12047 logical yes yes Latch relay L.

MO - M8191 logical yes yes Internal relay M.

Poll logical no yes When this value transitions from FALSE to

TRUE, Lookout polls the device.

PollRate numeric no yes Lookout expression that determines the
device polling frequency.

RO -R8191 numeric yes yes File register D.

S0 - S8191 logical yes yes Step relay S.

SDO - SD8191 numeric yes yes Signed data register.
SRD9000 — numeric | yes yes Special register D.
SRD9255

SRM9000 — logical yes yes Special relay M.
SRM9255

TCO - TC255 logical yes yes Timer (coil) T.

TNO — TN255 numeric yes yes Timer (present value) T.
TS0 —TS255 logical yes yes Timer (contact) T.
Update logical yes no Object-generated signal that pulses low each

time it polls the device.

W0 - w1023 numeric | yes yes Link register D.

Lookout Object Reference Manual 3-132 ni.com



Chapter 3 Lookout Driver and Protocol Objects

Table 3-39. Mitsubishi CLM Data Members

Data Member Type Read | Write Description
X0 -X2047 logical yes no Discrete inputs.
YO - Y2047 logical yes yes Discrete outputs.

Mitsubishi CLM Status Messages

The following errors are generated by Lookout. Lookout also passes
Mitsubishi errors to the Lookout Alarm window. For information on
Mitsubishi errors, consult the Computer Link Modules manual for
MitsubishiA/AnS Series PLCs.

No response within timeout period

Lookout did not receive a response from the device within the Receive
timeout period. The object was able to establish a connection, but the
device did not respond to the sent message. Significantly increase Receive
timeout and Poll Rate to ensure that Lookout allows enough time to
receive the expected response. Also, verify cable connections, making sure
you are using a null modem serial cable, or a null modem adapter on your
cable, serial port wiring, power supply, and configuration settings.

Unexpected frame length

The response from the PLC had the wrong number of bytes to be a valid
response. Make sure the CLM module works with the PLC programming
software.

STX not detected from PLC

The Start of Text byte was not received from the PLC. Make sure the CLM
module works with the PLC programming software. Also, verify cable
connections, making sure you are using a null modem serial cable, or a null
modem adapter on your cabl, serial port wiring, power supply, and
configuration settings.

If this does not fix the problem, significantly increase Receive timeout and
Poll Rate to ensure Lookout is allowing enough time to receive the
expected response.

Invalid protocol information in response (no ETX)

No End of Text byte received from the PLC. Make sure the CLM module
works with the PLC programming software. Also, verify cable
connections, making sure you are using a null modem serial cable, or a null
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modem adapter on your cable, serial port wiring, power supply, and
configuration settings, and so on.

If this does not fix the problem, you may have to significantly increase
Receive timeout and Poll Rate to ensure Lookout is allowing enough time
to receive the expected response.

Incorrect frame check sum (FCS)

The check sum received from the PLC was not correct. Make sure you have
enabled the check sum dip-switch on the CLM module.

Mitsubishi Models Supported

A series: A0J2, AOJ2H, A1, A1S, AIN, A1E, A2, A2AS, A2n, A2C, A2E,
A3, A3N, A3E, A3H, A3M.
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Modbus
ModbusMOSCAD

Modbus and ModbusMOSCAD are protocol driver classes Lookout uses
to communicate with equipment such as programmable logic controllers
(PLCs), remote terminal units (RTUs), or any other piece of equipment
using Modbus Serial (ASCII or RTU) or Modbus Plus communication
protocol.

The Modbus object class has general-purpose addresses, such as holding
register 40001, and is suitable for communicating with nearly all Modbus
devices, including the Control Microsystems TeleSAFE RTU.

The ModbusMOSCAD object class works with Motorola MOSCAD PLCs
and RTUs. It also uses the Modbus Serial (ASCII or RTU) or Modbus Plus
communication protocol, but its data members reflect the address of
Motorola MOSCAD devices.

You can limit the number of channels Lookout uses on the SA-85 card by
creating a modbus . ini file in the Lookout directory, as shown in the
following example.

[ALL]
MaxChannels=channel

where channel is a number between 1 and 8, inclusive (default = 8).

These protocol driver objects contain a great deal of data. All readable
and writable members (inputs/outputs), polling instructions, read/write
blocking, serial port usage, and so on are bundled with the object.
Therefore, as soon as you create a Modbus or ModbusMOSCAD object you
immediately have access to all the object data members (see data member
list in Table 3-41).

@ Note Lookout protocol driver objects automatically generate an efficient read/write
blocking scheme based on the inputs and outputs being used in your process file. You are
not required to build your own I/O blocking table.
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As protocol drivers, both object classes conform to the specifications in
the Modicon Modbus Protocol Reference Guide PI-MBUS-300 Rev. C.
The drivers support ASCII and RTU transmission modes, as well as
Modbus Plus.

Create Modbus Secondary E
M ame: IModbus‘I Mode: IModbus Serial
r— Communication Setting ; :
Address: |5 Serial port: |COM1 = . .
: . I J Cancel |
—Datarate— — Parity [rata bits Stop bitz
115200 & Mone 7 (G| o
efaults
& B7EOD  0dd LOl] 15 —I
€ 38400 € Even 2 Advanced. |
19200 7 Mark
' 9500 " Space Alarm priority: I
priority: |8
4800
2400 .
Phone numnber: Hel
e 10 ! _teb |
 gO0 PolRate = |0:01
300
110 Pall = I
Retry attemnpts: |4 Receive timeout: |5UU
msecs

Figure 3-17. Modbus Configuration Parameters Dialog Box

In this example, Lookout is connected to a Modbus-speaking PLC with
an address of 5 using serial port 1 (which was previously configured for
hardwired communications), and polling the device every second.

Modbus Serial indicates that the slave device talks either Modbus ASCII
or Modbus RTU. When you select this option, Lookout first tries to
communicate using the RTU format. If unsuccessful, it then tries the
ASCII format (a little slower). If your network is susceptible to repeated
communication problems, and if these problems slow scanning
considerably, you may want to disable Lookout from retrying both formats.
This can speed communication retries by Lookout; however, it will not fix
your communication problems. Call National Instruments technical
support to for information on how to prohibit Lookout from trying to
communicate using both formats.

Modbus Plus Network indicates that the slave device is connected to the
Lookout computer via a Modbus Plus network card.

Note NetBIOS-based networking software typically uses software interrupt SC. This is
also the default software interrupt used by the Modbus Plus Network card driver. Change
the Modbus Plus software interrupt from 5C to 5D, 5E, or 5F. Refer to your Modicon
documentation for instructions on changing the software interrupt setting.
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Modbus Ethernet indicates you are communicating with the Modbus
slave device using an Ethernet connection.

If you select Modbus Serial, you must specify Address, Serial Port, Data
Rate, Parity, Data Bits, and Stop Bits. And if you are using a Dial-up
modem connected to your communication port, you must also specify a
Phone Number.

If you select Modbus Plus Network, you need only specify the remote
device Address.

If you select Modbus Ethernet you must specify the IP address in
addition to Alarm Priority, Poll Rate, Poll Retry attempts, and Receive
timeout.

Address is a slave address and refers to the PLC or RTU address setting as
set on the device dip switches. If devices share a common line, they require
unique addresses (1 to 255).

IP address is the Internet Protocol address for the Modbus slave object you
are communicating with.

Unit identifier is used to distinguish between a device address and an IP
address.

Serial port specifies which port the object uses for communication to the
external device. This does not specify the communication type.
Communication type is determined by the Options»Serial Ports...
command.

Data rate, Parity, Data bits, and Stop bits reference the settings on the
hardware device.

The Defaults button replaces the current settings with default values.
Alarm priority determines the priority level of Modbus-generated alarms.

Phone number specifies the number to be dialed if the serial port setting is
configured for dial-up. This number only applies to the individual protocol
object.

PollRate is a numeric expression that determines how often to poll the
device. Modbus then polls the device at the specified time interval.
Normally, this is a simple time constant such as 0:01 (one second). See
Numeric Data Members in Chapter 2, How Lookout Works, of the Getting
Started with Lookout manual for information on entering time constants.
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Advanced Modbus

Lookout Object Reference Manual

Poll is a logical expression. When this expression changes from FALSE to
TRUE, Lookout polls the device. You can use a simple expression like the
signal from a pushbutton, or a complex algorithm.

Retry attempts specifies the consecutive number of times Lookout
attempts to establish communications with a device if it is not getting a
valid response. After it tries the number of Retry attempts specified, the
Modbus object generates an alarm and releases the communication port
back to the communications subsystem which then moves on to the next
device in the polling queue (if any). Refer to Chapter 3, Serial Port
Communication Service, in the Lookout Developer’s Manual for more
information.

Receive timeout is the time delay Lookout uses in waiting for a response
from a device before retrying the request.

Parameters

The Modbus driver attempts to block the reads and writes of coils, input
registers and holding registers into groups to maximize communication
efficiency. Through the Advanced Modbus Options dialog box, you can
control the maximum block sizes that the driver uses. In fact, if your device
does not support the default block sizes, you may have to specify smaller
blocks.

The Advanced... button invokes the Advanced Modbus Options dialog
box you can use to customize specific options within the Modbus protocol.
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—Maximum values per message

Ok |
Read cails: 2000
Fead discrete inputs: W fc2 ﬂl
Fead holding regs: 125 fc 3 Defaults |
Fead input regs: 125 fcd
Force caoils: goa fc15
Fresetregs: 100 fc 16

V' Immediately write autputs

Skip every |4 poll requests after comm failure

[~ Treatholding registers as 32-bitfloats (Daniel option)
™ Modicon 32-bitfloating point order (0123 vs. 3210)

™ Pall upon receipt of unsolicited message

Figure 3-18. Advanced Modbus Parameters Dialog Box

The Modbus object class uses Modbus Function Codes 01, 02, 03, 04, 05,
06, 15, and 16; and expects the remote I/O device to support these codes as
specified by Modbus. The driver can communicate with up to 247 Modbus
slave devices on each serial port.

The Maximum values per message settings specify the maximum number
of elements Lookout attempts toread (fc 1 - f£c 4), or write (Ec 15 and
fc 16), in a single Modbus message. The default values represent the
maximum number of elements that the protocol can transmit in a single
message, and provides optimal speed. However, some devices are not
capable of handling the maximum number of elements, so you should set
the values according to the documentation for those devices.

If the Immediately write outputs option is ON, Lookout immediately
polls the device any time a value changes that is being written out to the
device. If it is OFF, Lookout waits until the next scheduled poll to write out
changed values.

The Skip every... setting instructs Lookout to not poll a device it has lost
communication with on every scheduled poll. Instead, Lookout skips the
device in the polling cycle accordingly. Once communications have been
reestablished, the device is polled on its regular cycle.

The Daniel option is device-dependent and instructs Lookout to treat
holding registers as 32-bit IEEE floating values instead of 16-bit values.
If you set this flag, you must also set your hardware device to treat holding
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registers as 32-bit floats—most devices do not support this option, but
Bristol-Babcock RTUs and Daniel flow meters do.

@ Note Activating the Daniel option deactivates all Modbus holding register members (on
that device) except for 40001 — 49999 and 4000001 — 465000. If you attempt to read

D40001, for ex

ample, the returned value is 0, and Lookout will not attempt to write

D40001 to the RTU. Of course, in devices that do not support this option, you can still read
and write two adjacent holding registers as a floating point value with the Modbus data
members F40001 — F4999. In fact, this is a more general purpose solution than the Daniel
option, because you can still read bits and word values out of the holding registers, too.

Some Modbus PLCs reverse byte order in a floating point data member. If
your process is returning garbled or senseless floating point values, select
the Modicon 32-bit floating point order (0123 vs. 3210) option in the
Advanced Modbus Options dialog box. This option chooses whether the
characters within the floating point registers (data members F40001 -
F49999 and F400001 - F465000) are in little endian or big endian
format.

On occasion a Modbus PLC will direct a message to your process. To poll
for all data member values following receipt of such a poll, select the Poll
on receipt of unsolicited message option in the Advanced Modbus
Options dialog box. Using this option is a way to force a poll of a Modbus
device based on an event, without reference to the configured poll intervals
and somewhat outside the usual Lookout event-driven action.

A Caution Notice that the D and F data members read two adjacent registers as single, 32-bit
numbers. One consequence of this is that if you connect to two adjacent registers, such as

D40010 and D4

0011, you will get incorrect values because of overlapping. Make sure that

you do not connect to adjacent registers with the D or F data members.

Modbus Protocol Statistics

5} Note Theopt

The driver monitors Modbus Protocol Statistics. This data is held within
readable data members of the Modbus object and you can see them in the
Modbus Protocol Statistics dialog box. To view the dialog box, select
Options»Modbus... and click on Statistics....

ions»Modbus... option is only visible in the Options menu if a Modbus

object was previously created in your Lookout application.

Lookout Object Reference Manual
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aut |

Figure 3-19. Modbus Protocol Statistics Dialog Box

The Count column contains the accumulated number of messages received
from the selected Device that fall into each respective category since the
last time the Reset button was pressed. The percent column (%) indicates
the percentage of messages received that fall into each respective category
since the last time the Reset button was pressed.

When you depress the Reset button, the ResetCounts data member is set
TRUE, setting all statistical values to zero. Lookout records the date and
time that the reset was last performed in the Since last reset data field.

© National Instruments Corporation 3-141 Lookout Object Reference Manual



Chapter 3 Lookout Driver and Protocol Objects

Modbus Data Members

The Modbus object class supports both 5-digit and 6-digit addressing.
When you use a 6 digit address, the left-most digit represents the address
type as follows:

Table 3-40. 6-Digit Address Coding

First Digit Address Type
0 Single-bit coils
1 Discrete inputs
3 Input registers
4 Holding registers

The remaining 5 digits represent the actual address of the coil, input or
holding register.

@ Note When you reference address 000001 and address 1, you are referring to the same
point, but 40001 and 040001 do not refer to the same point. Because zero is the left-most
digit in the 6-digit address, 040001 points to the 400015 single-bit coil and 40001 refers to
the first holding register.

Table 3-41. Modbus Data Members

Data Member Type Read | Write Description

000001 - 065000 logical yes yes 6-digit addresses of single-bit coils

1 -9999 logical yes yes Single-bit coils

100001 — 165000 logical yes no 6-digit addresses of single-bit discrete
inputs

10001 — 19999 logical yes no Single bit discrete inputs

300001 — 365000 numeric yes no 6-digit addresses of 16-bit input
registers encoded as unsigned binary
integers ranging from 0 to 65535

30001 — 39999 numeric yes no 16-bit input registers encoded as
unsigned binary integers ranging
from 0 to 65535
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Table 3-41. Modbus Data Members (Continued)

Data Member Type Read | Write Description

400001 - 465000 numeric yes yes 6-digit addresses of 16-bit input
registers encoded as unsigned binary
integers ranging from 0 to 65535

400001.1 — 465000.16 logical yes yes 6-digit address used to access
individual bits out of holding registers
and read them as logical ON/OFF
values. The least significant bit is 1;
the most significant, 16.

40001 — 49999 numeric yes yes 16-bit holding registers encoded as
unsigned binary integers ranging
from 0 to 65535

40001.1 — 49999.16 logical yes yes Access individual bits out of holding
registers and read them as logical
ON/OFF values. The least significant
bit is 1; the most significant, 16.

BadCRC numeric yes no Number of responses from device
whose message failed the cyclic
redundancy check (CRC) or the
longitudinal redundancy check (LRC)

BCD300001 — numeric yes no 6-digit addresses of 16-bit input

BCD365000 registers encoded as binary-coded
decimal integers ranging from 0 to
9999

BCD30001 — numeric yes no 16-bit input registers encoded as

BCD39999 binary-coded decimal integers
ranging from 0 to 9999

BCD400001 — numeric yes yes 6-digit addresses of 16-bit holding

BCD465000 registers encoded as binary-coded
decimal integers ranging from
0 to 9999

BCD40001 - numeric yes yes 16-bit holding registers encoded as

BCD49999 binary-coded decimal integers
ranging from 0 to 9999
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Table 3-41. Modbus Data Members (Continued)

Data Member Type Read | Write Description

CommPFail logical yes no Driver-generated signal that is ON if
Lookout cannot communicate with
the device for whatever reason

D400001 — D465000 numeric yes yes 6-digit addresses of 32-bit unsigned
holding register—reads two adjacent
holding registers as a single 32-bit
number ranging from 0 to
4,294,967,296.

D40001 — D49999 numeric yes yes 32-bit unsigned holding
register—reads two adjacent holding
registers as a single 32-bit number
ranging from 0 to 4,294,967,296.

Exceptions numeric yes no Number of responses from device
whose message was understandable
to the driver but included an error
code indication from the device

F400001 — F465000 numeric yes yes 6-digit addresses of 32-bit IEEE
floating point register—reads two
adjacent holding registers as a single
32-bit floating point value

F40001 — F49999 numeric yes yes 32-bit IEEE floating point
register—reads two adjacent holding
registers as a single 32-bit floating
point value

Garbled numeric yes no Number of responses from device
whose message was unintelligible to
the driver

NoResponse numeric yes no Number of polls generated by driver

not responded to by device

OffHook logical no yes When TRUE, this flag instructs the
Modbus object to retain exclusive use
of its assigned communication port

Poll logical no yes When this expression transitions
from FALSE to TRUE, Lookout polls
the device.
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Table 3-41. Modbus Data Members (Continued)

Data Member Type Read | Write Description

PollRate numeric no yes Lookout expression that determines
the device polling frequency.

ProtocolErrors numeric yes no Total number of bad messages
received from polled device

ResetCounts logical no yes Resets number to zero in the
following data members: ValidFrame,
NoResponse, TooShort, BadCRC,
Garbled, Exceptions, &
ProtocolErrors

5400001 — S465000 numeric yes yes 6-digit addresses of 16-bit holding
registers encoded as signed binary
integers ranging from —32767 to

+32768.

S40001 — S49999 numeric yes yes 16-bit holding registers encoded as
signed binary integers ranging from
—32767 to +32768.

TooShort numeric yes no Number of responses from device

whose message length was too short

Update logical yes no Driver-generated signal that pulses
each time the driver polls the device

ValidFrame numeric yes no Number of good messages received
from polled device

Comments You can use the OffHook data member to enhance communications when
using the Modbus object class with dial-up modems. When OffHook is TRUE and the
serial port is connected to a dial-up modem, the Modbus object does not hang up the
modem when the poll is complete. Rather, it keeps the phone off the hook, retaining
exclusive use of the serial port. As long as OffHook is TRUE, the Modbus object
continues to poll the same PLC without hanging up the modem.

As soon as OffHook goes FALSE, the object releases the serial port to the
communications subsystem, which goes to the next poll request in the
queue, if any. The object also releases the port if data communications are
lost for any reason—such as if the PLC modem breaks the connection.
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When using OffHook, consider defining the driver object PollRate to poll
fast when OffHook is TRUE, and poll at its normal rate when OffHook is
FALSE. You might tie a Switch object to the OffHook writable data

member for this very purpose.

ModbusMOSCAD Data Members

Table 3-42. ModbusMOSCAD Data Members

Data Member

Type

Read

Write

Description

AIOrOc0O — AI30r255¢7

numeric

yes

no

Each address represents a 16-bit
analog input encoded as an unsigned
integer ranging from O to 65535

AOO0r0c0 — AO30r255c7

numeric

yes

yes

Each address represents a 16-bit
analog output encoded as an unsigned
integer ranging from O to 65535

BadCRC

numeric

yes

no

Number of responses from device
whose message failed the cyclic
redundancy check (CRC) or the
longitudinal redundancy check (LRC)

CommPFail

logical

yes

no

Driver-generated signal that is ON if
Lookout cannot communicate with
the device for whatever reason

DI0r0c0.0 -
DI30r255¢7.15

logical

yes

no

Each address represents an individual
discrete input read as a logical
ON/OFF value. The least significant
bit is 0; the most significant, 15.

DOO0r0c0.0 —
DO30r255¢7.15

logical

no

yes

Each address represents an individual
discrete input read as a logical
ON/OFF value. The least significant
bit is 0; the most significant, 15.

Exceptions

numeric

yes

no

Number of responses from device
whose message was understandable
to the driver but included an error
code indication from the device

Garbled

numeric

yes

no

Number of responses from device
whose message was unintelligible to
the driver
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Table 3-42. ModbusMOSCAD Data Members (Continued)

Data Member Type Read | Write Description

NoResponse numeric yes no Number of polls generated by driver
not responded to by device

Poll logical no yes When this expression transitions from
FALSE to TRUE, Lookout polls the
device.

PollRate numeric no yes Lookout expression that determines
the device polling frequency.

ProtocolErrors numeric yes no Total number of bad messages
received from polled device

ResetCounts logical no yes Resets number to zero in the
following data members: ValidFrame,
NoResponse, TooShort, BadCRC,
Garbled, Exceptions, &
ProtocolErrors

TooShort numeric yes no Number of responses from device
whose message length was too short

Update logical yes no Driver-generated signal that pulses
each time the driver polls the device

ValidFrame numeric yes no Number of good messages received
from polled device

Comments To specify the address of an analog input located in row 22, column 1 of

Table 12, you would enter AI12r22c1, where

Table Numbe

12 r22 ¢l

A
Signal Typt//

\\Column Number in Table

Row Number in Table
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Modbus Daniel

Use the Modbus Daniel Flow object to communicate with the Daniel
Industries flow meter RTUs that use the Daniel Industries version of the
Modbus protocol

Address is the PLC Modbus address.

Serial port specifies the COM port on the host computer that Lookout
object uses for communicating to the external device. This does not specify
the communication type. Communication type is determined by the
Options»Serial Ports command. See Chapter 3, Serial Port
Communication Service, of the Lookout Developer's Manual for more
information on configuring your serial ports for use with Lookout.

Data rate, Parity, Data bits, and Stop bits reference the settings on the
hardware device.

Phone specifies the telephone number dialed if the selected serial port is
configured for dial-up. This number only applies to the individual protocol
object.

PollRate is a numeric expression that determines how often to poll the
device. Lookout polls the device at the specified time interval. Normally,
this is a simple time constant such as 0:01 (one second). See Numeric Data
Members in Chapter 2, How Lookout Works, of the Getting Started with
Lookout manual for information on entering time constants.

Poll is a logical expression. When this expression changes from FALSE to
TRUE, Lookout polls the device. Use a simple expression like the signal
from a pushbutton, or a complex algorithm.

Communication alarm priority determines the priority level of the alarms
generated by the Modbus Daniel Flow object.

Retry attempts specifies the consecutive number of times the object
attempts to establish communication with a device if it is not getting a valid
response. After the specified number of Retry attempts, the object
generates an alarm and begins to SKip every n poll requests after comm
failure. Once the object reestablishes communication, it polls the device on
the cycle defined by PollRate.

Receive timeout is the time delay the object waits for a response from a
device before retrying the poll request.
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The SKip every setting instructs the object not to poll a device it has lost
communication with on every scheduled poll. Instead, the object polls the
device only once in the specified number of poll cycles. Once
communication has been reestablished, the device is polled on the specified
cycle.

Click the Advanced button to access advanced Modbus parameters. See the
Advanced Modbus Parameters topic of the online Help or the Advanced
Modbus Parameters section of this manual for information about setting
the advanced Modbus parameters.

Modbus Daniel Data Members
The following table lists the Modbus Daniel data members.

Table 3-43. Modbus Daniel Data Members

Data Member Type Read Write Description

CommPFail logical yes no Object-generated signal that is ON if
Lookout cannot communicate with the
device.

OffHook logical no yes When TRUE, this flag instructs the
Modbus Daniel Flow object to retain
exclusive use of its assigned
communication port.

Poll logical no yes When this value transitions from
FALSE to TRUE, Lookout polls the
device.

PollRate numeric no yes Lookout expression that determines the
device polling frequency.

Update logical yes no Object-generated signal that pulses low
each time it polls the device.

701.1.1- numeric yes no Archive register stored as an array of

741.840.100 IEEE floating point values within a
record, and an array of these records
within each register — addressed as
register.record.field.

1001-3000 logical yes yes Single-bit coils.
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Table 3-43. Modbus Daniel Data Members (Continued)

Data Member Type Read Write Description

3001-5000 numeric yes yes 16-bit holding registers encoded as
unsigned binary integers ranging from
0 to 65535.

5001-7000 numeric yes yes 32-bit holding registers encoded as
unsigned binary integers ranging from
0 to 4,294,967,296.

7001-9000 numeric yes yes 32-bit holding registers encoded as
IEEE floating point.

Bad CRC numeric yes no Number of responses from a device

whose message failed the cyclic
redundancy check (CRC) or the
longitudinal redundancy check (LRC).

Exceptions numeric yes no Number of responses from a device
whose message was understandable to
the driver but included an error code
indication from the device.

Garbled numeric yes no Number of responses from a device
whose message was unclear to the
driver.

NoResponse numeric yes no Number of polls generated by driver not

responded to by device.

ProtocolErrors numeric yes no Total number of bad messages received
from polled device.

ResetCounts logical no yes Resets number to zero in the following
data members: ValidFrame,
NoResponse, TooShort, BadCRC,
Garbled, Exceptions, &

ProtocolErrors.

TooShort numeric yes no Number of responses from device from
which the message length was too
short.

ValidFrames numeric yes no Number of good (valid) messages

received from polled device.
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Modbus OmniFlow

Lookout Object Reference Manual

Use the Modbus OmniFlow to communicate with the Omni 6000/Omni
3000 Flow Computers (firmware Version 70+). This driver uses the
Modbus communication protocol with a few device-specific modifications.

Create OmniFlow Secondary [ %]
Tag: Device [D:

|ModbusOmnit J1
Communication Setting

Serial port: IEDM‘I 'l Data Bits: IS 'l
Baud Rate: ISBDD 'l Stop Bits: |1 'l

Parity: INone j Phare: I
¥ Modicon Compatible

PallRate = |0:01
Pall = I Cancel |
Communication alarm priority:IS

Fietry attempts: (4 Feceive timeout: |70 mzecs

Skip every |5 poll requests after comm failure

Device Id is the Modbus ID in the Flow Computer.

Serial port specifies which COM port on the host computer the Lookout
object uses for communicating to the external device. This does not specify
the communication type. Communication type is determined by the
Options»Serial Ports command. See Chapter 3, Serial Port
Communication Service, of the Lookout Developer's Manual for more
information on configuring your serial ports for use with Lookout.

Baud rate, Parity, Data bits, and Stop bits reference the settings on the
hardware device.

Phone specifies the telephone number dialed if the selected serial port is
configured for dial-up. This number only applies to the individual protocol
object.

The Modicon Compatible check box is disabled, so that the Lookout
Modbus OmniFlow driver is always Modicon compatible. Make sure your
hardware setting is also Modicon compatible.

PollRate is a numeric expression that determines how often to poll the
device. Lookout polls the device at the specified time interval. Normally,
this is a simple time constant such as 0:01 (one second). See Numeric Data
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Members in Chapter 2, How Lookout Works, of the Getting Started with
Lookout manual for information on entering time constants.

Poll is a logical expression. When this expression changes from FALSE to
TRUE, Lookout polls the device. Use a simple expression like the signal
from a pushbutton, or a complex algorithm.

Communication alarm priority determines the priority level of the alarms
generated by the Modbus object.

Retry attempts specifies the consecutive number of times Lookout
attempts to establish communications with a device if it is not getting a
valid response. After the specified number of Retry attempts, the object
generates an alarm and begins to SKip every n poll requests after comm
failure. Once Lookout reestablishes communication, it polls the device on
the cycle defined by PollRate.

Receive timeout is the time delay Lookout waits for a response from a
device before retrying the poll request.

Modbus OmniFlow Data Members

Table 3-44. Modbus OmniFlow Data Members

Data Member Type Read | Write Description
1001 - 1099 logical yes yes Status and Command.
1101 - 1499 logical yes no Status.
13001 — 13999 numeric yes yes 16-bit integer register.
F15001 — F15299 numeric yes yes 32-bit IEEE Floating Point.
1501 — 1799 logical yes yes Status and Command.

F17001 - F18199

numeric yes yes 32-bit IEEE Floating Point.

1801 — 2699 logical yes no Status.

2701 -2799 logical yes yes Status and Command.

2801 — 2999 logical yes no Status.

3001 — 3999 numeric yes yes 16-bit integer register.

5001 — 5999 numeric yes yes 32-bit integer (2s complement).

F6001 — F8999

numeric yes yes 32-bit IEEE Floating Point.
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Table 3-44. Modbus OmniFlow Data Members (Continued)

Data Member Type Read | Write Description

CommPFail logical yes no Object-generated signal that is on if
Lookout cannot communicate with
the device.

Poll logical no yes When this value transitions from
FALSE to TRUE, Lookout polls the
device.

PollRate numeric no yes Lookout expression that determines
the device polling frequency.

Update logical yes no Object-generated signal that pulses
low (FALSE) each time it polls the
device.

Modbus OmniFlow Status Messages

Lookout Object Reference Manual

Modbus OmniFlow returns the following status messages.

Invalid Address returned in frame

The address received in the reply from the PLC is not the same as the
address sent in the request. This is normal if the PLC can not keep up with
the requests sent by Lookout. A high Poll rate/slow device response are
possible causes for this error.

Invalid Function Code returned in frame

The command received in the reply from the PLC was not the same as the
command sent in the request. This is normal if the PLC cannot keep up with
the requests sent by Lookout. A high Poll rate/slow device response are
possible causes for this error.

Message Garbled - Bad CRC

The object receives a poll response from the device, but it can not decipher
the response. Verify that all devices assigned to the device group have
unique unit codes. The last part of the message may be getting cut off
before it is completed. Increase the number of Retry attempts. Increase the
Lookout serial port Receive gap setting to ensure that Lookout is receiving
the entire message. Select Options»Serial Ports from the Lookout menu
to check your serial port settings. If the serial port is configured for radio,
this could be caused by an audible squelch tail occurring at the end of a
radio transmission. Adjust RTS delay off and CTS timeout.
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Unexpected data response length

Check to see if the OmniFlow hardware is set for Modicon compatibility.
At this time, Lookout requires Modicon compatibility to work with
OmniFlow hardware.

No response from PLC

Lookout did not receive a response from the device within the Receive
timeout period. The object was able to establish a connection, but the
device did not respond to the sent message. Significantly increase Receive
timeout and Poll Rate to ensure that Lookout allows enough time to
receive the response. Also, verify your cable connections, power,
configuration settings, and IP settings.

Exception Response: Modbus Exception String

This response is received when there is a MODBUS exception. The
Exception string will specify what the exception is. This is directly from the
MODBUS standard.

Unhandled Error
Contact National Instruments technical support if you receive this error.
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ModbusSlave

Lookout Object Reference Manual

ModbusSlave is an object class Lookout uses to act as a slave to equipment
such as PLCs, distributed control systems (DCSs), or any other device that
can act as a Modbus master. The ModbusSlave object enables Lookout to
respond to unsolicited messages generated by other devices on a Modbus
protocol network.

Applications include:

e PLCsand/or RTUs dial up a Lookout application over a non-dedicated
phone line when there is an alarm or event that must be reported
(unsolicited report-by-exception).

*  Two Lookout packages communicate with each other over radio. One
uses a Modbus object and the other uses a ModbusSlave object.

*  Lookout, directly connected to a Modbus network, responds to polls
from a DCS as a Modbus slave.

Think of the ModbusSlave object as representing a virtual PLC within
Lookout. It can receive reads and writes over a Modbus protocol-based
network. Like the Modbus object, the ModbusSlave object has a collection
of readable and writable data members, all created when you define the
ModbusSlave object.

You can create a unique ModbusSlave object for every master PLC, or you
can create a single ModbusSlave object for multiple master PLCs. In the
latter case, one master might write to one group of registers within the
ModbusSlave object and another master might write to another group of
registers within the ModbusSlave object.
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New Modbus Slave
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Figure 3-20. Modbus Slave Configuration Parameters Dialog Box

Address is a number (1 to 255) that refers to the address that this
ModbusSlave object will assume. Even though this object exists only in
software, other physical devices do not know that. They communicate with
this object using a physical communication line and need to know the slave

address.

Serial port identifies which communication port on the PC that the
Modbus master uses to communicate with the ModbusSlave in Lookout.

Data rate, Parity, Data bits, and Stop bits reference the settings utilized
by the master hardware device.

The Defaults button replaces the current settings with default values.

Table 3-45. ModbusSlave Data Members

Data Member Type Read | Write Description
1-9999 logical yes yes Single-bit coils
10001 — 19999 logical yes yes Single bit discrete inputs
30001 — 39999 numeric yes yes 16-bit input registers encoded as
unsigned binary integers ranging
from 0 to 65535
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Table 3-45. ModbusSlave Data Members (Continued)

Data Member Type Read | Write Description

40001 — 49999 numeric yes yes 16-bit holding registers encoded as
unsigned binary integers ranging
from 0 to 65535

BCD30001 — numeric yes yes 16-bit input registers encoded as

BCD39999 binary-coded decimal integers
ranging from 0 to 9999

BCD40001 — numeric yes yes 16-bit holding registers encoded as

BCD49999 binary-coded decimal integers
ranging from 0 to 9999

D30001 — D39999 numeric yes yes 32-bit input register

D40001 — D49999 numeric yes yes 32-bit unsigned holding
register—reads two adjacent holding
registers as a single 32-bit number
ranging from O to 4,294,967,296.

F30001 — F39999 numeric yes yes 32-bit input register

F40001 — F49999 numeric yes yes 32-bit IEEE floating point
register—reads two adjacent holding
registers as a single 32-bit floating
point value

H40001.f1 — logical yes yes Access individual bits out of holding

H49999.f16 registers and read them as logical
ON/OFF values. The least significant
bit is F1 and the most significant bit
is F16.

540001 — S49999 numeric yes yes 16-bit holding registers encoded as
signed binary integers ranging from
—32767 to +32768.
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NIDeviceNet
NIDeviceNetExplicit

Use the NIDeviceNet driver to connect to specific DeviceNet devices
through a National Instruments DeviceNet interface card. If you are
handling ordinary I/O to a device, use this as the object.

Use the NIDeviceNetExplicit driver when you are using special commands
unique to a particular DeviceNet device, as defined by the manufacturer of
that device. This object requires you to be aware of DeviceNet protocol
standards and the specific explicit messaging enabled by the device
manufacturer.

Use one NIDeviceNet object with a large number of NIDeviceNetExplicit
messaging objects for each device on a DeviceNet network.

)

Tip DeviceNet is a complicated protocol. Before using Lookout as your HMI/SCADA
interface, make sure you are familiar with the hardware itself. Install the National
Instruments DeviceNet card and use the accompanying DeviceNet card software to make
sure the card is installed and working properly before you attempt to create and configure
a DeviceNet object in Lookout. Consult the documentation supplied with your DeviceNet
hardware for help in installing the card properly and testing it to make sure it is properly
installed.

In addition to setting the basic parameters for your DeviceNet driver when
you create a Lookout DeviceNet object, configure your National
Instruments DeviceNet card. Access a dialog box for that purpose by
clicking on the Interface Configuration button on the Create
NIDeviceNet dialog box.

The first time you create a DeviceNet object (NIDeviceNet or
NIDeviceNetExplicit), the Interface Configuration dialog box appears
before the create object dialog box. After the first object, any time you
create an object, the Create NIDeviceNet or Create NIDeviceNetExplicit
dialog box will appear first. Click the Interface Configuration button to
change which National Instruments DeviceNet interface card to use with
that object.

For more information about configuring your National Instruments
DeviceNet card for use with Lookout, see the Configuring Your DeviceNet
Card for Lookout section.
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It is possible that a DeviceNet network can enter a state when no
communication is possible on the network. The only way to recover from
this event is to use the Test All command from the Hardware Configuration
Utility shipped with the National Instruments DeviceNet Interface Card.
This performs a reset of the interface.

NIDeviceNet Object Class

The following figure shows the Create NIDeviceNet dialog box.

MAC ID is the Media Access Control Identifier of the device you are
communicating with through the DeviceNet interface card. The lower the
number, the higher the priority of the device.

Connection type selects the connection between the interface card and the
device. The connection types are Poll, Cyclic, Strobe or Change Of
State (C0S). Some DeviceNet devices require a specific connection type.
Consult the device documentation to see what your particular devices
require.

@ Note Use the Simple Who utility that ships with the National Instruments DeviceNet
Interface card to determine what connection types are supported by a device.

If you choose Strobe as the Connection Type then the Expected Packet
Rate (EPR) dialog is disabled. All devices with a Strobe connection on a
particular Interface must have the same EPR. The EPR for the strobe
connection can be changed from the Interface Configuration dialog box as
detailed in the Configuring Your DeviceNet Card for Lookout section.

If you choose COS as the Connection Type, the PollRate field is disabled.

I/0 Input length must match the configuration device. This value controls
how many bytes your program reads from the device.

I/O Output length must match the device configuration. This value
controls how many bytes your program writes to the device.

@ Note The value of I/O Input length and I/O Output length must be greater than or equal to
0, and less than or equal to 255.

Lookout Object Reference Manual

Expected Packet Rate is the time in milliseconds between polls of a
device by a DeviceNet interface card.
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Poll is a logical expression. When this expression changes from FALSE to
TRUE, Lookout polls the DeviceNet interface card for data from the
specified device. Use a simple expression like the signal from a pushbutton,
or a complex algorithm.

PollRate is a numeric expression that determines how often to poll a
DeviceNet interface card. The object polls the card at the specified time
interval. This is a simple time constant such as 0:01 (one second). See
Numeric Data Members in Chapter 2, How Lookout Works, of the Getting
Started with Lookout manual for information on entering time constants.

The SKkip N poll requests after Comm failure setting instructs Lookout
not to poll a device that it has lost communication with on every scheduled
poll. Instead, Lookout skips the device in the polling cycle. Once
communication has been reestablished, the device is polled on the specified
cycle.

Communication alarm priority determines the priority level of alarms
generated by the object. These alarms are typically related to
communications with the physical device.

Clicking the Interface Configuration button activates the DeviceNet
Interface Configuration dialog box, discussed on the Configuring Your
DeviceNet Card for Lookout section. Use this dialog box to select which
DeviceNet interface card installed in your computer for the DeviceNet
object to communicate through, as well as to set the interface card's
configuration.

NIDeviceNetExplicit Object Class

The DeviceNet specification allows for a device manufacturer to use
explicit messaging for special purposes in their devices, most often for
configuration, or for non-standard devices. Use an NIDeviceNetExplicit
object to use this feature.

@ Note Explicit messaging is an advanced feature of DeviceNet. Use this feature only if
you are an experienced and advanced user of DeviceNet and if you’re familiar with the
manufacturer's implementation of explicit messaging on the particular device you intend
to use this feature with.

MAC ID is the Media Access Control Identifier of the device you are
communicating with through the DeviceNet interface card. The lower the
number, the higher priority of the device.
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Clicking the Interface Configuration button activates the DeviceNet
Interface Configuration dialog box, discussed in the Configuring Your
DeviceNet Card for Lookout section.

Explicit messaging for a given device uses three parameters to determine
what message is being sent to which element of the device functionality.
These three parameters are the service code, the class ID, and the instance
ID.

Because the service code and the class ID rarely change, set these two
parameters when creating an NIDeviceNetExplicit messaging object.
Create a different object for each combination of settings you make in the
Service Code and Class ID fields.

Use a number of different instance ID parameters with each service code
and class ID combination, so this parameter is incorporated into the
NIDeviceNetExplicit data members.

Poll is a logical expression. When this expression changes from FALSE to
TRUE, Lookout polls the DeviceNet interface card for data from the
specified device. Use a simple expression like the signal from a pushbutton,
or a complex algorithm.

PollRate is a numeric expression that determines how often to poll your
DeviceNet interface card. The object polls the card at the specified time
interval. This is a simple time constant such as 0:01 (one second). See
Numeric Data Members in Chapter 2, How Lookout Works, of the Getting
Started with Lookout manual for information on entering time constants.

Note DeviceNet explicit messaging is not a true polled system. In this object, the Poll and
PollRate parameters set how often the object sends out a message to get a response from
each connection for a given object, not for all the data members possible with that object.

The Skip N poll requests after comm failure setting instructs Lookout not
to poll a device that it has lost communication with on every scheduled poll.
Instead, Lookout skips the device in the polling cycle. Once
communications have been reestablished, the device is polled on the
specified cycle.

Communication alarm priority determines the priority level of alarms
generated by the object. These alarms are typically related to
communication with the physical device.
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Configuring Your DeviceNet Card for Lookout

Before you can use the Lookout DeviceNet driver, configure the DeviceNet
interface card using the Interface Configuration dialog box. Activate the
DeviceNet Interface Configuration dialog box by clicking the Interface
Configuration button in the Create NIDeviceNet dialog box.

If there is ongoing, active communication taking place through your
DeviceNet interface card, all the parameters in the Interface
Configuration dialog box are disabled. To stop communications, click the
Change Configuration button. A dialog box appears to warn that the
communication is in progress through the interface card and prompts you
to confirm that you want to halt communications.

When you select Change Configuration, make sure that no other
application is using the same interface card. For example, if you have a
National Instruments LabVIEW application using the same interface card
you are attempting to use with Lookout, a dialog box appears, warning that
another application is using the selected card.

All of the parameters set in this dialog box are global to the interface card
selected when you created the DeviceNet object. If you decide to use the
same interface card with another instance of the DeviceNet object, or with
an instance of the DeviceNetExplicit object, click the Change Interface
button to change the parameters.

Every DeviceNet interface card has a unique interface name set by the
Hardware Configuration Ultility that is shipped with the card. Interface
Name selects the name of DeviceNet interface card connected to the device
you want to communicate with.

MAC ID is the ID number of the card on that particular DeviceNet network
(0-63). The lower the MACID of a DeviceNet device, the higher priority it
has in the network. Interface cards typically have the lowest numbers.

Baud rate sets the speed at which the interface card communicates with the
network.

Default Poll Mode is the poll mode used by the interface card to talk to the
network.

Strobe EPR is the rate at which a Strobe command is initiated by the
interface card to the network.
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@ Note Refer to the NI-DNET User Manual and the NI-DNET Programmer Reference
Manual, shipped with National Instruments DeviceNet hardware, for more information
about the NIDeviceNet parameters mentioned in the previous section.

NIDeviceNet Data Members

Table 3-46. NiDeviceNet Data Members

Data Member Type Read Write Description

CommPFail logical yes no Object-generated signal that is on
if Lookout cannot communicate
with DeviceNet.

DINTO-DINT252 numeric yes yes 32-bit signed integer.

UDINTO-UDINT252 | numeric yes yes 32-bit unsigned integer.

INTO-INT254 numeric yes yes 16-bit signed integer.

LREALO-LREAL248 | numeric yes yes 64-bit floating point.

Poll logical no yes When this value transitions from
FALSE to TRUE, Lookout polls
the device.

PollRate numeric no yes Lookout expression that
determines the device polling
frequency.

REALO-REAL252 numeric yes yes 32-bit floating point.

SINTO-SIN255 numeric yes yes 8-bit signed integer.

UINTO-UINT254 numeric yes yes 16-bit unsigned integer.

Update logical yes no Object-generated signal that
pulses low each time it polls the
device.

USINTO-USINT255 numeric yes yes 8-bit unsigned integer.

BOOLO0.0 - logical yes yes Specified as ByteOffset.Bit offset

BOOL255.7 Look at the logical value at the
BitOffset in the specified in
ByteOffset.

NIBBLEO — numeric yes yes Looks at the lower nibble of the

NIBBLESI11 byte at the offset.
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Table 3-46. NIDeviceNet Data Members (Continued)

Data Member Type Read Write Description
UNIBBLEO - numeric yes yes Looks at the upper nibble of the
UNIBBLES11 byte at the offset.
UNIBBLEO.0.- logical yes yes Looks at the logical value at the
UNIBBLES11.3 BitOffset in the specified

NibbleOffset.

NIDeviceNetExplicit Messaging Data Members

Each DeviceNet explicit message data member has two parts, the instance
ID (11D) and the Data Type (DINT, REAL). Because one message may
return several data responses, each with its own data type, be familiar with
how the manufacturer of your device has implemented explicit
messaging—including knowing the specific instance ID and data type
requirements of the message you send, and the specific instance ID and data
type of the response.

DeviceNet explicit messaging uses a large buffer to hold data. All I/O from
a device uses that same, single buffer. The number after the data type
specifies the data offset into that buffer.

@ Tip In order to read a DeviceNetExplicit data member write out a value first. Make write
connections first before reading anything.

Example

The task is to get attribute 1 from Class ID 1, Instance 3 of an object. Class
ID 1 is the Identity Class, where all the identification information for the
device is contained.

You will have already entered background information when you created
the DeviceNetExplicit messaging object, setting the Service Code to 14
and the Class ID to 1. From the documentation provided by the device
manufacturer, you know that GetAttribute only accepts an unsigned
integer (USINT) as a parameter.

After creating the object, connect a pot to IID3.USINTO and set the pot
value to 1 for the attribute data. Then read IID3 using the data type that is
returned in attribute 1.

The baud rate for the object in question is an 8-bit unsigned integer
(USINT). To read the baud rate, access the IID3 .USINTO0 data member.
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Table 3-47. NIDeviceNetExplicit Messaging Data Members

Data Member Type Read Write Description

CommPFail logical yes no Object-generated signal that is on if
Lookout cannot communicate with
DeviceNet.

IIDO.DINTO-IID65535. | numeric yes yes 32-bit signed integer.

DINT252

IIDO.UDINTO- numeric yes yes 32-bit unsigned integer.

1ID65535.UDINT252

[IDO.INTO- numeric yes yes 16-bit signed integer.

IID65535.INT254

IIDO.LREALO- numeric yes yes 64-bit floating point.

[ID65535.LREAL248

Poll logical no yes When this value transitions from
FALSE to TRUE, Lookout polls the
device.

PollRate numeric no yes Lookout expression that determines

the device polling frequency.

IIDO.REALO- numeric yes yes 32-bit floating point.

1ID65535.REAL252

[IDO.SINTO- numeric yes yes 8-bit signed integer.

IID65535.SIN255

IIDO.UINTO- numeric yes yes 16-bit unsigned integer.

1ID65535.UINT254

Update logical yes no Object-generated signal that pulses
low (FALSE) each time it polls the
device.

IIDO.USINTO- numeric yes yes 8-bit unsigned integer.

IID65535.USINT255

DeviceNet Error Messages

The Lookout NIDeviceNet driver passes NI-DNET errors through to a
program. For detailed explanations of error messages, refer to the
NI-DNET documentation.
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National Instruments Fieldbus

Lookout can communicate with FOUNDATION Fieldbus devices using
the National Instruments AT-FBUS or PCMCIA-FBUS fieldbus interface
card.

The National Instruments Fieldbus object is available only when the
AT-FBUS or PCMCIA-FBUS is installed. The object contains no inherent
physical data members. All physical data members are obtained by reading
the device description associated with the FOUNDATION Fieldbus
device(s). A default Device Description that contains the standard function
blocks is available for devices which do not have any manufacturer defined
blocks. Lookout creates a Fieldbus object class dynamically for every
uniquely named block found in any of the device descriptions. If a block is
defined more than once by name, then the user is able select which device
description block definition to apply to the Lookout object in the object
creation dialog box.

In order to add or remove a Fieldbus block type to the Lookout object class
list, delete the Lookout . dat file in the \Lookout directory and restart
Lookout. This forces Lookout to re-index all of its subordinate object
classes. When re-indexing occurs, Lookout looks into every device
description in the directory system for Fieldbus blocks. The name of the
Fieldbus object class corresponding to a particular block is the name of the
block preceded by FF_. For example, the Lookout class name for the
standard Analog Input block would be FF_Analog_ Input.

Lookout also supports manufacturer supplied device descriptions. These
device descriptions must be imported using the NI-FBUS Interface
Configuration Utility. See the AT-FBUS or PCMCIA-FBUS
documentation for more information about how to import
manufacture-supplied device descriptions.

@ Note To work with Lookout, the manufacturer-supplied device description must have
been created with tokenizer version 4.2 or later.

It is highly recommended that you review the documentation for the
AT-FBUS or PCMCIA-FBUS interface card to learn about FOUNDATION
Fieldbus basics and to ensure proper installation and configuration prior to
beginning with the Lookout National Instruments Fieldbus object.
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Create Analog_Input object E

Mame: Device Description(s]:

IAnang_Input‘I C:SNIFBLIS datat 00000540005 nift
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Copy Fieldbuz Tagname |
Fieldbus Tag:

| =
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Alarm priority: IS Fietry attempts: |3

PollF ate: ID;DD_S Could not open NIFE session: Server not responding

Cancel | Help |

Figure 3-21. Fieldbus Configuration Parameters Dialog Box

To create an object from a device description other than the default, select
the appropriate device description for the device from the list and click the
Rescan button. Select the desired function block from the Fieldbus Tag
pull-down menu. Clicking the Copy Fieldbus Tagname button will
eliminate illegal characters from the object name and include naming
information from the function block. Set the other parameters as desired
and click on the OK button.

Name is the Lookout name and is used to reference this object in Lookout.

Copy Fieldbus Name replaces any invalid characters that may be in the
Fieldbus Name with underscores while copying the Fieldbus Name into the
Lookout Name edit box.

Fieldbus Name shows a list of all Fieldbus blocks, of the appropriate
type, available on your network. This list comes from comparing the
DD_Item_Type of the block on the networks with the type of object that the
user has selected to create. If there are no devices in this listbox, you can
click the Show all blocks checkbox and select the Rescan button to show
Fieldbus blocks of all types on the network.

@ Note Lookout treats the block selected as the type of block the user was trying to make.
If an incorrect block is selected, the wrong parameter list appears for that block and invalid

data request may occur.

Device Description contains a list of Device Descriptions that have
definitions for the block the user is about create. The parameter list for each
definition may vary. Care should be taken in selecting the device
description that corresponds with the device to be communicated with.

Lookout Object Reference Manual
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PollRate is a numeric expression that determines how often to poll the
device. The object then polls the device at the specified time interval.
Normally, this is a simple time constant such as 0:01 (one second). See
Numeric Data Members in Chapter 2, How Lookout Works, of the Getting
Started with Lookout manual for information on entering time constants.

Retry is the number of Fieldbus communication alarms to ignore before
reporting an alarm.

Alarm priority determines the priority level of alarms generated by the
National Instruments Fieldbus object. Such alarms are typically related to
communications with the physical device.

Fieldbus Alarms
The Fieldbus Alarms dialog box lets you acknowledge Fieldbus Alarms.

Fieldbus Alarms [ %]
Block.Param Type Friority Time Walue Statuz
Pricrity Filter: I‘I‘I— | Acknowledge:. I | """"" Elosel

Figure 3-22. Fieldbus Alarms Dialog Box

Priority Filter filters alarms by priority. If you Acknowledge an alarm, it
is removed from the list if successful.

Fieldbus Data Members

As with all Lookout drivers, you can access I/O points and other data
through data members. The following is a table of built-in data members
currently supported by the National Instruments Fieldbus object class.
All other data members are obtained from device descriptions.
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Table 3-48. National Instruments Fieldbus Data Members

Data Member Type Read | Write Description

Alarms numeric yes no Expression that shows number of
active Fieldbus alarms.

CommPFail logical yes no Object-generated signal that is on if
Lookout cannot communicate with
the device(s).

Poll logical no yes When this value transitions from
FALSE to TRUE, Lookout polls the
device.

ShowAlarms logical no yes When this value transitions from
FALSE to TRUE, Lookout shows the
Fieldbus alarm window.

Update logical yes no Object-generated signal that pulses
low each time it polls the device.

Fieldbus Status Messages

Lookout Object Reference Manual

No response within timeout period

Lookout did not receive a response from a device within the Receive
timeout period. Check the devices connection. Check to see if the device
can be polled using NI-FBUS Dialog.

Cannot find nifb.dll

Lookout could not find a component needed to communicate with the
Fieldbus devices. This component is placed during the installation of the
NI-FBUS software. Make sure the installation was successful.

Could not open NIFB session [: optional error message]

Lookout could not open a Fieldbus communications session. If available,
specific error text is shown providing specific information. Make sure that
the nifb driver in Settings»Control Panels»Devices is started. Also make
sure that ni fb . exe is running.

Block name could not be found on network

Lookout could not find the block name specified on the Fieldbus network.
Check name spelling or the device/network connections.
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I/O error: [error message]

Lookout encountered an error during the read/write process. The error
message, provided by the Fieldbus communication interface, contains
specific information regarding the cause of the failure.

Fieldbus Troubleshooting

If after deleting the lookout.dat file and restarting Lookout there are
no FF_(Fieldbus Object) classes listed in Lookout; check the following:

* Is the path to the base directory for manufacturer supplied device

descriptions specified correctly in the NI-FBUS Configuration Utility
under DD Info?

*  Does the NI-FBUS Dialog application work correctly?

Lookout cannot establish a fieldbus session with the card.

* Is NIFB.EXE running?

*  For Windows NT, has the device driver nifb been started by looking
in Devices in the Windows NT Control Panel?

* Does the NI-FBUS Dialog application work correctly?

Refer to the AT-FBUS and PCMCIA-FBUS documentation for more
troubleshooting information.
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FieldPoint is a protocol driver class Lookout uses to communicate with
FieldPoint devices using an enhanced version of the Optomux
communication protocol. Refer to the Choosing a Method to Access
FieldPoint topic in the Lookout Help for more information about accessing
FieldPoint in Lookout.

This protocol uses no parity, eight data bits and one stop bit. In Lookout,
a single FieldPoint object represents all devices connected to the same
COM port.

The Lookout FieldPoint object can read and write to all predefined data
points allowed by the particular FieldPoint module. When you create a
FieldPoint object, you have immediate access to all the object data
members. See the FieldPoint Data Members section for more information
on object data members.

5

Note Before attempting to use this object, you should install, configure, and test your

FieldPoint modules using FieldPoint Explorer.
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M ame: M ame:
FieldPaint1 FieldPaint1
Communication Settings Communication Settings
& Sedal Serial port: Drata rate:  Serial el port: [ata rate:
© Ethemet IEDM1 'l |1152DD 'l - IEDM1 'l |1152DD 'l
Phone numnber: I Address: l—
FolRate = |0:01 Rl L
Pal= | I

Communication alarm priority: IS

Receive timeout: |250

Communication alarm priority: IS
Bt attempts: |4
Shipeven |5 pall requests after camm faiure

MEecs

Retry atterpts: [4 Feceive Hmeaut: |250

Skip every |5 poll requests after comm failure

MEELS:

l&K. Configuration File
IF: ook 440 _Examplesidemo.iak

l&K. Configuration File
IF: ook 440 _Examplesidemo.iak

Brawse | V' Impart alias information Browse |
| o | |

Figure 3-23. National Instruments FieldPoint Configuration Parameters Dialog Box

V' Impart alias information

Help Help

Cancel | Cancel |

When you select the Ethernet option, the serial port configuration options
are disabled.
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Enter the IP address in the Address field. You could also enter the
FieldPoint network name instead.

@ Note If you replace a FieldPoint FP-1000 module (serial communications) with a
FieldPoint FP-1600 module (Ethernet communications) or replace an FP-1600 module
with an FP-1000 module, you must re-import your . I2AK file. First, you must use
FieldPoint Explorer to update your . IAK file. If necessary, consult your FieldPoint online
help for detailed instructions on using FieldPoint Explorer. To re-import the . IAK file,
deselect the Import alias information checkbox and click on OK. Reopen the FieldPoint
object dialog box and select the Import alias information checkbox again. When you
click on OK, Lookout re-imports the new . IAK file information.

Serial port specifies which COM port the object uses for communicating
to the external device. This does not specify the communication type.
Communication type is determined by the Options»Serial Ports... menu
command.

Data rate indicates the baud rate that Lookout uses to communicate with
the hardware device. This setting should match the selection made on each
of your network modules.

Phone number specifies the number to be dialed if the selected serial port
is configured for dial-up. This number only applies to the individual
protocol object.

PollRate is a numeric expression that determines how often to poll the
device. The object then polls the device at the specified time interval.
Ordinarily, this is a simple time constant such as 0:01 (one second). See
Numeric Data Members in Chapter 2, How Lookout Works, of the Getting
Started with Lookout manual for information on entering time constants.

Poll is a logical expression. When transitioned from FALSE to TRUE,
Lookout polls the device. This can be a simple expression, like the signal
from a pushbutton, or it can be a complex algorithm.

Communication alarm priority determines the priority level of alarms
generated by the FieldPoint object. Such alarms are typically related to
communications with the physical device.

Retry attempts specifies the consecutive number of times Lookout
attempts to establish communications with a device if it is not getting a
valid response. After it tries the number of Retry attempts specified, the
FieldPoint object generates an alarm and releases the COM port. Refer to
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Chapter 3, Serial Port Communication Service, in the Lookout Developer’s
Manual for more information.

Receive timeout is the time delay Lookout uses in waiting for a response
from a device before retrying the request.

The Skip every n setting instructs Lookout to not poll a device it has lost
communication with on every scheduled poll. Instead, Lookout skips the
device in the polling cycle. Once communications have been reestablished,
the device is polled on its regular cycle.

TAK configuration file is a dialog for selecting an IAK configuration file.
The TAK file contains alias and scaling information which is extracted for
use in Lookout. Choose the configuration file you want to use by entering
the path directly, or use the Browse button. Check Import alias
information if you want to extract information from the selected file.

FieldPoint Filtering for Counter Overflow Alarms

Lookout 4.5 includes a modified version of the FieldPoint driver object
class that can filter Counter overflow alarms.

To enable this capability you must make an entry in the fpoint . INT file.
The section name and entry are

[FieldPointTagName] FilterChAlarms=1

A value of 1 (TRUE) filters the alarms. A value of O (FALSE) disables the
alarms. If there is no entry (default), the alarms are not filtered.

Because you cannot filter only the Counter-overflow alarm, you must filter
other alarms of the same type with this setting, as shown in the following
table.

Module Name [chnl_status] Value Error Message
FP-AI-100 1 Out of range
FP-AI-110 1 Out of range
FP-AI-111 1 Out of range
FP-AO-200 1 Open Current Loop
FP-AO-210 1 Overcurrent Protection
FP-DO-410 1 Current Limited
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Module Name [chnl_status] Value Error Message
FP-TC-120 1 Out of Range
FP-RTD-122 1 Out of Range
FP-CTR-500 1 Overflow since Last Read

All the above alarms will be filtered with through the . INT file setting.
These are all basically the ChannelStatus 1 alarms. For more detailed
information consult the FieldPoint Programmer's Manual.

@ Note Refer to the FieldPoint documentation for more information about FieldPoint
module configuration.

FieldPoint Data Members

As with all Lookout drivers, you can access I/O points and other data
through data members. The following is a table of data members currently
supported by the FieldPoint object class.

Table 3-49. National Instruments FieldPoint Data Members

Data Member Type Read | Write Description

AI000.00 - AI255.15 numeric yes no Analog input channels.

A0000.00 - AO255.15 numeric yes yes Analog output channels.

CAO000.00 - CA255.15 numeric yes no Use to connect to count inputs on a
FieldPoint counter module.

CD000.00 - CD255.15 logical yes no Use to connect to digital inputs on a
FieldPoint counter module.

CI1000.00 - CI255.15 logical no yes Counter increment.

C0000.00 - CO255.15 logical yes yes Use to connect to digital outputs in a

FieldPoint Counter module.

CommPFail logical yes no Goes high if Lookout cannot
communicate with the device.

CR000.00 - CR255.15 logical no yes Counter reset.
DI000.00 - DI255.15 logical yes no Discrete input channels.
DO0000.00 - DO255.15 logical yes yes Discrete output channels.
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Table 3-49. National Instruments FieldPoint Data Members (Continued)

Data Member Type Read | Write Description

Offhook logical no yes When TRUE, this flag instructs the
object to retain exclusive use of its
assigned communication port.

PF000.00 - PF255.15 numeric yes yes Pulse width modulator period setting.
Period is the entire on/off time of the
pulse in milliseconds.

PhoneNumber text yes yes Phone number for dial-up use.

Poll logical no yes When transitioned from low to high,
Lookout begins a poll cycle on the
device.

PollRate numeric no yes Specifies the frequency at which

Lookout polls the device.

PWO000.00 - PW255.15 numeric yes yes Sets the FieldPoint pulse module duty
cycle on/off ratio. A setting of 10.00
means the pulse is on for 10% of the
pulse period and off for 90%.

RL000.00 - RL255.15 logical yes yes Use to connect to digital output
channels on a FieldPoint relay
module.

RT000.00 - RT255.15 numeric yes no RTD temperature measurement

module analog input; returns a value
in degrees Centigrade.

TC000.00 - TC255.15 numeric yes no Use to connect to analog input
channels on a FieldPoint
thermocouple module.

Update logical yes no Goes high when Lookout begins a
poll cycle on the device.
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Note When you use the Ca, CD, CI, CO, CR, PW, RL, RT, and TC data members with
FieldPoint serial modules, they are synonyms for analog or digital inputs or outputs as
follows:

CI, CD—Digital Input

CR, CA, RL—Digital Output

PF, PP, RT, TC—Analog Input

PW—Analog Output

With FieldPoint Ethernet, these data members represent different FieldPoint modules.

Note The first two characters of the I/O data members represent the kind of module being
accessed. The next three digits represent the device address of the module. This is the
address of the I/O module itself, not the network module that governs it. Following the
period are two digits representing the channel number within the module.

Not all of these data members are valid for every FieldPoint module. For all the device
types you are able to select the full range of device addresses and channels. So if you select
DO0123.03, you need to be certain that the device at address 123 is in fact a discrete output
module.

For a more complete definition of the function of these data members, see FieldPoint
documentation.

Note In the event of a power cycle to the FieldPoint device during use, the configuration
of the device reverts to some default state, which is configurable. You should keep in mind
that if the ranges you configured into the IAK file differ from those in the power-up
configuration, the scaling information imported from the TAK file and used as a Lookout
alias might become outdated and incorrect after a power loss. To avoid this, make certain
your power-up configuration ranges and your IAK configuration ranges are identical.

FieldPoint Multiple Discrete Data Members

Table 3-50. Multiple Discrete Data Members

Data Member Type Read | Write Description
MDI000.0000 - numeric yes no Multiple discrete input channels
MDI255.FFFF
MDO000.0000 - numeric yes yes Multiple discrete output channels
MDO255.FFFF

These special purpose data members are for reading or writing a numeric
integer value to a set of discrete channels.
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For instance, when you are configuring your modules with FieldPoint

Explorer, you have the option of selecting more than one discrete channel
for a data item that you are defining. If you do this and import the resulting
. 12K file into Lookout for use as aliases, the aliases created will correspond
to this set of data members. You can then read and write to all the discrete
channels with a single numeric data member. The data member names are

in the form MTTAAA . cccc, where:

M Indicates multiple as opposed to single
TT Two characters specifying module type (Discrete Out,
Discrete In)
ARA Three numeric characters specifying module address
cecee Four hexadecimal characters specifying which of
the 16 channels are included in this data member
@ Note These data members will not enumerate. You may use them either by importing

configurations from FieldPoint Explorer or by entering the data member name explicitly.

FieldPoint FPTB-10 Module Data Members

The following data members are for use with the FieldPoint FPTB-10
module. These data members appear in a FieldPoint object only if the
FPTB-10 module is installed and configured as part of the FieldPoint

hardware.

Table 3-51. FieldPoint TB-10 Module Data Members

Data Member Type Read Write Description
TBAI000.00 — numeric yes no Analog input channels
TBAI255.15
TBAO000.00- numeric yes yes Analog output channels
TBAO255.15
TBDI000.00 — logical yes no Digital input channels
TBDI255.15
TBDO000.00— logical yes yes Digital output channels
TBDO0255.15
@ Note The first two characters of the I/O data members, TB, indicate that the module being

accessed is an FPTB-10 module. An FPTB-10 module can have different channel types.
The next two characters represent the type of channel being accessed, such as Al for
Analog Input or DO for Discrete Output. The next three digits represent the device address
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of the module. This is the address of the I/O module itself, not the network module that
governs it. Following the period are two digits representing the channel number within the
FPTB-10 module. If you select TBDO4 . 03, there is an FPB-10 module at position 4 and
channel 3 is a Discrete Output. Similarly, TBAO4 . 05 is an FPTB-10 module at position 4
and channel 5 is an Analog Output type.

FieldPoint Error Messages

No response within timeout period

Lookout received no response from a device within the Receive timeout
period. The FieldPoint object is able to use the COM port, but when it
polls the device, the device does not respond. If you have daisy-chained
several devices, you have introduced an inherent delay. You may have to
significantly increase Receive timeout (and Poll Rate) to ensure Lookout
is allowing enough time to receive the expected response. This increase has
nothing to do with the processing capabilities of Lookout. Rather it is based
solely on Data rate and the number of devices on the chain. Also, verify
your baud rate settings, cable connections, power, configuration settings,
COM port settings, and polling addresses.

Module returning ?? checksum

This means that the frame sent from the PLC in response to the command
sent by Lookout out returned ? 2 instead of a valid checksum. Check
FieldPoint configuration.

Message Garbled - Bad CRC

This means the checksum (CRC in this case) failed in a frame received by
Lookout. Check cabling or for two or more devices with the same address.

Unexpected data response length

The frame received was of an unexpected length. Check the Lookout
receive gap setting.

Error loading IAK configuration file

Lookout was not able to successfully extract data from the . IAK
configuration file. Try running the FieldPoint Explorer again and
reconfigure your hardware.

FP error: Power-up clear expected

A command other than power-up clear was attempted after power-up or
power failure. The command sent is ignored and normal operations should
resume.
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FP error: Undefined command

The addressed module does not support this command. (for example, trying
to write to an input module) Check to see if you are sending a command
appropriate to the module.

FP error: Checksum error

This means the checksum (CRC in this case) failed in a frame sent by
Lookout. Check the Lookout receive gap setting.

FP error: Input buffer overrun

The command sent to the FieldPoint module was too long. Check the
Lookout receive gap setting.

FP error: Non-printable ASCII character received

Only characters from ASCII value 33 to 127 are permitted in FieldPoint
commands. The command is ignored.

FP error: Data field error

An insufficient or incorrect number or characters were received by the
FieldPoint module for the specified command. Check the Lookout receive
gap setting.

FP error: Communications link network watchdog timed out

There has been no network traffic in the amount of time specified by your
watchdog configuration settings, and the system has reverted to its
watchdog defaults.

FP error: Specified limits invalid for the command

This includes the case where an invalid digit (hex or decimal) was received.
Check the Lookout receive gap setting.

FP error: ASCII to binary conversion error

One or more ASCII characters could not be converted to binary on the
FieldPoint module. Check the Lookout receive gap setting.

FP error: Invalid device address

The command is valid, but the addressed module does not support the
command received. Check to see if you are sending a command appropriate
to the module.

FP error: Serial framing error

An improperly framed command was received by the FieldPoint module.
Check the Lookout receive gap setting.
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FP error: Addressed module does not exist

Make sure that you are addressing a valid module address.

FP error: Invalid channel

One or more channels specified in the command either do not exist or do
not support the operation specified.

FP error: Invalid range setting

Check to see that the range information on the module has not changed,
possibly due to a loss of power.

FP error: Invalid operation for the module

One or more module-specific operations specified in the command either
do not exist or do not support the operation specified. Make sure that you
are not requesting a discrete operation for an analog module, and vice
versa.

FP error: Module has been hotswapped since last command

The alarm should deactivate immediately after it appears. It appearance is
only to acknowledge that a hot swap has occurred.

FP error: Irrecoverable hardware fault

A malfunction in the FieldPoint firmware or hardware has made
communications from Lookout impossible.

Channel specific error: dev:##,ch:##,err:##

These are error codes returned from the FieldPoint I/O modules. The alarm
message specifies a device address, channel number, and error code. See
FieldPoint documentation for a description of the error condition.

© National Instruments Corporation 3-181 Lookout Object Reference Manual



Chapter 3 Lookout Driver and Protocol Objects

National Instruments Lookout OPC Client

Lookout uses the National Instruments Lookout OPC client to read data
from and write data to any OPC server. It supports numeric, logical
(boolean), and text I/O. The Lookout 4 OPC client normally reads from the
cache. You can connect a switch or pushbutton to the Pol1Device data
member to trigger a device update.

For your convenience, you can create OPCFieldPoint and OPCNIDAQ
versions of the OPCClient object class by selecting these two special cases
from the Select Object Class dialog box.
@ Note If you are using the National Instruments OPC IATest server, there is no device to
poll. Triggering the PollDevice data member returns a zero (0). Simulated data will be
restored shortly after such a poll.

Create OPC Client E

Mame: IDPEcIient‘I

— OPC Server Setting:

Server Mame: INationaI Instruments. DPCFieldPoint j
" In-Process Server
' Local Server
' Bemote Server I\\PUMMEL J
Blaeno V' Use Asynchronous 1/0
" Disabled ¢ Flat & Hierarchical .

™ Force Refresh after wiite

— OPC Group Setting

Update R ate:
Deadband:
Fall Device =

Default Access Path:

J100
Jo

millizeconds

percent

[optional)

[optional)

Communication alarm priority: IS

Cancel | Help |

The Server Name box enumerates all of the OPC servers registered on the
local computer. Select the appropriate server.

5

Note The Server Name listbox contains only local servers. It has no effect on what you
find when you browse remote servers.
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You can then select one of the In-Process Server, Local Server, and
Remote Server options. These options specify the type of server the OPC
client will attempt to launch. If it cannot successfully connect to the
selected server, the OPC client generates an alarm.

Select Remote Server to enable Computer Name, which specifies the
name of the computer on which the remote server is to be launched. If you
know the computer name you want, enter it preceded with two backslashes,
as in \ \ PUMMEL.

A Caution In-process servers should only be used if Lookout is the only program
communicating with the server. If other programs address the same server, use the Local
Server option.

The Browsing options include Disabled, Flat, and Hierarchical. If your
OPC servers permit browsing, select either Flat or Hierarchical. If you
enable flat browsing all data members appear in any Lookout windows
displaying OPC client data members. If you select Hierarchical, the data
members are arranged in hierarchical folders.

To browse remote servers, click on the browsing button next to the Remote
Server field. The following dialog box appears.

Select Remote OPC Server E

Entire Metwork OPC Servers
IPUMMEL |
Cancel |

- PRODMAN ;I Mational Instruments. LookoutOPCS erver
- PROTEST Mational Instrumentz. OPCDirectMET
M ational Instruments. OPCFieldPoint
- PROXY Mational [nstruments. OPCIAT est
- PSYLARK Mational Instruments. OPCLogosinterface
- PUGSLEY M ational [nstruments. OPCMitsubishi
- PULSAR Mational Instruments. 0 pcPpocom
 PUMBA M ational Instruments. OPCSiemens
. OPC.Simaticet
= PLIMBEL: Opto22 Mds.1
- PUME RS51.Gen32.1
- PUNJABI RSI1.0PCErmulatar.1
 PUNKIN — " |RSLire OPC Server
- PRIPCA
- QUALITY
- QUASI
. TILIELIE LI

Browse for the computer you want, and select the OPC server running on
the computer that you want to access.

@ Note You must have the Microsoft Remote Registry service installed for remote OPC
browsing to work on a computer running Windows 98/95. To install, select
Start»Settings»Control Panel and then select Network. Check the Configuration tab to

© National Instruments Corporation 3-183 Lookout Object Reference Manual



Chapter 3

Lookout Driver and Protocol Objects

see if Microsoft Remote Registry is installed. If it is not, click on the Add button, and select
Service in the Select Network Component Type dialog box. Choose Microsoft as the
manufacturer. If the Remote Registry service is not visible, you will need your

Windows 98/95 CD-ROM. You may have to browse through the disk to find the correct
service. Once you have installed this service, you can successfully use remote OPC
browsing in the Lookout OPCClient object.

Select Use Asynchronous I/0 if you want to us asynchronous
communications with your OPC server. This is the preferred
communications mode, and should be used when possible.

The Force Refresh after Write option is only available if you select the
Use Asynchronous I/0 option. This option forces the OPC server to return
the current status of all data members every time you write to one.

Note Selecting Force Refresh after Write can sometimes impair performance of your
Lookout process, depending on the number of data members in your OPC server and other
system variables, including communications speed and what other tasks are being
performed at any particular moment.

Update Rate is a numeric expression that determines how often the OPC
server updates the client. Enter this time interval in milliseconds.

Deadband sets the percentage change that must take place in a data
member before the OPC server reports a change in value to Lookout.

Poll Device is a logical expression. When this expression changes from
FALSE to TRUE, Lookout polls the OPC server for all values. You can use
a simple expression like the signal from a pushbutton, or a complex
algorithm. In most applications there is no need to do device reads, so this
parameter is often left blank.

Enter a Default Access Path if you want to simplify entering paths to
various data members.

Communication Alarm Priority specifies the priority of alarms generated
by this OPC client object.

Using OPC with Lookout

This section describes several issues you need to be aware of when using
OPC with Lookout.
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OPCClient Performance

National Instruments recommends that you use the OPCClient object to
communicate with National Instruments Data Acquisition, SCXI, and
FieldPoint products when possible for performance reasons.

Also, you will increase performance when you use Lookout with the
OPCClient on the same computer as the OPC server application you are
exchanging data with. You can then use the TCP/IP-based networking built
into Lookout to pass this data across the network to other Lookout clients
and servers.

Editing the OPCClient Database

When you open the OPCClient database to work with the OPC data
members, you must manually set the data type for each data member when
you select it. Lookout does not automatically set a data type for an
OPCClient data member.

Security and OPC Client/Server

When you disable task switching as a security option by selecting User
cannot switch to another program in the System Options dialog box,
you disable all top level windows. This can cause problems with OPC
servers under Windows 95 when someone with a security level lower than
the level you set logs in to Lookout.

To fix this problem, add the following lines to your lookout . ini file
using any text editor:

[Security]
DisableWindows=0

This . ini file setting fixes the OPC problem, but it does mean that an
operator can switch to other applications if he can click on their windows
or on their icons in the task bar. To maintain security, make sure you select
the Lookout will always be maximized option in the System Options
dialog box, and make sure that your Windows taskbar (accessed by
selecting Start»Settings» Taskbar) is set to Auto hide, and that Always
on top is disabled.

For more information on the 1ookout . ini file, see Appendix C, .INI File
Settings for Lookout, of the Lookout Developer’s Manual.
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OPC Client Data Members

As with all Lookout drivers, you can access I/O points and other data
through data members.

Unlike other Lookout driver objects, however, the OPCClient data member
set changes depending on the OPC servers you have running on your
computer.

If you selected hierarchical browsing when you created the OPCClient, the
data members for the OPC server you have connected your OPC client to
appear as data members inside a folder in your OPCClient list of data
members in the Lookout Object Explorer, connection editor, and other
windows as shown in the following illustration.

OPCclientl connections E
— Select member: :
Mwritable: members: Eisting connections: St Db|ECL"|

Activate
FollDevice

Accept |
OPCclient]
Mo member selected Clear |

— Signals:
Tags: Path Mode: I Relative j

Ir: P[DCESS1 Contents [readable]: numeric

-4 $alam - Al -
=48 OPCclient! Channel 0
5 FP Res Channel 1

-5 FPAT10 @2 Channel 2

-y FP-40-200 @3 Channel 3

-y FP-DO-401 @1 Channel 4 x|
-y FP-RLY-420 @4
Fg] FPRTD-122 @11
----- <% Panell

Cluit

Eeste | OPCclient1.'FP Res" FP-41-110 |
Help

If you selected flat browsing, you will see a long list of available data
members without hierarchical organization into folders.

If you did not enable browsing, or your computer cannot browse certain
OPC servers, you will only see the data members built into the Lookout
OPCClient.
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The Lookout OPCClient object class currently contains the built-in data
members contained in the following table.

Table 3-52. OPCClient Data Members

Data Member Type Read | Write Description
Activate logical yes yes When TRUE, the OPC client is active
and receives data. When FALSE, the
OPC client does not update.
CommPFail logical yes no Goes high if Lookout cannot
communicate with the server.
DataError logical yes no Goes high if the object cannot
properly process the data returned by
the server.
PollDevice logical no yes When transitioned from FALSE to
TRUE, the object polls the server.
Update logical yes no Pulses high and low when the OPC
server updates Lookout or Lookout
successfully polls the server.
The data members for the OPC Client depend on your OPC server. To use
one of the data members from your server, enter the data member directly
into an expression or URL field.
If the OPC server permits browsing, you can use data members as you
would with any other Lookout driver object. If you cannot browse your
OPC server, enter the item manually in the form acceptable to your OPC
server, as in the following example:
OPCclientl. 'device\folder\itemName'
@ Note Notice the use of single quotes. Using a single quote around a component of a path

allows the use of any character in that path, not just the normally allowed characters.

If all your items use the same access path, use the Default Access Path
option. If you need to specify a different access path, use a period and
tilde (.~) to denote the first element of the path, as in the following example:

OPCclientl.'device\itemN'.'~accesspath'

Notice that the access path must be a separate component. Single quotes
denote a string as being a single component.
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If an item name or access path already contains a tilde, you must enter one
additional tilde to act as an escape character for that tilde, and a second
additional tilde to denote an access path (for example, if the access path is
~COM1, enter ~~~COM1).

Examples

OPCclientl.'4:0'.'~Modbus Demo Box'

The access path is Modbus Demo Box and the OPC item ID is 4 : 0.
OPCclientl.'4:0'

The access path is Null and the OPC item ID is 4 : 0.

@ Note You cannot browse access paths for an item. You must enter access paths manually.
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NIDAQDevice

@ Note This section is included for compatibility with previous versions of Lookout.
National Instruments recommends that you use OPC Client to connect to NI-DAQ OPC.

Lookout uses the NIDAQDevice object class to communicate with
National Instruments data acquisition devices, including data acquisition
devices connected in parallel mode to SCXI hardware. Refer to the NISCXI
object class for more information concerning configurations using SCXI
hardware connected in multiplexed mode.

To use this object, you should have NI-DAQ 5.0 or better software installed.
While the NIDAQDevice object works with some earlier versions of
NI-DAQ software, it does not perform well with these earlier versions, and
has not been extensively tested.

Consult your NI-DAQ hardware and software manuals for information on
installing and configuring National Instruments data acquisition software
and hardware.

When you create an NIDAQDevice object for the first time, or when you
launch Lookout and run an application using the NIDAQDevice object,
Lookout automatically loads the NI-DAQ software. This can take a few
moments, during which the screen is frozen. Once the NI-DAQ software
has loaded, Lookout returns to its former speed.

@ Note This object class is available on 32-bit versions of Lookout 3.7 and later. It is not
backward compatible with earlier versions of Lookout, and does not run on the 16-bit
version of Lookout.
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NIDAQDevice Data Members

Figure 3-24. NIDAQ Device Configuration Parameters Dialog Box

Create NIDAQDevice E

M ame: Eioard]

Device: |1

Scanning interval: |5D

millizeconds
Communication alarm pricrity: Is

QK I Eancell Help |

Device is the NI-DAQ device number. The DAQ configuration utility
(WDAQConf . exe) assigns this number to an installed device. Valid device
numbers range is from 1 to 16.

Scanning interval is the time period between analog and digital input

polls. The valid range is 20 msec to 1 day (expressed in msec). You should
also keep in mind that some National Instruments DAQ cards need time to
stabilize, and so that a scanning rate that is faster than the stabilization rate
of the card returns suspect values.

Communication alarm priority determines the priority level of the alarms
generated by the NIDAQDevice object.

Table 3-53. NIDAQDevice Data Members

Data Member Type Read | Write Description

AlO, AI63 numeric yes no Analog input channel in volts.

AO0, AO63 numeric no yes Analog output channel in volts.

CommPFail logical yes no Object-generated signal that is on if,
for whatever reason, Lookout cannot
communicate with or control the
device without error.

DIO, DI31 logical yes no Digital input line.
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Table 3-53. NIDAQDevice Data Members (Continued)

Data Member Type Read | Write Description
DO0, DO31 logical no yes Digital output line.
Update logical yes no Object-generated signal that pulses
low each time the object polls the
device.

NIDAQ.INI

You may configure individual channel attributes by editing the NIDAQ. INT
file in your Lookout directory.

To specific a channel, use the following format: [DEV1.AIS]
This specifies analog input channel 5 on device number 1.

UPPERLIMIT specifies the upper input limit in volts (for example,
UPPERLIMIT=2.5). Usually used in conjunction with LOWERLIMIT.

LOWERLIMIT specifies the lower input limit in volts (for example,
LOWERLIMIT=-3.7). Usually used in conjunction with UPPERLIMIT.

INPUTMODE specifies the analog input connection mode to use for this
channel. Valid choices are 1 for differential, 2 for referenced single-ended,
and 3 for non-referenced single-ended.

NIDAQDevice Error Messages

Error loading NI-DAQ driver

Lookout was not able to communicate to the NI-DAQ driver. Be sure that
NI-DAQ has been installed properly, and the NI-DAQ Configuration Utility
has been used to configure the your hardware devices.

NIDAQ: Analog Input: Invalid Data Member(s)
NIDAQ: Analog Output: Invalid Data Member(s)
NIDAQ: Digital Input: Invalid Data Member(s)
NIDAQ: Digital Output: Invalid Data Member(s)

At least one channels you have specified is not valid for your current
hardware configuration. Be sure your hardware is configured properly
using the NI-DAQ Configuration Utility.

NIDAQ: Error code: NNNNN
NIDAQ: Analog Input: Error code: NNNNN
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NIDAQ: Analog Output: Error code: NNNNN
NIDAQ: Digital Input: Error code: NNNNN
NIDAQ: Digital Output: Error code: NNNNN

NI-DAQ has detected an error condition. Please refer to your NI-DAQ
Function Reference Manual to determine the meaning of the error code.

Table 3-54. National Instruments Data Acquisition Devices Supported

by Lookout
Device Al AO DIO
AT-AO-6 — yes yes
AT-AO-10 — yes yes
AT-MIO-16E-1 yes yes yes
AT-MIO-16E-2 yes yes yes
AT-MIO-16E-3 yes yes yes
AT-MIO-16DE-10 yes yes yes
AT-MIO-16XE-50 yes yes yes
AT-MIO-16X yes yes yes
AT-MIO-16F-5 yes yes yes
AT-MIO-64E-3 yes yes yes
CS-2017 ClC — —
DAQCard-1200 yes yes yes
DAQCard-700 yes — yes
DAQCard-5XX yes — yes
DAQPad-MIO-16XE-50 yes yes yes
DAQPad-1200 yes yes yes
Lab-PC+ yes yes yes
PC-LP-16 yes — yes
SC-2070 ClC — —
SCB-68 ClC — —
SCB-100 ClC — —
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NISCXI

@ Note This section is included for compatibility with previous versions of Lookout.
National Instruments recommends that you use OPC Client to connect to NI-DAQ OPC.

Lookout uses the NISCXI object class to communicate with National
Instruments data acquisition devices connected in multiplex mode to SCXI
hardware. Refer to the NIDAQDevice object class for more information
concerning parallel SCXI configurations, and data acquisition
configurations without SCXI.

To use this object, you should have NI-DAQ 5.0 or better software installed.
While the NIDAQDevice object works with some earlier versions of
NI-DAQ software, it does not perform well with these earlier versions, and
has not been extensively tested.

Consult your NI-DAQ and NI-SCXI hardware, and NI-DAQ software
manuals for information on installing and configuring National Instruments
data acquisition software and hardware.

When you create an NISCXI object for the first time, or when you launch
Lookout and run an application using the NISCXI object, Lookout
automatically loads the NI-DAQ software. This can take a few moments,
during which the screen is frozen. Once the NI-DAQ software has loaded,
Lookout returns to its former speed.

@ Note This object class is available on 32-bit versions of Lookout 3.7 and later. It is not

backward compatible with earlier versions of Lookout, and does not run on the 16-bit
version of Lookout.
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Create NISCXI E
M ame: B

Device: I‘I—
On-board channel: ID—
SCHl chassieid: [T
Scanning interval: |5U—

millizeconds
Communication alarm pricrity: Is

QK I Eancell Help |

Figure 3-25. NISCXI Definition Parameters Dialog Box

Device is the NI-DAQ device number of the controlling device. The DAQ
configuration utility (WDAQConf . exe) assigns this number to an installed
device. Valid device numbers range is from 1 to 16.

On-board channel specifies the analog input channel of the controlling
device used to address this SCXI chassis. When only one chassis is being
controlled by the controlling board, this value should be 0. When this
chassis in a multi-chassis configuration, this value should reflect the order
of this chassis. For instance, the first chassis should be 0, the next chassis
should be 1, and so on. Valid range is O to 7. If there are no analog input
channels in this chassis, use the value 0.

SCXI chassis id is the chassis Id number assigned to this chassis by the
DAQ configuration utility.

Scanning interval is the time period between analog and digital input
polls. Valid range is 20 msec to 1 day (expressed in msec).

Communication alarm priority determines the priority level of the alarms
generated by the NISCXI object.
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NISCXI Data Members

Table 3-55. NISCXI Device Data Members

Data Member Type Read | Write Description

CommPFail logical yes no Object-generated signal that is on if,
for whatever reason, Lookout cannot
communicate with or control the
device without error.

MD1.AI0-MD12.A163 numeric yes no Analog input channel in volts.

MD1.AO0-MD12.A063 | numeric no yes Analog output channel in volts.

MD1 .cjtemp— numeric yes no Built-in cold-junction sensor on

MD12.cjtemp analog input terminal blocks.

MD1.DI0-MD12.DI31 logical yes no Digital input line.

MD1.DO0-MD12.DO31 | logical no yes Digital output line.

MD1.EtcO-MD12Etc31 numeric yes no Analog input channel with built-in
polynomial conversion for an E type
thermocouple.

MD1.JtcO0 - MD12Jtc31 numeric yes no Analog input channel with built-in
polynomial conversion for a J type
thermocouple.

MD1.KtcO — numeric yes no Analog input channel with built-in

MD12Ktc31 polynomial conversion for a K type
thermocouple.

MD1.RtcO — MD12Rtc31 | numeric yes no Analog input channel with built-in
polynomial conversion for an R type
thermocouple.

MD1.StcO — MD12Stc31 | numeric yes no Analog input channel with built-in
polynomial conversion for an S type
thermocouple.

MD1.TtcO - MD12Ttc31 | numeric yes no Analog input channel with built-in
polynomial conversion for a T type
thermocouple.

Update logical yes no Object-generated signal that pulses
low each time the object polls the
device.

© National Instruments Corporation 3-195 Lookout Object Reference Manual



Chapter 3 Lookout Driver and Protocol Objects

Configuring NIDAQ

INI for NISCXI

You may configure individual channel attributes by editing the NIDAQ . INT
file in your Lookout directory.

Channel Attributes

To specify a channel, use the following format: [DEV3.SC1.MD2.AI5]

This specifies analog input channel 5 on module 2 of SCXI chassis 1
controlled by device 3.

UPPERLIMIT specifies the upper input limit in volts (for example,
UPPERLIMIT=2.5). Usually used in conjunction with LOWERLIMIT.

LOWERLIMIT specifies the lower input limit in volts (for example,
LOWERLIMIT=-3.7). Usually used in conjunction with UPPERLIMIT.

Cold-Junction Sensor Attributes

To specify a cold-junction sensor, use the following format:
[DEV3.SC1.MD2.CJC]

This specifies the cold-junction sensor on module 2 of SCXI chassis 1
controlled by device 3.

SENSORTYPE specifies the type of temperature sensor on the terminal
block. Valid choices are 1C and THERMISTOR. Check your SCXI terminal
block documentation to determine the correct sensor type.

RESAMPLE specifies the number of minutes between resampling the
cold-junction sensor. Valid range is 1 to 10080, and 0. Use 0 to only check
the cold-junction sensor once at the start, and do not resample the sensor
later.

NISCXI Error Messages

Lookout Object Reference Manual

Error loading NI-DAQ driver

Lookout was not able to communicate to the NI-DAQ driver. Be sure that
NI-DAQ has been installed properly, and that you used the NI-DAQ
Configuration Utility to configure the your hardware devices.

NIDAQ: Analog Input: Invalid Data Member(s)
NIDAQ: Analog Output: Invalid Data Member(s)
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NIDAQ: Digital Input: Invalid Data Member(s)
NIDAQ: Digital Output: Invalid Data Member(s)

At least one channels you have specified is not valid for your current
hardware configuration. Be sure your hardware is configured properly
using the NI-DAQ Configuration Utility.

NIDAQ: Error code: NNNNN

NIDAQ: Analog Input: Error code: NNNNN
NIDAQ: Analog Output: Error code: NNNNN
NIDAQ: Digital Input: Error code: NNNNN
NIDAQ: Digital Output: Error code: NNNNN

NI-DAQ has detected an error condition. Please refer to your NI-DAQ
Function Reference Manual to determine the meaning of the error code.

SCXI Devices

You can use the following National Instruments data acquisition devices
with Lookout.

De